Copyright

Dragon version 13.

2014 Nuance Communications, Inc.

This material may not include some last-minute technical changes and/or revisions to the software. Changes are periodically made to the information provided here. Future versions of this material will incorporate these changes.

No part of this manual or software may be reproduced in any form or by any means, including, without limitation, electronic or mechanical, such as photocopying or recording, or by any information storage and retrieval systems, without the express written consent of Nuance Communications, Inc. Specifications are subject to change without notice.

Copyright © 2014 Nuance Communications, Inc. All rights reserved.

Nuance, ScanSoft, the Nuance logo, the Dragon logo, Dragon, DragonBar, NaturallySpeaking, NaturallyMobile, RealSpeak, Nothing But Speech (NBS), Natural Language Technology, Select-and-Say, MouseGrid, and Vocabulary Editor are registered trademarks or trademarks of Nuance Communications, Inc. in the United States or other countries. All other names and trademarks referenced herein are trademarks of Nuance Communications or their respective owners. Designations used by third-party manufacturers and sellers to distinguish their products may be claimed as trademarks by those third-parties.

Adobe and Acrobat are registered trademarks of Adobe Systems Incorporated. AMD is a trademark of Advanced Micro Devices, Inc. America Online is a registered trademark of America Online, Inc., a division of AOL Time Warner. Corel and WordPerfect are registered trademarks of Corel Corporation. iPAQ is a registered trademark of the Hewlett-Packard Company. Lotus and Lotus Notes are registered trademarks of Lotus Development Corporation. Macromedia Flash is a trademark of Macromedia, Inc. Microsoft, Outlook, Windows, Windows NT, Visual Basic, and PowerPoint are trademarks or registered trademarks of Microsoft Corporation. Mozilla, Mozilla Firefox, and Mozilla Thunderbird are trademarks or registered trademarks of the Mozilla Foundation. Palm OS is a registered trademark of PalmSource, Inc. or its affiliates. Panasonic is a registered trademark of the Matsushita Electric Industrial Co., Ltd. Pentium is a registered trademark of Intel Corporation. Sony and Memory Stick are registered trademarks of the Sony Corporation. Voice It, the Voice It logo, and Voice It Link are trademarks or registered trademarks of VXI Corporation.

Disclaimer

Nuance makes no warranty, express or implied, with respect to the quality, reliability, currency, accuracy, or freedom from error of this document or the product or products referred to herein and specifically disclaims any implied warranties, including, without limitation, any implied warranty of merchantability, fitness for any particular purpose, or non-infringement.

Nuance disclaims all liability for any direct, indirect, incidental, consequential, special, or exemplary damages resulting from the use of the information in this document. Mention of any product not manufactured by Nuance does not constitute an endorsement by Nuance of that product.

Notice

Nuance Communications, Inc. is strongly committed to creating high quality voice and data management products that, when used in conjunction with your own company’s security policies and practices, deliver an efficient and secure means of managing confidential information.

Nuance believes that data security is best maintained by limiting access to various types of information to authorized users only. Although no software product can completely guarantee against security failure, Dragon software contains configurable password features that, when used properly, provide a high degree of protection.
We strongly urge current owners of Nuance products that include optional system password features to verify that these features are enabled! You can call our support line if you need assistance in setting up passwords correctly or in verifying your existing security settings.

Published by Nuance Communications, Inc., Burlington, Massachusetts, USA
Visit us on the Web at www.nuance.com. Links to our international web sites are shown there.
<table>
<thead>
<tr>
<th>Contents</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Upgrading Dragon</td>
<td>68</td>
</tr>
<tr>
<td>What you should know before upgrading from a previous version</td>
<td>69</td>
</tr>
<tr>
<td>Installing on or upgrading to Windows 7 or Windows 8</td>
<td>69</td>
</tr>
<tr>
<td>Upgrading multiple User Profiles</td>
<td>70</td>
</tr>
<tr>
<td>Upgrading Roaming User Profiles: Overview</td>
<td>73</td>
</tr>
<tr>
<td>Upgrading master Roaming User Profiles</td>
<td>74</td>
</tr>
<tr>
<td>Upgrading end-user systems</td>
<td>78</td>
</tr>
<tr>
<td>Upgrading User Profiles that use third-party vocabularies</td>
<td>79</td>
</tr>
<tr>
<td>Chapter 5: Installing Dragon using the Windows installer (MSI)</td>
<td>82</td>
</tr>
<tr>
<td>Overview of Installing Dragon using the Windows Installer (MSI)</td>
<td>82</td>
</tr>
<tr>
<td>Overview of the Network Installation of Dragon from a Server</td>
<td>84</td>
</tr>
<tr>
<td>Modifying Roaming User Profile, Miscellaneous, Schedule Settings in the INI File</td>
<td>85</td>
</tr>
<tr>
<td>Understanding and applying the Roaming User Options</td>
<td>85</td>
</tr>
<tr>
<td>Editing Miscellaneous and Scheduled Task Settings in nsdefaults.ini File</td>
<td>90</td>
</tr>
<tr>
<td>Understanding Network and Connection Settings in roamingdef.ini File</td>
<td>94</td>
</tr>
<tr>
<td>Carrying Out an Administrative Installation with .bat File</td>
<td>96</td>
</tr>
<tr>
<td>Install Dragon on an initial computer and choose the default settings</td>
<td>98</td>
</tr>
<tr>
<td>Extracting MSI/MST Files from the Dragon setup.exe</td>
<td>98</td>
</tr>
<tr>
<td>Using .MSI/.MST Files for Custom Installations Example</td>
<td>101</td>
</tr>
<tr>
<td>Installation using the Dragon installation process</td>
<td>101</td>
</tr>
<tr>
<td>Install the same Dragon configuration on multiple computers</td>
<td>103</td>
</tr>
<tr>
<td>Creating Custom Installation Using Microsoft Custom Install Wizard</td>
<td>104</td>
</tr>
<tr>
<td>Installation using the Dragon command line</td>
<td>110</td>
</tr>
<tr>
<td>Natspeak.exe command line reference</td>
<td>114</td>
</tr>
<tr>
<td>Other Actions You Can Take on Command Line</td>
<td>115</td>
</tr>
<tr>
<td>Modifying Default Installation Directory</td>
<td>115</td>
</tr>
<tr>
<td>Configuring Installation of Product Updates</td>
<td>116</td>
</tr>
<tr>
<td>Suppressing Reboot of the computer After Installation</td>
<td>116</td>
</tr>
<tr>
<td>Installing the same Roaming User Profile Configuration on Additional computer(s)</td>
<td>117</td>
</tr>
<tr>
<td>Revising Day/Time of Scheduled Tasks (Optional)</td>
<td>117</td>
</tr>
<tr>
<td>Configuring Local or On-Demand Install of Vocabularies/Text-to-Speech (Optional)</td>
<td>118</td>
</tr>
<tr>
<td>Upgrading Your Dragon Installation from the Command Line</td>
<td>120</td>
</tr>
<tr>
<td>Step-by-Step Process for Upgrading Roaming User Profiles</td>
<td>121</td>
</tr>
<tr>
<td>Major and Minor Upgrades: Silent Upgrade</td>
<td>126</td>
</tr>
<tr>
<td>Using setup.exe for Upgrades</td>
<td>129</td>
</tr>
<tr>
<td>Step-by-Step Command Line Installation with msiexec.exe</td>
<td>130</td>
</tr>
<tr>
<td>Additional Options for Installations with msiexec.exe</td>
<td>131</td>
</tr>
<tr>
<td>Additional Options for Silent Installations</td>
<td>132</td>
</tr>
<tr>
<td>MSI Options Specific to Dragon</td>
<td>136</td>
</tr>
<tr>
<td>MSI Options for Installing Dragon Features/Advanced Options</td>
<td>140</td>
</tr>
<tr>
<td>MSI Options for Roaming User Profile, Tuning, and Data Collection Setup</td>
<td>143</td>
</tr>
</tbody>
</table>
Feature Variables to Set Through the ADDLOCAL or ADVERTISE Properties ........................................... 145

Chapter 6: Configuring and using the Roaming feature and Roaming User Profiles .................. 150

Setting up the Roaming feature ............................................................................................................. 150
Overview of the Roaming feature .......................................................................................................... 152
Setting up the Roaming feature ............................................................................................................. 156
Creating a network storage location for the Master Roaming User Profiles ........................................ 157
Where to install and configure Dragon NaturallySpeaking13 ............................................................... 159
Storage space required for the Master and Local Roaming User Profiles .......................................... 161
How Dragon Synchronizes Master and Local Roaming User Profiles .............................................. 162
Estimating Network traffic caused by synchronization ........................................................................... 165
Enabling the Roaming feature on each computer where an end-user will dictate ................................ 170
Administrative Settings: Roaming tab .................................................................................................... 173
Administrative Settings: Roaming User Network Location ................................................................. 175
Setting up HTTP Connection: HTTP Settings ..................................................................................... 177
Setting up secure web server connection: SSL Settings ....................................................................... 179
Testing and troubleshooting an HTTP connection ............................................................................... 181
Setting and selecting Roaming User Profile options ........................................................................... 183
Creating a Roaming User Profile on the local computer ..................................................................... 187
Creating and training a new Roaming User Profile ............................................................................ 188
Converting a non-roaming local User Profile into a Roaming User Profile ......................................... 188
Dictating with a Roaming User Profile ................................................................................................. 189
Opening a Roaming User Profile .......................................................................................................... 189
Using multiple dictation sources with a single User Profile ................................................................. 190
Running the Acoustic and Language Model Optimizer for Roaming User Profiles ............................ 191
Controlling access to User Profiles ....................................................................................................... 192
Configuring Internet Information Services and WebDAV for HTTP Roaming ..................................... 194
Configuring Internet Information Services and WebDAV ................................................................ 194
Configuring Dragon internet roaming .................................................................................................. 195
Upgrading Roaming User Profiles: Overview ....................................................................................... 196
Preparing to upgrade Roaming User Profiles ...................................................................................... 197
Upgrading master Roaming User Profiles ............................................................................................ 199
Upgrading end-user systems .................................................................................................................. 203

Chapter 7: Using Dragon through a remote desktop connection .................................................... 206

Using Dragon through a remote desktop connection ........................................................................ 206
Overview of using Dragon on a remote computer through a remote desktop connection ............... 207
Overview of configuring Dragon and the Remote Desktop connection feature ................................ 209
Configuring the remote computer ......................................................................................................... 212
Configuring Remote Desktop Connection for Windows Server 2008 R2 Part 1 ............................. 212
Configuring Remote Desktop Connection for Windows Server 2008 R2 Part 2 .............................. 217
Configuring Remote Desktop Connection for Windows 7 and Windows 8 that run Dragon .......... 218
Configuring the client computer to connect to Dragon through a remote desktop connection .......... 220
Chapter 13: Configuring administrative features in Dragon

Summaries of Administrative Settings Dialog Boxes

Administrative Settings: Roaming tab
Administrative Settings: Roaming User Network Location
Administrative Settings: Miscellaneous tab
Administrative Settings: Scheduled Tasks tab

Glossary

.DRA files (definition)
Accuracy Center (definition)
Accuracy Tuning (definition)
Acoustic Optimizer (definition)
Advanced Scripting (definition)
Commands-only Vocabulary (definition)
Command Browser (definition)
Correction menu (definition)
Command Mode (definition)
Correction-only mode (definition)
Data Distribution Tool (definition)
Dictation Box (definition)
Dictation Mode (definition)
Dictation Source (definition)
DragonPad (definition)
Language Model optimization (definition)
Language Model Optimizer (definition)
Normal Mode (definition)
Numbers mode (definition)
QuickStart (definition)
Recognition Modes (definition)
Roaming User (definition)
Spell Mode (definition)
User Profile (definition)
Chapter 1: Introduction to Dragon NaturallySpeaking

The Dragon NaturallySpeaking Administrator guide is intended for administrators that deploy and manage installations of:

- Professional edition
- Legal edition

The administrator guide refers to these products generically as Dragon NaturallySpeaking. We will mention when a feature applies specifically to one or more of these products editions.

Use the Dragon Administrator guide to install Dragon NaturallySpeaking, and to configure and manage the many features, tools, and User Profiles in Dragon NaturallySpeaking. To install Dragon NaturallySpeaking and perform the tasks in this guide, you must have administrator access to the workstations in your network.

Dragon NaturallySpeaking contains new features and improvements that enhance the ability to talk to, control, and interact with a computer. This section contains general information about Dragon and the exciting new features of Dragon NaturallySpeaking.
## Getting started with Dragon NaturallySpeaking

<table>
<thead>
<tr>
<th>What's New for administrators</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dragon on the Web</td>
</tr>
<tr>
<td>The Nuance web site (<a href="http://www.nuance.com">www.nuance.com</a>) gives you access to many resources, including frequently asked questions, usage tips, customer stories, customer service information, technical support content, and a detailed comparison between Dragon editions.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Installing, modifying and upgrading Dragon NaturallySpeaking and Installation checklists</th>
</tr>
</thead>
<tbody>
<tr>
<td>View information on the different ways to install, modify, and upgrade Dragon NaturallySpeaking.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Setting up the Roaming feature</th>
</tr>
</thead>
<tbody>
<tr>
<td>The <strong>Roaming</strong> feature lets end-users dictate with Dragon NaturallySpeaking from different network locations and different computers without having to create and train individual User Profiles at each location.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Adding words, commands, or vocabularies to User Profiles</th>
</tr>
</thead>
<tbody>
<tr>
<td>You use the <code>nsadmin</code> command line utility and the <strong>Data Distribution Tool</strong> when you want to make new words, customized vocabularies or new commands available to all User Profiles on a particular Dragon NaturallySpeaking installation.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Using the Convert XML to DAT tool and the MyCommands Protection Utility</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Using Structured Commands</strong></td>
</tr>
<tr>
<td><em>Dragon Professional and Legal editions</em> - include an extension to Text-and-Graphics commands that let you to set the values of variables in text blocks based on voice input.</td>
</tr>
</tbody>
</table>

| Dragon NaturallySpeaking System requirements |
Chapter 1: Introduction to Dragon NaturallySpeaking

Known issues in Dragon NaturallySpeaking 13
**TN 16500 - Dragon is not working with some web pages**

**Information:**

Dragon users may access a web site that does not support RIA (Rich Internet Application) or Dragon Web Extensions.

Some web pages were designed to work with a specific version of Internet Explorer 8 or earlier. Once newer versions of Internet Explorer were released, these web sites did not display correctly. To fix this issue, the web site author made the site render in a compatibility mode for the older versions of Internet Explorer 8 or earlier.

On these web sites, RIA support or Dragon Web Extensions do not work. The web site is not fully compatible with the current version of Internet Explorer that is used to access the site. The issue is not caused by Dragon RIA support or Dragon Web Extensions.

**Note:** For more information about RIA for Dragon 12 and Dragon Web Extensions for Dragon 13 please see [http://nuance.custhelp.com](http://nuance.custhelp.com).

---

**TN 16499 - Dragon Web Extension is no longer functional after upgrading to Dragon NaturallySpeaking 13**

**Problem:**

When upgrading from Dragon NaturallySpeaking 12 to Dragon NaturallySpeaking 13, the Dragon Web Extension functionality may no longer be available in any web browser.

**Cause:**

This behavior may occur when the Dragon NaturallySpeaking 12 User Profile has the "Enable HTML support" option disabled when upgrading the profile.

**Solution:**

In order to resolve this issue, ensure that the "Enable HTML support" option is checked when upgrading a Dragon NaturallySpeaking 12 User Profile.

---

**TN 16518 - Prompt to install Dragon Web Extension after it has already been installed**

**Problem:**

When launching the Google Chrome or Mozilla Firefox web browser, the prompt to install the Dragon Web Extension may appear, even if it had already been installed previously in the web browser.

**Cause:**

This behavior may occur when Dragon NaturallySpeaking 13 is un-installed and re-installed.

**Workaround:**
### TN 16519 - Unable to dictate into the Google Chrome log-in site or web store

**Information:**

When a user accesses certain web sites in Google Chrome and Firefox web browsers, Dragon NaturallySpeaking 13 is unable to process RIA commands such as "Click text link" or dictate into text fields.

Some sites, including the Chrome Sign-In page and Chrome Webstore, are affected by this issue. Dragon is unable to process RIA commands for these sites.

The RIA is inactive in Chrome and Firefox in the above mentioned pages and cannot be loaded.

When a user uses Firefox to access the the address bar, the Chrome Sign-in page, or the Chrome WebStore site, and the 'Use the Dictation Box for unsupported applications' is enabled, Dragon displays the Dictation Box to the user. If the 'Use the Dictation Box for unsupported applications' option is not enabled, Dragon has basic text control functionality.

**Note:** This is a limitation of RIA on these pages and cannot be corrected.

---

To suppress the prompt:
1. Check the "No Thanks" checkbox.
2. When the Dragon Web Extension installation prompt appears, click "Do not ask me again".
What's new for administrators
**Upgrading to Dragon NaturallySpeaking13**
You can upgrade from Dragon NaturallySpeaking 11.x and 12.x to Dragon NaturallySpeaking13.

For details, visit [Upgrading Dragon](#).

**Support for Bluetooth speech models**
Dragon NaturallySpeaking13 does not include support for Bluetooth-specific speech models or Enhanced Bluetooth.

When you upgrade a User Profile that contains Bluetooth models to Dragon NaturallySpeaking13, the Bluetooth models are upgraded to non-Bluetooth models.

**Canadian vocabulary**
For Canadian customers: When creating a profile, you can now pick Canada as your region to have Dragon's vocabulary support the unique spellings of Canadian English. For example, "honour" instead of "honor."

Impact on upgrading User Profiles:
User Profiles with US English models marked with a Canadian region are upgraded to the new Canadian Language Model (Vocabulary).

Creating and using custom Canadian vocabularies:
An end-user can create a custom *Canadian* vocabulary that uses the Canadian vocabulary as a base.

For example: An end-user creates a user profile with the ‘Canada’ region, adds and removes words, and/or changes some word properties, then exports the vocabulary from the User Profile.

When the end-user creates a new User Profile, they can use the nsadmin tool to add a new vocabulary that is based on the exported vocabulary. A custom *Canadian* vocabulary is available as a choice in the ‘Canada’ region.

**Choosing a vocabulary for a new User Profile**
When you create a new User Profile, the vocabulary choice is only available after customized vocabularies have been created and deployed.

This means that the **Choose your speech options** screen displays the **Select your preferred vocabulary option** only if:

- A new vocabulary is installed using the nsadmin tool.
- A Commands Only vocabulary is available.

**Managing audio sources**
In Dragon NaturallySpeaking13, you cannot delete an audio source.

**Support for laptops with a built-in microphone**
Dragon NaturallySpeaking 13 includes support for end-users that use Dragon with a laptop that has a built-in microphone. This type of microphone is considered to be 'far' from the user's mouth when they are performing dictation.

The user may use the Far Field BestMatch IV acoustic model or the Far Field BestMatch V acoustic model when they create a User Profile. Both of these models are available in the *Speech acoustic model* drop-down list on the *Choose speech recognition options* screen.

The Far Field BestMatch V acoustic model is also selected automatically by the “Auto Accent Model” detection phase during Acoustic and Language Model Optimization.

### Web experience

The Dragon Web extension now gives Full Text Control in Chrome and Firefox as well as in Internet Explorer, in most web sites. In order to use Dragon in the supported browsers, you must enable this add-on.

There are some differences in functionality between browsers. When you are in Internet Explorer, Firefox, or Chrome, see the Learning Center for commands you might want to say, as well as tips.

For more information, see [Installing and enabling the Dragon Web Extension](#).

### Compatibility Alerts

If its add-in for a supported application (such as Microsoft Word) becomes disabled, Dragon now displays a warning, with a link to Help on how to solve the issue. (These add-ins enable Full Text Control; they are known as “compatibility modules.”)

This can be turned off on the Miscellaneous tab of the Options dialog.

For details, see 'The Options dialog box Miscellaneous tab' in the Dragon Help.

### Shorter Profile Creation Process

For the first profile, the profile creation wizard simply assigns the profile a name rather than asking you to enter a name (if you want to rename the profile later, use the Manage Profiles dialog).

The step where Dragon proposed reading a text aloud is now omitted. (As before, you can read a training text after creating your profile; see “Read text to train Dragon to your voice” in the Accuracy Center.)

Similarly, the step where Dragon offered to adapt its vocabulary based on documents and sent emails is now omitted, and you can launch the analysis of documents and emails once your profile is created.

### Simplified Audio Setup

Dragon now detects audio devices better. In most cases, when Dragon presents the list of detected devices, you can just pick the device it shows as recommended and continue.
In addition, the Microphone Check is now just one screen and its text is easier to read.

Important: Using more than one input device is now done by picking Manage Dictation Sources on the DragonBar’s Profile menu. If you add multiple audio sources in your profile, you benefit from your profile’s refinements (such as changing an option, correcting an error, or analyzing emails to personalize the vocabulary) whenever you use Dragon, regardless of what audio device you’re speaking into.

For details, see ‘Using Multiple Dictation Sources with a Single User Profile’ in the Dragon Help.

**Open-ended custom commands (Professional and Legal editions only)**

In the Professional and Legal editions, Dragon now offers new flexibility for custom command types that support variable names: the ability to end the command’s name with any word or phrase in the vocabulary, as opposed to a word or phrase from a defined list of command variables.

This can allow users to have, for instance, commands that search for given words within their company’s intranet (similar to the built-in search commands like “search Wikipedia for…”).

For details, see ‘Creating open-ended custom commands’ in the Dragon Help.

**Always replaces Ask Me as the default for deferred correction (Professional and Legal editions only)**

The option to automatically create a recording (DRA file) along with your dictated document (available in the Professional and Legal editions only) is now set to Always, by default.

If you wish, you can change it to Never or Ask Me on the Data tab of the Options dialog. DRA files can be large, so once you no longer need them you may want to delete them.

For details, see ‘Correcting dictation later’ in the Dragon Help.

Note: The option ‘Always preserve wave data’ has been removed from the Options dialog (it was on the Data tab, under Advanced).

**Updated system requirements**

Updates to the system requirements include support for:
- Microsoft® Internet Explorer 9 or higher or the current version of Chrome or Firefox for Rich Internet Applications.
- Office 2010 and Office 2013
- Support for the Remote Desktop Connection feature with Windows Server 2012

For details, see [Dragon system requirements](#).

**Updates to the Dragon log file**

In DNS 13, the Dragon log file is stored in a new location and uses a new file format. For details, see [The Dragon log file](#).
Changes to Dragon client features

The following features have been removed:
- Tip of the Day
- The ability to read a training text “with prompting”
- The non-interactive Tutorial
- The Audio Bar

For more details about Dragon client end-user features, see the Dragon Help.

Auto-saving end-user recognition history data

In Dragon NaturallySpeaking, you can configure Dragon to auto-save recognition history data for Dragon end-users. This feature creates an on disk transcript of Dragon use for each Dragon end-user. These transcripts can then be used to monitor and help end-users during pilot and training programs.

Dragon writes the end-user recognition data into two recognition history log text files. Dragon always stores the recognition history log files in the end-user’s local User Profile directory on the Dragon client computer. Dragon stores the files in this location regardless if the end-user is a roaming or non-roaming end-user.

You can only consider the data in the recognition history log files as valid when the User Profile is not loaded. Dragon only allows two recognition history log files to exist at any one time.

The recognition history log files contain private information. You must implement appropriate security measures to protect and control access to the log files.

See the following topics for more information:

- Creation and management of the recognition history log files
- Contents of the recognition history log files
- Enabling or disabling the logging of recognition history for an end-user
- Removing the recognition history log files
- Enabling the auto-saving of recognition history during a Dragon push installation

Creation and management of the recognition history log files

Dragon creates and manages two recognition history log files:

- RecogLog_<year_month_day>.txt: An older recognition history log file. Dragon no longer saves data into this file. The name of this file includes its creation date, for example, RecogLog_2011_08_04.txt.

The RecogLog files are located:
In the local User Profile directory:
C:\ProgramData\Nuance\NaturallySpeaking13\Users

In the backup locations for the User Profiles:
C:\ProgramData\Nuance\NaturallySpeaking13\Users\backup

When an end-user loads a User Profile, Dragon examines the creation date of the oldest recognition history log file. Dragon keeps a maximum of two log files. Dragon creates a new log file every 10 days or when the size of the old log file exceeds 3 MB.

If creating a new recognition history log file would result in three files, Dragon deletes the oldest recognition history log file.

Contents of the recognition history log files

Each recognition history log file contains the same information you can view in the Recognition History window:

- Words, phrases, and commands that Dragon recently recognized for the end-user.
- All words, phrases, and commands that Dragon has ever recognized for the end-user.

In addition, each log file includes the following information:

- The name of the User Profile used to create the recognition data.
- The name of the vocabulary used to create the recognition data.
- The name of the dictation audio source used to create the recognition data.

Enabling or disabling the logging of recognition history for an end-user

To enable or disable auto-saving of recognition history for an end-user, perform the following steps on the Dragon client computer:

1. Open text editing software such as Notepad. On Windows 7, or Windows 8, make sure you have administrator rights when you open the text editor (use the “Run as administrator” option to open the text editor).
2. In the text editor, navigate to the folder that contains the nssystem.ini file.
   In Windows 7 and Windows 8, by default, the nssystem.ini file is located in:
   C:\ProgramData\Nuance\NaturallySpeaking13
3. In the text editor, open the nssystem.ini file.
4. In the “[Settings]” section, add the following line of text: `SavePerUserProfileUtteranceData`. The option name is case sensitive. You should type the option name exactly as it appears here.
5. To enable the logging of recognition history, set the `SavePerUserProfileUtteranceData` option to 1. For example, `SavePerUserProfileUtteranceData=1`. This will log the spoken form of data.
6. To enable the logging of recognition history, including spoken and written form data, set the `SavePerUserProfileUtteranceData` option to 2. For example, `SavePerUserProfileUtteranceData=2`. This is useful for debugging activities.
7. To disable the logging, delete the \SavePerUserProfileUtteranceData\ line from the .ini file. Optionally, you can set \SavePerUserProfileUtteranceData=0\ to disable logging.

8. Save and close the nssystem.ini file.

9. To activate the setting, re-open the User Profile.

Removing the recognition history log files
There are several ways you can remove the recognition history log files for an end-user.

Disable the \SavePerUserProfileUtteranceData\ option
When an end-user loads a User Profile, Dragon checks the profile to see if the \SavePerUserProfileUtteranceData\ option is enabled.

If the option is disabled (set to 0 or the option is not in nssystem.ini), when Dragon next loads that particular User Profile, Dragon deletes all existing recognition history log files for that User Profile.

Manually delete the recognition history log files
Delete the RecogLog.txt and RecogLog_….txt files in the following locations:

- In the local User Profile directory:
  C:\ProgramData\Nuance\NaturallySpeaking13\Users
- In the backup locations for the User Profiles:
  C:\ProgramData\Nuance\NaturallySpeaking13\Users\backup

Enable auto-saving of recognition history during a Dragon push installation
You can enable auto-saving of recognition history when you install Dragon to workstations using an MSI push install.

1. Use administrator privileges to install Dragon on a Windows computer.
2. Start Dragon.
3. In a text editor, open the nsdefaults.ini file.
   In Windows 7 and Windows 8, by default, the nsdefaults.ini file is located in the following directory:
   C:\ProgramData\Nuance\NaturallySpeaking13
4. Add the following line to the nsdefaults.ini file: \SavePerUserProfileUtteranceData\ option=1.
5. (Optional) Open Dragon and set options that you want to be set on all Dragon installations in your network. You can set Dragon Options and the Roaming User, Miscellaneous, and Scheduled Task Administrative Settings.
6. Save the changes and close Dragon.
7. Copy the updated nsdefaults.ini file to a new location so you can use the updated file to push install Dragon on other workstations. When you push install the Dragon configuration to other workstations, use the updated nsdefaults.ini file as input for the DEFAULTSINI option. For example, DEFAULTSINI=":c:\<path>\nsdefaults.ini".
   See step 7 in Install the same Dragon configuration on multiple computers.
For more information about pushing Dragon installations to workstations, see:

- Overview of the Network Installation of Dragon from a Server
- Install the same Dragon configuration on multiple computers

**Supporting Web applications**

Dragon NaturallySpeaking includes Web Application Support that provides Full Text Control when an end-user dictates into Web mail applications. With some limitations, end-users can dictate content and use commands just as they would in a desktop program.

Web application support means support for selected browser-based applications using Rich Internet Application (RIA) support. RIA support installs extensions in supported Web browsers.

**Supported web browsers**

Dragon NaturallySpeaking provides RIA support for the following Web browsers:

- Internet Explorer 9 (32-bit) or higher
- Mozilla Firefox 12 or higher
- Google Chrome 16 or higher

**Supported web applications**

Dragon NaturallySpeaking recognizes unique commands for the following Web applications:

- Gmail
- Hotmail

**Non-supported browsers and non-supported web applications**

In non-supported web browsers, an end-user can still use Dragon's basic commands with the Web application, but they won't have access to the commands that work specifically with that application.

In non-supported web applications, an end-user can use the Dictation Box to utilize Full Text Control while they dictate. After the end-user enters text in the Dictation Box, they can transfer the text to a field they are working in.

See the Dragon Help for details.

**Enabling and using Web application support**

An end-user performs the following general steps to enable web application support:

1. Ensures the requirements for web application support are met.
2. Launches Dragon and launches the browser.
3. Clicks or says "Yes" at the prompt to enable the browser extensions or perform the steps in .Enabling Web application support in a supported browser
4. Goes to the site for the Web application they want to use and logs in to their account.
5. Determine if the feature is turned on. See Verifying web application support is on.
6. Begin a dictation session in the web application.

**Notes:**
With Google Chrome - RIA does not work if using Chrome's Incognito mode.

After an end-user enables the extensions in Internet Explorer, they must restart the browser or open a new tab before they can use the new commands.

Web application support commands don't work if an end-user is working off-line.

Verifying web application support is on

When Dragon's Web application support is active in Hotmail or Gmail:

- Users see a green dot next to objects that they can click by voice
- When the cursor in an e-mail field or the message body, the Full Text Control Indicator is green

Troubleshooting web application support

See Troubleshooting web applications for details.

**Enabling Web application support in a supported browser**

Dragon's Rich Internet Application extensions install on a computer when you install Dragon. Afterwards, the extension must be enabled to work with a supported web browser.

After installing Dragon, the easiest way to enable the extensions is for the end-user to click or say "Yes" to the prompt to enable them the first time the end-user opens one of the supported browsers. The end-user just says or clicks "Yes" to enable the extensions.

The following are the steps for enabling Rich Internet Application extensions with one of the following supported browsers:

- Internet Explorer 9 (32-bit)
- Mozilla Firefox 12 or higher
- Google Chrome 16 or higher

**Enabling Web application support in Internet Explorer 9 (32-bit mode) or later**

After installing Dragon, a Dragon end-user performs the following steps to enable web application support or to check the extension settings with Internet Explorer 9:

1. Open Internet Explorer.
2. Click the cog icon on the title bar.
3. Click "Manage Add-ons."
4. Scroll the Add-ons list to the section for Nuance Communications, Inc.
5. If the Status column indicates that either the Plugin or Extension is "Disabled," do the following:
   vi. Select the name of the item from the list.
   vii. Click "Enable" at the bottom of the Manage Add-ons dialog box.
8. Click "Close" to close the Manage Add-ons dialog box.
9. Close and reopen the browser. The feature will now be enabled.

**Enabling Web application support in Mozilla Firefox 12 or higher**

After installing Dragon, a Dragon end-user performs the following steps to enable web application support or to check the extension settings with Mozilla Firefox:
1. Open Mozilla Firefox.
2. Click the Firefox button to open the Firefox file tab.
3. Click "Add-ons" to open the Extensions pane. The Dragon RIA extension shows.
4. If the extension is disabled, click "Enable."
5. Click "Plugins" to open the Plugins screen, and look for the Dragon RIA plugin.
6. If the extension is disabled, click "Enable."

Be careful when you upgrade!

When you upgrade Firefox, you’ll see a window prompting you to choose which add-ons you want to keep active. **You must select the Dragon RIA extension, or Firefox will automatically disable it.** If this happens, use the steps above to re-enable it.

Enabling Web application support in Google Chrome 16 or higher

After installing Dragon, a Dragon end-user performs the following steps to enable web application support or to check the extension settings with Google Chrome:

1. Open Google Chrome.
2. Click the Wrench icon beside the Address bar to open the Google Customization and Control menu.
3. Click "Settings."
4. Click "Extensions." The Dragon RIA Extension for Chrome displays.
5. Close and reopen the browser. If necessary, click "Enable" to enable the Dragon Rich Internet Application extension. A checkmark appears in the "Enabled" checkbox when the Dragon RIA extension is enabled.

**Troubleshooting web applications**

Check the following items if an end-user experiences issues using Dragon with web applications:

- Make sure end-users are using a supported browser.
- Make sure web application support is turned on.
- Make sure the browser extension or plug-in is enabled: Dragon NaturallySpeaking includes plug-in and extension files that Web browsers use to provide Rich Internet Application support. If an end-user is having trouble, make sure the RIA plug-in or extension is enabled for the browser they are using. This can be done from a Tools or Options menu. After enabling it, the end-user must restart the browser.
- Make sure there are no issues with the site: Changes a site makes to its layout or functionality can cause compatibility problems for Dragon. Nuance makes every effort to keep up with these changes, but if end-users encounter difficulties, please contact Nuance Technical Support.
- Make sure end-users are using the correct language: To use Rich Internet Application support and web browser commands, end-users must set the language of the Web application to the same language as their User Profile. If a profile is set up in English, end-users must set up the web application (Hotmail or Gmail) in English.
- Make sure end-users are not working offline: Offline mode is not supported for working with Web-based documents.
Play back dictation in a web application: use voice commands such as "Play that back," "Read that," and "Read selection." Dragon does not support playback of dictation using menus and buttons.

Trouble opening the Correction menu: Dragon does not currently support the following methods for opening the Correction menu when working in web applications:
- Using the hot key. By default, this is the Minus key (-)
- Double-clicking on selected text
- Clicking the Correction button on the DragonBar Extras toolbar

Managing Smart Format Rules

Dragon NaturallySpeaking can learn from the corrections an end-user makes. If the corrections are format related or related to alternate written forms, Smart Format Rules may display a prompt to allow an end-user to set up corresponding format rules for future dictation. When the end-user edits dictated text that corresponds to an Auto-Formatting option or Alternate Written Form Formatting, Dragon displays a "hint," asking if the end-user wants to enable or disable the setting. The end-user can also ignore the hint by continuing dictation, making keyboard edits, or saying "Cancel" to close the hint.

If an end-user selects a smart format rule, the rewrite rule will apply for their future dictation. To revert the rule, the end-user can make corrections in a different way. For example, if you have applied a rule to always rewrite kilogram to kg. Making a correction from "kg" to "kilogram" will trigger a Smart format rule prompt and you can apply the rule to "always rewrite kg to kilogram"

Smart Format Rules hints display when an end-user edits auto-formatted text using:
- The Correction menu
- The Spelling window
- The keyboard.

Enabling or disabling Smart Format Rules

Both Dragon end-users and administrators can enable or disable Smart Format Rules.

Enabling Smart Format Rules
1. Select Tools menu > Options from the DragonBar.
2. Select Correction.
3. Check the Show Smart Format Rules option.
4. Select OK to close the dialog box and apply your changes.

Disabling Smart Format Rules
1. Select Tools menu > Options from the DragonBar.
2. Select Correction.
3. Uncheck the Show Smart Format Rules option.
4. Select OK to close the dialog box and apply your changes.
Hiding Dictation Box confirmation

In Dragon NaturallySpeaking, Dragon end-users can close the Dictation Box without having to view or respond to the ‘confirm’ dialog box.

Hide the Dictation Box close confirmation for one end-user

1. Make sure Dragon is closed.
2. In Windows 7, on the Dragon workstation, navigate to
   C:\ProgramData\Nuance\NaturallySpeaking13\Users\<user_name>\current
3. Use a text editor to open the options.ini file.
4. To have Dragon not display the close confirmation dialog box, add the following to the options.ini file: Confirm Dictation Box Close=0
5. To have Dragon display the close confirmation dialog box again, delete the Confirm Dictation Box Close line from the options.ini file.
6. Save the options.ini file.

Hide the Dictation Box close confirmation for all created end-users

1. Start Dragon.
2. In Windows 7 or Windows 8, on the Dragon workstation, navigate to
   C:\ProgramData\Nuance\NaturallySpeaking13
3. Use a text editor to open the nsdefaults.ini file.
4. To have Dragon not display the confirmation dialog box for all end-users created on the Dragon installation, add the following two lines to the nsdefaults.ini file:
   [options.ini Options]
   Confirm Dictation Box Close=0.
5. Save the changes and close Dragon.
6. Copy the updated nsdefaults.ini file to a new location so you can use the updated file to push install Dragon on other workstations. When you push install the Dragon configuration to other workstations, use the updated nsdefaults.ini file as input for the DEFAULTSINI option. For example, DEFAULTSINI="c:\<path>\nsdefaults.ini". See step 7 in Install the same Dragon configuration on multiple computers.

For more information about pushing Dragon installations to workstations, see:

- Overview of the Network Installation of Dragon from a Server
- Install the same Dragon configuration on multiple computers

Sending a notification when the AutoTranscribe Folder Agent completes a transcription job

Administrators can use the command line send an email notification when the AutoTranscribe Folder Agent completes a transcription job. After the transaction job completes, the agent sends an email to an address specified by the administrator or end-user.

Users need to specify a path to a .cmd file and must specify the email address of the email recipient(s) in the Command line field on the Dragon AutoTranscribe Folder Agent dialog.
When the Auto-Transcribe Folder Agent dialog completes a transaction job, an email is sent to the email address or addresses in the **Command line** field.

An email notification can be sent using Microsoft Exchange 2000 Server, SMTP, or Lotus Notes.

**Note:** The mapisend.exe, blat.exe, bmail.exe tools are third party software and Dragon does not include them.

**Microsoft Exchange command line example**

**Message syntax**

mapisend.exe -u <profile> -p <password> -r <recipient> -s <subject>

**Example cmd file content**

```cmd
@echo off
Echo "Output directory - " %1
Echo "Output filename - " %2
Echo "Output format - " %3
If "%3" == "TXT" (  
    mapisend.exe -u Microsoft Outlook Profile - p ********* -r %4 -s "Transcribing has been completed"
)
If "%3" == "RTF" (  
    mapisend.exe -u Microsoft Outlook Profile - p ********* -r %4 -s "Transcribing has been completed"
)
If "%3" == "DOC" (  
    mapisend.exe -u Microsoft Outlook Profile - p ********* -r %4 -s "Transcribing has been completed"
)
mapisend.exe options

- -u profile - the end-user mailbox of the sender
- -p password - mailbox password of the sender
- -r recipient - email address(s) of the recipient. If more than one recipient - separate with ";" these must not be ambiguous in the default address book.
- -s subject - subject line of the email message
- -text message [options]
- -text_file [options]
```

**options:**
-i interactive login (prompts for profile and password)
-cc cc: list
-f File Attachment - path and file name(s)
-v generates verbose output (an 8 line summary of the message)

SMTP command line example
Message syntax
bmail.exe -s <server_name>-t <recipient> -a <subject> -d

Example cmd file content
@echo off
Echo “Output directory - ” %1
Echo “Output filename - ” %2
Echo “Output format - ” %3
If “%3” == “TXT” ( 

bmail.exe -s smtp.companyname.com -t %4 -a "Transcribing has been completed"
)
If “%3” == “RTF” ( 

bmail.exe -s smtp.companyname.com -t %4 -a "Transcribing has been completed"
)
If “%3” == “DOC” ( 

bmail.exe -s smtp.companyname.com -t %4 -a "Transcribing has been completed"
)

bmail.exe options
- -s SMTP Server Name - the name of the SMTP server
- -p SMTP Port Number (optional, defaults to 25) - the port number of the SMTP server
- -t To: Address - email address(s) of the recipient
- -f From: Address - email address(s) of the sender
- -b Text Body of Message (optional) - text for the body of the email message
- -h Generate Headers
- -a Subject (optional) - subject line of the email message
- -m Filename (optional) - use file as Body of Message
-c - Prefix above file with CR/LF to separate body from header
-d Debug -Show all mail server communications

See the Dragon Help for details.

The Dragon Support Packager

Dragon NaturallySpeaking provides a new tool to improve customer support interaction should you experience a problem.

The Dragon Support Packager (dragon_support_packager.exe) collects and important files and data and places them into an encrypted package. This encrypted package can then be sent to Nuance Technical support to help resolve any issues you might be experiencing.

Starting the Dragon Support Packager

You can run the Dragon Support Packager without starting Dragon, and even if there are no User Profiles. If there are no User Profiles or if there is only one profile, the packager automatically presses Proceed.

1. On the Start Menu, select Dragon NaturallySpeaking > Dragon NaturallySpeaking Tools > Gather files for support.
2. In the Choose the User Profile to investigate dialog box, select a User Profile.

3. Click Proceed.
4. In the Save As dialog, Choose a place to save the Dragon archive file.
5. Click Save.
Chapter 1: Introduction to Dragon NaturallySpeaking

6. When the progress bar reaches 100%, click **Finished**.

7. Find the .dgnarc file and email it to Nuance Technical Support.

What to do if the Dragon Support Packager produces an error

The Dragon Support Packager creates a log file every time it runs. If the packager fails to run properly, the packager creates a log file. You can use the log file and the dump file to view error information if the packager crashes. Every time the packager runs, it overwrites both the log file and the dump file.

**Location of the Dragon Support Packager log file**

<Windows OS User Temp>\DragonSupportPackager_log.txt

For example, on Windows 7:

C:\Users\<user_name>\AppData\Local\Temp\DragonSupportPackager_log.txt

**Location of the Dragon Support Packager dump file**

<Windows OS User Temp>\DragonSupportPackager_crash_000.dmp

**Setting the amount of information to log**

You can control the amount of data that the packager logs. From a command line, run `dragon_support_packager.exe`, using the `/vl` argument to specify the verbosity level of the log file.

You can set `/vl` to 0, 1, 2, or 3.

0 means no data is placed in the log file.

3 places the maximum amount of data in the log file.

The default verbosity level is 1.

For example:

dragon_support_packager.exe /vl=3
Creating Windows shortcuts to User Profiles and Vocabularies

If Dragon NaturallySpeaking is shared with other people, or if a person has more than one User Profile, you can create Windows Shortcuts on the Desktop to start Dragon NaturallySpeaking and open particular User Profiles. If User Profiles have multiple Vocabularies, you can also specify the Vocabulary to open.

To create a shortcut to a User Profile and Vocabulary

1. Right-click the Dragon NaturallySpeaking shortcut icon on the Windows Desktop and then click Properties to open the icon’s Properties dialog box.
2. Click the Shortcut tab of the Properties dialog box.
   
   In the Start In box, at the end of the path type "natspeak.exe /user <User Profile name>". The text in the target box should look similar to the following line:

   "C:\Program Files (x86)\Nuance\NaturallySpeaking13\Program\Natspeak.exe/user "David""


   *David* is the name of the User Profile.

   **For Roaming User Profiles:**

   Or, if Roaming User is enabled, type the path to the Master Roaming User Profile location, then /user, then the sub-folder if applicable, and then the User Profile name on the network. The text in the target box should look similar to the following:

   "C:\Program Files (x86)\Nuance\NaturallySpeaking13\Program\Natspeak.exe/user "\<server_name>\<subfolder_path>\<user_profile_name>" for
   (Windows 7, Windows 8, or Windows Server 2008)

   **For Vocabularies**

   To specify a Vocabulary, follow the User Profile name with "/Vocabulary" and the name of the Vocabulary. The text in the target box should look similar to the following:

   "C:\Program Files\Nuance\NaturallySpeaking13\Program\NatSpeak.exe" /user "David" /Vocabulary Psychiatry

   If the User Profile or Vocabulary name contains a space, enclose the name in quotation marks. For example, enter: /user "Mike Workman" /Vocabulary "Family Medicine - Large"
If the User Profile name contains a space, enclose the name in quotation marks. For example, type: /user "Mike Workman"

3. Click OK.

When finished, double-click the shortcut icon to start Dragon NaturallySpeaking. The User Profile opens along with the Vocabulary specified.

Types of Paths
The path can be a UNC, HTTP, or HTTPS path:

**UNC**
"C:\Program Files\Nuance\NaturallySpeaking13\Program\Natspeak.exe"
/user "\\<directory>\<directory>\<username>"

For example:
"C:\Program Files\Nuance\NaturallySpeaking13\Program\Natspeak.exe"
/user "\\Roaming\Profiles\Roaming1"

**HTTP or HTTPS**
"C:\Program Files\Nuance\NaturallySpeaking13\Program\Natspeak.exe"
/user "http://<url_of_server>\<user_name>"

For example:
"C:\Program Files\Nuance\NaturallySpeaking13\Program\Natspeak.exe"
/user "http://test01.roam.test\Roaming1"

- The path to an HTTP or HTTPS location must only contain forward slashes - the same as the Network Location dialog.
- Precede the username with a backslash.

**Tip**
It is possible to add a shortcut to the top of the Start menu by dragging the shortcut icon onto the Start button.

Using multiple acoustic models with a User Profile
If the computer that an end-user dictates on meets certain system requirements, Dragon NaturallySpeaking13 uses two acoustic models with a User Profile. Using two acoustic models instead of one improves recognition and dictation accuracy. Acoustic models that can be added in pairs to a User Profile are called BestMatch V models.

Any time you add a new dictation source to a User Profile that uses two BestMatch V models, the dictation source will also be associated with the two models.

A User Profile with two BestMatch V models uses more computer resources, including RAM memory, than a User Profile with one acoustic model. Dragon NaturallySpeaking13 uses two BestMatch V models on a multi-core computer with at least 4 GB RAM.
NaturallySpeaking13 recognizes when it is installed on a computer that meets these system requirements and selects the BestMatch V acoustic model as the default.

**Acoustic Optimization for User Profiles with BestMatch V acoustic models**

BestMatch V is normally the default acoustic model if the system has at least 4GB of RAM.

If a User Profile includes BestMatch V models, you must run the Acoustic and Language Model Optimizer (ACO) on a computer with multi-core processors. Dragon NaturallySpeaking13 uses two BestMatch V models only on a multi-core computer with at least 4 GB of RAM.

If the ACO processes a User Profile that was created on a computer with multi-core processors, the optimizer always selects the BestMatch V models to optimize.

**Multiple acoustic models and User Profiles on single and multi-core computers**

If an end-user creates a User Profile on a multi-core computer, when the end-user opens the User Profile on a single-core computer, Dragon uses the first acoustic model for recognition. Dragon does not load the second acoustic model.

If an end-user creates a User Profile on a single-core computer, when the end-user opens the User Profile on a multi-core computer, Dragon uses the single acoustic model for recognition.

If an end-user selects BestMatch V models for a User Profile and trains the profile on a multi-core computer, when the end-user opens the User Profile on a single-core computer, Dragon displays the following warning message:

"Your computer has a single core processor. You have opened a User Profile created on a computer with a multi-core processor. Dragon NaturallySpeaking13 will work normally on this computer but you may see some change in performance and accuracy".
Installing, modifying and upgrading Dragon

To install Dragon NaturallySpeaking:

1. Be sure your systems meet the system requirements.
2. Prepare for the installation or upgrade by backing up User Profiles.
3. Install or upgrade the software by choosing the type of installation. See the table below for installation options.
4. Become familiar with the Dragon file structure and carry out other post installation tasks.

Note: When an administrator installs Dragon NaturallySpeaking, installation instructions appear in the primary language for the product. An administrator cannot install Dragon using a language that is different than the primary language. For example, when an administrator installs Dragon, Professional English, installation instructions appear in English.
<table>
<thead>
<tr>
<th>Installation topic</th>
<th>Topic link</th>
</tr>
</thead>
<tbody>
<tr>
<td>Installation checklists</td>
<td>• Installation checklists</td>
</tr>
<tr>
<td>System requirements</td>
<td>• System requirements</td>
</tr>
<tr>
<td>Preparing for an installation or upgrade</td>
<td>• Preparing for an installation or upgrade</td>
</tr>
<tr>
<td>Installing Dragon on a single computer</td>
<td>• Installing on a single computer</td>
</tr>
<tr>
<td>Installing using the Windows Installer (MSI)</td>
<td>• Using the Windows Installer (MSI) to install Dragon</td>
</tr>
<tr>
<td>Upgrading from a previous version</td>
<td>• Upgrading from a previous version</td>
</tr>
<tr>
<td>View the Dragon file structure and carry out post installation tasks</td>
<td>• Post Installation Tasks</td>
</tr>
</tbody>
</table>

**Troubleshooting silent install errors**

If an error occurs during a silent install of Dragon, the installer does not display any error information. You will not see any error messages.

You can find information about the error in the dgnsetup.log file in the Temp directory. Use the information to resolve the problem yourself or supply the log file to Nuance Technical Support for additional investigation. Whenever a new install or upgrade is performed, information is appended to the dgnsetup.log file.

You can also review the msi*.log file for information about installation errors. Whenever a new install or upgrade is performed, a new msi*.log file is created in the Temp directory.

**Search for silent install error information in log files**

1. **On Windows 7, or Windows 8,** navigate to C: \ Users\<user_name>\AppData\Local\Temp.
2. Use a text editor like Notepad to open dgnsetup.log.
3. Search for the following words: "Error", "Severe", and "Warning".
4. Scroll through to the bottom of the log file to view information about the installation error.
5. In the Temp directory, find the msi*.log file with a 'last modified' date and time stamp that is similar to the 'last modified' date and time stamp of the dgnsetup.log file.
6. Use a text editor like Notepad to open the msi*.log file.
7. Scroll through to the bottom of the log file to view information about the installation error.
Chapter 2: Preparing to Install Dragon

This section contains information on the prerequisites for installing Dragon, Dragon system requirements, and information on which Dragon products you can install on the same computer.

Preparing for an installation or upgrade

Before installing, modifying, or upgrading Dragon NaturallySpeaking:

- Close all open applications.
- Turn off or disable any antivirus software; installation can sometimes trigger a false virus report.
- Look at the supplied Installation Checklist.
- Installation restrictions
- Be sure your system meets the hardware requirements before attempting to install Dragon NaturallySpeaking. See Dragon system requirements
- Administrator rights are not required to create a User Profile or use the software after installation.
- These restrictions also apply to an upgrade installation: On Windows 7, Windows 8, Windows Server 2008 R2, and Windows Server 2012, if you want to create a Dragon User Profile for a Windows limited user (with restricted privileges), you must log on to Windows using that limited user account, then create the Dragon User Profile. If you create a Dragon user account for a Windows limited user while logged in as a Windows administrator, the limited user will not be able to access that user account.
- You are permitted to create multiple User Profiles, so long as each User Profile is for a single individual. If someone else wants to create or use another User Profile, that person must purchase a separate license for Dragon NaturallySpeaking.

Volume license agreements are available.
File Structure

Upgrading from Dragon 11.x or 12.x automatically relocates some Dragon directories and files.

For information, see Dragon File Structure.

Installation checklist

☐ Do all of your workstations meet the recommended system requirements for Dragon?

☐ Will you install the Dragon software manually at each computer or will installation be unattended? (If the latter, read Installing, modifying, and upgrading Dragon for information on setup or MSI command-line parameters.)

☐ Which features will you install on each computer?

☐ Which vocabularies do you need to install on each computer?

Note: Installing only selected vocabularies helps conserve disk space consumption and shortens setup time. A full installation with all vocabularies uses about 4800 MB and takes about 20 minutes, while an installation with only one vocabulary uses less than 1800 MB. See Dragon system requirements for more information on disk size requirements.

☐ Will you install the text-to-speech component?

☐ Will you set up roaming User Profiles? (Read Setting up the Roaming feature)

☐ If so, where will you place the User Profiles?

☐ In a shared network directory?

☐ In multiple shared network directories? (for example, one per department or clinic)

☐ In each end-user’s Windows home directory?

Note: Placing each end-user’s profile in his or her Windows home directory is not recommended, because this makes it more difficult for the administrator to perform operations on multiple User Profiles, such as running the Acoustic and Language Model Optimizer or upgrading User Profiles to a new version.

☐ On an Internet server running WebDAV (HTTP roaming)?

☐ If not, what location will you designate as the backup directory for each User
Profile?

☐ Where will you place the data distribution directory for distributing word lists and command sets?

☐ Will you be collecting data for the acoustic optimizer?

☐ Will you restrict end-users from modifying commands and vocabularies?

☐ Which default end-user-specific options will you set at installation time? (See the Dragon Help on the Options dialog.) Which Administrative options will you set?

Note: Where you store User Profiles will also depend on other factors. Each User Profile requires about 277 MB hard disk space if it is local, 90 MB if it is roaming. With default settings, acoustic optimizer data can take up to an additional space per workstation, to a total of 1000 MB in the master Roaming User Profile (more precisely, 1000 MB per dictation source per master Roaming User Profile).

Upgrade checklist

☐ Are there User Profiles that need to be upgraded from a previous version?

☐ If so, will an administrator upgrade them or will each end-user upgrade his/her own?

Support Checklist

☐ Who will be responsible for running the Acoustic and Language Model Optimizer?

☐ Who is responsible for collecting word lists and commands?

☐ Who is responsible for distributing word lists and commands?

☐ Will words and commands be distributed through the data distribution directory or by some other means, such as email?

☐ Who will Dragon end-users contact if they need help?

Dragon system requirements

Dragon supports Microsoft Office 2010 & 2013.


- **CPU**: Minimum: 2.2 GHz Intel® dual core or equivalent AMD processor. Faster processors yield faster performance.

- **Free hard disk space**: 4GB
- **Supported Operating Systems**: Windows 7 32-bit and 64-bit; Windows 8 & 8.1, 32-bit and 64-bit; Windows Server 2008 R2; Windows Server 2012.

- Internet Explorer 9 or higher or the current version of Chrome or Firefox for Rich Internet Applications.

- A sound card supporting 16-bit recording.

- A DVD-ROM drive for installation.

- A Nuance-approved microphone. See [support.nuance.com/compatibility](http://support.nuance.com/compatibility) for more information.

- An Internet connection for automatic product activation (a quick anonymous process).

**Note**

Streaming SIMD Extensions (SSE) are not supported.
Operating systems and RAM

<table>
<thead>
<tr>
<th>Operating system</th>
<th>32-bit</th>
<th>64-bit</th>
<th>RAM min</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows Server 2012</td>
<td>X</td>
<td>√</td>
<td>4 GB</td>
</tr>
<tr>
<td>Windows Server 2008 R2 (SP2 or higher)</td>
<td>X</td>
<td>√</td>
<td>4 GB</td>
</tr>
<tr>
<td>Windows 8, 8.1</td>
<td>√</td>
<td>√</td>
<td>2 GB for 32-bit, 4 GB for 64-bit</td>
</tr>
<tr>
<td>Windows 7, SP1 or higher</td>
<td>√</td>
<td>√</td>
<td>2 GB for 32-bit, 4 GB for 64-bit</td>
</tr>
</tbody>
</table>

Note: Windows Vista, Windows XP SP2 and Windows XP 64-bit, Windows 2000, Windows 2000 Server, and Windows Server 2003 are not supported and installation is blocked on those systems.

Note

* If your computer has less than the recommended amount of RAM, Dragon will install but displays a message recommending that you install additional RAM for optimum performance.

<table>
<thead>
<tr>
<th>Computer class</th>
<th>Minimum resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Desktop</td>
<td>1024 x 768</td>
</tr>
<tr>
<td>Laptop</td>
<td>1024 x 768</td>
</tr>
<tr>
<td>Netbook</td>
<td>1024 x 600</td>
</tr>
</tbody>
</table>

Storage space required for User Profiles

Adequate storage space must be available for Dragon User Profiles (that store information about each particular person’s voice, vocabulary, custom commands (if applicable), and option settings). The space needs to exist on:

- Stand-alone installations where end-users work on dedicated computers.
- File servers where Master Roaming User Profiles are stored.
- Only for Enterprise Profile Management Central computers (sometimes servers) where Master Roaming User Profiles are stored.
Having Roaming User Profiles lets end-users run Dragon on more than one computer or device by accessing centrally stored provider-specific voice and speech information, rather than requiring that the profile be on each computer.

Roaming User Profiles also let end-users with one computer use Dragon from different locations that have a connection to the network, for example, the office, at home, or different locations with the office or home.

The following information should be treated as guidelines for allocating disk space on your system. The actual amount of disk space will vary from site to site.

For each Master Roaming User Profile (User Profiles stored on the central computer), you should plan to have this much space:

- 90 MB for each Roaming User Profile
- 21 MB for each additional vocabulary you add for this User Profile
- 70 MB for each additional dictation source you add for this User Profile
- 1000 MB for Acoustic Optimizer data associated with each dictation source of each User Profile

To set how much data you have elected to store:

2. When the Administrative Settings dialog box opens, check the Disk space reserved for network archive option.

In addition, for the Local Roaming User Profile, you should plan to have the following space on each PC where the end-user dictates:

- 90 MB for each Roaming User Profile
- 21 MB for each additional vocabulary added for this user profile
- 70 MB for each additional dictation source added for this user profile
- 240 MB for acoustic optimizer data associated with each dictation source of each User Profile

The settings in the Data tab of the Options dialog box control how much acoustic optimizer data Dragon retains locally:

1. To set the number of minutes of audio to retain locally, click the Archive size... button and position the slider.
2. To turn off retaining this data locally, check the Conserve disk space required by User profile (for portability) option.

A non-Roaming User Profile requires approximately three times as much disk space as a local Roaming User Profile. Dragon periodically creates a backup copy of a non-Roaming User Profile and stores the copy on the local computer. On the other hand, a Roaming User Profile is stored in a network storage location and Dragon does not create a backup copy of a Roaming User Profile.

An administrator should create backup copies of all Roaming User Profiles on a regular basis.
Coexistence with other Dragon products

Coexistence with previous versions of Dragon

You can have only one version of Dragon installed on your system.

*Note:* Running Dragon 11.x or Dragon 12.x concurrently with Dragon NaturallySpeaking 13 is not supported.

Coexistence with Dragon SDK Client Edition

You can install Dragon SDK Client Edition 13 on the same computer where Dragon NaturallySpeaking is installed. In addition, Dragon NaturallySpeaking and Dragon SDK Client Edition can share User Profiles.

If you install the Dragon 13 SDK Client Edition (DSC 13) and Dragon NaturallySpeaking on the same machine, if you uninstall DSC 13, you may not be able to start Dragon NaturallySpeaking. To fix this issue, run the Repair option from the installation DVD. Enter the installation DVD into the DVD drive of the Dragon workstation and start the installation process. At the prompt, select the Repair option and follow the instructions on the screen.

If you are running Dragon SDK Client Edition, you can not display the DragonBar.

*Note:* Dragon NaturallySpeaking 13 can coexist with Dragon SDK Client Edition 11.x and 12.x.

Run Dragon SDK Client Edition 13 on a computer with Dragon NaturallySpeaking 13

You must have administrator privileges to perform the following step. In Windows 7, and Windows 8, make sure to elevate the command prompt.

At a command prompt, type the following command:

```
C:\Program Files\Nuance\Dragon SDK Client Edition13\Program\natspeak.exe /fixguids
```

Run Dragon NaturallySpeaking 13 on a computer with Dragon SDK Client Edition 13

You must have administrator privileges to perform the following step. In Windows 7, and Windows 8, make sure to elevate the command prompt.

At a command prompt, type the following command:

```
C:\Program Files\Nuance\NaturallySpeaking13\Program\natspeak.exe /fixguids
```

Switch between Dragon NaturallySpeaking 13 and Dragon SDK Client Edition 13

1. At a command prompt, type the following command:
2. `C:\Program Files (x86)\Common Files\Nuance\dgnsvc.exe /products`
3. Choose the product that you want to use.
Chapter 3: Installing Dragon

This section provides information on how to install Dragon, post-installation tasks, the Dragon file structure, sample commands.

Note: Upgrading from Dragon 10.x or earlier to Dragon 13 is not supported.

Installing Dragon on a single computer

This topic presents the basic steps for installing Dragon NaturallySpeaking on a single computer.


Notes:

- In Dragon NaturallySpeaking, the installation process does not present the QuickStart option. If you wish to enable this option, you can do so after Dragon is installed.
- You must have Windows Administrator rights to install or uninstall Dragon NaturallySpeaking. For more information about how Administrator rights impact the creation of Dragon User Profiles, refer to Preparing for an installation or upgrade.
- When you install Dragon NaturallySpeaking, Dragon installs using the primary language for the product. You cannot install Dragon using a language that is different than the primary language. For example, when you install Dragon NaturallySpeaking, English version, Dragon installs using the English language. If you attempt to use the setup.exe with the /1 option on the command line to install using a non-primary language, the installation process uses the primary language for that edition of Dragon and ignores the /1 option.

Installing on Windows 7, or Windows 8

For information about installing the product on Windows 7, or Windows 8, refer to Installing or Upgrading to Windows 7 or Windows 8.

Installing Dragon on a single computer

1. If you are installing from a DVD, insert the first Dragon DVD into your DVD drive. If you are downloading the installation, then download it to your local drive. If you are installing from the network, first assign a drive letter to the network location where your installer is located.
2. If you are installing from a DVD, on the DVD, click setup.exe. If you downloaded the installation, click NaturallySpeaking.exe. Do not click it again unless you are certain it is not running.

3. After the installation Wizard begins, click Next to proceed to the License Agreement screen. Read the text of the agreement and select I accept..., then click Next.

4. Enter your customer information—User Name and Organization—then the Serial Number supplied with your Dragon installation.

5. On the next screen, choose your installation directory. If there are no previous versions of Dragon on your system, the default directory on Windows 8 is:

   C:\Program Files(x86)\Nuance\NaturallySpeaking13

See Dragon file structure on page 63

6. On the same screen, choose your Setup Type:

   If you decide not to install some Dragon components by selecting Custom installation, you can install them later by running the Setup program again and choosing Modify.

   1. Typical/Complete: Installs all options and User Profiles and requires the most disk space.

   2. Custom: Lets you select options and User Profiles to install. Customizing your installation options can greatly reduce the disk space required.

   In the Professional and Legal editions of Dragon, you can modify the following settings during a custom installation. These settings are applied to all User Profiles created with this installation of Dragon, including User Profiles created using Windows 7, Windows 8, Windows Server 2008 and R2, and Windows Server 2012 limited accounts.

   5. Click Next.

   6. If you chose the Custom setup type, the installer displays a screen that lets you select the features to install. Select features, read the feature description in the box to the right, and
click **Next**. The installation process will display dialog boxes that let you set the options.

7. On the next screen, click **Install**.

8. Continue following the on-screen instructions. The setup program will install the files for *Dragon* on your computer. During the installation process, the installer displays graphics that provide information such as dictation tips and how to position your microphone.

9. If you did a **Custom** installation, one or more of the following windows appears:

   1. If you checked **Modify the application’s settings for all users**, the installation process will display the **Options** dialog box. For more information on the **Options** dialog box, see the main *Dragon* Help file.

   2. If you checked **Modify the administrative settings**, the installation process will display the **Administrative Settings** dialog box. For more information on setting administrative options under the Roaming, Miscellaneous, and Scheduled Tasks tabs:
      - See Administrative Settings: Roaming tab
      - See Administrative Settings: Miscellaneous
      - See Administrative Settings: Scheduled Tasks

   3. If you checked **Modify the formatting options for all users**, the installation process will display the **Auto-Formatting** dialog box. For more information on the **Auto-Formatting** dialog box, see the main *Dragon* Help file.
11. When installation of Dragon is complete, the installer displays the **InstallShield Wizard Completed** screen. Verify that the screen states "The InstallShield Wizard has successfully installed Dragon" as opposed to a message that indicates something failed. By default, the 'Check for updates when setup is finished' option is selected. Click **Finish**.

12. On the **Product Registration** screen, choose to register Dragon online now or remind me to register in seven days, then click **OK**.

13. To start Dragon, select **Start > All Programs > Dragon NaturallySpeaking > Dragon NaturallySpeaking**. Alternately, you can double-click on the Nuance desktop shortcut, or, in Windows 8, on the Metro interface, choose **Apps > Dragon NaturallySpeaking**.

**Activating Dragon**

The first time you start **Dragon**, you will be prompted to activate your copy of **Dragon**. If you do not activate the software, **Dragon** will stop working after you start the product five times.

For more information on activation, please see the **Dragon User Guide**.

**Enable or disable tutorials during a custom Dragon installation**

You can choose to enable both Dragon interactive tutorial and the language tutorial when you perform a custom installation of Dragon.

1. In the Dragon installation wizard, on the **Select the program features you want installed** screen, perform one of the following steps:

   - To install and enable both the Dragon interactive tutorial and the language tutorial, select **Tutorial Files**.
• To turn off both the Dragon interactive tutorial and the language tutorial, click the down arrow beside **Tutorial Files**, and select **This feature will be installed when required**.

![Dragon NaturallySpeaking 12.0 - InstallShield Wizard](image)

• To install and enable the Dragon interactive tutorial and turn off the language tutorial, click the down arrow beside **<Language> Tutorial** and select **This feature will be installed when required**.
2. Click **Next**.

**Sample custom installation of Dragon**

**Note:** This is an example only and is provided to give administrators an overview of a typical installation and the kind of decisions you have to make. Though the example provides recommendations it is not meant as a substitute for your own planning.

For more information, see:

- Installation checklists
- Installing Dragon on a single computer
- Step-by-Step Command Line Installation
- Overview of Installing Dragon using the Windows Installer (MSI)

**Preparing for the Roaming feature**

1. Create network storage location for Master Roaming User Profiles. For example, you can create a shared drive that all Dragon end-users will have read/write access to. In this example, we’ll name this shared folder **Dragon**.

2. In the shared **Dragon** folder, you can create 2 sub-folders; **Dragon Profiles** and **Data Directory**.
   - **Dragon Profiles** is the location for the master copies of the User Profiles. (For planning purposes allow for 1100 MB per User Profile.)
   - **Data Directory** is the location for custom commands and word lists that automatically update the User Profiles by use of the Data Distribution Tool.

For more information, see **Setting up the Roaming feature**.
Install Dragon
See Installing Dragon on a single machine.

Setting the Dragon Options
When the installation is complete, the three customization dialog boxes will open. The first to open is the Options dialog box.

Correction tab:
You use this tab to control how the correction feature and spelling features work.
In this example:

- Check **Enable double-click to correct**. Selecting this checkbox gives the end-user a way to correct with the mouse.

The Commands tab:
You use this tab to set options that control how Dragon interprets commands. Unless otherwise indicated, changing these options only affects user profiles created in the future;
any other end-users keep their existing settings.

If a user is having accessibility issues, they can enable/check the option “Enable mouse motion controls”.

When you click the **More Commands** button, only enable Natural Language Commands for the applications that you use with Dragon NaturallySpeaking.

**Enable HTML Support**: Enables Dragon to work with Internet Explorer, Firefox, and Chrome. You must select this option to use web browser commands when the Dragon Web Extension is installed. If you de-select this option, the Dragon Web Extension functionality becomes unavailable in all browsers. In this case, you'll need to click Web page elements using your mouse and keyboard, and dictate content using the Dictation Box.

The following example shows the default settings:

![Options Window](Image)

**The View tab:**

You use the **View** tab to control the behavior and appearance of the DragonBar and the **Results Box**.
The View settings are typically options that the user would change according to their own preferences. However, we recommend changing the Auto-hide delay setting for the Results Box to “3 seconds”.

The Hot keys tab:

You use the Hot keys tab to specify hot key assignments.

You can setup your own default scheme for Dragon’s Hotkeys. By default, most are set to different keys on the Number Pad.

Most laptops do not have a Number Pad and if the machine does have a Number Pad, Dragon’s hotkeys will commandeer the current functionality of those keys to utilize as Dragon’s hotkeys.

When considering keyboard keys for the hotkeys, we recommend that you use single keys, instead of key combinations, so that you can use one hand instead of two. Make sure that you aren’t using hotkeys that are being utilized by other applications or a key that you commonly use in your daily workflow.

To change the hotkey, click on the button of the hotkey name (For example: Microphone on/off), then press the key you wish to set the hotkey functionality to or press
the Backspace key to remove the hotkey. The most commonly used hotkey is for **Microphone on/off** and we find that users typically prefer to set this to one of the Fkey (F1,F2,F3,etc.), the Pause/Break key, or even the Insert key, because these keys are not commonly used.

If your end-users will be using Dragon on a Notebook, then click **Microphone on/off** and hit the **F10** key to change the hotkey.

![Hotkey table]

**The Playback/Text-to-Speech tab:**

You use the Playback/Text-to-speech tab to adjust the attributes of text-to-speech and playback.

In this example, increase the **Speed** slider slightly. The default value is a little too slow. For example:
The Miscellaneous tab:

You use this tab to set miscellaneous options.

We recommend disabling/unchecking the option for **Use the Dictation Box for unsupported applications**.

In this example

- Leave the **Have the microphone on but asleep** option unchecked unless the end-user cannot or does not want to use their hands to turn the microphone on and off.

For example:
The Data tab:

You use the Data tab to instruct Dragon to store corrections in an archive, conserve disk space for better portability of User Profiles, and control how Dragon adapts training, saves recorded dictation, and backs up User Profiles.

We recommend changing the option for Save recorded dictation with document from “Ask Me” to “Never”.

In this example:

- Set the **Automatically back up user profile every "n" saves** to nothing if your end-users are using the Roaming feature. When you have an end-user with a Roaming User Profile, the Master Roaming User Profile most likely resides on a server that should be backed up every night.

For example:
Chapter 3: Installing Dragon

Setting the Administrative Options: Roaming User Profiles

The second dialog to open at the end of the installation is the Administrative Settings dialog box. This section describes the Roaming tab of the Administrative options dialog box.

You use the Roaming tab of the Administrative Settings dialog box to set up the Roaming feature. You must set up the Roaming feature on each computer where you want end-users to dictate with a Roaming User Profile. For more information, see Administrative Settings: Roaming tab.

In this example:

1. Select Enable to activate the Roaming feature and the Roaming User Profile options.
2. Click the Add button. You use the Roaming User Network Location dialog box to define the network location of the master Roaming User Profiles. The location you pick must be accessible to all computers on the network that you want available for dictation with Dragon. In this example, we'll use the network storage location we initially created.
Administrative Settings

Roaming User Profile

- Enable: checked

Network Directories

Display Name: Roaming User Profile

Roaming User Network Location

Display Name: Roaming User Profile

Address: K:\Dragon\Dragon Profiles

Browse For Folder

Choose a directory containing a user profile:

- Dragon
- Data Directory
- Dragon Profiles
- Dragon - old docs and projects
- Dragon 10 Roaming Users
- Dragon 10.1 Client Specifications

Folder: Dragon Profiles

OK

Examples:

- S:\ or S:\users (mapped network drive)
- \MyComputer\Users (UNC Path)
- http://MyServer.com/webdav (HTTP)
- https://MyServer.com/webdav (HTTP with SSL)
3. The **Administrative Settings** dialog box also contains several options that you can choose from to indicate how you want a Roaming User Profile to function at each Roaming User Profile location. In addition to the default settings, also enable the **Access network at user profile open/close only**.

4. You will be prompted to create the default directory if it does not already exist. When you see the message, always click **Yes**:

**Setting the Administrative Options: Miscellaneous options**

When the installation is complete, the three customization dialog boxes will open. The second to open is the Administrative Settings dialog box. This section describes the Administrative options dialog box.

Choosing a backup profile location and a directory for Data Distribution allows you to centralize where profiles are backed up and allows you to specify a central location where you can share or host commands, word lists, and vocabularies. If network connectivity is an issue, we recommend keeping these settings set to their defaults.

Another other option is to choose local directories on the user’s machines and create a script to copy files to and from these locations on the user’s machines.

In this example, click **Change...** to set the location of the **Data Distribution Location** to the network directory that you created at the beginning.

**Setting the Administrative Options: Scheduled Tasks**

When the installation is complete, the three customization dialog boxes will open. The second to open is the Administrative Settings dialog box. This section describes the **Scheduled Tasks** tab of the Administrative options dialog box.

The following example shows the default settings for the **Scheduled Tasks** tab:

![Scheduled Tasks Tab](image)
For more information, see the Dragon Help file.

Setting Auto-Formatting Options

The third dialog to open at the end of the installation is the *Auto-Formatting* dialog box. For example, this version of the Auto-Formatting dialog box displays when you are installing a non-medical edition of Dragon:
To set Auto-Formatting Options

1. Set the Auto-Formatting options.
2. Click OK to save your changes in the current tab, close the Auto-Formatting dialog box, and have the changes take effect. Your changes do not take effect until after you close the dialog box.

Nuance recommends that you review these tabs to make appropriate choices for your site.
Post Installation Tasks

Once you have installed or upgraded Dragon, you might want to carry out some of these tasks before you proceed:

- Cleaning up after uninstalling Dragon
- Dragon File Structure
- Turning off Dragon’s use of Microsoft Active Accessibility Service

Cleaning up after uninstalling Dragon NaturallySpeaking

The following files will remain on your computer after you uninstall Dragon NaturallySpeaking.

C:\Windows\Speech

- VText.dll
- Vdict.dll
- WrapSAPI.dll
- XTel.dll
- Xcommand.dll
- Xlisten.dll
- Xvoice.dll
- spchtel.dll
- speech.cnt
- speech.dll
- speech.dll
- spchtel.dll
- vcauto.tlb
- vcmd.exe
- vcmshl.dll
- vtxtauto.tlb

Dragon installs these files for Microsoft SAPI4 support. If you do not have other speech applications that require SAPI4, you can safely remove these files manually. If you have installed other speech applications that require SAPI4 support, you may need to re-install those applications if you remove the files.

Dragon file structure

Upgrading Dragon automatically relocates some directories and files.

Dragon sets up the following default folders and file locations for application and data file storage during installation:

Windows 7/Windows 8
Upgrade log

C:\Users\<My_Windows_User_Name>\AppData\Roaming\Nuance\NaturallySpeaking13
Turning off Dragon's use of Microsoft Active Accessibility Service

Dragon NaturallySpeaking uses Microsoft Active Accessibility Service to let you control certain menus and dialog boxes by voice. Without Microsoft Active Accessibility Service, you would be unable to use Dragon to select menu commands and dialog box controls with your voice.

If you don't need to control the menus and dialog boxes by voice, you can speed up Dragon performance by turning off Microsoft Active Accessibility Services.
To turn off Active Accessibility Services in Dragon for all applications
1. Open the **Options** dialog box by selecting **Tools > Options** on the **DragonBar**.
2. Click the **Miscellaneous** tab.
3. Clear the **Voice enable menus, buttons, and other controls, excluding** box if it is selected.
4. Click **OK**. You will need to exit and re-start **Dragon** for this change to take effect.

Use a command line to turn off Active Accessibility in Dragon for specific applications
1. Exit **Dragon**.
2. Open **nssystem.ini** in a text editor. By default, **nssystem.ini** is located in:
   
   C:\ProgramData\Nuance\NaturallySpeaking13

   See **Dragon file structure** for information on Dragon paths in other Windows operating systems.
3. Under **[MSAA Modules Disabled]**, add a line similar to the following for each application where you want to disable the use of Active Accessibility Services:

   \[
   \text{<executable_name>=1}
   \]

4. Save and close **nssystem.ini**.
5. Re-start **Dragon**.

For example, to disable **Dragon** use of Active Accessibility Services in Microsoft Word and Microsoft Excel, you would add the following lines to **nssystem.ini**:

   **[MSAA Modules Disabled]**
   winword=1
   excel=1

**Note:** If you do not know the name of an application's executable file, you can start the application from the Windows **Start** menu and then use the Windows Task Manager to view the list of current Windows applications. The executable names are listed under Image Name on the Processes tab. You can also right-click the application’s icon and select the shortcut tab—the **Target** field will provide the name of the executable.

Use a GUI to turn off Active Accessibility in Dragon for specific applications
1. On the Dragon Bar, select **Tools > Options**.
2. Select the **Miscellaneous** Tab.
3. Check the **Voice-enable menus, buttons, and other controls, excluding** option.
4. Below the **Voice-enable menus, buttons, and other controls, excluding** option, open the drop-down list. The list contains installed and running applications, and also the following static applications:
   - Microsoft Outlook
   - Lotus Notes
   - Internet Explorer
   - Microsoft Word
   - Microsoft Excel
   - WordPerfect
5. To turn off Active Accessibility for an application, place a check mark beside the application.
6. Click OK.

**Enhancing the privacy of patient data**

When an end-user dictates with Dragon NaturallySpeaking, Dragon automatically saves all audio and transcribed text in Dragon Recorded Audio (.DRA) files. If the end-user corrects any of the dictated text, Dragon automatically stores these corrections in .enwv files. Both these files are saved in the background.

These automatically created .DRA and .enwv files are used by Dragon to optimize the User Profile. For example, Dragon uses these files when an end-user runs the Acoustic and Language Model Optimizer.

Dragon encrypts these automatically created .DRA and .enwv files before storing them in the local or Roaming User Profile directories to ensure they do not become a back door into patient data and violate the patient's privacy.

Due to the restrictions mandated by the HIPAA regulations, these encrypted .DRA and .enwv files can only be opened by Dragon for its internal use. For example, they cannot be accessed by the non-Medical versions of Dragon, the Dragon NaturallySpeaking SDK Client Edition (DSC), or the Dragon NaturallySpeaking SDK Server Edition (DSS). In addition, any encrypted .DRA and .enwv files automatically created by Dragon, cannot be opened in DragonPad.

**Notes:**

- Dragon does not encrypt .DRA files explicitly saved by an end-user. For example, if an end-user saves recorded dictation when saving a document (for example, in Word, WordPerfect, or DragonPad), these saved .DRA files are unencrypted. The end-user that created these files has the responsibility of saving these files in a secure location.
- Nuance does not guarantee that the file encryption provided in Dragon will ensure total HIPAA compliance. Other security measures are required for full compliance.

**Security Considerations**

As long as other adequate security protections are in place to protect patient data, you can avoid saving excess patient data by choosing to:

1. Turn off encryption of patient data (not recommended)
2. Turn off creation of .DRA files and set options to conserve disk space, resulting in fewer saved files
3. Turn off creation of unencrypted .nwv files

**Turning on/off encryption of patient data**

It is possible to turn off the encryption of these background speech recognition files by un-checking the Encrypt Patient Health Information check box in the Miscellaneous tab of the Administrative Settings dialog box.
For example, you may want to turn off this option if you are running software that automatically encrypts all files that are saved to the hard drive.

For more information, see the Miscellaneous tab of the Administrative Settings dialog box.

**Turning on/off creation of .dra patient data files**

You can choose to turn off creation of the .DRA files containing patient data to further protect the patient’s privacy when other security measures are in place, by:

- Turning off data collection, which sends data to Nuance for future product improvements. The check box to enable/disable data collection is on the Scheduled Tasks tab of the Administrative Settings dialog box. For more information, see:
  - About Data Collection and Other Scheduled Tasks

  and

- Checking settings to conserve disk space, which automatically stops creating files that require large amounts of storage space:
  i. On the DragonBar, select Tools > Options and click the Data tab.
  ii. Check the Conserve disk space required by user profiles (for portability) option. For more information on the Data tab of the Options dialog box, refer to the main Dragon Help file’s topic on the Data tab in the Options dialog box.

**Turning on/off creation of unencrypted text correction .nwv archive files**

To further ensure privacy, any end-user can turn off creation of archive files that might contain patient data:

1. On the DragonBar, select Tools > Options and click the Data tab.
2. Uncheck the Store correction in archive option. For more information on the Data tab of the Options dialog box, refer to the main Dragon Help file’s topic on the Data tab in the Options dialog box.
Chapter 4: Upgrading Dragon

This section contains information on how to upgrade Dragon and Roaming User Profiles, as well as how to upgrade profiles that use third-party vocabularies. You can update Dragon 11.x and 12.x User Profiles to Dragon NaturallySpeaking 13.

Upgrading Dragon

An administrator performs the following steps to upgrade a User Profile to Dragon NaturallySpeaking 13:

- Prepare to upgrade:
  - Based on the version of Dragon being upgraded from, determine how to proceed (see What you should know before upgrading from a previous version)
  - If upgrading to Windows 7, or Windows 8, see Installing on or upgrading to Windows 7, or Windows 8

- Carry out one of these procedures:
  - Upgrade multiple User Profiles (see Upgrading multiple User Profiles)
  - Upgrade Roaming User Profiles (see Upgrading Roaming User Profiles)
  - Upgrade User Profiles with custom or customized vocabularies (see Upgrading User Profiles with Custom and Customized Vocabularies)

Administrators can work with the User Profile Upgrade Wizard (see Upgrading multiple User Profiles)

See "Upgrading User Profiles to Dragon NaturallySpeaking 13" in Dragon - What's New for administrators for more information.

Note: If upgrading from Dragon version 10.x or earlier to Dragon NaturallySpeaking 13, version 10.x or earlier custom words and commands can be re-used in Dragon NaturallySpeaking 13:

1. In Dragon 10.x or earlier, export the custom words and commands
2. In Dragon NaturallySpeaking 13, create a new User Profile
3. In Dragon NaturallySpeaking 13, import the custom words and commands

See the Dragon Help for information on exporting and importing custom words and commands.
What you should know before upgrading from a previous version

An administrator can upgrade to Dragon NaturallySpeaking from Dragon 11.x or 12.x by following the installation instructions for Dragon NaturallySpeaking, but first, be sure to:

- Retain existing User Profiles, to be updated after the installation completes.
- Check that it is possible to upgrade from the existing edition to the edition the administrator is installing.

For details, see Upgrading Dragon.

Edition considerations

An administrator must upgrade to the same edition or greater and to the same language.

For example, if upgrading from Dragon 11.x German/English to Dragon NaturallySpeaking 13. English only, the Dragon 11.x German User Profiles are not upgraded. Upgrading to Dragon German/English upgrades both German and English User Profiles.

After upgrading, an administrator can install other Dragon languages.

Notes:

- If an end-user is using Dragon version 10.x or earlier, they can re-use custom words and commands in Dragon NaturallySpeaking 13:
  1. In Dragon 10.x or earlier, export the custom words and commands
  2. In Dragon NaturallySpeaking 13, create a new User Profile
  3. In Dragon NaturallySpeaking 13, import the custom words and commands

  See the Dragon Help for information on exporting and importing custom words and commands.

- When an administrator installs Dragon NaturallySpeaking 13, Dragon installs using the primary language for the product. An administrator cannot install Dragon using a language that is different than the primary language. For example, if an administrator installs Dragon 13 Professional, English version, Dragon installs using the English language. If the administrator attempts to use the /l option with setup.exe to install Dragon 13 using a non-primary language, the installation process uses the primary language for that edition of Dragon and ignores the /l option.

Installing on or upgrading to Windows 7 or Windows 8


Upgrade considerations

If you upgrade a computer from:

- Windows XP to Windows 7
- Windows XP or Windows 7 to Windows 8
and the computer has Version 8.x, 9.x, or 10.x of *Dragon* installed, that version of *Dragon* will not work after the upgrade.

For details, see Upgrading Dragon.

Roaming User Profiles in an MSI Installation on Windows 7, or Windows 8

For more details about carrying out an MSI installation on Windows 7, or Windows 8, see Modifying Roaming User Profile, Miscellaneous, Schedule Settings in the INI File.

**Upgrading multiple User Profiles**

You use the User Profile Upgrade Wizard to upgrade a *Dragon* 11.x or 12.x User Profile to *Dragon* NaturallySpeaking13. There are several ways you can start the User Profile Upgrade Wizard:

- In the **Open User** profile dialog box, select a User Profile to upgrade. *Dragon* displays a dialog that gives you the option of upgrading the User Profile now (by pressing **OK**) or upgrading the User Profile later (by pressing **Cancel**). If the end-user selects **OK**, *Dragon* displays the **User Profile Upgrade Wizard**.
- In Windows 8.x, on the Metro interface, go to **Apps > Upgrade User Profiles**.
- In the Start menu, select **Programs > > Dragon NaturallySpeaking Tools > Upgrade User Profiles**. *Dragon* displays the **User Profile Upgrade Wizard**.

**Using the User Profile Upgrade Wizard**

The User Profile Upgrade Wizard guides you through the process of upgrading User Profiles to *Dragon* NaturallySpeaking.

The wizard cannot upgrade User Profiles created by versions of *Dragon* prior to *Dragon* 11.

**User Profile Upgrade Wizard: Select the profile(s) to upgrade**

On the **Select the profile(s) to upgrade** page, you see these elements:

**User profile(s) to upgrade**

This screen displays the location and name of all the User Profiles that the wizard will upgrade. Modify the list of User Profiles to include all User Profiles that you want to upgrade. The wizard starts by including all the User Profiles in the current folder as candidates to upgrade. You add User Profiles to the list by clicking the **Browse to add a profile** button and browsing for additional User Profiles in other locations. You remove User Profiles from the list by selecting them and clicking the **Remove from list** button. Once the list of User Profiles contains the profiles you want to upgrade, click **Next**.

**Note:** If you have end-users with roaming User Profiles in your network, see Upgrading Roaming User Profiles: Overview

**Current Location**

The location of the User Profiles to upgrade.

**User Profile**

Displays the names of all the User Profiles to upgrade.
Total profiles to be upgraded
Displays the total number of User Profiles to upgrade.

Browse to add a profile
Opens a *Browse for Folder* window that you use to locate additional User Profiles for the wizard to upgrade.

Remove from list
Deletes the User Profile you select from the User Profile Upgrade Wizard.

Once you have made a selection, click *Next*.

If you choose to upgrade only one User Profile, the wizard displays the number of minutes the upgrade requires to complete.

![User Profile Upgrade Wizard](image)

User Profile Upgrade Wizard: Choose where to store the upgraded profile(s)
As the User Profile Upgrade Wizard updates a User Profile to Dragon NaturallySpeaking, the wizard can move a copy of the upgraded User Profile to another location without modifying the old profile.

Location for upgraded profile(s)
Click the *Browse* button or select a new destination from the list if you want to choose a destination other than the suggested destination. You must have read and write access to the location.
Advanced

Click the Advanced button to open the Advanced Options dialog box where you can change how the wizard upgrades the User Profile.

User Profile Upgrade Wizard: Advanced Options

The Advanced Options dialog box lets you make finer adjustments to how the wizard upgrades User Profiles.

User profiles to

The User profiles to list box provides information about the location, vocabulary, and the acoustic model for each profile you plan to update.

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Name</th>
<th>Old Value</th>
<th>New Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Location</td>
<td>The name of the User Profile.</td>
<td>The current location of the User Profile.</td>
<td>The location where Dragon will place the updated User Profile.</td>
</tr>
<tr>
<td>Vocabulary</td>
<td>The name of the current vocabulary for the User Profile.</td>
<td>The name of the base vocabulary for the current vocabulary.</td>
<td>The name of the new base vocabulary for the current vocabulary.</td>
</tr>
<tr>
<td>Acoustic model</td>
<td>The name of the audio input device for the User Profile.</td>
<td>The name of the current language/voice model for the User Profile.</td>
<td>The name of the new language/voice model for the User Profile.</td>
</tr>
</tbody>
</table>

Setting a location for an upgraded User Profile

When you click on the Location line in the User profiles to list box, Dragon enables the New Location text box. The text box displays the location that the wizard recommends or that you chose on the Choose where to store the upgraded profile(s) page. You can click Browse and choose a new location. You must have read and write access to the location.

Setting a new base vocabulary for a User Profile

When you click on the Vocabulary line in the User profiles to list box, Dragon enables the New Base Vocabulary text box. The text box displays the current vocabulary of the User Profile or the one that the User Profile Upgrade Wizard assigns to the upgraded User Profile if Dragon does not support the old vocabulary.

You can select a new base vocabulary from the drop-down list.

Setting a new acoustic model for a User Profile

When you click on an Acoustic model line in the User profiles to list box, Dragon displays the New Acoustic Model text box. The text box displays the current language (such as US English), language model, and accent of the User Profile. You can choose a new acoustic model from the drop-down list.

After you modify the information for each User Profile in the list box, click OK to return to the wizard, and click Next to proceed.
User Profile Upgrade Wizard: Begin profile upgrading

On the **Begin profile upgrading** page, click **Begin upgrading** to start the upgrade process. The wizard requires approximately 12 to 24 minutes to upgrade each User Profile. When the process is complete, click **Finish**.

If the **User Profile Upgrade** wizard starts automatically after you upgrade and start Dragon, the **Open User Profile** window opens and displays a list of the User Profiles you can choose from to begin dictation.

### Upgrading Roaming User Profiles: Overview

This section describes how to upgrade Roaming User Profiles to Dragon NaturallySpeaking 13.

When you use the Roaming feature, each Dragon User Profile has a master Roaming User Profile that can be opened from multiple networked computers where Dragon is installed. These master Roaming User Profiles are stored on a network location made accessible to your Dragon users.

When a master Roaming User Profile is opened from that central network location, Dragon transfers a copy of that profile to the Local Roaming User Profile on the local computer.

Since the Local Roaming User Profile is a copy of the User Profile data taken from the master Roaming User Profile, you cannot directly upgrade the Local Roaming User Profile when you upgrade the local Dragon installation to Dragon NaturallySpeaking 13.

**Notes:**

- If upgrading from Dragon version 10.x or earlier to Dragon NaturallySpeaking 13, version (10.x or earlier custom words and commands can be re-used in Dragon NaturallySpeaking 13. See the Dragon Help for information on exporting and importing custom words and commands.
  - In Dragon 10.x or earlier, export the custom words and commands
  - In Dragon NaturallySpeaking 13, create a new User Profile
  - In Dragon NaturallySpeaking 13, import the custom words and commands
- Upgrading a set of master Roaming User Profiles to Dragon NaturallySpeaking 13 leaves the master Roaming User Profiles unchanged and intact. This allows the end-users in your network to run the current version of Dragon while you plan your upgrade.
- Plan to upgrade the master Roaming User Profiles at a time when they are not being opened by end-users, for example during the night or on a weekend.
- Even though the Dragon NaturallySpeaking 13 **User Profile Upgrade Wizard** supports both mapped drives and UNC paths, Nuance strongly recommends that you upgrade your Master Roaming User Profiles on a drive on a computer where Dragon NaturallySpeaking 13 is locally installed. Nuance does not recommend that you upgrade your Master Roaming User Profiles across a network to either a mapped drive or UNC path; upgrading over a network will take an undetermined length of time. In addition, the **User Profile Upgrade Wizard** does not support upgrading User Profiles over an HTTP connection.
Step 1: Preparing to upgrade Roaming User Profiles

To upgrade your Master Roaming User Profiles from a previous version of Dragon, Nuance recommends that you install Dragon NaturallySpeaking 13 directly on the network computer where the current Master Roaming User Profiles are located and upgrade those Master Roaming User Profiles directly to Dragon NaturallySpeaking 13 Master Roaming User Profiles.

If you are unable to install Dragon where your current Master Roaming User Profiles are located, Nuance recommends that you:

1. Install Dragon NaturallySpeaking 13 on a separate computer where you will perform the upgrades.
2. Copy the current Master Roaming User Profiles from their network location to the computer where Dragon NaturallySpeaking 13 is installed.
3. Upgrade the current Master Roaming User Profiles on the computer where Dragon NaturallySpeaking 13 is installed.
4. Copy the upgraded Dragon NaturallySpeaking 13 Master Roaming User Profiles to a network accessible directory on the original network location.

For more information, see Preparing to upgrade Roaming User Profiles.

Step 2: Upgrading the User Profiles

As administrator you must separately upgrade the master Roaming User Profiles to Dragon NaturallySpeaking 13 using the User Profile Upgrade Wizard.

After you upgrade the Master Roaming User Profiles, you can then proceed to upgrade end-user systems that deploy the Roaming feature.

For more information, see Upgrading master Roaming User Profiles

Step 3: Upgrade the end-user systems

For more information:

See Upgrading end-user systems.

See "Upgrading User Profiles to Dragon NaturallySpeaking 13" in Dragon - What’s New for administrators for more information.

Upgrading master Roaming User Profiles

You must use the User Profile Upgrade Wizard to upgrade master Roaming User Profiles to Dragon NaturallySpeaking 13.

Before you proceed with the tasks in this topic, complete the procedure in Preparing to upgrade Roaming User Profiles.

After you upgrade the Dragon 11.x or 12.x Master Roaming User Profiles and optionally copy them back to their network location, you can proceed to upgrade your end-user systems that use the Roaming feature. For more information, see Upgrading end-user systems.
Step 1: Upgrade the Dragon 11.x or 12.x Master Roaming User Profiles

On the computer with the current Master Roaming files and where Dragon NaturallySpeaking 13 is installed:

1. Select **Start > Programs > Dragon NaturallySpeaking > Dragon NaturallySpeaking Tools > Upgrade User Profiles**.
2. On the **Select the profile(s) to upgrade** page, click **Browse to add a profile** to select the location of the Dragon 11.x or 12.x Master Roaming User Profiles. The **Select the profile(s) to upgrade** page now displays a list of User Profiles in the selected directory:

   ![Select the profile(s) to upgrade](image)

   - **User Profile Upgrade Wizard**
   - Listed below are the profiles that will be upgraded. Use the "Browse" or "Remove" buttons below to modify the list. Note: You can upgrade more profiles later if desired. Upgrading one profile can take 2 to 20 minutes. See the Help for details.
   - When you have finished adding or removing profiles to upgrade, select "Next".

   **User profiles to upgrade:**
   - Current Location  |  User Profile
   - <Previous version> | Profile 1
   - <Previous version> | Profile 2

   **Total profiles to be upgraded:** 2
   - **Browse to add a profile...**  |  **Remove from list**

Continue to add User Profiles from other local locations or use the **Remove from list** button to remove specific User Profiles. Click **Next** to continue.
3. If you choose to upgrade only one User Profile, the wizard displays the number of minutes the upgrade requires to complete the upgrade.

   ![User Profile Upgrade Wizard](image)

   The following user profile will be upgraded:
   
   **Profile1**

   The estimated time to complete the upgrade is 12-24 minutes.

4. On the Choose where to store the upgraded profile(s) page, in the Location for upgraded profile(s) text box, choose the local location you previously created to contain the upgraded Dragon NaturallySpeaking13 master Roaming User Profiles. If a location is
not visible, click **Browse**, find the correct location, and click **Next**.

5. The **Begin profile upgrading** page displays the number of User Profiles that the wizard is prepared to upgrade.

   Click **Begin upgrading** to start the upgrade process. The upgrade process can take 12-24 minutes or more per User Profile, depending on the speed of the computer system and the speed of the network. Click **Stop** at any time to interrupt this process. The upgrade process creates new master Roaming User Profiles in the destination you selected.

6. Click **Finish** to complete the upgrading process and exit the **User Profile Upgrade Wizard**.

   The **User Profile Upgrade Wizard** names each Dragon NaturallySpeaking13 master Roaming User Profile as follows: `<name> (v13.x)`. For example, Dragon copies and upgrades a Dragon 11.x Master Roaming User Profile with a filename of *roaminguser1* to *roaminguser1 (v13)*. Dragon does not change the name of the Dragon 11.x Master Roaming User Profile.

   Do not store the Dragon 11.x or 12.x Roaming User Profiles in the same directory as the upgraded Dragon NaturallySpeaking13 Roaming User Profiles. The **Open User Profile** dialog box displays all the Dragon 11.x and 12.x profiles. A Dragon end-user may not be sure of the profile they should select for dictation.

**Step 2: Clean up the Dragon 11.x or 12.x locations for master Roaming User Profiles (optional)**

When the **User Profile Upgrade Wizard** modifies the Dragon 11.x or 12.x master Roaming User Profiles, it create a copy of the upgraded User Profile and does not change the original profiles. This ensures the original profiles are available in case someone requires them.
Chapter 4: Upgrading Dragon

An administrator can optionally rename or remove the Dragon 11.x or 12.x master Roaming User Profiles through the Manage User Profiles dialog box.

Step 3: Copy the Dragon NaturallySpeaking13 Master Roaming User Profiles to their network location (Optional)

If you were unable to install Dragon NaturallySpeaking13 where you store the Dragon 11.x or 12.x Master Roaming User Profiles, and you instead copy them to a different computer with Dragon NaturallySpeaking13 installed, you must now copy the Dragon NaturallySpeaking13 Master Roaming User Profiles back to the new network directory. This is the directory you created on their original network location.

You can skip this step if you installed Dragon NaturallySpeaking13 on the computer where the Dragon 11.x or 12.x Master Roaming User Profiles are located and you upgraded those Master Roaming User Profiles directly to Dragon NaturallySpeaking13.

Step 4: Upgrade end-user systems to Dragon NaturallySpeaking13

After you upgrade the master Roaming User Profiles, you can upgrade the end-user systems that use the Roaming feature.

For more information, see Upgrading end-user systems.

Upgrading end-user systems

After you upgrade the master Roaming User Profiles, you can upgrade the end-user systems that use the Roaming feature.

Before proceeding with this section, make sure you perform the procedure in Upgrading master Roaming User Profiles.

Step 1: Upgrade systems that use the Roaming feature

Since the User Profile Upgrade Wizard does not change or move the current master Roaming User Profiles, your current Dragon systems can continue to use the Roaming feature until you upgrade to Dragon NaturallySpeaking 13.

To upgrade a Dragon 11.x or 12.x system to Dragon NaturallySpeaking 13, follow the installation instructions under Installing Dragon on a single computer.

Notes:

- When prompted, choose to remove the Dragon 11.x or 12.x installation. If you choose not to remove the previous installation, you cannot continue to upgrade.

Step 2: Enable the Roaming feature on the Dragon systems

When you upgrade to Dragon NaturallySpeaking 13, the Roaming feature is off by default.

To turn on the Roaming feature, perform the following steps on each Dragon NaturallySpeaking 13 client computer:

1. Start Dragon.
2. Close all User Profiles.
3. Click Administrative Settings on the DragonBar Tools menu. This displays the Administrative Settings dialog box.
5. The **Network Directories** list displays the network location of the current master Roaming User Profiles.

If you created a new network directory for the Dragon NaturallySpeaking 13 master Roaming User Profiles, you can either click the **Add** button to add the new network location or select a listed directory and then click **Edit** to change the path to the new location. When you have finished, click **OK** to close the **Administrative Settings** dialog box. You should also remove any Dragon 11.x or 12.x master Roaming User Profile directories that are not in use.

6. Select **Profile** > **Open User Profile** on the **DragonBar**. This action displays the **Open User Profile** dialog box. If you allow end-users to select both non-roaming local and Roaming User Profiles, make sure they select the correct location (the Dragon NaturallySpeaking 13 Roaming User Profile location) from the **Location of user profile** field.

7. Select a User Profile and click **Open**.

**Note:** If you did not upgrade the Roaming User Profiles and store them in the new master Roaming User Profile directory, when you click **Open**, the **User profile needs to be upgraded** dialog box appears. Since you cannot upgrade Roaming User Profiles locally, you should click **Cancel** and return to **Upgrading master Roaming User Profiles**. If you click **OK** instead of **Cancel**, you receive a message stating **You cannot upgrade a roaming user** because you cannot upgrade Roaming User Profiles on a workstation where the Roaming feature is on.

### Upgrading User Profiles that use third-party vocabularies

**Vocabularies Created by a Third Party (other than by Nuance)**

**Note:** Any installation can use vocabularies that are not provided by Nuance, but created by a third party specifically for a particular installation.

**Using a custom vocabulary from Dragon 10.x or earlier with Dragon 13**

You cannot use a custom vocabulary created in Dragon 10.x or earlier with Dragon NaturallySpeaking 13. You must recreate the custom vocabulary in Dragon NaturallySpeaking 13. If you have a custom vocabulary from a Nuance VAR, you should contact the VAR to obtain a new version of the vocabulary.

**Upgrading User Profiles with third party vocabularies**

When you upgrade a User Profile whose base vocabulary was created by a third party, all custom words and other changes to that vocabulary will be maintained but the vocabulary’s base type will be changed. For example, Dragon 11.x or 12.x User Profiles that use the **US English | Large | Nuance** vocabulary with a topic ID of **9005** are upgraded to use the **General—Medium** vocabulary, that upgraded User Profile’s vocabulary also contains all customizations in the Dragon 11.x or 12.x vocabulary.

See "Upgrading User Profiles to Dragon NaturallySpeaking 13" in Dragon - What's New for Administrators for more information.

To preserve new words from the custom vocabulary and words added by an end-user, perform the following steps. **Note:** The following steps do not preserve the custom language
model. End-users may not achieve the same accuracy as they did with the custom vocabulary. To take advantage of the custom language model, contact the third party to obtain a new version of the vocabulary.

Step 1: Export custom words added to the custom vocabulary

If you added any additional custom words to the vocabulary created by a third party, you must first export those words. To export custom words:

- On the DragonBar menu, select Vocabulary > Export custom word and phrase list. This action displays the Export Custom Words dialog box.
- Enter the path and name of the file containing the custom words to add to the vocabulary that you want to create, or use Save in list to find a location for the file you want to create.

Step 2: Upgrade a User Profile that uses a custom vocabulary

To upgrade User Profiles with a third party vocabulary:

1. Run the User Profile Upgrade Wizard. To run the wizard, select Dragon > Dragon NaturallySpeaking Tools > Upgrade User Profiles.
2. In the User Profile Upgrade Wizard, select a Dragon User Profile that uses a vocabulary from a third party.
3. Click Next and follow the on-screen prompts.

The User Profile Upgrade Wizard displays the original vocabulary deployed to create the User Profile and lets you choose a Dragon NaturallySpeaking 13 base vocabulary that the User Profile Upgrade Wizard should assign to the upgraded User Profile.

Step 3: Import custom words to the upgraded User Profile

If you exported words in Step 1, you now must import those words. To import a word list:

1. On the DragonBar, click Vocabulary > Import list of words or phrases. This displays the Add Words from Word Lists wizard.
2. Click Next to add the file you created in Step 1.

Step 4: Export the customized vocabulary

You can share vocabularies among different User Profiles by first exporting a vocabulary from one User Profile and then importing it to a new User Profile. Use the following procedure to export a vocabulary. To export a vocabulary:

1. Create a folder in which to save the exported vocabulary files.
2. Open the upgraded User Profile that uses the custom vocabulary.
3. On the DragonBar, select Vocabulary > Manage Vocabularies or say "Manage Vocabularies."
4. In the Manage Vocabularies dialog box, select the vocabulary you want to export and then export it.
5. Locate and open the target folder, enter a name for the exported vocabulary in the File Name box, and then save it.
6. In the Manage Vocabularies dialog box, click or say "Close" to save and close it.
Note: Exporting a vocabulary creates a copy of the four files that make up the vocabulary in the new location. You can access these files via the Data Distribution Tool or the nsadmin tool to create new custom base vocabularies.

Step 5: Use nsadmin or the Data Distribution tool to copy the vocabulary you export

Using the nsadmin command line or the Data Distribution Tool, you can import the vocabulary you created in Step 2 as a base vocabulary on any Dragon installation.

Once you add a base vocabulary to a Dragon installation, you can then use the new vocabulary to create new User Profiles or add a new vocabulary to an existing User Profile.

When you run nsadmin or the Data Distribution Tool to import the exported vocabulary to your Dragon installation, be sure to give the new vocabulary the same name and topic ID that the customized vocabulary had.

For example, if your custom vocabulary was named US English | Large | Nuance topic ID 9005, you would use nsadmin or the Data Distribution Tool to create a new base vocabulary with that same name and topic ID number.
Chapter 5: Installing Dragon using the Windows installer (MSI)

This section provides information on using MSI files to install Dragon over a network, modifying Roaming User and other options, using .ini file to install Dragon with a specific configuration, creating and using MST files to install Dragon, installing Dragon from a command-line using natspeak.exe or msiexec.exe, upgrading Dragon and Roaming User Profiles from the command-line, and other related topics.

Overview of Installing Dragon using the Windows Installer (MSI)

Dragon NaturallySpeaking13 includes a native Windows Installer (MSI) that lets you customize your installations as well as install across a network to multiple client computers. In addition, you use this service to modify, repair, or remove any existing installations. If you need to uninstall, and this is not a push command to client machines, use the control panel to remove Dragon Naturally Speaking.

Although you have several choices when deciding how you want to install Dragon NaturallySpeaking13 on the command line, Nuance recommends that you follow the approach presented initially in this document.

You can use this procedure to install the software on one computer at a time or combine it with Systems Management Server (SMS) or Windows Active Directory Service to install the software across a network to multiple client computers. Also, if you have already installed the product, you use this process to upgrade, modify, repair, or remove any existing installations.

Before You Begin

To ensure a smooth installation, before you proceed, you should gather the following information regarding your network and Dragon settings.

- Preferred settings for Dragon Windows Auto-Formatting options to be applied to the recognized text. You set these settings in the Auto-Formatting dialog box of Dragon.
Path to and/or mapped drive of the location where Roaming User Profiles are stored or are going to be stored, are normally set in the **Network Settings** sub-dialog of the **Roaming** tab in the **Administrative Settings** dialog box.

Information about your http or https connection to the Roaming User Profiles storage location, if applicable, normally viewed in the **Roaming User Network Location** sub-dialog of the **Administrative Settings** dialog box, accessible when clicking on “Add” for a Network Directory.

Preferred settings for collecting dictation data to be sent back to Nuance Communications for improving the future accuracy of **Dragon**, are normally set under the **Scheduled Tasks** tab of the **Administrative Settings** dialog.

Install a third-party indexing/search software before you install **Dragon**; if no third-party indexing/search is installed, when you try to set **Dragon** options, the **Enable Desktop Search commands** check box will not be available for selection. **Dragon** supports Google Desktop and Microsoft Search.

**Finding the MSI Installer on the DVD**

The compiled **MSI** file is located on your installation DVD. The files for each edition are named:

- Dragon NaturallySpeaking 13.msi

You can double click on this **.msi** file to start the InstallShield Wizard; however, to instead take advantage of available command line options, you can pass the file name as the application to install to the **msiexec.exe** command using the **/i** option:

```
msiexec.exe /i "Dragon NaturallySpeaking13.msi"
```

**Entering Command Lines**

Unless otherwise noted:

- All command line options are case-insensitive (unless otherwise noted) and can be combined.
- No options require special values based on the values of other options.
- In the examples, user-supplied information is displayed between angle brackets. Do not use angle brackets (<,>) as part of the command line.
- Do not use quotation marks unless you are explicitly instructed to.
- If a path name contain spaces, place a backslash followed by a quotation mark (\"), before each space in the path.
- Whenever you set an option to an .ini file, you must give the full path to that .ini file.
- All msiexec.exe command-line options you pass with /v must be prefaced with a forward slash (/) only.

**Windows 7, Windows 8 Notes**

**Dragon** setup is designed so that **msiexec.exe** can be run from an elevated command prompt in Windows 7 and Windows 8.

To launch an elevated command prompt in Windows 8:

Select **Start > All Programs > Accessories > Command Prompt** (without releasing the mouse), then right click **Command Prompt** and select an **Run as administrator**.
Overview of the Network Installation of Dragon from a Server

Overview of Pushing Client Installation from a Server

You can install the Dragon runtime in a network environment, in other words, push the software application out to client computers without having to install it separately on each client system.

Dragon includes a native Windows Installer (MSI) that lets you both install across a network to multiple client computers and customize your installations. Several servers support this type of network installation:

- Windows Server 2008
- System Management Server (SMS)
- Active Directory Services

The administrator carrying out the installation creates an image of the installation program on the server and then configures the server to automatically push the application onto the client systems. You can also configure network installations to modify, repair, or remove an existing installation.

Support for SMS and Windows Server with Active Directory

Systems Management Server (SMS) provides a mechanism for pushing application installations out from the server to client systems. SMS supports using the Windows Installer (MSI) to push client installations on clients using Windows 7 or Windows 8. SMS requires that a client application be installed on all client computers.

Active Directory Services is a feature of Windows Server 2008. The Group Policy component of Active Directory Services includes a Software Installation snap-in that lets an administrator create a network installation. Administrators can use this feature to install software to Windows 7 and 8 clients.

Dragon supports the Active Directory Services Assign to Computers installation option. This option successfully installs the software when the computer is rebooted. You (as administrator) can delay installation on Windows 7, and Windows 8 clients by enabling logon optimization for group policy; for this type of installation, an entry for the installation can be viewed in the event log after the first reboot. The installation is then performed on the second reboot. The installation takes place silently, and the software is installed for all end-users on the computer. When you perform a silent installation of Dragon, the installation process does not display any messages. To view installation messages, administrators should view the setup log.

Overview of Alternative Ways to Carry Out Administrative Installation

Dragon NaturallySpeaking13 includes a native Windows Installer (MSI) that lets you install across a network to multiple client computers and customize your installation in the process. In addition, you can use this service to modify, repair, or remove any existing installations. You can use any of the following command line approaches to installing Dragon over a network:

- Carrying Out an Administrative Installation with .bat File
- Configuring Installation of Product Updates
Creating Custom Installation Using Microsoft Custom Install Wizard

Once you have installed the server image, you can configure your installation, then use SMS or a similar product to install Dragon. If the product you use to push the installation out to a server requires it, you can install Dragon with msiexec (see Step-by-Step Command Line Installation with msiexec.exe) instead of setup.exe.

Modifying Roaming User Profile, Miscellaneous, Schedule Settings in the INI File

Suppose you have a large installation that involves several departments. Three departments require one group of configure settings and two others require modifications. After you complete the installation on the three departments requiring the same configuration, you might want to edit your configuration files before using them on the additional two departments.

To edit the settings, you can use the natspeak command again. You can either return to the computer where you carried out the initial installation to use natspeak or install the configuration from the first three departments on the first computer in the two departments with different settings. Modify the settings using:

- natspeak/setdefaultoptions
- natspeak/setdefaultadministrativeoptions

Then copy the new nsdefaults.ini and roamingdef.ini files to a location accessible from all the client computers to have the alternative configuration. For example, if you want these files to be accessible to the MSI installer from a mapped network drive, copy the files to that location before installing to the client PCs.

Or, if the Roaming User Profile network settings are not changing, you can edit any of the other Roaming User Profile, Miscellaneous, and Scheduled Tasks settings of your configuration by rerunning Dragon with any command listed above. (You cannot make changes to the roamingdef.ini file, where the network settings reside.) Lists of the options in the nsdefaults.ini and roamingdef.ini files are provided in the tables that follow:

Caution: Be sure to use the full path to the file if you set an option to an .ini file name.

Understanding and applying the Roaming User Options

You can set Roaming User options during an MSI installation of Dragon NaturallySpeaking13. In the command line:

- Set the /SETDEFAULTS option to 1 to display the Options dialog box at the end of the installation. The Options dialog box lets you change Dragon’s standard behavior, including specifying hot keys, customizing how text is formatted, changing initial microphone settings, and setting the how often your User Profiles are backed up.
- Set the /SETADMINS option to 1 to display the Administrative settings dialog box at the end of the installation. The Administrative settings dialog box lets you set up the Roaming feature.
In the **Roaming**, **Miscellaneous**, and **Schedule** tabs of the Administrative Settings dialog box, you set default values for the Roaming User options in the table below. The default values are then written to the `nsdefaults.ini` file, the `roamingdef.ini` file, and the `roaminguser.ini` file.

After the MSI installation is finished, you can use the `nsdefaults.ini` file, the `roamingdef.ini` file, and the `roaming.ini` file to install Dragon on other computers using the same settings that are in the .ini files.

See **Overview of Installing Dragon using the Windows installer (MSI)** and it’s subtopics for more information on installing Dragon using an MSI installation.

See **MSI Options Specific to Dragon** for more information on options that can be set during an MSI installation of Dragon.

**Do not attempt to manually modify the .ini files.** Manually modifying the .ini files may cause unpredictable or undesirable results.
<table>
<thead>
<tr>
<th>Option</th>
<th>Description and UI equivalent</th>
</tr>
</thead>
<tbody>
<tr>
<td>RoamingUserOn=0 (or 1)</td>
<td>Turns on the Roaming feature.</td>
</tr>
<tr>
<td></td>
<td>Default 0 = Off</td>
</tr>
<tr>
<td></td>
<td>Same as the <strong>Roaming Tab - Enable</strong> option.</td>
</tr>
<tr>
<td>Roaming User Local Cache Directory=“&lt;existing</td>
<td>Sets the location of the local copy of the Roaming User Profile. The default location is:</td>
</tr>
<tr>
<td>directory&gt;”</td>
<td>ProgramData\Nuance\NaturallySpeaking13\RoamingUsers\</td>
</tr>
<tr>
<td></td>
<td>Same as the <strong>Roaming Tab - Local directory (for cache)</strong> option.</td>
</tr>
<tr>
<td>Open User Large Collection=0 (or 1)</td>
<td>Same as the <strong>Roaming Tab - Display Classic Open User Profiles dialog</strong> option.</td>
</tr>
<tr>
<td></td>
<td>See Dragon - What’s New for administrators for more information.</td>
</tr>
<tr>
<td>Roaming User Restrict Local User Access=1 (or 0)</td>
<td>Permits non-Roaming User Profiles to be opened when the Roaming feature is active. Default of 1 restricts access to Roaming User Profiles only, preventing non-roaming (local) end-users from dictating by accident.</td>
</tr>
<tr>
<td></td>
<td>Same as the <strong>Roaming Tab - Allow non-roaming user profiles to be opened</strong> option.</td>
</tr>
<tr>
<td>Roaming User Incorporate Voc Delta=0 (or 1)</td>
<td>When the vocdelta.voc file reaches 90% of its maximum size (1000 KB, or 1 GB), incorporates the contents of the local vocdelta.voc file into the master Roaming User Profiles (acoustic model for the User Profile), without running the <strong>Acoustic and Language Model Optimizer</strong>. After it incorporates the contents of the file into the master Roaming User Profile, it clears that data from the local User Profile, where new data is pulled from subsequent dictation. If the data is being incorporated when you open a roaming User Profile, the process can be time consuming. Default 0 = On</td>
</tr>
<tr>
<td></td>
<td>Same as the <strong>Roaming Tab - Merge contents of vocdelta.voc into network user profile when file is full</strong> option.</td>
</tr>
<tr>
<td></td>
<td>In Dragon NaturallySpeaking, Dragon does not display a message when the vocdelta.voc file reaches 90% of its maximum size.</td>
</tr>
<tr>
<td>Roaming User Limited Network Traffic=0 (or 1)</td>
<td>Transfers local Roaming User Profile changes to the master Roaming User Profile to synchronize the local and the master Roaming User Profile only when you open or close the User Profile. This includes the changes an end-user makes locally from the Options dialog box. For more information, see the Dragon Administrator Guide Help file topic on Synchronizing Master and Local Roaming User Profiles. Excessive network slowdowns can be alleviated by checking this option because it limits multiple interim synchronization of local and master Roaming User Profiles.</td>
</tr>
<tr>
<td>Option</td>
<td>Description and UI equivalent</td>
</tr>
<tr>
<td>--------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Default 0 = Off</td>
<td>Same as the <strong>Roaming Tab - Access network at user profile open/close only</strong> option.</td>
</tr>
<tr>
<td>Roaming User Always Break Lock=0 (or 1)</td>
<td>Ask before breaking locks on network User Profiles (recommended). A network lock prevents opening a Roaming User Profile that is already open. Network problems can cause a lock to become &quot;stuck&quot; and not release even after opening the User Profile is complete. Default of 0 produces a prompt that states the User Profile is locked and asks you to override the lock. A setting of 1 does not produce the prompt, but breaks the lock automatically. Same as the <strong>Roaming Tab - Ask before breaking locks on network user profiles (recommended for UNC and mapped drives)</strong> option.</td>
</tr>
<tr>
<td>ASW Override=0 (or 1)</td>
<td>(ASW is short for Audio Setup Wizard.) Runs a <strong>Volume</strong> and <strong>Quality Check</strong> on the microphone each time you open a Roaming User Profile. This setting affects all end-users. Turn this option on if your end-users experience reduced accuracy because of differences in the microphone, sound card, and ambient sound levels at different locations. Default 0 = Off. Nuance recommends you set this option to 1. Same as the <strong>Roaming Tab - Set audio levels on each machine</strong> option.</td>
</tr>
<tr>
<td>Roaming ASW Override =0 (or 1)</td>
<td>Runs a <strong>Volume</strong> and <strong>Quality Check</strong> on the microphone each time you open a Roaming User Profile. Set to 1 if the Roaming feature is enabled and <strong>ASW Override</strong> is 1. <strong>ASW Override</strong> and <strong>Roaming ASW Override</strong> should always have the same setting. Same as the <strong>Roaming Tab - Set audio levels on each machine</strong> option.</td>
</tr>
<tr>
<td>Roaming User Save Acoustics =0 (or 1)</td>
<td>When set to 1 (by default), when an end-user dictates on a computer, acoustic adaptation that occurred as Dragon 'adapted' to the end-user's voice, is saved. Acoustic optimization on the master User Profile applies the acoustic adaptation data from dictation to the acoustic model for the profile. When set to 0, the .usr and .sig files created during dictation are not saved. Acoustic optimization on the master User Profile does not apply the acoustic adaptation data from dictation to the acoustic model for the profile. Same as the <strong>Roaming Tab - Save acoustic information</strong> option.</td>
</tr>
<tr>
<td>Roaming User Copy Dragon Log=0 (or 1)</td>
<td>Copies the <em>dragon.log</em> file from the local Roaming User Profile location to the master Roaming User Profile location at the same time that the program synchronizes the local and the master Roaming User Profiles. See <strong>Dragon - What's New</strong> for administrators for more information.</td>
</tr>
<tr>
<td>Option</td>
<td>Description and UI equivalent</td>
</tr>
<tr>
<td>--------------------------------------------</td>
<td>-------------------------------</td>
</tr>
<tr>
<td>Default 0 = Off</td>
<td></td>
</tr>
<tr>
<td>Same as the Roaming Tab - Copy Dragon log to network option.</td>
<td></td>
</tr>
<tr>
<td>Copies the User Profile’s acoustic information to the master Roaming User Profile location when you do not want to run the Acoustic and Language Model Optimizer on the master Roaming User Profiles. The local Roaming User Profile acoustic information is stored in: \ProgramData\Nuance\NaturallySpeaking13\RoamingUsers&lt;displayname&gt;&lt;username&gt;\current&lt;acousticnumber&gt;</td>
<td></td>
</tr>
<tr>
<td>The &lt;display name&gt; is the name you defined for the master Roaming User Profile location. You can have multiple network storage locations. The &lt;username&gt; contains the names of an individual master Roaming User Profile. Default 0 = Off.</td>
<td></td>
</tr>
<tr>
<td>If you chose not to copy the User Profile’s acoustic information to the network, corrections you make on one computer are not available on other computers used by that particular Roaming User Profile until you run the Acoustic and Language Model Optimizer on the master Roaming User Profile location and the local and master Roaming User Profile synchronize.</td>
<td></td>
</tr>
<tr>
<td>When this option is set to 1 (on), the latest acoustic information is always available and automatically synchronized when the master Roaming User Profile is opened from another location. The transfer of acoustic information is not limited by setting the Disk space reserved for network archive option.</td>
<td></td>
</tr>
<tr>
<td>Same as the Roaming Tab - Always copy acoustic information to network option.</td>
<td></td>
</tr>
<tr>
<td>Prevents making files that contain acoustic data from the latest dictation session available to the Acoustic Optimizer when the program synchronizes the local and master Roaming User Profiles. You use this option to prevent the transfer of acoustic optimization data to local User Profiles.</td>
<td></td>
</tr>
<tr>
<td>Same as the Roaming Tab - Conserve archive size on network option.</td>
<td></td>
</tr>
<tr>
<td>Controls the maximum size for each container directory in the master Roaming User Profile directory. Defaults to 1000 MB.</td>
<td></td>
</tr>
<tr>
<td>Same as the Roaming Tab - Disk space reserved for</td>
<td></td>
</tr>
<tr>
<td>Option</td>
<td>Description and UI equivalent</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Allow Users to Configure</td>
<td>An administrator enables this option to allow end-users to access the Scheduled Tasks tab in the Administrative Settings dialog box. Users can use the options in the Scheduled Tasks tab to set schedules for tasks, including the accuracy tuning task and the data collection task. If an administrator does not enable this option, end-users cannot access the Scheduled Tasks tab and the tasks will use the default schedule. Same as the Scheduled Tasks Tab - Let the user choose when to run Accuracy Tuning and Data Collection option.</td>
</tr>
<tr>
<td>Tasks=0 or 1</td>
<td></td>
</tr>
<tr>
<td>Custom Directory=&lt;full path&gt;</td>
<td>Sets the location of the Data Distribution directory used by the Data Distribution Tool or the nsadmin command. The Data Distribution directory can be set to any directory that Windows has read and write access to. This includes portable devices such as Zip drives and CD/DVD burners. In enterprise installations, the Data Distribution directory is likely set to mapped network drives and UNC paths. Same as the Miscellaneous Tab - Data Distribution location option.</td>
</tr>
</tbody>
</table>

**Editing Miscellaneous and Scheduled Task Settings in nsdefaults.ini File**

Of the settings in the nsdefaults.ini file retrieved from the Administrative Settings dialog box, several settings are from the Miscellaneous and Scheduled Tasks tabs of the dialog box. You can modify the following settings in the nsdefaults.ini file:
<table>
<thead>
<tr>
<th>Options</th>
<th>Description</th>
<th>UI</th>
</tr>
</thead>
<tbody>
<tr>
<td>AO Archive Time Limit</td>
<td>Maximum audio archive size in minutes. The same option in the options.ini file for a particular end-user contains the size of the current audio archive for that end-user. Default max is 3600000 minutes.</td>
<td>Archive Size dialog box, displaying the range of audio archive sizes</td>
</tr>
<tr>
<td>Disable command changes for restricted users=0 (or 1)</td>
<td>Turns on or off the option that lets non-administrative end-users add or modify commands.</td>
<td>Do not allow restricted users to add or modify commands</td>
</tr>
<tr>
<td>Disable vocabulary changes for restricted users=0 (or 1)</td>
<td>Turns on or off the option that lets non-administrative end-users modify vocabularies.</td>
<td>Do not allow restricted users to modify vocabularies</td>
</tr>
<tr>
<td>Global Enable Pause Results=0 (or 1)</td>
<td>Turns on or off recognition when the speaker pauses.</td>
<td>Record wave data between utterances</td>
</tr>
<tr>
<td>Custom Directory=&lt;full path&gt;</td>
<td>Sets the location of the Data Distribution directory used by the Data Distribution Tool or the nsadmin command.</td>
<td>Data Distribution location</td>
</tr>
<tr>
<td>Current Status Ctfmngr=0 (or 1)</td>
<td>Turns on or off Windows advanced text services. Turning off these services prevents conflict between them and Dragon.</td>
<td>Disable Windows advanced text services</td>
</tr>
</tbody>
</table>
### Chapter 5: Installing Dragon using the Windows installer (MSI)

<table>
<thead>
<tr>
<th>Options</th>
<th>Description</th>
<th>UI</th>
</tr>
</thead>
<tbody>
<tr>
<td>No Dictation=0 or 1</td>
<td>When No Dictation is on (set to 1) the end-user cannot dictate, but can only correct dictation; used to designate an end-user as a transcriptionist.</td>
<td>Correction Only Mode</td>
</tr>
<tr>
<td>Global MyCommands MacroRecorder=0 or 1</td>
<td>Allows or does not allow the end-user to modify Macro Recorder commands. The end-user should still be able to dictate with those commands, even when not allowed to modify them.</td>
<td>Disable use of Macro Recorder commands</td>
</tr>
<tr>
<td>Global MyCommands StepByStep Scripting=0 or 1</td>
<td>Allows or does not allow the end-user to modify Step-by-Step commands. The end-user should still be able to dictate with those commands, even when not allowed to modify them.</td>
<td>Disable use of Step-by-Step commands</td>
</tr>
<tr>
<td>Global MyCommands VBA Scripting=0 or 1</td>
<td>Allows or does not allow the end-user to modify Advanced Scripting commands. The end-user should still be able to dictate with those commands, even when not allowed to modify them.</td>
<td>Disable use of Advanced Scripting commands</td>
</tr>
<tr>
<td>enx ACO uses</td>
<td>When set to 1, the</td>
<td>Disable automatic</td>
</tr>
<tr>
<td>Options</td>
<td>Description</td>
<td>UI</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>------------------------------------------------------------------</td>
</tr>
<tr>
<td>Auto Accent AM selection=0 or 1</td>
<td>Acoustic Optimizer engine can automatically select an acoustic model that it believes is more suited to your speech. To avoid having this switch occur, set the option to 0. In Dragon NaturallySpeaking 13, special conditions apply if you run the Acoustic Optimizer on a User Profile that has two acoustic models. See Using multiple acoustic models with a User Profile for more information.</td>
<td>acoustic model selection in Acoustic Optimizer</td>
</tr>
<tr>
<td>Data Collector Batch Mode=0 or 1</td>
<td>When set to 1, turns on a process that automatically collects data to help improve speech recognition in the future. The process sends the data to Nuance over the Internet, but does not send any personal information - it collects recorded dictation and the corresponding text. Collecting data for Nuance is optional.</td>
<td>Enable scheduled Data Collection</td>
</tr>
<tr>
<td>Allow Users to Optimize=0 or 1</td>
<td>When set to 1, turns on a process</td>
<td>Enable scheduled Accuracy Tuning</td>
</tr>
</tbody>
</table>
Options & Description

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
<th>UI</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>that automatically runs an optimization process on speech recognition for</td>
<td></td>
</tr>
<tr>
<td></td>
<td>the currently open User Profile.</td>
<td></td>
</tr>
<tr>
<td>Allow Users to Configure Tasks=0 or 1</td>
<td>Turning this option on lets end-users set the schedule for accuracy tuning and data collection tasks. Otherwise, these tasks take place on a default schedule.</td>
<td>Let the user choose when to run Accuracy Tuning and Data Collection</td>
</tr>
</tbody>
</table>

Understanding Network and Connection Settings in roamingdef.ini File

Although you cannot edit the roamingdef.ini file because it is encrypted, you should know that the following information is in the file. You can modify these settings through the Administrative Settings dialog only. For more information on values for each option, refer to the Dragon Administrator Guide Help file available through the product menu:
<table>
<thead>
<tr>
<th>Options</th>
<th>Description and UI</th>
</tr>
</thead>
<tbody>
<tr>
<td>[&lt;Network Settings&gt;]</td>
<td><em>Display Name</em> assigned to the network directory where Roaming User Profiles are stored, in the <em>Network Directories</em> box.</td>
</tr>
<tr>
<td>location</td>
<td><em>Address.</em> Path to a network directory, web server, or secure web server where Roaming User Profiles are stored.</td>
</tr>
<tr>
<td><strong>HTTP Settings (HTTP)</strong></td>
<td></td>
</tr>
<tr>
<td>type</td>
<td><em>Authentication Type.</em></td>
</tr>
<tr>
<td>authscheme=1</td>
<td>Indicates authentication is required.</td>
</tr>
<tr>
<td>queryforuserpassword</td>
<td><em>Prompt for user and password check box.</em></td>
</tr>
<tr>
<td>authuser</td>
<td><code>&lt;domain&gt;\&lt;username&gt;</code> required to log in.</td>
</tr>
<tr>
<td>authpassword</td>
<td>Actual password required to log in.</td>
</tr>
<tr>
<td>followredirects</td>
<td><em>Follow Redirects.</em> Never, Always, or Same Scheme Only.*</td>
</tr>
<tr>
<td>keepalive</td>
<td><em>Keep Connection Alive check box.</em></td>
</tr>
<tr>
<td>locktimeout</td>
<td><em>Lock under Timeouts.</em> Number of seconds after timeout expires to lock the connection.*</td>
</tr>
<tr>
<td>connectiontimeout</td>
<td><em>Connection under Timeouts.</em> Number of seconds after timeout expires to close the connection.*</td>
</tr>
<tr>
<td>connectiontimeoutinactivity</td>
<td><em>Type under Timeouts.</em> Set if you selected <em>Inactivity</em> option.*</td>
</tr>
<tr>
<td>connectiontimeoutabsolute</td>
<td><em>Type under Timeouts.</em> Set if you selected <em>Absolute</em> option.*</td>
</tr>
<tr>
<td>firewall</td>
<td><em>Firewall and Proxy Servers.</em> Set if a firewall is configured.*</td>
</tr>
<tr>
<td>proxy</td>
<td><em>Use Proxy Server check box.</em> Set if checked.*</td>
</tr>
<tr>
<td>proxyserver</td>
<td><em>Network Location.</em> URL to the web server.*</td>
</tr>
<tr>
<td>firewalltype</td>
<td><em>Type.</em> Type of firewall represented by a number.*</td>
</tr>
<tr>
<td>firewallhost</td>
<td><em>Server.</em> Name of server for the firewall.*</td>
</tr>
<tr>
<td>firewallport=1080</td>
<td><em>Port.</em> Port used by the proxy server or firewall. <em>1080</em> is the default.*</td>
</tr>
</tbody>
</table>
Chapter 5: Installing Dragon using the Windows installer (MSI)

<table>
<thead>
<tr>
<th>Options</th>
<th>Description and UI</th>
</tr>
</thead>
<tbody>
<tr>
<td>firewalluser</td>
<td>Username. Login name of the administrator that can access the firewall.</td>
</tr>
<tr>
<td>firewallpassword</td>
<td>Password. Password to log in to the firewall.</td>
</tr>
<tr>
<td>firewalldata</td>
<td>Firewall Data or Proxy Authorization. Special authentication string for firewall or proxy server, if applicable.</td>
</tr>
</tbody>
</table>

**SSL Settings (HTTPS)**

<table>
<thead>
<tr>
<th>SSL Settings (HTTPS)</th>
<th>Description and UI</th>
</tr>
</thead>
<tbody>
<tr>
<td>sslcertstore</td>
<td>Certificate store text box with no label. Name of the certificate.</td>
</tr>
<tr>
<td>sslcertstorepassword</td>
<td>Certificate Store Password.</td>
</tr>
<tr>
<td>sslcertstoretype</td>
<td>Certificate Store Type, indicated by numeric designation.</td>
</tr>
<tr>
<td>useopenssl</td>
<td>Using OpenSSL check box.</td>
</tr>
<tr>
<td>opensslcipherlist</td>
<td>Cipher List.</td>
</tr>
<tr>
<td>opensslcafile</td>
<td>Certificate Authority File.</td>
</tr>
<tr>
<td>opensslcadir</td>
<td>CA Directory.</td>
</tr>
</tbody>
</table>

**SSL Enabled Protocols**

<table>
<thead>
<tr>
<th>SSL Enabled Protocols</th>
<th>Description and UI</th>
</tr>
</thead>
<tbody>
<tr>
<td>tls1</td>
<td>Version 1 of the Transport Layer Security (TLS) protocol.</td>
</tr>
<tr>
<td>ssl3</td>
<td>Version 3 of the Secure Sockets Layer (SSL) protocol.</td>
</tr>
<tr>
<td>ssl2</td>
<td>Version 2 of the Secure Sockets Layer (SSL) protocol.</td>
</tr>
<tr>
<td>pct1</td>
<td>Version 1 of the Private Communications Transport (PCT) protocol.</td>
</tr>
</tbody>
</table>

**Carrying Out an Administrative Installation with .bat File**

A straightforward way to install Dragon from the command line to a server is to carry out an administrative installation using a .bat file.

**Caution:** Only advanced administrators should attempt any type of administrative installation.
Note: A script for carrying out a full administrative installation is provided in the admininstall.bat file at the top of the directory structure on the DVD. The script includes a bare minimum of the options available, so you might want to read through the Installation using the Dragon command line to find out about other options you might use.

Understanding the script in admininstall.bat

Below are some of the lines from the script in the admininstall.bat file, a batch file that de-compresses setup files into a network location for installation using SMS or another service. To run the batch file, you enter admininstall.bat and follow it with the location of the Dragon .msi file.

Near the top of the batch file, you see the lines that check the parameters entered and if the parameter passed is not acceptable, execute a routine that handles that situation:

```
:rem //Check and analyze input parameters if .%l==.. goto bad_args
```

If the arguments you pass when you enter the command is acceptable, the batch file sets the NETWORK_DNS_DIR to the location of the Dragon .msi file:

```
set NETWORK_DNS_DIR=%1%
```

When you run the admininstall.bat file, the file installs Dragon using a single line of code that calls the setup.exe command and passes it:

- /a option — Indicates administrative install
- /s option for a silent no-GUI installation
- /v option to indicate msiexec options follow, enclosed in quotation marks

When you perform a silent installation of Dragon, the installation process does not display any messages. To view installation messages, administrators should view the setup log.

The setup/ msiexec options with /v include /qb for display of a basic GUI during the process, the TARGETDIR setting, and a /L with a series of log file options, including the name and location for the log file:

```
echo Installing Dragon NaturallySpeaking... setup.exe /a /s /v"/qb TARGETDIR=%NETWORK_DNS_DIR% /L*v %TEMP%\admininstall.log"
```

When the installation of Dragon succeeds or fails, the batch file displays an appropriate message. The remainder of the file handles errors and cases where bad arguments are passed on the command line.

Modifying admininstall.bat

You can modify the admininstall.bat file by adding to and changing the options you pass for installing Dragon. You can add more options and/or modify the options shown here. For more on installation options, refer to Installation using the Dragon command line or these summaries:

- MSI Options Specific to Dragon
- MSI Options for Installing Dragon Features/Advanced Options
Chapter 5: Installing Dragon using the Windows installer (MSI)

- Feature Variables to Set Through the ADDLOCAL or ADVERTISE Properties
- MSI Options for Roaming User Profile, Tuning, and Data Collection Setup

Install Dragon on an initial computer and choose the default settings

Before you proceed, you should be familiar with installing the product on a single computer from the DVD. For more information, see Installing, modifying and upgrading Dragon.

The initial installation is used to set default values for the Administrative, end-user, and Auto-Formatting options. These options can then be used to install on other computers using the same values.

Even if you are installing from a server, you should run through the initial installation below first. For more information on installing from a server, proceed to Overview of the Network Installation of Dragon from a Server.

Caution: If you want to set any administrative settings, be sure you have Windows administrator privileges. Administrator rights are not required to create a User Profile or use the software after installation.

Before you begin:

- Install any pending Windows updates and reboot the computer when you are finished.
- Close all open applications.
- Turn off or disable antivirus software; the installation process can sometimes trigger a false virus report.

Note: An alternative to this approach is to use msiexec.exe to install Dragon, covered under Step-by-Step Command Line Installation with msiexec.exe.

Extracting MSI/MST Files from the Dragon setup.exe

Some minor releases of Dragon do not include an MSI file. Instead, the file is part of the setup.exe file. You can run silent installations from the command line with msiexec.exe or by setup.exe. You don't need to first extract the msi and mst files. Use the following information if you are comfortable using .msi installers.

If you are using the setup.exe method, you must ensure that all flags/properties (SERIALNUMBER, DEFAULTS.INI,/qn, etc.) are all with in the same quotes directly after /v without a space.

This sample command line launches setup and installs Dragon into the C:<full_path>\Dragon directory:

```
setup /a /s /v"INSTALLDIR="C:\<full_path>\Dragon" /qn"
```

You can carry out an administrative installation using setup.exe, as follows:

- Create a server image of Dragon files for later installing clients. You create the image by executing setup.exe and passing it the /a option and a Dragon-specific option that
extracts MST and MSI files from the Dragon setup.exe file provided.

- Use the options to extract the MSI/MST Files from the Dragon setup.exe.

**Extracting MSI/MST Files from setup.exe**

The following setup.exe options are designed to extract .msi/.mst files for Windows Installer-oriented distributions.

**Note:** When you install Dragon NaturallySpeaking13, Dragon installs using the primary language for the product. You cannot install Dragon using a language that is different than the primary language. For example, when you install Dragon, Professional - English version, Dragon installs using the English language.

If you attempt to use the `/l` option with setup.exe to install Dragon NaturallySpeaking13 using a non-primary language, the installation process uses the primary language for that edition of Dragon and ignores the `/l` option.

These options do not install any files, but rather extract an installable set of files into the server directory you specify.
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>/a</td>
<td>Administrative installation. Instructs <code>setup.exe</code> to perform an administrative installation to a network for use by a workgroup instead of a normal installation. This option is required when trying to extract the <code>.msi</code> files. An administrative installation installs a source image of the application onto the network. The image is similar to a source image on a CD or DVD. Users in the workgroup who have access can then install the product over the network from this source image.</td>
</tr>
<tr>
<td>/v&quot;&lt;msiexec options&gt;&quot;</td>
<td>Passes <code>msiexec</code> options to Windows Installer. See table of <code>msiexec</code> options for details. This option is required when trying to extract the <code>.msi</code> files.</td>
</tr>
<tr>
<td>/l&lt;Windows Language Code&gt;</td>
<td>Specifies the language to use for installing Dragon. For example, to launch the installation in French, the command line would include <code>/L1036</code>. The language codes supported for installing Dragon are: 1031=German 1033=English 1034=Spanish 1036=French 1040=Italian 1043=Dutch Also creates an MST file for the language you specify, such as <code>1036.MST</code>.</td>
</tr>
<tr>
<td>EXTRACTFILES=&quot;c:\xyz&quot;</td>
<td>Indicates the directory where the extracted <code>.msi/.mst</code> files are to be written. Long path names containing spaces need to be in quotation marks escaped by having a backslash precede each quotation mark (<code>\</code>). This property is required to extract the <code>.msi</code> files. If the directory you specify does not exist, the installer creates it. Here is a sample command line to extract <code>msi</code> files from a single executable:</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td><code>setup.exe /a /s /v&quot;EXTRACTFILES=c:\temp\msifiles&quot;</code></td>
<td>Use with administrative installations only. Indicates the full path to where to install the image of Dragon.</td>
</tr>
</tbody>
</table>

**Using .MSI/.MST Files for Custom Installations Example**

Using .MST files you can tailor the MSI installation without changing the setup.exe file that Nuance provides.

**Note:** When you install Dragon NaturallySpeaking13, Dragon installs using the primary language for the product. You cannot install Dragon using a language that is different than the primary language. For example, when you install Dragon, Professional, English version, Dragon installs using the English language.

If you attempt to use the `/l` option with setup.exe to install Dragon NaturallySpeaking13, using a non-primary language, the installation process uses the primary language for that edition of Dragon and ignores the `/l` option.

**Step1: Running setup.exe to Extract .MSI and .MST Files**

If you are using the setup.exe method, you must ensure that all flags/properties (SERIALNUMBER, DEFAULTS.INI,/qn,etc.) are all with in the same quotes directly after `/v` without a space.

The following sample command line extracts the Dragon NaturallySpeaking msi file and the mst file used for installing Dragon:

```
setup.exe /a /s /v"EXTRACTFILES=c:\temp\MSIfiles /qn"
```

Caution: The first time you try any command line, you should not run it in Silent mode, because if you have neglected to provide required information, you then receive a GUI prompt for that information.

Next, you specify the extracted .MSI and .MST files in a command line to install Dragon. The next two examples show how these files are used running first setup.exe, then msiexec.exe.

**Installation using the Dragon installation process**

Perform the following steps to use the user interface of the Dragon installation process:

1. Insert the product DVD in the DVD drive. If the installation does not start, run setup.exe from the DVD.
2. Choose the Custom installation with appropriate languages and vocabularies.
3. Choose the following check boxes under **Additional options** to have additional dialog boxes pop up at the end of the installation, where you can make changes that affect all end-users dictating on this computer.
Chapter 5: Installing Dragon using the Windows installer (MSI)

- **Modify the application’s settings for all user profiles** - Displays the Options dialog box at the end of the installation.

- **Modify the administrative settings** - Displays the Administrative Settings dialog box at the end of the installation, where you set up the Roaming feature, where to back up your User Profiles, and who can modify commands/vocabularies.

- **Auto-Formatting options** - Displays the Auto-Formatting dialog box at the end of the installation, where you apply uniform formatting to all documents dictated at this installation; for example, formats for dates, times, and phone numbers.

4. When the Options dialog box appears, select the default options that should apply to all client installations and click OK. This dialog box is where you set up all the options under the various tabs (Correction, Command, and so on).

Note: Settings under the Playback/Text-to-Speech tab are not saved. To include Text-to-Speech as a feature of your installation, work with options in **Summary: MSI Options for Installing Dragon Features/Advanced Options**.

Note: At least one supported third-party indexing/search software should be installed on the system before you install Dragon, or the Enable Desktop Search commands check box will not only be unchecked, but will not be available to be checked. Dragon supports Google Desktop and Microsoft Search.

5. When the Auto-Formatting dialog box appears, select Auto-Formatting options to apply to all client installations and click OK.

6. When the Administrative Settings dialog box appears, if you want to set up Roaming User Profiles, set the options under Roaming User Profile (to set the HTTP or HTTPS settings under the HTTP Settings or HTTPS Settings button, you must have either http:// or https:// in front of the network directory path); whether you have Roaming User Profiles or not, set the options under Miscellaneous and Scheduled Tasks tabs and click Apply for each; then, when you have set all the settings, click OK.

7. Dragon has saved the configuration you created with running natspeak.exe in the nsdefaults.ini and roamingdef.ini files (the roamingdef.ini file is created only if you set up Roaming User Profiles). You can find these .ini files under C:\ProgramData\Nuance\NaturallySpeaking13\.

These .ini files are now considered customized files, because they now contain the custom settings that will be applied to each of the DNS client installations you deploy.

Retrieve the nsdefaults.ini and roamingdef.ini files and copy them to a directory where you can access them from the other client computers. (If you did not run natspeak.exe on the command line, you do not find a roamingdef.ini file; in that case, you can use a roaming.ini file from an existing installation whose settings you’d like to replicate. If you did not change the Network Settings, you do not need a roamingdef.ini or roaming.ini file at all.)

You are now ready to install the same configuration you just established here onto other computers.

Notes:

- If you are installing Dragon on more than one client computer and over a network, you can use the same .ini files with the MSI Installer (msiexec). You also use SMS Server or another server-based program that pushes the installation out to several clients at once. Even if you are installing from a server, you should run through the initial
installation before you carry out the administrative installation. Then, for more information on installing from a server, proceed to Overview of Installing Dragon using the Windows Installer (MSI).

- When you install Dragon NaturallySpeaking13, Dragon installs using the primary language for the product. You cannot install Dragon using a language that is different than the primary language. For example, when you install Dragon, Professional - English version, Dragon installs using the English language. If you attempt to use the /1 option with setup.exe to install Dragon NaturallySpeaking13 using a non-primary language, the installation process uses the primary language for that edition of Dragon and ignores the /1 option.

Install the same Dragon configuration on multiple computers

Note: If you chose Enable Desktop Search Commands on the Commands tab during the initial installation, you must install Google Desktop or Microsoft Search before you install Dragon; otherwise, that option does not take effect.

1. Be sure you can access the .ini files you created in the previous procedure from the computer you will be installing on or copy the files to a local path on the client computer where you are about to install Dragon.
2. Be sure you have the Dragon serial number (or the group serial number, if you are installing Dragon to multiple computers on a network).
3. Be sure all mapped drives you plan to use are mapped on individual client computers where you are distributing the installation.
4. Install any pending Windows updates and reboot the computer.
5. Open a command line window (Start > Run cmd).
6. Insert the product DVD in the DVD drive and search the DVD for the path where the Dragon setup.exe is located.
7. On the computer where you are installing Dragon, to install the same configuration you created during the initial installation, enter the following on the command line (using the customized nsdefaults.ini file) of a single client. You pass the Dragon serial number for the SERIALNUMBER option and the full path to the nsdefaults.ini file using the DEFAULTSINI option (this line assumes no Roaming User Profiles):

```
setup.exe /s /v"SERIALNUMBER=#####-#####-#####-#####
INSTALLDIR="C:\<full_path>\Dragon13"
DEFAULTSINI="C:\<full_path>\nsdefaults.ini"
/L+V C:\Logs\logfile.log"
```

Note: The full path for the DEFAULTSINI setting uses escaped out quotation marks (preceded by a backslash) only when there are spaces in the full path.

If you are using the setup.exe method, you must ensure that all flags/properties (SERIALNUMBER, DEFAULTS.INI,/qn, etc.) are all with in the same quotes directly after /v without a space.

Caution: The first time you test any installation, you should pass /q rather than /qn so that
if you have neglected to provide information about a setting that does not have a default, you receive a GUI prompt for that information.

8. If you entered a network address in the Network Directories box and set up HTTP or HTTPS settings in the Roaming tab of the Administrative Settings dialog during the initial installation, those settings are transferred to your client computers only if you include the ROAMINGUSERINI option, set to roamingdef.ini:

```bash
setup.exe /s /v"SERIALNUMBER=#####-###-####-####-##
INSTALLDIR="C:\<full_path>\Dragon13"
DEFAULTSINI="C:\<full_path>\nsdefaults.ini"
ROAMINGUSERINI="C:\<full_path>\roamingdef.ini"
/L*v C:\Logs\logfile.log" 
```

You include the bolded portion of the above command lines so that if something goes wrong during the installation, you receive messages about it. You pass /L and a series of sub-options followed by a log file name to have the installation log errors and other messages related to the process. (You can send the log file to technical support should any issues arise.)

**Note:** You can also use the /qn option to install the product in Quiet mode, where no GUI or other messages appear. Another option, the /passive mode, runs the entire installation unattended, but displays a progress bar. However, the first time you run any installation command line, you should not use the /qn option, because turning off the GUI also turns off any messages that help you determine any problems with that command line. To use the /qn option, add it to the end of the command line.

If you are using the setup.exe method, you must ensure that all flags/properties (SERIALNUMBER, DEFAULTS.INI,/qn,etc.) are all with in the same quotes directly after /v without a space.

```bash
setup.exe /s /v"SERIALNUMBER=#####-###-####-####-##
INSTALLDIR="C:\<full_path>\Dragon13" DEFAULTSINI="C:\<full_path>\nsdefaults.ini"
/L*v C:\Logs\logfile.log /qn"
```

Creating Custom Installation Using Microsoft Custom Install Wizard

If you are installing Dragon on a network, you can create a custom installation program using a set of tools available from Microsoft.

1. Download and install the tools
2. Run the wizard
You are then ready to use the custom installer to install the product.

Installing the Microsoft Custom Installation Wizard

The Microsoft Custom Installation Wizard is part of the Microsoft Office Resource Kit Tools. To install the Custom Installation Wizard:


2. After downloading OrkTools.exe, to install the tools, you either double-click the executable or select Start > Programs > Microsoft Office Tools > Microsoft Office XP Resource Kit Tools.

After you install the tool, you use its Custom Installation Wizard to create your custom installation. For details on using the wizard, proceed to Modifying setup Properties for Custom Installation.

Modifying setup Properties for Custom Installation

The following explains how to modify setup properties for a custom installation of Dragon. This example shows how to add to the installer configuration one of the many MSI options you can set for installing Dragon, the SERIALNUMBER property. (You can add any options available to MSI on the command line.)

1. Start the Microsoft Custom Installation Wizard by choosing Start > Programs > Microsoft Office Tools > Microsoft Office XP Resource Kit Tools, and then click Custom Installation Wizard. The Custom Installation Wizard screen displays:

   ![Microsoft Office Custom Installation Wizard](image)

   - **Welcome to the Custom Installation Wizard**
     - Use this wizard to create a Windows Installer transform (MST file) and customize your Microsoft Office installation when you deploy to users over the network.

   - **Using this wizard, you can:**
     - Choose where to install Microsoft Office
     - Specify whether to remove previous versions
     - Set and disable feature installation states
     - Add a profile with default application settings
     - Add custom files, registry entries and shortcuts
     - Specify Office Security Settings
     - Customize default Outlook profile
     - Set other properties
2. Click Next.

3. On the Open the MSI File page of the wizard, shown below, select the .MSI file you want to use to create a custom installation. The compiled .MSI file is located on your installation CD. The files are named:
   - Dragon NaturallySpeaking 13.msi

4. The following example uses Dragon NaturallySpeaking 10.msi.

5. Click Next.

6. Click Yes when you see the following message:

```
Microsoft Office Custom Installation Wizard

The MSI specified is not meant to be customized with this version of the Office Custom Installation Wizard. It is not recommended to use this version of the Custom Installation Wizard with older versions of Office or with other products that were not created with the intention of being customized. Some customization features will not work as expected. Are you sure you want to continue?

[Yes] [No]
```

7. On the Open the MST File page of the wizard, select Create a new MST file.

8. Click Next to continue.

9. On the Select MST File to Save page of the wizard, select a file name and path for the MST file you are creating:
10. Click Next.

11. On the Specify a Default Path and Organization page, select the default path for the installation. By default, Dragon installs in `\Program Files\Nuance\NaturallySpeaking13`. 
12. Click Next.

13. On the Remove Previous Versions page, keep the default selections and click Next. This page applies only to Microsoft Office and does not affect the Dragon installation.

14. Click Next to keep all the defaults when you come to the Set Features Installation States page, where you select particular components to install.

15. On the next several pages of the wizard, click Next on each, and proceed until you reach the Modify Setup Properties page. All the pages in between apply only to Microsoft Office.
   - Customize Default Application Settings page
   - Change Office User Settings page
   - Add/Remove Files page
   - Add/Remove Registry Entries page
   - Add, Modify, or Remove Shortcuts page
   - Identify Additional Servers page
   - Specify Office Security Settings page
   - Add Installations and Run Programs page
16. Use the Modify Setup Properties page, shown below, to add, modify, and set the MSI options of your custom installation.

17. Click the Add button to display the Add/Modify Property Value dialog box, where you modify the MSI installation options. In this example, we add and set the SERIALNUMBER option.

18. In the following Add/Modify Property Value page, enter the new property name SERIALNUMBER and a valid serial number, then click OK:

19. Note that the Modify Setup Properties page re-displays with the updated information. For example:
20. Continue adding or modifying other MSI options that apply for your environment. Once you are done, click Next.


22. When the Custom Installation Wizard page appears, click Exit. This screen displays the location of Windows Installer transform (.MST file) that you created.

After you save changes, you can use the resulting .MST file to manage an installation through a Group Policy in Active Directory Services.

You are now ready to use the custom installer you created to install the product.

**Installation using the Dragon command line**

When you install Dragon NaturallySpeaking 13, Dragon installs using the primary language for the product. You cannot install Dragon using a language that is different than the primary language. For example, when you install Dragon, Professional - English version, Dragon installs using the English language.

If you attempt to use the `/l` option with setup.exe to install Dragon NaturallySpeaking 13 using a non-primary language, the installation process uses the primary language for that edition of Dragon and ignores the `/l` option.

Perform the following steps to use the Dragon command line:

1. Open a command prompt window in administrator mode. For more information about running a command prompt as an administrator on Windows 7 or on the Windows 8 Metro interface, see Windows 7, Windows 8 Notes.
2. Insert the product DVD in the DVD drive, search the DVD for the path where the Dragon setup.exe is located, and switch directories to the path on the product DVD where the Dragon setup.exe is located.

3. Enter the following command line to install Dragon on this initial computer (ignore any errors you receive regarding the serial number, as it is not required for this in initial installation, unless you plan to dictate later):

```
setup.exe /s /v"INSTALLDIR=c:\Dragon13 /L*v C:\Logs\logfile.log /qn"
```

The /s option sets the silent option for every .exe that setup.exe provides a wrapper for - so that no GUI pops up. When you perform a silent installation of Dragon, the installation process does not display any messages. To view installation messages, administrators should view the setup log.

By contrast the /qn inside the quotation marks after /v sets the silent option for the Dragon .msi installation.

The /v option introduces any series of msiexec.exe options you want to pass to the Windows installer, all enclosed in quotation marks after the /v, with no space allowed between the /v and the opening quotation mark. Among the options inside the quotation marks are:

- **INSTALLDIR** — Indicates the full path to where you want Dragon installed
- **/L*v** — (either upper or lowercase) Indicates the log file where messages about the installation should be written. You can refer to the /L Option in the table in the following Microsoft website: [http://msdn.microsoft.com/en-us/library/aa367988(v=vs.85).aspx](http://msdn.microsoft.com/en-us/library/aa367988(v=vs.85).aspx).
- **/qn** — (Quiet mode—also called Silent mode—no GUI) Turns off the Dragon GUI

**Caution:** The first time you test any installation, you should not run it in Silent mode, because if you have neglected to provide information about a setting that does not have a default, you receive a GUI prompt for that information. You should initially pass the /L*v option because it runs the entire installation GUI. When the Welcome dialog appears, you can stop and look into the log file., where you can search for Command line to verify that all command line parameters are being incorporated. The line you find will have this format:

```
MSI (c) [##:##][##:##:##:##] Command Line: <OPTION>=<value>
<OPTION>=<value> ...
```

The above command line is to install the primary language of the Dragon product.

**Logging errors and other messages**

Sub-options for /L indicate the types of messages to send to the log:
Running natspeak.exe to Set Options

When the installation completes, you then set up the configuration on this initial computer by running natspeak up to five times in total, in the steps that follow. All steps are optional; by skipping a step, you are choosing to accept the default values for the options applicable for associated options.

1. On a workstation PC where Dragon is installed, close Dragon if it is running.
2. From the Windows Start menu, select All Programs > Accessories > Command Prompt to open the Command Prompt window.
3. Switch to the Program directory. The default is:
   
   C:\Program Files\Nuance\NaturallySpeaking13\Program

![Command Prompt](image-url)
4. Enter the following natspeak command:
   natspeak.exe /setdefaultsoptions

5. When the Options dialog box appears, select the default options that should apply to all client installations and click OK. This dialog box is where you set up all the options under the various tabs (Correction, Command, and so on).

   **Note:** Settings under the Playback/Text-to-Speech tab are not saved. To include Text-to-Speech as a feature of your installation, work with options in Summary: MSI Options for Installing Dragon Features/Advanced Options.

   **Note:** At least one supported third-party indexing/search software should be installed on the system before you install Dragon, or the Enable Desktop Search commands check box will not only be unchecked, but will not be available to be checked. Dragon supports Google Desktop and Microsoft Search.

6. Enter another natspeak command:
   natspeak /SetDefaultFormattingOptions

7. When the Auto-Formatting dialog box appears, select Auto-Formatting options to apply to all client installations and click OK.

8. Enter a final natspeak command:
   "C:\ProgramFiles(x86)\Nuance\NaturallySpeaking13\Program\natspeak.exe"/setdefaultadministrativeoptions

9. When the dialog box appears, if you want to set up Roaming User Profiles, set the options under Roaming User Profile (to set the HTTP or HTTPS settings under the HTTP Settings or HTTPS Settings button, you must have either http:// or https:// in front of the network directory path); whether you have Roaming User Profiles or not, set the options under Miscellaneous and Scheduled Tasks tabs and click Apply for each; then, when you have set all the settings, click OK.

10. Dragon has saved the configuration you created with running natspeak.exe in the nsdefaults.ini and roamingdef.ini files (the roamingdef.ini file is created only if you set up Roaming User Profiles). You can find these .ini files under C:\ProgramData\Nuance\NaturallySpeaking13\. 

   **Note:**

   These .ini files are now considered customized files, because they now contain the custom settings that will be applied to each of the DNS client installations you deploy. Retrieve the nsdefaults.ini and roamingdef.ini files and copy them to a directory where you can access them from the other client computers. (If you did not run natspeak.exe on the command line, you do not find a roamingdef.ini file; in that case, you can use a roaming.ini file from an existing installation whose settings you’d like to replicate. If you did not change the Network Settings, you do not need a roamingdef.ini or roaming.ini file at all.)

11. When you have located the nsdefaults.ini file, verify that your option settings have been changed. Double-click the nsdefaults.ini file to open it in a text editor. You should see values defined for the options you changed.

   **Example:** If the Capitalize ‘allergy’ and ‘allergies’ as ‘ALLERGY’ and ‘ALLERGIES’ option
has been turned on, the nsdefaults.ini file contains this statement:

```
;(ALLERGY_CAP) Capitalize "allergy" and "allergies" as "ALLERGY" and "ALLERGIES"
ALLERGY_CAP=1
```

12. Include the newly created nsdefaults.ini file in your MSI package to distribute the file to all end-user workstations where Dragon is installed.

You are now ready to install the same configuration you just established here onto other computers.

**Note:** If you are installing Dragon on more than one client computer and over a network, you can use the same .ini files with the MSI Installer (msiexec). You also use SMS Server or another server-based program that pushes the installation out to several clients at once. Even if you are installing from a server, you should run through the initial installation before you carry out the administrative installation. Then, for more information on installing from a server, proceed to Overview of Installing Dragon using the Windows Installer (MSI).

### Natspeak.exe command line reference

You can use command line options to modify the way that Dragon NaturallySpeaking13 starts.

These switches are used in the following syntax:

```
natspeak /switch
```

where /switch is one or more switches from table below (each switch is a single word without spaces or hyphens).

On 64-bit machines, use the following path from a command line:

```
"C:\Program Files(x86)\Nuance\NaturallySpeaking13\Program\natspeak.exe"/setdefaultoptions
```
<table>
<thead>
<tr>
<th>Switch</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>/diagnose</td>
<td>Runs Dragon in diagnostic mode to output info to Dragon.log file and exits.</td>
</tr>
<tr>
<td>/user &lt;user&gt;</td>
<td>Automatically loads the User Profile.</td>
</tr>
<tr>
<td>/topic &lt;topic&gt;</td>
<td>Automatically loads the topic (Professional/Legal editions only).</td>
</tr>
<tr>
<td>/quick</td>
<td>Runs Dragon in QuickStart mode, a mode that starts Dragon without loading a User Profile or any speech models on startup of your computer.</td>
</tr>
<tr>
<td>/SetDefaultOptions</td>
<td>Displays the Options dialog box.</td>
</tr>
<tr>
<td>/SetDefaultAdministrativeOptions</td>
<td>Displays the Administrative settings dialog box.</td>
</tr>
<tr>
<td>/SetDefaultFormattingOptions</td>
<td>Displays Auto-Formatting dialog box.</td>
</tr>
</tbody>
</table>

**Other Actions You Can Take on Command Line**

When you perform a silent installation of Dragon, the installation process does not display any messages. To view installation messages, administrators should view the log files. See Troubleshooting silent install errors for details.

Here are other (optional) actions you can take on the command line as part of a silent installation:

**Note:** In Dragon NaturallySpeaking 13, the installation process does not present the QuickStart option. If you wish to enable this option, you can do so after Dragon is installed.

Additional Options for Silent Installations

- Modifying the Default Installation Directory
- Configuring Installation of Product Updates
- Suppressing Reboot of the computer After Installation
- Installing Same Roaming User Profile Configuration on Additional computer(s)

Additional Options with Extensive Settings for Silent Installations

- Revising Day/Time of Scheduled Tasks (Optional)
- Configuring Local or On-Demand Install of Vocabularies/Text-to-Speech (Optional)

**Modifying Default Installation Directory**

**Note:** If the value assigned to INSTALLDIR does not include 'NaturallySpeaking13', setup.exe appends 'NaturallySpeaking13' to the value.
Chapter 5: Installing Dragon using the Windows installer (MSI)

If you want to set an installation directory other than the default, pass INSTALLDIR="<full path to install>" on the command line (note that the quotation marks are required only if you have spaces in the path):

```
setup.exe /s /v"SERIALNUMBER=#####-####-####-####-
DEFAULTSINI="C:\<full_path>\nsdefaults.ini"
INSTALLDIR="C:\<full_path>\Dragon13" /L*v C:\Logs\logfile.log /qn"
```

Note: If the installation directory does not have spaces, note how the INSTALLDIR directory is designated in the command line:

```
setup.exe /v"INSTALLDIR=C:\Dragon13 ADDLOCAL=ALL"
```

If the installation directory has space(s), it is surrounded in quotation marks that are escaped out by having backslashes precede them:

```
setup.exe /v"INSTALLDIR="C:\NaturallySpeaking13" ADDLOCAL=ALL"
```

Caution: The first time you try any installation, you should not run it in Silent mode, because if you have neglected to provide information about a setting that does not have a default, you receive a GUI prompt for that information.

### Configuring Installation of Product Updates

If you want the individual client computer to download product updates to Dragon over the web, you would set the PRODUCTUPDATEFLAG option to 1 (option checks the check box). If you prefer to install the updates on the servers and later distribute them to client computers, set this option to 0 (unchecks the check box). If your enterprise does not install service packs provided by Nuance, Nuance recommends you set this flag to -1:

```
setup.exe /s /v"SERIALNUMBER=#####-####-####-####-
DEFAULTSINI="C:\<full_path>\nsdefaults.ini"
INSTALLDIR="C:\<full_path>\Dragon13"
PRODUCTUPDATEFLAG=-1 /L*v C:\Logs\logfile.log /qn"
```

If you are using the setup.exe method, you must ensure that all flags/properties (SERIALNUMBER, DEFAULTS.INI,/qn, etc.) are all with in the same quotes directly after /v without a space.

### Suppressing Reboot of the computer After Installation

To suppress rebooting of the computer after installation of Dragon completes, you can pass Microsoft’s REBOOT option set to ReallySuppress. Using this option is highly recommended if you are executing a silent installation.

**WARNING:** If a system reboot is required, you must reboot the system for the silent installation to properly install Dragon and for Dragon to function as expected.

```
REBOOT=ReallySuppress
```
The altered command line would look like this:

```
setup.exe /s /v"SERIALNUMBER=#####-###-####-##
DEFAULTSINI="C:\<full_path>\nsdefaults.ini"
INSTALLDIR="C:\<full_path>\Dragon13" /qn
PRODUCTUPDATEFLAG=-1 REBOOT=ReallySuppress
/L*v C:\Logs\logfile.log /qn"
```

### Installing the same Roaming User Profile Configuration on Additional computer(s)

Use the roamingdef.ini file you created during the initial installation as the input for the ROAMINGUSERINI option in this format (be sure to use the full path to the file when you pass the option):

```
ROAMINGUSERINI="C:\<full_path>\roamingdef.ini"
```

The default is empty (no .ini file will be used). Include the ROAMINGUSERINI option in the installation command line:

```
setup.exe /s /v"SERIALNUMBER=#####-###-####-##
DEFAULTSINI="C:\<full_path>\nsdefaults.ini"
INSTALLDIR="C:\<full_path>\Dragon13"
ROAMINGUSERINI="C:\<full_path>\roamingdef.ini"
/L*v C:\Logs\logfile.log /qn"
```

The example above assumes that the full path has spaces in it, so it has escaped out quotation marks around the option value. After you have completed the installation, verify that all options are correctly set on the client computer.

### Revising Day/Time of Scheduled Tasks (Optional)

This section describes how to modify the schedule for Dragon tasks to later take place on each dictation client computer by passing particular options in a command line installation. This section is a continuation of Installation using the Dragon command line. When you finish this section, you might want to proceed to Configuring Local or On-Demand Install of Vocabularies/Text-to-Speech (Optional).

Note: You take the following actions on the client computer to install Dragon on client PCs, not on the computer where you installed the initial installation and configured default option settings for end-users.

You can include an additional option on the command line to run one or more of the following tasks on a particular schedule:

- **Acoustic model optimization (ACO)** — This task optimizes the acoustic files used to recognize words that the end-user trains and speaks. You can set a particular date and time for this optimization to occur. When a speaker is new to Dragon, you might want to run the optimization more often, after the speaker has worked with Dragon for a while.
Chapter 5: Installing Dragon using the Windows installer (MSI)

- Language model optimization (LMO) — This task optimizes the language model (vocabulary files) used to help recognize words that the end-user speaks. The model incorporates data from the end-user’s speech into the language model he or she is using, ultimately customizing the model for that User Profile.
- Data Collection (DC) — This task automatically collects data that helps improve Dragon’s ability to recognize speech. You can choose to allow this data to be sent back to Nuance over the Internet on a particular schedule or choose not to send the data. This process does not collect your personal information. Data collection is available in non-US English versions of Dragon NaturallySpeaking.

You turn on/off the above tasks and set the schedule for those you turn on by passing an option called PERIODIC_TASK to the MSI installer. You set PERIODIC_TASK to a string containing short acronyms for the types of tasks, aco | lmo | dc, separated by vertical bars. If you do not pass the acronym for the feature, that feature is set to its default.

After the acronyms for the tasks to schedule, the string for PERIODIC_TASK should include the administrator login and password, then the schedules that correspond to the acronyms, in the order that they occur in the string. The schedules use three-letter weekday abbreviations and 24-hour time with two digits for the hour and two for the minute, separated by a colon. The two schedules are separated by vertical bars and presented in the same order as their corresponding acronyms. While the acronyms for the tasks are separated from each other by vertical bars, semicolons separate the group of tasks from the admin user name, password, and group of schedules.

For instance, to retain the default schedule for data collection and modify schedules for acoustic model optimization to Mondays at 1 AM and language model optimization to Mondays at 6 AM, you would set PERIODIC_TASK as follows:

```
PERIODIC_TASK="aco|lmo;admin;pswd;Mon, 01:00|Mon, 06:00"
```

An installation command line including this task setting option might look like the following:

```
setup.exe /s /v"SERIALNUMBER=####-####-####-####-
DEFAULTSINI="C:\<full_path><nsdefaults.ini"
INSTALLDIR="C:\<full_path><Dragon13"
ROAMINGUSERINI="C:\<full_path><roamingdef.ini"
PERIODIC_TASK="aco|lmo;admin;pswd;Mon, 01:00|Mon, 06:00"
/L*V C:\Logs\logfile.log /qn"
```

For more information on the PERIODIC_TASK option, refer to MSI Options for Roaming User Profile, Tuning, and Data Collection Setup.

Configuring Local or On-Demand Install of Vocabularies/Text-to-Speech (Optional)

This section describes how to enable Roaming User Profiles in a command line installation and is a continuation of Installation using the Dragon command line.

**Note:** You take the following actions on the client computer where you want to install Dragon, not on the computer where you carry out the initial installation.
Installing only particular vocabularies locally, others on-demand

When you install Dragon on a client computer as outlined in Installation using the Dragon command line, by default you install all the available vocabularies locally.

If you do not want all of those vocabularies to be installed locally, but to instead have them installed only if/when an end-user attempts to deploy a particular vocabulary, you can indicate that fact on the installation command line by adding the ADDLOCAL option and setting it to the names of the vocabularies to install locally.

For example, say you want to do a partial installation of Dragon and you only want to install the General vocabulary. You set ADDLOCAL to NatSpeak, ENUGeneral, and the command line would appear as follows (NatSpeak must be in the setting of ADDLOCAL, unless you set ADDLOCAL to ALL; otherwise, the installation fails):

```
setup.exe /s /v"SERIALNUMBER=#####-####-####-####-
DEFAULTSINI="C:\<full_path>\nsdefaults.ini"
INSTALLDIR="C:\<full_path>\Dragon13"
PRODUCTUPDATEFLAG=-1
REBOOT=ReallySuppress
ADDLOCAL=NatSpeak,ENUGeneral
/L*v C:\Logs\logfile.log /qn"
```

**Note:** There must not be any spaces between the arguments specified for ADDLOCAL.

If you want other vocabularies to be available, you set ADDLOCAL to ALL and set the ADVERTISE property to a list of additional vocabularies. The command line might look like the following:

```
setup.exe /s /v"SERIALNUMBER=#####-####-####-####-
DEFAULTSINI="C:\<full_path>\nsdefaults.ini"
INSTALLDIR="C:\<full_path>\Dragon13"
PRODUCTUPDATEFLAG=-1
REBOOT=ReallySuppress
ADDLOCAL=ALL
ADVERTISE=<Additional vocabularies separated by commas>
/L*v C:\Logs\logfile.log /qn"
```

Separate the features/vocabularies for ADDLOCAL with commas, but do not put spaces in the list. The names you must use for the vocabularies consist of a prefix for the language, then the name of the vocabulary, such as ENU for English and General to form ENUGeneral. For a list of the exact names for features/vocabularies you can assign to ADDLOCAL or ADVERTISE on the command line, refer to MSI Options for Installing Dragon Features/Advanced Options.

Installing Text-to-Speech feature

To install Text-to-Speech locally, you would include the feature in the list of features for ADDLOCAL; for instance, you would add TTSENX for Text-to-Speech in English:

```
setup.exe /s /v"SERIALNUMBER=#####-####-####-####-
DEFAULTSINI="C:\<full_path>\nsdefaults.ini"
INSTALLDIR="C:\<full_path>\Dragon13"
PRODUCTUPDATEFLAG=-1
REBOOT=ReallySuppress
ADDLOCAL=TTSENX,NatSpeak,ENUGeneral
/L*v C:\Logs\logfile.log /qn"
```
Chapter 5: Installing Dragon using the Windows installer (MSI)

For more information, see these summary topics:

- MSI Options Specific to Dragon.
- Feature Variables to Set Through the ADDLOCAL or ADVERTISE Properties
- MSI Options for Roaming User Profile, Tuning, and Data Collection Setup

Upgrading Your Dragon Installation from the Command Line

There are two command line upgrade scenarios:

- Major Upgrade—Upgrading from Version 11.x or 12.x to Dragon NaturallySpeaking13.
- Minor Upgrade—Upgrading to a higher point release within the same edition and version of Dragon. For example, upgrading from Dragon 13.0 to Dragon 13.x.

All of these types of upgrades can either display the GUI or be silent (not display the GUI), except the minor upgrade, which does not support the silent option. Upgrades to Dragon NaturallySpeaking13 are only supported from Dragon 11.x or 12.x.

When you perform a silent installation of Dragon, the installation process does not display any messages. To view installation messages, administrators should view the log files. See Troubleshooting silent install errors for details.

An administrator cannot upgrade User Profiles with the command line installation. For more information on upgrading Roaming User Profiles, see the section below. If User Profiles are not Roaming User Profiles, administrators run the User Profile Upgrade Wizard after installation completes.

Upgrading Roaming User Profiles

Before upgrade User Profiles, administrators must upgrade Roaming User Profiles in the Roaming User Profile directory. Afterwards, administrators can upgrade Dragon on the client computers and the Roaming User Profiles become available as soon as the upgrade is complete.

See "Upgrading User Profiles to Dragon NaturallySpeaking13" in Dragon - What's New for administrators for more information.

Background on Roaming User Profiles

Before administrators upgrade Roaming User Profiles to Dragon NaturallySpeaking13, they need to recall some basics about how the Roaming feature works: Each Dragon end-user has a master Roaming User Profile that can be opened from any networked computer where Dragon is installed. The master Roaming User Profiles are stored on a network location. When a master Roaming User Profile is opened from that central network location, Dragon transfers a copy of that User Profile to the Local Roaming User Profile on the computer where the end-user is dictating.

Recommended Approach

Since the Local Roaming User Profile is a copy of the end-user data taken from the master Roaming User Profile, it does not make any sense to directly upgrade the Local Roaming User Profile when upgrading the local Dragon installation.
Instead, administrators should install Dragon NaturallySpeaking 13 directly on the network computer where the current Master Roaming User Profiles are located and upgrade those Master Roaming User Profiles directly. After upgrading the master Roaming User Profiles, administrators can then proceed to upgrade end-user systems that deploy the Roaming feature.

Notes:

- Even though the **User Profile Upgrade Wizard** supports both mapped drives and UNC paths, Nuance strongly recommends upgrading the Master Roaming User Profiles on a drive on a computer where Dragon NaturallySpeaking 13 is locally installed. Nuance does not recommend upgrading the Master Roaming User Profiles across a network to either a mapped drive or UNC path; upgrading over a network will take an undetermined length of time. In addition, the **User Profile Upgrade Wizard** does not support upgrading User Profiles over an HTTP connection.

- Upgrading the master Roaming User Profiles to Dragon NaturallySpeaking 13 leaves the current master Roaming User Profiles unchanged, so that the end-users in the network can run the current version of Dragon while the administrator plans the upgrade.

- If upgrading from Dragon version 10.x or earlier to Dragon NaturallySpeaking 13, version 10.x or earlier custom words and commands can be re-used in Dragon NaturallySpeaking 13:
  1. In Dragon 10.x or earlier, export the custom words and commands
  2. In Dragon NaturallySpeaking 13, create a new User Profile
  3. In Dragon NaturallySpeaking 13, import the custom words and commands

See the Dragon Help for information on exporting and importing custom words and commands.

**Step-by-Step Process for Upgrading Roaming User Profiles**

1. Plan to upgrade the master Roaming User Profiles at a time when they are not being opened by end-users, for example during the night or on a weekend. Nuance recommends backing-up User Profiles before upgrading them.

2. Install Dragon NaturallySpeaking 13 on the computer where the current Master Roaming User Profiles are located. If that is not possible, Nuance recommends that you install Dragon NaturallySpeaking 13 on a separate computer where you will perform the upgrades.

   OR

   If unable to install Dragon where the current Master Roaming User Profiles are located, Nuance recommends administrators:

   - Install Dragon NaturallySpeaking 13 on a separate computer where they will perform the upgrades.
   - Copy the current Master Roaming User Profiles from the network location to the computer where Dragon NaturallySpeaking 13 is installed.
- Upgrade the current Master Roaming User Profiles on the computer where Dragon NaturallySpeaking 13 is installed.
- Copy the upgraded Dragon NaturallySpeaking 13 Master Roaming User Profiles to a network accessible directory on the original network location.

In Dragon NaturallySpeaking 13 or earlier, if the upgrade installation displays an option to upgrade existing User Profiles to work with this installation, ignore the option, as it does not affect Roaming User Profiles. Administrators manually run the User Profile Upgrade Wizard later.

3. On the end-user systems where the end-users dictate, save and close any open User Profiles on each current Dragon system that uses the Roaming feature. If there is no time when all of the Roaming User Profiles are not in use (for example, in a hospital where physicians use Dragon during a night shift), administrators can upgrade different groups of Roaming User Profiles at different times.

4. On the central network location that stores the current master Roaming User Profiles, back up the master Roaming User Profiles to a separate location by using any system backup utility that is implemented at your facility. On the central network location that stores the current master Roaming User Profiles, create a new directory to store the upgraded Dragon NaturallySpeaking 13 Master Roaming User Profiles. Always be sure the upgraded User Profiles are in a different location from the current User Profiles. If end-users see two versions of each User Profile, they may become confused when they try to open a User Profile. Nuance recommends storing User Profiles, from different versions of Dragon, in different locations.

5. If Dragon NaturallySpeaking 13 is not installed on the computer where the current Master Roaming User Profiles are located, create a directory on the local computer where Dragon NaturallySpeaking 13 is installed. The directory stores all the Master Roaming User Profiles you plan to upgrade. Copy the current Master Roaming User Profiles from the network location to this directory.

6. On the administrator system where you upgrade the Master Roaming profiles to Dragon NaturallySpeaking 13, start Dragon and make sure the Roaming feature is turned off. **To turn off the Roaming feature:**
   - Close any open User Profiles.
   - Click **Tools > Administrative Settings** on the menu to display the Administrative Settings dialog box.
   - On the **Roaming** tab, make sure **Enable** is not selected.

7. Close Dragon.

8. On the computer where both the current Master Roaming profiles and Dragon NaturallySpeaking 13 are installed, select **Start > Programs > Dragon NaturallySpeaking > Dragon NaturallySpeaking Tools > Upgrade User Profiles**. The User Profile Upgrade Wizard opens.

If you do not turn off the Roaming feature in the Administrative Settings dialog box before attempting to start the User Upgrade Wizard, you see an error message stating that you cannot upgrade a Roaming User Profile. If you see the message, go back to the Administrative Settings dialog and make sure the **Enabled** check box is not checked.
9. On the **Select the profile(s) to upgrade** page, click **Browse to add a profile** to select the location of the current Master Roaming User Profiles. The **Select the profile(s) to upgrade** page now displays a list of User Profiles in the selected directory:

![Select the profile(s) to upgrade](image)

Continue to add User Profiles from other local locations or use the **Remove from list** button to remove specific User Profiles. Click **Next** to continue.
10. If you choose to upgrade only one User Profile, the wizard displays the number of minutes the upgrade requires to complete the upgrade.

11. On the Choose where to store the upgraded profile(s) page, in the Location for upgraded profile(s) text box, choose the local location you previously created to contain the upgraded Dragon NaturallySpeaking13 master Roaming User Profiles. If a location is
12. The Begin profile upgrading page displays the number of User Profiles that the wizard is prepared to upgrade. Click Begin upgrading to start the upgrade process. The upgrade process can take 12-24 minutes or more per User Profile, depending on the speed of the computer system and the speed of the network. Click Stop at any time to interrupt this process. The upgrade process creates new master Roaming User Profiles in the destination you selected.

13. Click Finish to complete the upgrading process and exit the User Profile Upgrade Wizard.

The User Profile Upgrade Wizard renames Dragon NaturallySpeaking13 master Roaming User Profile as follows: `<name> (v13)`. For example, Dragon copies and renames a Dragon 11.x Master Roaming User Profile named `roaminguser1` to `roaminguser1 (v13.x)` when the profile upgrades to Dragon NaturallySpeaking13. Dragon does not change the Dragon 11.x Master Roaming User Profile named `roaminguser1`.

14. (Optional) If you cannot install Dragon where the original Master Roaming User Profiles are located and those User Profiles were copied to another computer where Dragon NaturallySpeaking13 was installed, copy the upgraded Master Roaming User Profiles back to the new network-accessible directory that you created to store them.

15. Since the User Profile Upgrade Wizard leaves the Dragon 11.x or 12.x master Roaming User Profiles unchanged and in their original network location, the Dragon 11.x or 12.x systems can continue to use the Roaming feature until you upgrade the systems to Dragon NaturallySpeaking13. Follow the steps in "Major and Minor Upgrades: Silent Upgrade" and be sure to enable the Roaming feature. In the Network Directories settings, set the correct path to the upgraded Roaming User Profiles.

16. Run Dragon on the end-user system and open a User Profile.
Chapter 5: Installing Dragon using the Windows installer (MSI)

Dragon 10.x or earlier custom words and commands can be re-used in Dragon NaturallySpeaking 13:

1. In Dragon 10.x or earlier, export the custom words and commands
2. In Dragon NaturallySpeaking 13, create a new User Profile
3. In Dragon NaturallySpeaking 13, import the custom words and commands

See the Dragon Help for information on exporting and importing custom words and commands.

**Major and Minor Upgrades: Silent Upgrade**

To upgrade to Dragon NaturallySpeaking 13 (major upgrade), you can use either msiexec.exe or setup.exe. You can carry out this installation with a GUI or silently. The procedure presented here shows how to upgrade silently using msiexec.exe.

**Note:** A Minor upgrade involves upgrading to a higher point release within the same edition and version of Dragon. For example, upgrading from Dragon 13.0 to Dragon 13.x.

**Overview of Silent Upgrade**

Before you use a script to push install/upgrade to Dragon NaturallySpeaking 13, you must remove/uninstall the previous version of Dragon. The upgrade fails if it detects a previous version of Dragon is installed on the computer.

When you use the msiexec.exe installer to uninstall Dragon from a command prompt, the msiexec.exe installer automatically retains User Profiles from the previous version of Dragon. Afterwards, an end-user can upgrade their local (but not Roaming) User Profiles when they start Dragon.

If your environment requires that you perform a silent installation and use msiexec.exe, rather than setup.exe, take these high-level actions in this order:

- Uninstall the older version of Dragon.
- For major upgrades only: Perform an initial installation of the new version of Dragon on a single computer and establish the configuration you want to use by calling natspeak.exe on the command line and passing it these options:
  - /setdefaultoptions
  - /setdefaultformattingoptions (to set only the general Auto-Formatting options)
  - /setdefaultadministrativeoptions

When you run the Dragon command line installation silently, the msiexec.exe installer automatically retains User Profiles from the previous version. Afterwards, individual end-users can upgrade their local (but not Roaming) User Profiles when they start Dragon. (For updating Roaming User Profiles, see Before You Upgrade.)

When you perform a silent installation or upgrade of Dragon, the installation process does not display any messages. To view installation messages, administrators should view the log files. See Troubleshooting silent install errors for details.

The table below lists GUIDs that you pass to the /x option of msiexec for each version of Dragon and Visual C++ Runtime for Dragon. Make sure to use the /x option with the GUID.
### Products and versions

<table>
<thead>
<tr>
<th>Products and versions</th>
<th>GUID</th>
</tr>
</thead>
<tbody>
<tr>
<td>DNS V13</td>
<td>{33EA20FB-5389-4938-BA59-2BCD9BB68F41}</td>
</tr>
<tr>
<td>DNS V12</td>
<td>{D5D422B9-6976-4E98-8DDF-9632CB515D7E}</td>
</tr>
<tr>
<td>DNS V11</td>
<td>{EFFA53BC-8C04-2E21-3D90-A13B1697B0CA}</td>
</tr>
</tbody>
</table>

### Step-by-Step Upgrade Process

You must follow these steps to set options for your end-users:

1. If you are upgrading from a previous version of Dragon, copy the nsdefaults.ini and roamingdef.ini files to a central location so they can accessed later.
2. Open a command line window as an administrator.
3. Uninstall the current version of Dragon with msiexec.exe by passing the installer the /x option followed by the old version’s GUID and the /qn option to turn off any GUI.

   The correct GUID for each Version you can upgrade to Dragon NaturallySpeaking 13 on the command line is shown in the adjacent table and the example below uses the Dragon 9.x GUID:

   ```
   msiexec /x {33EA20FB-5389-4938-BA59-2BCD9BB68F41} /L*v "C:\updatelog.log" /qn
   ```

   msiexec automatically retains User Profiles when you use the silent option.

   **Caution:** The first time you try any upgrade, you should not run it in Silent mode, because if you have neglected to provide required information, you then receive a GUI prompt for that information.

   C:\updatelog.log is only needed if you are trying to create a log of the uninstall process and/or update process. You can change C:\updatelog.log to a different location or login name.

4. Be sure you have the Dragon serial number (or the group serial number, if you are upgrading Dragon on multiple networked computers).
5. Be sure all mapped drives you plan to use are mapped on individual client computers where you are upgrading the upgrade.
6. Install any pending Windows updates on clients and reboot as needed before continuing.
7. If you are performing a minor upgrade, skip this step. If you are performing a major upgrade, perform an initial installation on a single computer where you configure the settings of User Profile options, Auto-Formatting options, and administrative settings. You can follow the instructions in *Install the Same Configuration on Additional computers* under **Installation using the Dragon command line**.
8. Be sure you can access the .ini files from the old installation (minor upgrades) or the .ini files you just created in the initial installation (major upgrades) from all computers you will be upgrading. (Or copy the files to a local path on the client computer where you are about to upgrade.)
9. For a major upgrade, install the new version of Dragon with msiexec.exe by passing the installer the /i option followed by the name of the Dragon .msi file and options like those
Chapter 5: Installing Dragon using the Windows installer (MSI)

shown in the sample below:

```
msiexec /i "Dragon NaturallySpeaking 13.msi"
SERIALNUMBER=#####-###-####-####-##
REBOOT=ReallySuppress
INSTALLDIR="C:\<full_path>\Dragon13"
DEFAULTSINI="C:\<full_path>\nsdefaults.ini"
ROAMINGUSERINI="C:\<full_path>\roamingdef.ini"
REMOVEOLDPROD=1 /L*v "C:\logfile.log" /qn
```

To ensure that the entire old version of the product is removed, you pass REMOVEOLDPROD=1 (major upgrades only, not minor upgrades) so that the process removes the old version of Dragon before installing the new. In addition, you should be sure to provide the full path to each .ini file you are using.

REMOVEOLDPROD=1 will not cause your installation to fail if you don’t have a previous version of Dragon that resides on the machine. This property tells the installer to look for previous versions of Dragon and uninstall if found, otherwise, it will just continue with the installation of Dragon.

DEFAULTSINI= This is the flag that points to the nsdefaults.ini file that you copied.

If you are using the setup.exe method, you must ensure that all flags/properties (SERIALNUMBER, DEFAULTSINI, /qn, etc.) are all within the same quotes directly after /v without a space.

10. For a minor upgrade, install the new version of Dragon with msiexec.exe the same way as you would the major upgrade, only passing both REINSTALL or REINSTALLMODE options, as shown in the sample below. Here REINSTALL is set to ALL and REINSTALLMODE is set to vemus, where /v indicates to reinstall from the source (reup-dating cache), e indicates to install the newer file if one is available, mu means to rewrite the registry settings, and s means to reinstall all shortcuts and recache all icons. For more information on the REINSTALL and REINSTALLMODE settings, refer to MSI Options for Installing Dragon Features/Advanced Options.

Here is a typical minor upgrade installation line:

```
msiexec /i "Dragon NaturallySpeaking 13.msi"
SERIALNUMBER=#####-###-####-####-##
REBOOT=ReallySuppress
INSTALLDIR="C:\<full_path>\Dragon13"
DEFAULTSINI="C:\<full_path>\nsdefaults.ini"
ROAMINGUSERINI="C:\<full_path>\roamingdef.ini"
REINSTALL=ALL REINSTALLMODE=vamus
/L*v "C:\logfile.log" /qn
```

Caution: If you do not pass the REINSTALL and REINSTALLMODE options, the minor upgrade will fail.

11. After the installation of Dragon is complete, perform the steps in Edit the NSSYSTEM.INI file.
Edit the NSSYSTEM.INI file

After you install Dragon using a script, to let Dragon know where the previous version profiles are located, and, to launch the User Profile Upgrade wizard when the user opens Dragon after the upgrade, you must edit the nssystem.ini file.

For the following steps, you must edit the nssystem.ini file from the same machine where you just installed Dragon. Do not use an nssystem.ini file from a different computer where Dragon is installed.

1. Navigate to C:\ProgramData\Nuance\NaturallySpeaking13.
2. Use a text editor like Notepad to open the nssystem.ini file.
3. In the nssystem.ini file, in the [Settings] section, add the following line:
   Old Users Directory=<path to previous Dragon version profile>.
4. Save the nssystem.ini file.

Note:

“Old Users Directory” is the path to the previous version of Dragon’s profiles. For example, on Windows 7 and Windows 8.x, the path to the user profiles is:
C:\ProgramData\Nuance\NaturallySpeaking13\Users

Using setup.exe for Upgrades

Note: A Minor upgrade involves upgrading to a higher point release within the same edition and version of Dragon. For example, upgrading from Dragon 13.0 to Dragon 13.x.

Although the upgrade does not migrate forward the configuration and Roaming User Profile settings from the earlier version, you can reuse the nsdefaults.ini and roamingdef.ini files you used to install Dragon NaturallySpeaking13. You can also create new .ini files or update existing ones.

When you run setup.exe with a GUI to install a minor upgrade, setup.exe can detect when a previous version of Dragon exists on a target computer. Once it detects a previous version, setup.exe runs the rest of your installation in minor upgrade mode, automatically overwriting older files with newer files and adding any missing files.

Using setup.exe for Silent Upgrades

If you are using the setup.exe method, you must ensure that all flags/properties (SERIALNUMBER, DEFAULTS.INI,/qn, etc.) are all with in the same quotes directly after /v without a space.

If you are upgrading a previous version of Dragon, you must use the REINSTALL=ALL option and REINSTALLMODE set to the sub-options that indicate which files to reinstall, usually REINSTALLMODE=vamus. If you did not originally install in the default location, the INSTALLDIR option is also required. Here is the command line using setup.exe:

To upgrade silently with setup.exe, you pass the /s option, then pass REINSTALL or REINSTALLMODE options. When you perform a silent installation of Dragon, the installation process does not display any messages. To view installation messages, administrators should view the setup log.

```
setup.exe /s /v"/i "Dragon NaturallySpeaking 13.msi"
SERIALNUMBER=#####-#####-#####-#####-####
```
When you perform a silent installation or upgrade of Dragon, the installation process does not display any messages. To view installation messages, administrators should view the log files. See Troubleshooting silent install errors for details.

**Step-by-Step Command Line Installation with msiexec.exe**

Another way to install Dragon from the command line on several dictation client computers is to use the msiexec.exe program from Microsoft. You are required to use msiexec.exe instead of setup.exe if you are installing Dragon from a server across a network to a single or multiple computers.

In the sections that follow, you carry out these two tasks:

- Install Dragon on Initial computer and Establish Configuration
- Install Same Configuration on Additional computer(s)

**Finding the MSI Installer on the Dragon DVD**

The compiled *MSI* file is located on your installation DVD. The files for each edition are named after the product name. For example:

- **Dragon NaturallySpeaking 13.msi**

You can double click on one of these `.msi` files to start the InstallShield Wizard; however, to instead take advantage of available command line options, you can pass the file name as the application to install to the `msiexec.exe` command using the `/i` option:

```
msiexec.exe /i "Dragon NaturallySpeaking13.msi"
```

**Install Dragon on Initial computer and Establish Configuration**

Follow the steps outlined under Installation using the Dragon command line.

Then return here and continue with the next section to install the same configuration on individual client computers using msiexec.exe instead of setup.exe.

**Install Same Configuration on Additional computer(s)**

If you chose Enable Desktop Search Commands on the Commands tab during the initial installation, you must install Google Desktop or Microsoft Search before you install Dragon; otherwise, that option does not take effect.

1. Be sure you can access the `.ini` files you created in the previous procedure from the computer you will be installing on or copy the files to a local path on the client computer where you are about to install Dragon.

2. Be sure you have the Dragon serial number (or the group serial number, if you are installing Dragon to multiple computers on a network).
3. Be sure all mapped drives you plan to use are mapped on individual client computers where you are distributing the installation.
4. Install any pending Windows updates/reboot the computer.
5. Open a command line window by selecting Start > Run and entering cmd.
6. On your product DVD, locate the compiled .msi file for the edition of Dragon you want to install and switch to that directory.
7. Retrieve the customized nsdefaults.ini and roamingdef.ini files from the computer where carried out the initial installation.
8. To install Dragon, enter the following command line, using the /i option also using the /qn option to install the product in Quiet mode, where no GUI appears. You also pass the Dragon serial number for the SERIALNUMBER option, the full path to the nsdefaults.ini file for the DEFAULTSINI option, and the full path to the roamingdef.ini file for the ROAMINGUSERINI option:

```bash
msiexec /i "Dragon NaturallySpeaking 13.msi"
SERIALNUMBER=#####-#####-#####-#####
DEFAULTSINI="C:\<full_path>\nsdefaults.ini"
ROAMINGUSERINI="C:\<full_path>\roamingdef.ini"
/L*v "C:\Logs\logfile.log" /qn
```

**Notes:**

- For an administrative installation, you pass the /a option to msiexec rather than the /i option. You also need to pass the TARGETDIR option instead of the INSTALLDIR option.
- The first time you test this installation, you should pass /q rather than /qn so that if you have neglected to provide information about a setting that does not have a default, you receive a prompt asking for that information.

The bolded portion of the preceding command line is included so that if something goes wrong during the installation, you receive messages about it. You pass /L and a series of sub-options to have the installation process log errors and other types of messages related to the process. (You can then send the log file to Nuance Technical Support should any issues arise.)

### Additional Options for Installations with msiexec.exe

**Note:** In Dragon NaturallySpeaking 13, the installation process does not present the QuickStart option. If you wish to enable this option, you can do so after Dragon is installed.

When you perform a silent installation of Dragon, the installation process does not display any messages. To view installation messages, administrators should view the log files. See **Troubleshooting silent install errors** for details.

**Additional Options for Silent Installations**

- Modifying the Default Installation Directory
- Configuring Installation of Product Updates
- Suppressing Reboot of computer After Installation
- Installing Same Roaming User Profile Configuration on Additional computer(s)

**Additional Options with Extensive Settings for Silent Installations**
Chapter 5: Installing Dragon using the Windows installer (MSI)

- Installing Some Vocabularies Locally/Others Only On Demand
- Installing Text-to-Speech Feature
- Reinstalling Dragon with Particular Set of Features
- Setting Day/Time of Scheduled Tasks

Additionally, you can launch the Online Registration Form After Installation

**Additional Options for Silent Installations**

**Note:** In Dragon NaturallySpeaking13, the installation process does not present the QuickStart option. If you wish to enable this option, you can do so after Dragon is installed.

When you perform a silent installation of Dragon, the installation process does not display any messages. To view installation messages, administrators should view the log files. See Troubleshooting silent install errors for details.

**Additional Options for Silent Installations**

- Modifying the Default Installation Directory
- Configuring Installation of Product Updates
- Suppressing Reboot of computer After Installation
- Installing Same Roaming User Profile Configuration on Additional computer(s)

**Additional Options with Extensive Settings for Silent Installations**

- Installing Some Vocabularies Locally/Others Only On Demand
- Installing Text-to-Speech Feature
- Reinstalling Dragon with Particular Set of Features
- Setting Day/Time of Scheduled Tasks

Additionally, you can launch the Online Registration Form After Installation

**Modifying Default Installation Directory**

If you want to set an installation directory other than the default, pass INSTALLDIR="<path to install>" to msiexec on the command line:

```plaintext
msiexec /i "Dragon NaturallySpeaking 13.msi"
SERIALNUMBER=###-###-###-###-###
DEFAULTSINI="C:\<full_path>\nsdefaults.ini"
INSTALLDIR="C:\<full_path>\Dragon13"
/L*v "C:\Logs\logfile.log" /qn
```

**Note:** For an administrative installation, you should pass the TARGETDIR option instead of the INSTALLDIR option.

**Configuring Installation of Product Updates**

If you want the individual client computer to download product updates to Dragon over the web, you would set the PRODUCTUPDATEFLAG option to 1 (option checks the check box). If you prefer to let the server download the updates and later distribute them to client computer, set this option to 0 (unchecks the check box). To not even display the check box,
set the option to -1. For enterprise sites, choose -1 to prevent product updates from being downloaded.

```bash
msiexec /i "Dragon NaturallySpeaking 13.msi"
SERIALNUMBER=#####-#####-#####-#####
DEFAULTSINI="C:\<full_path>\nsdefaults.ini"
INSTALLDIR="C:\<full_path>\Dragon13"
PRODUCTUPDATEFLAG=-1 /i "C:\Logs\logfile.log" /qn
```

**Suppressing Reboot of computer After Installation**

To suppress rebooting of the computer after installation of Dragon completes, you can pass Microsoft’s REBOOT option set to ReallySuppress. Using this option also suppresses the reboot sometimes required by the installation of Visual C++ Runtime for Dragon, which setup.exe installs in the background. Using this option is highly recommended if you are executing a silent installation (But if system updates are pending, rebooting is required for DNS to work normally).

```bash
REBOOT=ReallySuppress
```

The altered command line would look like this:

```bash
setup.exe /s /v"SERIALNUMBER=#####-#####-#####-#####
DEFAULTSINI="C:\<full_path>\nsdefaults.ini"
INSTALLDIR="C:\<full_path>\Dragon13" /qn
PRODUCTUPDATEFLAG=-1 REBOOT=ReallySuppress
/L*v C:\Logs\logfile.log /qn"
```

**Suppressing Reboot of computer After Installation**

To prevent the computer where you are installing Dragon from rebooting automatically after the installation ends, you can pass Microsoft’s REBOOT option set to ReallySuppress:

```bash
REBOOT=ReallySuppress
```

The altered command line would look like this:

```bash
msiexec /i "Dragon NaturallySpeaking 13.msi"
SERIALNUMBER=#####-#####-#####-#####
DEFAULTSINI="C:\<full_path>\nsdefaults.ini"
INSTALLDIR="C:\<full_path>\Dragon13"
PRODUCTUPDATEFLAG=-1
REBOOT=ReallySuppress
/L*v "C:\Logs\logfile.log" /qn
```

**Installing the Same Roaming User Profile Configuration on Additional computer(s)**

Use the roamingdef.ini file you created during the initial installation as the input for the ROAMINGUSERINI option in this format (be sure to use the full path to the file when you pass the option):
Chapter 5: Installing Dragon using the Windows installer (MSI)

ROAMINGUSERINI="Y:\<full_path>\roamingdef.ini"

In the above example, Y: is mapped network drive, accessible from client computers.

Optionally include the ROAMINGUSERINI option in the installation command line. If you do not use this property, default settings are assumed.

```
msiexec /i "Dragon NaturallySpeaking 13.msi"
SERIALNUMBER=#####-###-####-####-##
DEFAULTSINI="C:\<full_path>\nsdefaults.ini"
INSTALLDIR="C:\<full_path>\Dragon13"
ROAMINGUSERINI="C:\<full_path>\roamingdef.ini"
/L*v "C:\nuanceLogs\logfile.log" /qn
```

After you have completed the installation, verify that all options are correctly set on the client computer.

**Launching Online Registration Form After Installation**

To have the online registration form for Dragon pop up on the workstation in its browser immediately after the installation completes, you can pass a option to the WEBREGISTRATION option and set it to 1 (applies only if you do not use the /qn option). The default is 0 which means registration will not be launched.

```
WEBREGISTRATION=1
```

The revised command line would look like this:

```
msiexec /i "Dragon NaturallySpeaking 13.msi"
SERIALNUMBER=#####-###-####-####-##
DEFAULTSINI="C:\<full_path>\nsdefaults.ini"
INSTALLDIR="C:\<full_path>\Dragon13"  PRODUCTUPDATEFLAG=-1
REBOOT=ReallySuppress
WEBREGISTRATION=1 /L*v "C:\Logs\logfile.log"
```

**Installing Some Vocabularies Locally and Others On Demand**

When you install Dragon on a client computer, by default you install all the available vocabularies locally.

If you do not want all of those vocabularies to be installed locally, but to instead have them installed only if/when an end-user attempts to create a particular vocabulary, you can indicate that fact on the installation command line by adding the ADDLOCAL option and setting it to the names of the vocabularies to install locally.

For instance, to install only an English Legal vocabulary, you would set ADDLOCAL to NatSpeak, ENUGeneral and the command line would appear as follows (NatSpeak must be in the setting of ADDLOCAL, unless you set ADDLOCAL to ALL, or the installation will fail):

```
msiexec /i "Dragon NaturallySpeaking 13.msi"
SERIALNUMBER=#####-###-####-####-##
DEFAULTSINI="C:\<full_path>\nsdefaults.ini"
```
Separate the features/vocabularies for ADDLOCAL with commas, but do not put spaces in the list. The names you must use for the vocabularies consist of a prefix for the language, then the name of the vocabularies such as ENU for English and General to form ENUGeneral. For a list of the exact names for features/vocabularies you can assign to ADDLOCAL or ADVERTISE on the command line, refer to Summary: MSI Options for Installing Dragon Features/Advanced Options.

Installing Text-to-Speech Feature

To install Text-to-Speech locally, you would include the feature in the list of features for ADDLOCAL; for instance, you would add TTSENX for Text-to-Speech in English:

```cmd
msiexec /i "Dragon NaturallySpeaking 13.msi" REINSTALL=ALL REINSTALLMODE=vamus /qn
```

Reinstalling Dragon with Particular Set of Features

Sometimes you want to reinstall Dragon and add or remove particular features of the product. You can also take this action on the command line using the REINSTALL and REINSTALLMODE options of the MSI installer. You set REINSTALL to those features you want to install or to ALL.

For example, to install a minor upgrade to Dragon, you might use this command line:

```cmd
msiexec /i "Dragon NaturallySpeaking 13.msi" REINSTALL=ALL REINSTALLMODE=vamus /qn
```

The vemus options: v indicates to reinstall from the source (reupdating cache), e indicates to install the newer file if one is available, mu means to rewrite the registry settings, and s means to reinstall all shortcuts and re-cache all icons. For more information on the REINSTALL and REINSTALLMODE settings, refer to Summary: MSI Options for Installing Dragon Features/Advanced Options.

**Note:** A Minor upgrade involves upgrading to a higher point release within the same edition and version of Dragon. For example, upgrading from Dragon 13.0 to Dragon 13.x.

Setting Day/Time for Scheduled Tasks

To retain the default schedule for data collection and modify schedules for acoustic model optimization to Mondays at 1 AM and language model optimization to Mondays at 6 AM, you would set the PERIODIC_TASK string as follows:

```cmd
PERIODIC_TASK="aco|lmo;admin;pswd;Mon, 01:00|Mon, 06:00"
```
Chapter 5: Installing Dragon using the Windows installer (MSI)

An MSI installation command line including the option setting this schedule would look like this:

```
msiexec /i "Dragon NaturallySpeaking 13.msi"
SERIALNUMBER=#####-####-####-####-####
INSTALLDIR="C:\<full_path>\Dragon13"
DEFAULTSINI="C:\<full_path>\nsdefaults.ini"
ROAMINGUSERINI="C:\<full_path>\roamingdef.ini"
PERIODIC_TASK="aco|lmo;admin;pswd;Mon, 01:00|Mon, 06:00"
/L*v "C:\Logs\logfile.log" /qn
```

For more information on the PERIODIC_TASK option, refer to MSI Options for Roaming User Profile, Tuning, and Data Collection Setup.

Launching Online Registration Form After Installation

To have the online registration form for Dragon pop up on the workstation in its browser immediately after the installation completes, you can pass a option to the WEBREGISTRATION option and set it to 1 (applies only if you do not use the /qn option). The default is 0 which means registration will not be launched.

```
WEBREGISTRATION=1
```

The revised command line would look like this:

```
msiexec /i "Dragon NaturallySpeaking 13.msi"
SERIALNUMBER=#####-####-####-####-####
DEFAULTSINI="C:\<full_path>\nsdefaults.ini"
INSTALLDIR="C:\<full_path>\Dragon13" PRODUCTUPDATEFLAG=-1
REBOOT=ReallySuppress
WEBREGISTRATION=1 /L*v "C:\Logs\logfile.log"
```

MSI Options Specific to Dragon

This section describes the fundamental msiexec.exe options that apply to Dragon NaturallySpeaking13. Additional options that apply only to a Dragon installation are listed in:

- MSI Windows Installer Options
- MSI Options for Installing Dragon Features/Advanced Options
- MSI Options for Roaming User Profile, Tuning, and Data Collection Setup

Dragon command line options do not need to be prefaced by hyphens or slashes.

Notes:

- In Dragon NaturallySpeaking13, the installation process does not present the QuickStart option. If you wish to enable this option, you can do so after Dragon is installed.
- Launching msiexec.exe /i "Dragon NaturallySpeaking 13.msi" XYZ=ABC automatically sets the property named XYZ to the value of ABC internally and continues the installation. However, if you use setup.exe to install, you must put all msiexec.exe options you pass it in quotation marks after the /v option.
Unless noted otherwise, all property values are in UPPERCASE.
**Chapter 5: Installing Dragon using the Windows installer (MSI)**

<table>
<thead>
<tr>
<th>Options</th>
<th>Description</th>
</tr>
</thead>
</table>
| DEFAULTSINI="c:\<path>\nsdefaults.ini" | Indicates a default settings (nsdefaults.ini) file that the installer uses to change the default behavior of the product for all end-users at installation time. This file must be in an .ini file format; any settings you want to take effect on clients must have a section name encased in square brackets as well as the value and data. If only values and data are set in this file without the section name encased in brackets, the settings are not propagated on client computers. Usually, you do not edit the nsdefaults.ini file directly; instead you set defaults in Dragon’s **Options** and **Administrative Settings** dialog boxes. Follow these steps to create a nsdefaults.ini file for an MSI installation:

Install Dragon on a computer with Windows administrator privileges.

Set options in the **Options** and **Administrative Settings** dialog boxes as required in your environment and save them by closing Dragon.

Copy the nsdefaults.ini file created by this installation of Dragon to a separate location. By default, the nsdefaults.ini is located in:

C:\ProgramData\Nuance\NaturallySpeaking13\ Use the copied nsdefaults.ini as the input for the DEFAULTSINI option. |
<p>| SERIALNUMBER=abcd e-fgh-ijkl-mnop-qr | A serial (license) number is required for all installations. You must specify a valid serial number on the command line. <strong>Note:</strong> Specifying a serial number on the command line does not bypass the serial number checking within setup. |
| PRODUCTUPDATEFLAG=0 (or 1 or –1) | Sets the default state of the product update check box at the end of installation, to indicate whether the installation should automatically check the web for product updates. Automatic product updates are not supported for enterprise installations. |</p>
<table>
<thead>
<tr>
<th>Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>A value of 0 (zero) turns the check box off by default, 1 (one) turns it on by default. To disable the option entirely (turn the option off and suppress the display of the check box altogether), set the value to –1. The default setting is 1 (enables the check box and checks for product updates by default).</td>
</tr>
<tr>
<td>SETDEFAULTS=0 (or 1)</td>
<td>If set to 1, sets the default state of <strong>Modify the application’s settings for all users</strong> check box to display the <strong>Options</strong> dialog box at the end of the installation. The <strong>Options</strong> dialog box lets you change Dragon’s standard behavior, including specifying hot keys, customizing how text is formatted, changing initial microphone settings, and setting the how often your User Profiles are backed up. Applies only if your installation displays the <strong>Installation Wizard</strong>. A value of 0/1 will turn check box off/on accordingly. With SETDEFAULTS=1, no dialogs display during installation if /qn is used for Quiet mode installation.</td>
</tr>
<tr>
<td>SETADMINS=0 (or 1)</td>
<td>If set to 1, sets the default state of <strong>Modify the administrative settings</strong> check box to display the <strong>Administrative settings</strong> dialog box at the end of the installation. The <strong>Administrative settings</strong> dialog box lets you set up the <strong>Roaming</strong> feature, set the backup location of your User Profiles, and restrict end-users from modifying commands and vocabularies. Applies only if your installation displays the <strong>Installation Wizard</strong>. A value of 0/1 will turn checkbooks off/on accordingly. With SETADMINS=1, no dialogs display during installation if /qn is used for Quiet mode installation.</td>
</tr>
<tr>
<td>SETFORMATTINGS=0 (or 1)</td>
<td>If set to 1, sets the default state of <strong>Modify the administrative settings</strong> check box to display the <strong>Auto-Formatting</strong> dialog box at the end of installation. A value of 0/1 will turn check books off/on accordingly. With SETFORMATTINGS=1, no dialogs display during installation if /qn is used for Quiet mode installation.</td>
</tr>
<tr>
<td>Options</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>the installation. The <strong>Auto-Formatting</strong> dialog box lets you set up visual formats for the output of the recognized text, including standard abbreviations and other preferences. Applies only if your installation displays the <strong>Installation Wizard</strong>. A value of 0/1 will turn check box off/on accordingly. With <strong>SETFORMATTINGS=1</strong>, no dialogs display during installation if (/qn) is used for <strong>Quiet</strong> mode installation.</td>
</tr>
<tr>
<td>WEBREGISTRATION=1 (or 0)</td>
<td>Determines whether or not to launch the online product registration form after the installation completes. 0 disables the product registration. The default of 1 enables display of the form.</td>
</tr>
</tbody>
</table>

**MSI Options for Installing Dragon Features/Advanced Options**

This section describes additional `msiexec.exe` options that apply to Dragon NaturallySpeaking13. Although these options are for `msiexec.exe`, they are also available for `setup.exe` if you use them with the `/v` option.

Other options are listed under:

- Summary: MSI Windows Installer Options
- Summary: MSI Options Specific to Dragon.
- Summary: MSI Options for Roaming User Profile, Tuning, and Data Collection Setup

**Note:** A Minor upgrade involves upgrading to a higher point release within the same edition and version of Dragon. For example, upgrading from Dragon 13.0 to Dragon 13.x.

The following table presents options that apply to a Dragon installation where you select particular features to install. Unless noted otherwise, all property values are in **UPPERCASE**.
<table>
<thead>
<tr>
<th>Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ADDLOCAL=Feature1, Feature2,... or ADDLOCAL=ALL</td>
<td>Set the ADDLOCAL property to a list of features to be installed locally, delimited by commas. To install all features locally (including User Profiles), use ADDLOCAL=ALL on the command line.</td>
</tr>
<tr>
<td>ADVERTISE=Feature1, Feature2, FEATURE3,...</td>
<td>Set the ADVERTISE property to a list of features to be available but not locally installed, delimited by commas. To install all features as advertised, use ADVERTISE=ALL on the command line. The ADVERTISE option overrides the ADDLOCAL option. The best method for installing a particular set of features is to set the ADDLOCAL property to ALL and then set the ADVERTISE property to those features you do not want installed locally. A list of the features that you can set for installation is listed in the section after this table.</td>
</tr>
<tr>
<td>REINSTALL=Feature1, Feature2,... (or ALL)</td>
<td>List of features that are to be reinstalled, delimited by commas. To reinstall all features use REINSTALL=ALL on the command line. If you set the REINSTALL property, you should also set the REINSTALLMODE property, to indicate the type of reinstall to be performed. If the REINSTALLMODE property is not set, then by default all files that are currently installed are reinstalled only if the currently installed file is an earlier version (or is not present). By default, no registry entries are rewritten. Note that even if REINSTALL is set to ALL, only those features that were already installed previously are reinstalled. Thus, if REINSTALL is set for a product that is yet to be installed, no installation action takes place at all. For more information, see: <a href="http://msdn.microsoft.com/library/default.asp?url=/library/en-us/msi/setup/reinstall.asp">http://msdn.microsoft.com/library/default.asp?url=/library/en-us/msi/setup/reinstall.asp</a></td>
</tr>
<tr>
<td>REINSTALLMODE ={type of reinstallation to perform}</td>
<td>String that contains letters indicating the type of reinstall to perform. Options are case-insensitive and order-independent. This</td>
</tr>
</tbody>
</table>
Options | Description
--- | ---
 | property should normally always be used in conjunction with the REINSTALL property. However, this property can also be used during installation, not just during a reinstall. See REINSTALLMODE for more details.

REMOVEOLDPROD=1 | Removes the old version of the product before installing the new version. Should be used in major upgrades only.

\$x<Product.msi|ProductCode> | Un-installs the currently installed version of Dragon. You are required to take this action during upgrading; however, you should be familiar with the entire upgrade procedure before proceeding with this option.

**REINSTALLMODE**

By default the REINSTALLMODE=**omus** to reinstall all files whose checksums are missing or corrupt, rewrite all registry names, reinstall all shortcuts and re-cache icons. Below is a list of the options with abbreviated definitions:

- p — Reinstall only if the file is missing.
- o — Reinstall if the file is missing or is an older version.
- e — Reinstall if the file is missing or is an equal or older version.
- d — Reinstall if the file is missing or a different version is present.
- c — Reinstall only files whose checksums are missing or corrupt.
- a — Force all files to be reinstalled, regardless of checksum or version.
- u — Rewrite all required registry entries from the Registry Table that go under HKEY_CURRENT_USER or HKEY_USERS.
- m — Rewrite all required registry entries from the Registry Table that go under HKEY_LOCAL_MACHINE or HKEY_CLASSES_ROOT. Regardless of computer or user assignment, rewrite all info from these tables: Class, Verb, PublishComponent, ProgID, MIME, Icon, Extension, and AppID. Reinstall all qualified components. When reinstalling an application, run the RegisterTypeLibraries and InstallODBC actions.
- s — Reinstall all shortcuts and re-cache all icons, overwriting existing shortcuts and icons.
- v — Run from the source package, re-cache the local package. Does not apply to new installation of a product or feature.

If you set **REINSTALLMODE** without also setting **REINSTALL**, then the detection modes you specify still apply and the overwrite mode is used. The **REINSTALLMODE** property affects only those features selected for installation using **REINSTALL**.

For example, to launch a minor upgrade without using setup.exe, you must set the following properties on the command line:
REINSTALL=ALL REINSTALLMODE=vamus

To install a minor upgrade using an .msi file, use this command line:

msiexec /i "Dragon NaturallySpeaking13.msi" REINSTALL=ALL REINSTALLMODE=vamus

For more information on REINSTALLMODE and the reinstall option codes, see:

MSI Options for Roaming User Profile, Tuning, and Data Collection Setup

This section summarizes the Roaming User Profile, acoustic/language model tuning, and data collection options for command line installations of Dragon NaturallySpeaking13. Data collection is available in non-US English versions of Dragon NaturallySpeaking.

Other options are listed under:

- Summary: MSI Windows Installer Options
- Summary: MSI Options Specific to Dragon
- Summary: MSI Options for Installing Dragon Features/Advanced Options

<table>
<thead>
<tr>
<th>Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PERIODIC_TASK=&lt;string&gt;</td>
<td>Sets schedule for either one, two, or three tasks — an acoustic model optimization (ACO) task, language model optimization (LMO) task, and/or data collection (DC) task. You can schedule each task to run daily or weekly, but need to set the schedule for each task only once. See PERIODIC_TASK for more details.</td>
</tr>
<tr>
<td>ROAMINGUSERINI=&quot;c:\xyz.ini&quot;</td>
<td>Specifies a roaming user .ini file (roamingdef.ini) that contains the Master Roaming User Profile location and any associated HTTP or HTTPS settings for a Roaming User Profile. These are the same options set in the Network Directories field of the Roaming tab of the Administrative settings dialog box and the HTTP and HTTPS Settings dialog boxes. See ROAMINGUSERINI for more details.</td>
</tr>
</tbody>
</table>

PERIODIC_TASK

The <string> of PERIODIC_TASK contains these arguments, separated by semicolons:

aco | lmo | dc — One, two, or all three of them with a vertical bar separating each. If you do not pass the acronym for the feature, that feature is set to its default.

Administrator login name. Be sure you use the fully qualified <domain name>\<account name> in a case where the end-user is a local administrator but the computer is on a domain.
Chapter 5: Installing Dragon using the Windows installer (MSI)

Administrator password.

When to run the task(s), with times for each of multiple tasks separated by a vertical bar (|). Each scheduled time should be in the format *DayOfWeek, hh:mm*, where the day of the week is the three letter abbreviation (no period), the time is the 24-hour time, and the comma between them is required.

The task runs once a week on the day/at the time you indicate. If you omit the *DayOfWeek*, the task runs every day at the time given.

The first of multiple times becomes the schedule for the first task named in the first parameter, the second time the schedule for the second task, the third the schedule for the third task. If you omit a time by having two vertical bars with no time between them or by leaving out the first or last time, the corresponding task is scheduled for a default time.

**Default Schedules**

Acoustic model optimization (ACO) — Mon, 02:00
Language model optimization (LMO) — Every day, 03:00
Data collection (DC) — Fri, 01:00

**Examples of PERIODIC_TASK Settings**

A string setting this option to perform an acoustic model optimization every Monday at 1 AM and a language model optimization the same day at 4 AM is (notice the comma between the day of the week and the time):

```
PERIODIC_TASK="aco|lmo;admin;pswd;Mon, 01:00|Mon, 04:00"
```

To schedule only data collection and language model optimization tasks and have them occur every day at 4 PM and 11 PM, respectively, you would enter only the time for each task, without indicating a particular day:

```
PERIODIC_TASK="dc|lmo;myadmin;mypswd;04:00|23:00"
```

A string setting this option to perform an acoustic model optimization every Tuesday at midnight, data collection every Wednesday at 3 AM, and a language model optimization every Friday night at 10 PM is:

```
PERIODIC_TASK="aco|dc|lmo;myadmin;mypswd;Tue, 00:|Wed, 03:00|Fri, 22:00"
```

To have the data collection and language model optimization tasks occur at default times, you modify the previous string by removing the times for those tasks, but leaving space between the vertical bars and after the last vertical bar:

```
PERIODIC_TASK="aco|dc|lmo;myadmin;mypswd;Tue, 00:| |
```

**ROAMINGUSERINI**

When you enable the Roaming feature, Dragon creates an encrypted roamingdef.ini file.
Use the following steps to create a `roamingdef.ini` file to be used for an MSI installation where the Roaming feature is enabled:

Install Dragon on a computer with Windows administrator privileges.

Enable the Roaming feature options required in your environment. These must include the Master Roaming User Profile location set in the Network Directories field in the Roaming tab of the Administrative Settings dialog box and any HTTP or HTTPS settings.

Test these settings to make sure the Roaming User Profile connection works.

Save your settings by closing Dragon.

Copy the encrypted roamingdef.ini or roaming.ini file (use the one that is newer) created by this installation of Dragon to a separate location. By default, the .ini is located in:

```
C:\ProgramData\Nuance\NaturallySpeaking13\nsdefaults.ini
```

Set the ROAMINGUSERINI option to the name of the roamingdef.ini file. The default is empty (no .ini file will be used).

To set these options using ROAMINGUSERINI, the Roaming feature must be enabled in the `nsdefaults.ini` file.

**Feature Variables to Set Through the ADDLOCAL or ADVERTISE Properties**

When specifying features on the command line:

- If a feature does not exist in a particular edition or language, overriding its default property has no effect.
- Some features (such as Text-to-Speech) have sub-features. Setting these features on the command line automatically turns on the properties of all sub-features, unless you specify an additional override for those sub-features.
- Any information in parentheses after the sub-feature is not included in the feature name.

You can specify any of the following features using ADDLOCAL and ADVERTISE properties on the command line:
<table>
<thead>
<tr>
<th>Feature</th>
<th>Sub-feature</th>
<th>Feature</th>
</tr>
</thead>
<tbody>
<tr>
<td>NatSpeak</td>
<td>None</td>
<td>Dragon NaturallySpeaking13:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Sub-features for ENU (US English):</td>
</tr>
<tr>
<td>Samples (Sample Commands file)</td>
<td>None</td>
<td></td>
</tr>
<tr>
<td>TTS (Text-to-Speech)</td>
<td>TTSDEU (German Text-to-Speech)</td>
<td>TTSESP (Spanish Text-to-Speech)</td>
</tr>
<tr>
<td></td>
<td>TTSEnu (US English Text-to-Speech)</td>
<td>TTsFRA (French Text-to-Speech)</td>
</tr>
<tr>
<td></td>
<td>TTSEng (British English Text-to-Speech)</td>
<td>TTsITA (Italian Text-to-Speech)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>TTsNLD (Dutch Text-to-Speech)</td>
</tr>
<tr>
<td>Tutorial</td>
<td>TutDEU (German Tutorial)</td>
<td>TutFRA (French Tutorial)</td>
</tr>
<tr>
<td></td>
<td>TutENX (English Tutorial)</td>
<td>TutITA (Italian Tutorial)</td>
</tr>
<tr>
<td></td>
<td>TutESP (Spanish Tutorial)</td>
<td>TutNLD (Dutch Tutorial)</td>
</tr>
<tr>
<td>Speech—DEU (German)</td>
<td>Sub-features for DEU (German)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>DEUGeneral (German General Large, Swiss German General, Empty Dictation General)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>DEULegal (German Legal)</td>
<td></td>
</tr>
<tr>
<td>Tutorial</td>
<td>TutDEU (German Tutorial)</td>
<td>TunFRA (French Tutorial)</td>
</tr>
<tr>
<td></td>
<td>TutENX (English Tutorial)</td>
<td>TunITA (Italian Tutorial)</td>
</tr>
<tr>
<td></td>
<td>TutESP (Spanish Tutorial)</td>
<td>TunNLD (Dutch Tutorial)</td>
</tr>
<tr>
<td>Speech—ENX—ENU (US English)</td>
<td>Dragon NaturallySpeaking13:</td>
<td>The ENU sub-feature includes support</td>
</tr>
<tr>
<td></td>
<td>Sub-features for ENU (US English)</td>
<td></td>
</tr>
</tbody>
</table>

146
<table>
<thead>
<tr>
<th>Feature</th>
<th>Sub-feature</th>
<th>for the following accents:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>ENULegal <em>(US English Legal Large)</em></td>
<td>• General — Use if your accent is not covered by the other choices or you are not sure which accent to select.</td>
</tr>
<tr>
<td></td>
<td>ENUGeneral <em>(US English General Medium, US English Empty Dictation, US English Commands Only)</em></td>
<td>• Australian accented English</td>
</tr>
<tr>
<td></td>
<td>ENUGenSvc <em>(US English Large General)</em></td>
<td>• British accented English</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Indian accented English</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Pakistani accented English</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• SEAsian accented English — South East Asian</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Southern US — Covers most of the Southern United States, including Texas.</td>
</tr>
<tr>
<td>Speech ENX <em>(English)</em></td>
<td>Sub-features for ENG <em>(UK English)</em>:</td>
<td>• Spanish Accented English.</td>
</tr>
<tr>
<td>(UK English)</td>
<td>ENSGeneral <em>(UK English General Large, Empty Dictation General, Commands Only)</em></td>
<td>• Teens</td>
</tr>
<tr>
<td></td>
<td></td>
<td>The ENG sub-feature includes support for the following accents:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• General — Use if your accent is not covered by the other choices or you are not sure which accent to select.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Australian</td>
</tr>
<tr>
<td>Feature</td>
<td>Sub-feature</td>
<td></td>
</tr>
<tr>
<td>---------------------</td>
<td>--------------------------------------------------</td>
<td>---------------</td>
</tr>
<tr>
<td></td>
<td></td>
<td>accent English.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Indian accented English.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- SEAAsian accented English – South East Asian.</td>
</tr>
<tr>
<td>Speech ENX (Eng-lish)</td>
<td>CanadaGeneral (Canadian English General Large)</td>
<td>The Canadian ENG sub-feature includes support for the following accents:</td>
</tr>
<tr>
<td>Canada (Canadian English)</td>
<td></td>
<td>- Standard</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Australian accented English</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- British accented English</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Indian accented English</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Pakistani accented English</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Southeast Asian accented English</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Southern US</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Spanish accented English</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Teens</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Accent not otherwise</td>
</tr>
<tr>
<td>Feature</td>
<td>Sub-feature</td>
<td>Specified</td>
</tr>
<tr>
<td>--------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>-----------</td>
</tr>
<tr>
<td>Speech—ITA (Italian)</td>
<td>Sub-features for ITA (Italian): ITA (Italian General Large and Italian Empty Dictation General Large)</td>
<td></td>
</tr>
<tr>
<td>Speech—NLD (Dutch)</td>
<td>Sub-features for NLD (Dutch) NLDGeneral(Dutch General Large and Dutch Empty Dictation General Large)</td>
<td></td>
</tr>
<tr>
<td>Speech—FRA (French)</td>
<td>Sub-features for FRA (French): FRAGeneral (French General Large, French Empty Dictation General Large)</td>
<td></td>
</tr>
<tr>
<td>Speech—ESP (Spanish)</td>
<td>Sub-features for ESP (Spanish) ESP (Latin American Spanish General Large) ESP (Latin American Spanish Empty Dictation General Large) ESP (Castilian Spanish General Large)</td>
<td>Speech—ESP (Spanish)</td>
</tr>
</tbody>
</table>
This section describes how to set up, configure, and enable the Roaming feature on client computers. This section also provides information on how to create, dictate with, and upgrade Roaming User Profiles.

**Setting up the Roaming feature**

The Roaming feature lets end-users dictate with Dragon NaturallySpeaking 13 from different network locations and on different computers without having to create and train individual User Profiles at each location. The Roaming feature works by storing User Profiles in a central network location so that the information Dragon learns from an end-user dictating on one computer is also available on other computers. To set up Roaming User Profiles, carry out the steps shown in the table below, in chronological order.
<table>
<thead>
<tr>
<th>Topic</th>
<th>Link</th>
</tr>
</thead>
<tbody>
<tr>
<td>The Roaming feature</td>
<td></td>
</tr>
<tr>
<td>Setting up the Roaming feature</td>
<td>- Overview of the Roaming feature</td>
</tr>
<tr>
<td></td>
<td>- Setting up the Roaming feature</td>
</tr>
<tr>
<td>Enabling the Roaming feature on each computer where an end-user dictates</td>
<td>- Enabling the Roaming feature on each computer where an end-user will dictate</td>
</tr>
<tr>
<td></td>
<td>- Creating a network storage location for the Master Roaming User Profiles</td>
</tr>
<tr>
<td></td>
<td>- Where to install and configure Dragon NaturallySpeaking</td>
</tr>
<tr>
<td></td>
<td>- Storage space required for the Master and Local Roaming User Profiles</td>
</tr>
<tr>
<td></td>
<td>- How Dragon Synchronizes Master and Local Roaming User Profiles</td>
</tr>
<tr>
<td></td>
<td>- Estimating Network traffic caused by synchronization</td>
</tr>
<tr>
<td>Creating Roaming User Profiles</td>
<td>- Creating a Roaming User Profile on the local computer</td>
</tr>
<tr>
<td></td>
<td>- Creating and training a new Roaming User Profile</td>
</tr>
<tr>
<td></td>
<td>- Converting a non-roaming local User Profile into a Roaming User Profile</td>
</tr>
<tr>
<td></td>
<td>- Copying a non-Roaming User Profile to the Master Roaming User Profile location</td>
</tr>
<tr>
<td>Dictating with a Roaming User Profile</td>
<td>- Dictating with a Roaming User Profile</td>
</tr>
<tr>
<td></td>
<td>- Opening a Roaming User Profile</td>
</tr>
<tr>
<td></td>
<td>- Using multiple dictation sources with a single User Profile</td>
</tr>
<tr>
<td></td>
<td>- Running the Acoustic and Language Model Optimizer for Roaming User Profiles</td>
</tr>
<tr>
<td></td>
<td>- Synchronizing Master and Local Roaming User Profiles</td>
</tr>
<tr>
<td>Upgrade Roaming User Profiles to Dragon NaturallySpeaking 13</td>
<td>- Upgrading Roaming User Profiles: Overview</td>
</tr>
</tbody>
</table>
Overview of the Roaming feature

The Roaming feature lets end-users dictate with Dragon from different network locations and on different computers without having to create and train individual User Profiles at each location.

Some situations that the Roaming feature makes possible:

- A doctor may need to dictate reports in a medical office building using a desktop computer, in a hospital room using a Tablet PC, or at home using a laptop computer. The Roaming feature allows the doctor to use the same set of User Profiles containing the same vocabulary words with the acoustic information from each location.

- An end-user dictates on the same laptop at multiple offices and at home. Before leaving the office, the end-user loads a set of User Profiles from a central location on the network to his laptop. Once home, the end-user dictates and corrects as you normally would. When the end-user returns to the office, they reconnect the laptop to the network. The next time the end-user opens a Dragon user profile, the Roaming feature synchronizes the updated User Profiles on the laptop with those at the network’s central location.

The relationship between the Master and the Local Roaming User Profile

With the Roaming feature, each Dragon user profile has a single Master Roaming User Profile that can be opened from multiple networked computers running Dragon. The Master Roaming User Profile is stored on a network location accessible to your dictating end-users.

When a Master Roaming User Profile is opened from that central network location, Dragon transfers a copy of that User Profile to the local computer. That local copy is called the Local Roaming User Profile.

The Local Roaming User Profile is a copy of the end-user data taken from the Master Roaming User Profile but modified locally by corrections and acoustic data gathered during a dictation session.

You can set a central storage device to contain all your Master Roaming User Profiles. By loading a Dragon User Profile from the central network location, your end-users can dictate at any computer where Dragon is installed. When end-users exit Dragon and save the changes to their User Profiles, these changes are saved in that central location. The next time the end-user runs Dragon, all the changes saved are available regardless of which computer on the network he or she uses for dictation.
Advantages of the Roaming feature

It is important to distinguish the Roaming feature from simply browsing to a network directory and creating files there. Nuance recommends using the Roaming feature rather than storing non-Roaming User Profiles in a network directory. Using the Roaming feature, you can:

- Minimize network traffic. When Dragon opens a User Profile, if there is already a copy of the Roaming User Profile on the local computer, only the updates are downloaded from the network. When the end-user closes the User Profile at the end of his or her dictation session, only the updates from the current session are uploaded to the network. These updates typically amount to no more than a few KB of data, as opposed to roughly 90 MB of data if the entire User Profile is opened and closed over the network.
- Allow the end-user to use Dragon even if the network directory is unavailable. In that case, Dragon opens the local copy of the Roaming User Profile.
- Give the administrator precise control over where end-users can put User Profiles. If the Roaming feature is enabled, the administrator can specify whether or not to also allow end-users to browse to any User Profile location; the default is not to allow browsing. This means that the administrator can easily see how many User Profiles have been created and who created them. If the Roaming feature is not enabled, end-users can browse to any location to which they have access and create User Profiles there.
- If HTTP Roaming is configured, it can be used to provide username/password authentication on User Profiles.

Hosting Master Roaming User Profiles

There are several methods for hosting your Master Roaming User Profiles:

- On a file server you connect to over a Mapped Drive
- On a file server that you connect to over a UNC (Universal Naming Convention) address
- On a web server that you connect to over HTTP (http://)
- On a secure web server that you connect to over SSL (https://)

Why the Master Roaming User Profiles should be in shared directories

Nuance recommends placing the master Roaming User Profiles in a shared directory to make certain administrative tasks more efficient. These tasks include:

- Scheduling an Acoustic and Language Model Optimizer task that optimizes multiple User Profiles
- Upgrading multiple User Profiles to a new major release of Dragon
- Keeping track of how many User Profiles have been created, which helps with licensing compliance (note that Dragon is licensed per end-user, not per workstation)

It is possible, though not recommended, to place Roaming User Profiles in a non-shared, end-user-specific location such as the end-user’s home drive, provided every end-user’s home drive is mapped to the same drive letter (this is because the Roaming User Profile location is an administrative setting that is per-workstation, not per-user).
Chapter 6: Configuring and using the Roaming feature and Roaming User Profiles

Using multiple Roaming User Profile locations

If you have a large number of Roaming User Profiles, you may want to divide them among multiple shared directories. This facilitates performing tasks such as scheduling the Acoustic and Language Model Optimizer on a subset of User Profiles. You can choose how to divide your User Profiles, for example:

- By department
- By alphabetical groupings (for example A through H, I through M, N through R, and S through Z)

On each PC, you can configure any number of Roaming User Profile locations. Make sure you give each Roaming User Profile location a display name that makes it clear to your end-users which location to choose from.

Controlling access to User Profiles

If you have multiple Dragon end-users on an end-user workstation, those end-users will have multiple User Profiles to choose from in Dragon’s Open User Profile dialog box.

If you use a shared directory for User Profiles, whether they are roaming or non-roaming, you may be concerned about the ability of an end-user to see and/or open another end-user’s profile as well as their ability to open the correct profile. There are several ways to address this concern:

- Many of Nuance’s customers address this concern simply through end-user training. Each end-user should be aware that if they open another end-user’s profile and try to use it, their accuracy will be poor and end-user-specific customizations will not be available. Therefore, each end-user has an incentive to use only their own profile. However, this fact does not prevent a malicious end-user from damaging another end-user’s profile.

- If end-users always log into Windows with a unique Windows user ID, you can use Windows file permissions to control access to the profiles. Typically, you do this by granting Full Control or Read/Write/Modify access to the shared directory, but do not allow this permission to propagate to sub-directories. That way, each end-user becomes the creator owner of any Dragon User Profile that he or she creates. End-users can still see all of the Dragon User Profiles in the Open User Profile dialog box, but if they try to select another end-user’s profile, a message will appear saying that they do not have permission to access that profile. Apply similar file permissions to the local copy of each Roaming User Profile; the default location for local copies is under `C:\ProgramData\Nuance\NaturallySpeaking13\RoamingUsers` for Windows 7, Windows 8, and Windows Server 2008.

- If end-users log in using a shared Windows user ID, the best way to control access is through HTTP Roaming. In this configuration, you set up a web server running either IIS or Apache and with the WebDAV file system enabled. On each workstation, you specify a URL on the web server as the Roaming User Profile location. When an end-user launches Dragon, before displaying the Open User Profile dialog it prompts for a user name and password, which it uses to authenticate against the web server.

You can use file permissions on the web server to specify which User Profiles are accessible to each account on the web server. File security is a function of the web server and the WebDAV software.
Making it easier for end-users to select their User Profiles

As described above, the Dragon Open User Profile dialog shows a list of all of the User Profiles in a shared directory (unless you are using HTTP Roaming to limit access to User Profiles). If there are more User Profiles than will fit on one screen, you can train end-users to go directly to a specific User Profile by typing the first few letters of its name.

It is possible to create an icon in the Start Menu and/or the Windows desktop that opens a specific User Profile. This can be helpful if there are only a few end-users of Dragon who share a particular workstation. Make a copy of the Dragon icon for each end-user, and place the parameter /user "user name" on the natspeak.exe command line.

In Dragon NaturallySpeaking13, you can display and view groups of User Profiles in a tree-style structure. See "Open User Profiles dialog box optimized for Roaming" in Dragon - What's New for administrators for more information.

Backing up your Master Roaming User Profiles

Dragon does not backup local Roaming User Profiles on the end-user workstations and does not backup the Master Roaming User Profiles on the location where they are stored on your network.

It is the responsibility of your local system administrator to back up the Master Roaming User Profiles.

Notes: For use of WebDAV

- After you install Internet Information Services and WebDAV, you need to use the Internet Information Services Manager tool to set the “Allow Unknown MIME Types”, “Allow Custom Properties”, and “Allow Property Queries with Infinite Depth” settings to true. For example, in IIS 7:
For more information, see Configuring Internet Information Services and WebDAV for HTTP Roaming.

If you connected to your Roaming User Profile Master Directory over HTTP and you find that the Open User Profile dialog box does not display all the vocabularies and acoustic models for your User Profiles, make sure that you:
  * Check that no files in your User Profile directory are locked, password protected, or otherwise access-restricted by your server permissions.

**Setting up the Roaming feature**

When setting up the Roaming feature, note the following:

- Creating a network storage location for the Master Roaming User Profiles
- Where to install and configure Dragon
- Storage space required for the Master and Local Roaming User Profiles
- Synchronizing Master and Local Roaming User Profiles
- Estimating Network traffic caused by synchronization

**Note:** To enable the Roaming feature and set the Roaming User Profile options, you must log into an account with Windows Administrator privileges.
Creating a network storage location for the Master Roaming User Profiles

For any installation of Dragon, you must first determine where on the network the Master Roaming User Profiles should be located.

Dragon lets you store your Master Roaming User Profiles on:

- Any networked computer.
  You are not strictly required to store Master Roaming User Profiles on a server. Any shared location accessible to other computers on the network is a perfectly acceptable place to store Master Roaming User Profiles.
- A Windows file server
- A web server (HTTP)
- A secure web server running SSL (HTTPS)

Note: The location(s) you pick must be accessible to all computers where users will dictate with a Roaming User Profile. Each location must have adequate storage space for Roaming User Profiles. For more information, see Storage space required for User Profiles.

What to consider for the Master Roaming User Profile location

To set up a location for the Master Roaming User Profiles, you should first determine:

- The kind of network file server on which you want to store your Master Roaming User Profiles. Make sure it has enough storage space. Each location you pick must be accessible to all computers where your users will dictate with Roaming User Profiles. You can create multiple network storage locations.
- How the computers from where your users will dictate will connect to that network location; for example using a mapped drive, UNC connection, or an HTTP or HTTPS connection.

Using a networked computer or Windows file server

If you choose to use a networked computer or Windows server, you should determine the path to where the Master Roaming User Profiles will reside. You can create multiple network storage locations.

The Roaming feature supports the following types of locations for your Master Roaming User Profiles:

- Mapped Drives—Connects to a shared network folder that has a drive letter assigned to it.
- UNC Paths—Connects to a shared network folder using the Universal Naming Convention (UNC) to locate a User Profile. Format is: \\<servername>\<sharename>\<path>\<filename>.

What you'll need to know to configure your local Roaming User Profiles

After you have chosen the type of computer to store the Master Roaming User Profiles, you should determine the following information so that you configure your local copies of Dragon to connect to a mapped or shared drive:

Mapped Drives
UNC paths

Using a HTTP or HTTPS web server

If you choose to use a HTTP or HTTPS web server, the Roaming feature supports the following types of locations for your Master Roaming User Profiles:

- **HTTP** (http):—Connects to computer on the internet or your local intranet. Format is: http://<myserver.com>/<webdav>
- **HTTP with SSL** (https):—Connects to computer on the internet or your local intranet with SSL. Format is: https://<myserver.com>/<webdav>

Supported web servers

If you want to store your Master Roaming User Profiles on a web server, Internet access to Master Roaming User Profiles is supported on two web servers:

- Microsoft Internet Information Services (IIS) 7.0 and 7.5. For this type of server:
  - Be sure that the server has Web-based Distributed Authoring and Versioning (WebDAV) software is turned on to publish content to an Internet Information Services (IIS) web server.
  
  If you have not already installed the WebDAV component, use the Add or Remove Programs in your Control Panel and run the Windows Components Wizard. WebDav is listed under Application Server>Internet Information Services>World Wide Web Service>WebDAV Publishing.

- Apache HTTP Server 2.0.54 and higher. For this type of server:
  - Internet Roaming User—Redirects must be turned on when using Digest authentication.
  
  - Be sure that the server has Web-based Distributed Authoring and Versioning (WebDAV) software turned on. The WebDAV Apache module is available free of charge at http://www.webdav.org/mod_dav/.

What you'll need to know to configure your local Roaming User Profiles

After you have chosen the type of computer to store the Master Roaming User Profiles, you should determine the following information so that you configure your local copies of Dragon to connect to the HTTP server:

- **The network location**: You need to know the URL address of your HTTP server. For more information, see XXXXX.

- **HTTP settings**: For your http (or https) connection you need to know authentication, firewall, and proxy server information. For more information, see HTTP Settings.

Notes: For use of WebDAV

- After you install Internet Information Services and WebDAV, you need to use the Internet Information Services Manager tool to set the “Allow Unknown MIME Types”, “Allow Custom Properties”, and “Allow Property Queries with Infinite Depth” settings to true. For example, in IIS 7:
For more information, see Configuring Internet Information Services and WebDAV for HTTP Roaming.

If you connected to your Roaming User Profile Master Directory over HTTP and you find that the Open User Profile dialog box does not display all the vocabularies and acoustic models for your User Profiles, make sure that you:

- Add all file extensions within your Master Roaming User Profile directories and sub-directories to the Registered MIME types list of your IIS server. You could also add a wildcard (.* ) MIME-type.
  For more information on adding a wildcard (.* ) MIME-type, see:
  For Windows Server 2008:

- Check that no files in your User Profile directory are locked, password protected, or otherwise access-restricted by your server permissions.

Where to install and configure Dragon NaturallySpeaking13

Installing Dragon NaturallySpeaking13 where you plan to dictate using the Roaming feature

Dragon NaturallySpeaking13 must be installed each computer where you plan to have users dictating with Roaming User Profiles.
Chapter 6: Configuring and using the Roaming feature and Roaming User Profiles

Installing Dragon NaturallySpeaking13 on the same computer as your Master Roaming User Profiles

Nuance recommends that you install Dragon NaturallySpeaking13 on the same computer where the Master Roaming User Profiles for your network are located.

As the system administrator, you are responsible for running the **Acoustic and Language Model Optimizer** on the network location of the Master Roaming User Profiles. The **Acoustic and Language Model Optimizer** and the **Acoustic and Language Model Optimizer Scheduler** can only be run on the Master Roaming User Profiles.

Running the Acoustic and Language Model Optimizer updates the Master Roaming User Profiles with the accumulated acoustic data from any corrections and additional training done by the users at the computers where they dictate. Running the Acoustic and Language Model Optimizer will increase your overall accuracy. Any optimizations done by the **Acoustic and Language Model Optimizer** are copied to each Local Roaming User Profile when synchronization occurs.

Running the **Acoustic and Language Model Optimizer** over the network can result in a large amount of data being transferred between the server and the workstation running the optimizer.

For more information, see Running the Acoustic and Language Model Optimizer for Roaming User Profiles.

If you are using Dragon NaturallySpeaking13, see Using multiple acoustic models with a User Profile for information on using the Acoustic and Language Model Optimizer with a User Profile that has two acoustic models.

**Notes:**

- You must have Windows Administrator privileges on the computer where you are running the **Scheduler** for the **Acoustic and Language Model Optimizer**.
- Do not enable the Roaming feature on the administrator computer where you plan to run the **Acoustic and Language Model Optimizer**.
- When the Roaming feature is enabled on a computer where someone dictates, that computer is blocked from locally running the **Acoustic and Language Model Optimizer** or the **Acoustic and Language Model Optimizer Scheduler** on the local copy of the Roaming User Profiles.

For more information on installing or upgrading Dragon

For more information on installing or upgrading Dragon NaturallySpeaking13 on the computers in your network, see:

- The Installation Guide that came with your copy of Dragon for information on installing Dragon on a single computer.
- The Dragon Administrator Guide for information on how to use MSI to install or upgrade Dragon on multiple computers.
Storage space required for the Master and Local Roaming User Profiles

Adequate storage space must be available for User Profiles that store information about each particular user's speech patterns.

You need to plan for storage space on:

- Each computer where you plan to have users dictating with a Roaming User Profile.
- The network accessible central computer or computers where Master Roaming User Profiles are stored.

These are guidelines only and not definitive specifications—actual size will vary from site to site.

For each Master Roaming User Profile on the network

For each Master Roaming User Profile (User Profiles stored on the central network location), you should plan on:

- 90 MB for each set of Roaming User Profiles, this includes:
  - 21 MB for each additional vocabulary you add for this user profile
  - 68 MB for each additional dictation source you add for this user profile
- 1000 MB for acoustic optimizer data associated with each dictation source of each User Profile

For each computer where Dragon is installed

You must install 1 copy of Dragon NaturallySpeaking13 on each computer where your users will be dictating with the Roaming feature. Multiple users can use a single Dragon installation.

Each installation of Dragon NaturallySpeaking13 takes a minimum of 1.8 GB of free hard disk space for a custom installation where you install only the program files and 1 set of User Profiles. Installations can range from 800 MB (US English Home Edition) to 5 GB (Dragon NaturallySpeaking13), depending on which languages and vocabularies you install. See Dragon system requirements for information on disk space requirements for Dragon NaturallySpeaking13.

For each Local Roaming User Profile on the client PC

On each installation of Dragon where your users plan to dictate using the Roaming feature, each Local Roaming User Profile (the User Profiles stored on the local computer running Dragon NaturallySpeaking13), require the following:

- 90 MB for each set of Roaming User Profiles. This includes:
  - 21 MB for each additional vocabulary you add for this user profile
  - 68 MB for each additional dictation source you add for this user profile
- 10 MB per topic for language model optimizer data in the topic container data
- 240 MB for acoustic optimizer data associated with each dictation source of each User Profile

How much acoustic optimizer data is retained locally is controlled by settings on the Data tab of the Options dialog box:
1. To set the number of minutes of audio to retain locally, click the **Archive size**... button and position the slider.
2. To turn off retaining this data locally, check the **Conserve disk space required by user profile (for portability)** option.

A non-Roaming User Profile requires approximately three times as much disk space as a local Roaming User Profile. Dragon periodically creates a backup copy of a non-Roaming User Profile and stores the copy on the local computer. On the other hand, a Roaming User Profile is stored in a network storage location and Dragon does not create a backup copy of a Roaming User Profile.

An administrator should create backup copies of all Roaming User Profiles on a regular basis.

**How Dragon Synchronizes Master and Local Roaming User Profiles**

When an end-user that uses a Roaming User Profile exits *Dragon*, switches User Profiles, closes a User Profile, or saves a User Profile, *Dragon* saves changes to the Local Roaming User Profile and then synchronizes these changes with the Master Roaming User Profiles on the network.

In a networked situation, this occurs at the time one of these operations is performed.

When an end-user dictates using a computer not currently connected to a network, all changes are saved to the Local Roaming User Profile; synchronization occurs when the end-user reattaches the computer to the network containing the Master Roaming User Profile and opens that User Profile again.

For more information on what options affect what data gets synchronized between the Master and Local Roaming User Profile, see Setting/selecting Roaming User Profile options.

**Note:** During synchronization, changes to the Master Roaming User Profile overwrite any changes made to a Local Roaming User Profile that an end-user has been using for dictating and correcting dictation while not on the network.

What happens during synchronization

The following changes take place when Local and Master Roaming User Profiles are synchronized:

- Combines words added to the Local Roaming User Profile during a dictation session with the Master Roaming User Profile vocabulary,
- Removes words deleted from the Local Roaming User Profile from the Master Roaming User Profile vocabulary,
- Copies acoustic data (from files with a **.DRA** or **.NWV** extension) from the Local Roaming User Profile and adds them to the Master Roaming User Profile where the data become available to the Acoustic Optimizer (Note that .DRA files saved voluntarily by the end-user along with a document do not get added to the Master Roaming User Profile. The .DRA files created automatically by Dragon for use by the optimizer are the only ones that get added to the Master Roaming User Profile).
more information on running the Acoustic Optimizer, see Running the Acoustic and Language Model Optimizer for Roaming User Profiles.

- Copies any custom commands created or modified locally (using the MyCommands editor) to the Master Roaming User Profile.
- Saves any local end-user options that you changed on the Options or Formatting dialog box to the Master Roaming User Profile, except the options listed below.

**What changes don't get synchronized**

The following options are not synchronized with the Master Roaming User Profile; they remain exclusively on the local computer with the Local Roaming User Profile:

Locally set options on the Options dialog:

- On the Data tab:
  - `Conserve disk space required by user profile` option
  - `Create usability log` option in the Advanced dialog box
  - `Incremental adaptation in general training` option

- On the Miscellaneous tab:
  - `Voice enable menus and dialog controls` option
  - `Launch Dragon in QuickStart mode when Windows starts` option

- On other tabs of Options dialog box:
  - All the options on the Playback/Text-to-speech tab
  - All the options on the Hot keys tab

- Settings in the Auto-Formatting dialog box:
  - The UK and Canadian postcodes option

**What files are synchronized**

The following table explains how and when individual files are copied or updated to the master Roaming User Profile or to the local cache when the Master and Local Roaming User Profiles are synchronized.

For more information on what options affect what data gets synchronized between the Master and Local Roaming User Profile, see Setting/selecting Roaming User Profile options.

These options can affect how much data is transferred across your network when the Master and Local Roaming User Profiles are synchronized. For more information, see Estimating Network traffic caused by synchronization.
<table>
<thead>
<tr>
<th>File name or type</th>
<th>Copied or updated with the master Roaming User Profile</th>
<th>Copied or updated to local cache</th>
</tr>
</thead>
<tbody>
<tr>
<td>Acoustic files: *usr and *.sig</td>
<td>At save time if the <strong>Always copy acoustic information to network</strong> option in the Administrative settings is on. See <strong>Acoustic files</strong> for more details.</td>
<td>Copied if version number on server is different</td>
</tr>
<tr>
<td>Vocabulary files: *.voc</td>
<td>Copied only after the acoustic files for the User Profile have been modified with information from <strong>Learn from specific documents</strong>, <strong>Learn from sent e-mails</strong>, <strong>Import a list of words or phrases</strong>, and similar procedures.</td>
<td>Copied if version number on server is different</td>
</tr>
<tr>
<td>Acoustic archive created for each dictation session:</td>
<td>Copied to session folder if it exists; once master voice_container limit is reached, nothing more is copied. The local copy is deleted and a zero-length file is created.</td>
<td>Never</td>
</tr>
<tr>
<td>acarchive.nwv (encryption disabled), acarchive.enwv</td>
<td></td>
<td></td>
</tr>
<tr>
<td>(encryption enabled)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Audio.ini</td>
<td>Copied to master after running the Check Microphone wizard or at User Profile close if not copied successfully after running the Check Microphone wizard</td>
<td>Copied if version number on server is different; also copied right before Check Microphone wizard is run</td>
</tr>
<tr>
<td>Backups</td>
<td>Never - Dragon does not backup local Roaming User Profiles on the end-user workstations and does not backup the Master Roaming User Profiles on the location where they are stored on your network. See <strong>Backups</strong> for more details.</td>
<td>Never</td>
</tr>
<tr>
<td>DRA files, aco.ini;</td>
<td>Copied to session folder if</td>
<td>Never</td>
</tr>
</tbody>
</table>
Acoustic files

If the setting is off (the default), after the acoustic optimizer runs on the master Roaming User Profile, the server incorporates the changes.

In Dragon NaturallySpeaking 13, an end-user can set the **Save Acoustic information** option to control if Dragon saves the .usr and .sig files on each computer they dictate on. See "Controlling updates to the acoustic components of a User Profile" in Dragon What's New for administrators for more information.

Backups

It is the responsibility of your local administrator to back up the Master Roaming User Profiles. However, Dragon does automatically back up local non-Roaming User Profiles on the end-user workstations as specified in the Miscellaneous tab of the Administrative Settings dialog box.

Estimating Network traffic caused by synchronization

The following table explains how and when individual files are copied or updated to the master Roaming User Profile or to the local cache when the Master and Local Roaming User
Profiles are synchronized and how much data is transferred in the process.

In addition, this table which option controls whether the data is transferred. For more information on what options affect what data gets synchronized between the Master and Local Roaming User Profile, see Setting/selecting Roaming User Profile options.

The estimates of the data transferred across the network is for a single Roaming User Profile.
<table>
<thead>
<tr>
<th>Files copied to the Master Roaming User Profile</th>
<th>Transfer Direction &amp; Data Amount</th>
<th>Files copied to the Local Roaming User Profile</th>
<th>Administrative Setting to enable for Transfer</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Acoustic files:</strong> *user and *.sig</td>
<td>68 MB</td>
<td><strong>Transfer time:</strong> Copied if server version is different from client version</td>
<td>● Always copy acoustic information to network</td>
</tr>
<tr>
<td><strong>User Action:</strong> Dictation, Audio Setup</td>
<td></td>
<td></td>
<td>● Save Acoustic information</td>
</tr>
<tr>
<td><strong>Transfer time:</strong> When the User Profile is saved</td>
<td></td>
<td><strong>Transfer time:</strong> Copied if server version is different from client version</td>
<td></td>
</tr>
<tr>
<td><strong>Vocabulary files:</strong> *voc</td>
<td>21 MB</td>
<td><strong>Transfer time:</strong> Copied if server version is different from client version</td>
<td><strong>Access network at user profile open/close only</strong></td>
</tr>
<tr>
<td><strong>User Action:</strong> Dictation, Learn from specific documents, Learn from sent e-mails, Vocabulary Optimizer.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Transfer time:</strong> Copied only after the vocabulary files for the end-user have been modified with information from Learn from specific documents, Learn from sent e-mails, and the Vocabulary Optimizer. Copied only after saving or closing a User Profile.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Acoustic archive created for each dictation session:</strong> acarchive.nwv, acarchive.enwv</td>
<td>240 MB</td>
<td><strong>Transfer time:</strong> Never. The local copy is deleted and a zero-</td>
<td><strong>Access network at user profile open/close only</strong></td>
</tr>
<tr>
<td><strong>User Action:</strong> Dictation,</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Files copied to the Master Roaming User Profile</td>
<td>Transfer Direction &amp; Data Amount</td>
<td>Files copied to the Local Roaming User Profile</td>
<td>Administrative Setting to enable for Transfer</td>
</tr>
<tr>
<td>-----------------------------------------------</td>
<td>---------------------------------</td>
<td>-----------------------------------------------</td>
<td>-----------------------------------------------</td>
</tr>
<tr>
<td>Correction</td>
<td></td>
<td>length file is created after files are copied to the server.</td>
<td></td>
</tr>
<tr>
<td><strong>Transfer time:</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Copied to session folder if it exists.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Once master voice_container limit is reached, nothing more is copied. Copy only happens after saving or closing a User Profile.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>DRA files created during dictation:</strong> DRA files, aco.ini, drafiles.ini</td>
<td>1.3 MB/minute &lt;-----</td>
<td><strong>Transfer time:</strong> Never. Files are deleted after being copied; aco.ini and drafiles.ini are recreated at zero-length</td>
<td>Conserve archive size on network</td>
</tr>
<tr>
<td><strong>User Action:</strong> Dictation, Correction</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Transfer time:</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Copied to session folder if the master voice_container has space.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Custom commands created on client PC:</strong> Mycmds.dat</td>
<td>66 K &lt;-----</td>
<td><strong>Transfer time:</strong> Copied when a User Profile opens on the local PC and the version number on the server is different from the version</td>
<td></td>
</tr>
<tr>
<td><strong>User Action:</strong> Changes to some Options on the local PC</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Transfer time:</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Copied when a User Profile is closed or saved.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Files copied to the Master Roaming User Profile</td>
<td>Transfer Direction &amp; Data Amount</td>
<td>Files copied to the Local Roaming User Profile</td>
<td>Administrative Setting to enable for Transfer</td>
</tr>
<tr>
<td>-----------------------------------------------</td>
<td>---------------------------------</td>
<td>-----------------------------------------------</td>
<td>-----------------------------------------------</td>
</tr>
<tr>
<td>.INI file changes on client PC: options.ini, soptions.ini, itnoptions.ini</td>
<td>&lt; 1 k</td>
<td>Transfer time: Copied to local cache on when a User Profile opens and merged into the voc if the version number is different on the server</td>
<td></td>
</tr>
<tr>
<td><strong>User Action:</strong> Changes to some Options on the local PC</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Transfer time:</strong> Copied at User Profile close, Options dialog close when the timestamp on the local file has changed</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>History of changes to the vocabulary: vocdelta.voc</td>
<td>500 KB max. (12 bytes/word)</td>
<td>Transfer time: Copied when a User Profile opens or the Options dialog opens if the server version is different from the client version</td>
<td>Merge contents of vocdelta.voc into network user profile when file is full</td>
</tr>
<tr>
<td><strong>User Action:</strong> Adding words, changing word properties</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Transfer time:</strong> Merged to master copy when a User Profile is saved or opened. When vocabularies are copied, vocdelta.voc is reset to zero in the master copy for that vocabulary</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Log file: Dragon.log</td>
<td>&lt; 1 MB</td>
<td>Transfer time: Never</td>
<td>Copy Dragon log to network</td>
</tr>
<tr>
<td></td>
<td>&lt;------</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Enabling the Roaming feature on each computer where an end-user will dictate

After you have set up the network location for the Master Roaming User Profiles and installed or upgrading Dragon NaturallySpeaking 13 on the computers in your network, you must enable the Roaming feature on each computer where the end-user will dictate using a Roaming User Profile.

Step 1: Start Dragon NaturallySpeaking

You must start Dragon NaturallySpeaking 13 to enable the Roaming feature.

Step 2: If already Dragon is running, select Administrative Settings

If Dragon is already running, on the DragonBar, select Tools > Administrative Settings and click Proceed. This action closes all open User Profiles and displays the Administrative Settings dialog box.

Step 3: Turn on the Roaming feature

After closing any open User Profiles:

1. If Dragon is running, from the DragonBar menu, select Tools > Administrative Settings. This action displays the Administrative Settings dialog box. Note: You do not have to be running Dragon to act as an administrator of the product. Instead of opening the Administrative Settings dialog box from the DragonBar menus, you can open the dialog box from the command line by selecting Start > Run, then entering the following command in the Open text box (include a space between natspeak.exe and the /SetAdministrativeOptions option that follows it):

   "C:\Program
2. On the Roaming tab, check **Enable**.
3. Click **Apply** to save the changes and keep the dialog box open.

**Note:** With the Roaming feature enabled, the **Open User Profile** dialog box later displays only User Profiles in the Roaming User Profile storage locations. To let the end-users open both local (non-roaming) and Roaming User Profiles, check the **Allow non-roaming user profiles to be opened** option in the **Administrative Settings** dialog box. Clearing this option prevents end-users from dictating with a non-roaming (local) User Profile by mistake.

**Step 4: Set the location of Master Roaming User Profiles**

On each computer where you plan to have end-users dictating as Roaming users, you must tell that installation of **Dragon** where the Master Roaming User Profiles are located.

After selecting **Enable** on the **Roaming** tab:

1. Click the **Add** button. The **Roaming User Network Location** dialog box displays. You use the **Roaming User Network Location** dialog box to define the network location of the master Roaming User Profiles. The location you pick must be accessible to all computers on the network that you want available for dictation with **Dragon**.

2. Set the **Display Name** to the way the name of the directory should display in other dialog boxes. The display name later appears in the **Roaming** tab of the **Administrative Settings** dialog and the **Location of user profile** text box of both the **Open User Profile** and the **Manage User Profiles** dialog boxes.

3. Set the **Network Location**. See the types of locations that the Roaming feature supports in Creating a network storage location for Master Roaming User Profiles.

4. If you are using a web server to store Master Roaming User Profiles, click the **HTTP Settings** and **SSL Settings** (if you are using HTTPS) button to set information about your HTTP and HTTPS connection and proceed with **HTTP Settings** and **SSL Settings** for further information. After entering the **HTTP** and **SSL Settings**, use the **Test Connection** button to make sure your settings are correct. For help troubleshooting a problem with the connection, see Testing and troubleshooting an HTTP connection.

5. Click **OK** in the **Roaming User Network Location** dialog box.

For more information on setting the location of the master Roaming User Profiles, see Roaming User Network Location.

**Note:** You cannot create a non-Roaming User Profile on an HTTP connection. You can only create Roaming User Profiles on an HTTP connection when the Roaming feature is enabled.

**Step 5: Set location of Local Roaming User Profiles**

When an end-user opens a Master Roaming User Profile, **Dragon** transfers a copy of that User Profile to the local computer. That local copy is called the Local Roaming User Profile. This is the location on the computer where changes made during a dictation session, such as corrections or new acoustic data, are stored before they are synchronized with the master Roaming User Profile.

You can set this location, called `<Roaming Local>`, from the **Administrative Settings** dialog box. Nuance recommends leaving this option at the default setting.
Chapter 6: Configuring and using the Roaming feature and Roaming User Profiles

Note: the location of <Roaming Local> is per-PC and cannot be changed to an end-user-specific location.

<Roaming Local>

To accept the default <Roaming Local> location (which Nuance recommends), click OK on the Administrative Settings dialog box. You will be prompted to create the default directory if it does not already exist. When you see the following message, click Yes.

The roaming user local directory you have chosen does not exist. Please either choose a different directory or create it. Would you like to create <Roaming Local>?

The default location of <Roaming Local> is:

- Windows 7, and Windows 8:
  C:\ProgramData\Nuance\NaturallySpeaking13\RoamingUsers\<display name>\n
See Dragon file structure for information about the default location of the RoamingUsers directory for Dragon NaturallySpeaking 13 on other Windows operating systems.

The <display name> is the name you defined for the Master Roaming User Profile location. You can have multiple network storage locations for your Master Roaming User Profiles and each has its own corresponding directory for Local Roaming User Profiles.

Changing the default location for <Roaming Local>

1. Use the Browse for Folder dialog box to open a location where you want to store the local Roaming User Profile. This is the location on the computer where changes made during a dictation session, such as corrections or new acoustic data are stored before they are synchronized with the master Roaming User Profile.
2. If the directory does not currently exist, click Make New Folder and type a name for the new folder. The new directory can have any name, but calling it something meaningful, such as Local Roaming User Profiles, will make the folder easier to find in the future.
3. Click OK.

Step 6: Set Roaming feature options

The Administrative Settings dialog box also contains several options that affect how the Roaming feature works. You select the options that indicate how you want a Roaming User Profile to function at each Roaming User Profile location. For a list of the options to choose from, refer to Selecting Roaming User Profile options.

Notes:

- Once you set up an installation of Dragon to use the Roaming feature, end-users on that computer can only open Roaming User Profiles; they cannot open any locally created User Profiles unless you choose the "Allow non-roaming user profiles to be opened" option. For a list of the options to choose from, refer to Selecting Roaming User Profile options.
- If an end-user is dictating with a Roaming User Profile, the Acoustic and Language Model Optimizer Scheduler is disabled on the local end-user's computer. You must run the Acoustic and Language Model Optimizer on the computer where your
Master Roaming User Profiles are located or on an administrator’s workstation. For more information, see Running the Acoustic and Language Model Optimizer with a Roaming User Profile.

**Administrative Settings: Roaming tab**

You use the *Roaming* tab of the *Administrative Settings* dialog box to set up the Roaming feature. You must set up the Roaming feature on each computer where you want end-users to dictate with a Roaming User Profile.

When Roaming is enabled in Administrative Settings by default the Open User Profiles dialog box displays large numbers of User Profiles quickly. They can also be organized into subfolders. See "Creating subfolders for Roaming User Profiles" in the Dragon Help for more information.

**Enable**

Select *Enable* to activate the Roaming feature and the Roaming User Profile options.

**Network Directories**

To set the location of the master Roaming User Profile(s):

1. Click the *Add* button. You use the *Roaming User Network Location* dialog box to define the network location of the master Roaming User Profiles. The location you pick must be accessible to all computers on the network that you want available for dictation with Dragon.

2. Set the *Display Name* and the *Address* under *Network Location*. The Roaming feature supports the following types of locations:

   - Mapped Drive—the format is: `<drive letter>:<\folder name>`. For example, `y:\roaming`.
   - UNC Path—the format is: `\servername\sharename\path\filename`.
   - HTTP (http:)—the format is: `http://myserver.com/<name_of_virtualdirectory>` where `<name_of_virtualdirectory>` is the name of the virtual directory set up by an administrator during setup of the IIS or Apache web site. For HTTP locations, click the *HTTP Settings* button to set information specific to your HTTP connection. You can also test your connection to the HTTP server from the *HTTP Settings* dialog box.

   - HTTP with SSL (https:)—the format is: `https://myserver.com/<name_of_virtualdirectory>` where `<name_of_virtualdirectory>` is the name of the virtual directory set up by an administrator during setup of the IIS or Apache web site. For HTTP with SSL locations, click the *SSL Settings* button to set information specific to your HTTP with SSL connection. You can also test your connection to the HTTP with SSL server from the *SSL Settings* dialog box.

**Local directory (for cache)**

When an end-user opens a Master Roaming User Profile, Dragon transfers a copy of that User Profile to the local computer. The local copy is called the Local Roaming User Profile.

You can change the setting of this location, always called `<Roaming Local>`.
The default location of <Roaming Local> is:
C:\ProgramData\Nuance\NaturallySpeaking13\RoamingUsers\<display name>\<username>

See Dragon file structure for information about the default location of the RoamingUsers directory for Dragon NaturallySpeaking13 on other Windows operating systems.

The <display name> is a name you assigned as a Master Roaming User Profiles location. You can have multiple network storage locations for your Master Roaming User Profiles.

The <username> is the name of an individual Master Roaming User Profile. There is a separate directory for each User Profile.

Click the Browse button to find or create a new location.

Check Boxes for Roaming User options

The check boxes and other components below the Local directory are the Roaming User options. You can also configure the Open User Profiles dialog box to display the Classic Open User Profiles dialog if desired. See Selecting Roaming User Profile options for details.

Restore Defaults

Returns the Administrative Settings dialog box to the state it had when you first installed Dragon. Note that the default is to have the Roaming feature turned off.

Notes: For use of WebDAV

- After you install Internet Information Services and WebDAV, you need to use the Internet Information Services Manager tool to set the “Allow Unknown MIME Types”, “Allow Custom Properties”, and “Allow Property Queries with Infinite Depth” settings to true. For example, in IIS 7:
For more information, see Configuring Internet Information Services and WebDAV for HTTP Roaming.

If you connected to your Roaming User Profile Master Directory over HTTP and you find that not all your User Profiles are listed in the Open User Profile dialog box, or after creating a Roaming User Profile you cannot open it again, or the Open User Profile dialog box does not display all the vocabularies and acoustic models for your User Profiles, make sure that you:

- Check that no files in your User Profile directory are locked, password protected, or otherwise access-restricted by your server permissions.

**Administrative Settings: Roaming User Network Location**

You use the Roaming User Network Location dialog box to define the network location of the master Roaming User Profiles.

The location you pick must be accessible to all computers where end-users will dictate using a Roaming User Profile.

**Display Name**

Sets the directory name displayed in the following locations:

- The Roaming tab of the Administrative Settings dialog box
- The Location of user profile drop-down list in the Open User Profile dialog box.
**Note:** With the Roaming feature enabled, the *Open User Profile* dialog box displays only User Profiles in the Roaming User Profile locations. To let the end-users open both local (non-roaming) and Roaming User Profiles, select the *Allow non-roaming user profiles to be opened* option on the *Administrative Settings* dialog box. Clearing this option prevents end-users from dictating with a non-roaming (local) User Profile by accident. For more information, see *Enabling the Roaming feature on each computer where an end-user will dictate.*

- The **Location of user profile** drop-down list in the *Manage User Profiles* dialog box.

**Network Location—Address**

On each computer where you plan to have users dictating as Roaming users, you must tell that installation of *Dragon* where the Master Roaming User Profiles are located.

The Roaming feature supports the following types of locations:

**Mapped Drives and UNC Paths**

Mapped drives connect to a shared network folder that has a drive letter assigned to it.

UNC paths connect to a shared network folder using the Universal Naming Convention (UNC) to locate a User Profile. The UNC is a way to identify a shared file on a computer or network without having to know the storage device it is on. The UNC path format is: `\servername\sharename\path\filename`.

To use a mapped drive or UNC path:

1. Under **Network Location**, enter the address of the mapped drive or UNC path.
   
   You can click Browse to browse for the location of the mapped drive or UNC path. This displays the Browse for Folder dialog box. You can also create a new directory on the mapped drive or UNC path by clicking the Make New Folder button.

2. Click **OK** when you are done.

**Intranet/Internet connections**

The Intranet/Internet connection supports both HTTP and HTTPS over an encrypted Secure Sockets Layer (SSL).

To use an Intranet/Internet connection:

1. Under **Network Location**, enter the URL address of your HTTP or HTTPS server where your master Roaming User Profiles are located.

2. Click

   - **HTTP Settings**...to display the *HTTP Settings* dialog box, where you can set information specific to your HTTP connection like Authentication, Firewall, and Proxy Server information. You can also test your connection to the HTTP server from this dialog box. For more information, see *HTTP Settings*.

   - **SSL Settings**...to display the *SSL Settings* dialog box, where you can set information specific to your HTTPS (SSL) connection. You can also test your connection to the HTTPS server from this dialog box. For more information, see *SSL Settings*.
Note: You cannot create a non-Roaming User Profile on an HTTP or HTTPS connection. You can create only Roaming User Profiles on an HTTP or HTTPS connection and only when the Roaming feature is enabled.

Setting up HTTP Connection: HTTP Settings

You use the HTTP Settings dialog box to define and configure the connection to your web (HTTP) server. Enter information about your connection in the following sections and text boxes of the dialog box:

Authentication

Passwords

Defines how an end-user that uses a Roaming User Profile enters the server username and password. This username/password is to the server, not a local login:

- **Prompt for User and Password**: Select if local end-users will be prompted for a username/password when they connect to the HTTP server.
- **User/password**: Sets the default username/password needed to connect to the HTTP server. Be sure to put the domain name followed by a backslash in front of the end-user login name; for example, Nuance\JWyman.

Authentication Type

Sets the type of authentication used on the HTTP server you specified as the Address in the Roaming User Network Location dialog box. Select the type that indicates how your server is configured:

- **Basic**: Choose if the server is configured for Basic authentication, where the username and password are passed over the network as clear text.
- **Digest**: Choose if the server is configured for Digest authentication, where the passwords are never transmitted across the internet in unencrypted form. Digest is not supported for IIS.

  Note: Digest authentication through a proxy server with Internet Information Server (IIS) 6.0 is not supported.

Note: For security reasons, be sure that anonymous logins are disabled on the HTTP or HTTPS server.

Connection

Follow Redirects

If you are storing the Master Roaming User Profiles on a server that redirects incoming connections to another location, you can define how Dragon handles these redirects:

- **Never**: redirects are never followed, but ignored.
- **Always**: redirects are always followed.
- **Same Scheme Only**: only redirects using the same scheme as the client request are permitted.

Keep Connection Alive

This setting tells the client and server to keep the connection alive after the current session ends.
Chapter 6: Configuring and using the Roaming feature and Roaming User Profiles

Firewall and Proxy Servers

Use Proxy Server

Select Use Proxy Server if you are connecting to your HTTP server through a proxy server.

Type

Select the type of firewall used on the HTTP server from the drop-down list:

- **HTTP Proxy**: Select for a proxy server that specializes in HTML (web page) transactions.
- **Tunnel**: Select if you are connecting to the server with tunneling software.
- **SOCKS4**: Select for a SOCKS4 protocol that relays TCP sessions at a firewall host to allow application end-users transparent access across the firewall. SOCKS4 doesn't support authentication, UDP proxy. SOCKS4 clients require full Domain Name Service (DNS).
- **SOCKS5**: Select for a SOCKS5 protocol that relays TCP sessions at a firewall host to allow application end-users transparent access across the firewall. SOCKS5 supports multiple authentication methods. SOCKS5 clients use the SOCKS5 server to perform the DNS lookup.

Server

Enter the server name provided by your network administrator.

Port

Enter the port number needed to connect to the proxy server or firewall.

User

Enter any username needed to log in to the proxy server or firewall.

Password

Enter any password needed to log in to the proxy server or firewall.

Firewall Data or Proxy Authorization

Enter any special authentication string provided by your network administrator.

Timeouts

Lock

Set to the number of seconds the server should wait before breaking the lock on any open Master Roaming User Profiles. Setting the lock to 0 uses the default setting from the server. Specifying another time overrides the server default. The administrator is responsible for breaking this type of lock.

A network locks prevent anyone from opening a Master Roaming User Profile that someone else has already opened. While this process does not take a long time, network problems can cause a lock to become “stuck” and not release when the opening process is completed. When this happens, the next time you try to open that User Profile, you see a message informing you of the lock.

The Administrator has to break the lock.
Connection

Number of seconds before Dragon should close the connection to the server either when the connection is idle or after the connection has been open for that duration.

Type

Sets when the connection timeout in the previous text box applies:

- **Inactivity**: Closes the connection after the Roaming User Profile is inactive for the specified time.
- **Absolute**: Closes the connection after the specified time independent of any Roaming User Profile network activity. Use this option with caution, as it could close the connection during synchronization.

Test Connection

Once you have filled in the information, you can click the Test Connection button to test the connection to the HTTP server.

Restore Defaults

Restores the default settings.

After you click OK, you return to the Administrative Settings dialog box.

Setting up secure web server connection: SSL Settings

You use the SSL Settings dialog box to define and configure the connection to your secure web (HTTPS) server. Enter information about your connection in the following sections and text boxes of the dialog box:

Certificate Store

Here you indicate the type of certificate that provides server identity, certificate, and public key information to clients that try to establish a connection:

Certificate Store Type

Select the certificate store type used for the client certificate on the local computer:

- **User (default)**: For Windows, choose if the certificate store is a certificate store owned by the current user. For Java, choose if the certificate store is the name of a JKS (Java Key Store) file. If the provider is OpenSSL, choose if the certificate store is a file that contains the PEM encoded certificate and private key.
- **Machine**: Choose if the certificate store is a machine store (not available in Java or when provider is OpenSSL).
- **PFX file**: Choose if the certificate store is the name of a Private Key Server or PFX (PKCS12) file containing certificates. If the provider is OpenSSL, the file may contain only one certificate and private key.
- **PFX Blob**: Choose if the certificate store is a string (binary or base64 encoded) representing a certificate store in PFX (PKCS12) format.
- **PEM Key**: Choose if the certificate store is a string or file name that contains a Privacy Enhanced Mail (PEM) encoded certificate and private key. This store type is currently not supported in Java.
Chapter 6: Configuring and using the Roaming feature and Roaming User Profiles

Certificate Store

The name of the certificate store for the client certificate on the local computer:

The storage location is called the certificate store. A certificate store will often have numerous certificates, possibly issued from a number of different certification authorities:

- **MY**: A certificate store holding personal certificates with their associated private keys.
- **CA**: A certificate store holding Certifying Authority (CA) certificates.
- **ROOT**: A certificate store holding ROOT certificates.
- **SPC**: A certificate store holding Software Publisher Certificate (SPC) certificates.
- **Other**: Any other Certificate Store not listed above.

Notes:

- If you select **PFX file** for the Certificate Store Type, for the Certificate Store select **Other** and enter the name of the file in the associated text box below it.
- If you select **PFX Blob** for the Certificate Store Type, for the Certificate Store select **Other** and enter the binary contents of a PFX file (for example, the PKCS12) in the associated text box below it.
- If you are using OpenSSL, for the Certificate Store select **Other** and enter the name of the file containing a certificate and a private key in the associated text box.

Certificate Store Password

The password for the Certificate Store on the local computer if one is required.

Open SSL

Select **Using OpenSSL** if the HTTPS server uses OpenSSL as a Certificate Authority. OpenSSL is a free non-commercial implementation of SSL.

When you select **Using OpenSSL**, you must provide:

- **Cipher List**: A string that controls the ciphers to be used by SSL. The cipher list consists of one or more cipher strings separated by colons.
- **Certificate Authority File**: Name of the file containing the list of certificate authorities (CAs) trusted by your application. The file set by this property should contain a list of CA certificates in PEM format.
- **CA Directory**: Path to a directory containing CA certificates. The path set by this property should point to a directory containing CA certificates in PEM format.

General

Use this section to enable/disable the supported security protocols on the HTTPS server.

- **TLS1**: Version 1 of the Transport Layer Security (TLS) protocol.
- **SSL3**: Version 3 of the Secure Sockets Layer (SSL) protocol.
- **SSL2**: Version 2 of the Secure Sockets Layer (SSL) protocol.
- **PCT1**: Version 1 of the Private Communications Transport (PCT) protocol.

Notes:

- Although a number of sites still support SSL2, Nuance recommends that you disable it because of potential security vulnerabilities.
If you select *Using OpenSSL*, this functionality is provided by the *Cipher List*.

**Test Connection**

Once you have filled in the information, you can click the *Test Connection* button to test the connection to the HTTPS (SSL) server.

**Restore Defaults**

Restores the default settings.

After you click *OK*, you return to the *Administrative Settings* dialog box.

**Testing and troubleshooting an HTTP connection**

Once you have supplied all the necessary information needed to connect to your HTTP server, press the *Test Connection* button. The *Test Connection* button tests the connection to your HTTP server based on the information you supplied in the Roaming User Network Location and HTTP Settings dialog boxes.

**Troubleshooting test connections**

The table below lists the possible messages you might receive after pressing the *Test Connection* button.
<table>
<thead>
<tr>
<th>Message</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connection test successful!</td>
<td>None—test successful.</td>
</tr>
</tbody>
</table>
| Could not connect to the network location                              | • Check spelling and syntax of the HTTP address in the HTTP Settings dialog.  
• Check your local network for problems. |
| Could not copy a file to the network location                          | • Check create and write privileges on the server  
• WebDav Server not installed or active. For more information, see Configuring Internet Information Services and WebDAV for HTTP Roaming. |
| Could not create a directory on the network location                   | • Check the create directory privileges on the server for the Master Roaming directory.  
• Check the privileges for creating sub-directories under the Master Roaming directory. |
| Could not delete a file from the network location                      | • Check permissions on the Master Roaming directory.  
• The end-user must have read, write, and modify privileges  
• Check that privileges are inherited in the sub-directories. |
| Could not delete a directory from the network location                 | • Check permissions on the Master Roaming directory.  
• The end-user must have read, write, and modify privileges  
• Check that privileges are inherited in the sub-directories. |
| Could not copy files into a directory created on the network location   | • Check permissions on the Master Roaming directory.  
• The end-user must have read, write, and modify privileges  
• Check for authentication time-out on your server.  
• Check your local network for problems. |
| Could not list the contents of a directory created on the network location | • Check permissions on the Master Roaming directory.  
• The end-user must have read, write, and modify privileges  
• Check that privileges are inherited in the sub-directories. |
<p>| Contents of newly created directory TempDir were incorrect             | • Caused by an incomplete directory listing. Try again. If the problem persists, check the condition of your network. |
| Could not copy a file from the network                                 | • Check permissions on the Local Master Roaming directory. |</p>
<table>
<thead>
<tr>
<th>Message</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Check that the Local Master Roaming directory exists.</td>
<td></td>
</tr>
<tr>
<td>MIME types not set to <em>.</em> (the file is .txt).</td>
<td></td>
</tr>
<tr>
<td>Check that the Local Master Roaming directory exists.</td>
<td></td>
</tr>
<tr>
<td>MIME types not set to <em>.</em> (the file is .txt).</td>
<td></td>
</tr>
<tr>
<td>Apache: Make sure DavDepthInfinity directive is set to &quot;on&quot; for Master Roaming directory.</td>
<td></td>
</tr>
<tr>
<td>Check permissions on the Master Roaming directory.</td>
<td></td>
</tr>
<tr>
<td>The end-user must have read, write, and modify privileges</td>
<td></td>
</tr>
<tr>
<td>Check that privileges are inherited in the sub-directories.</td>
<td></td>
</tr>
<tr>
<td>Check permissions on the Master Roaming directory.</td>
<td></td>
</tr>
<tr>
<td>The end-user must have read, write, and modify privileges</td>
<td></td>
</tr>
<tr>
<td>Check that privileges are inherited in the sub-directories.</td>
<td></td>
</tr>
<tr>
<td>Check permissions on the Master Roaming directory.</td>
<td></td>
</tr>
<tr>
<td>The end-user must have read, write, and modify privileges</td>
<td></td>
</tr>
<tr>
<td>Check that privileges are inherited in the sub-directories.</td>
<td></td>
</tr>
<tr>
<td>Check permissions on the Master Roaming directory.</td>
<td></td>
</tr>
<tr>
<td>The end-user must have read, write, and modify privileges</td>
<td></td>
</tr>
<tr>
<td>Check that privileges are inherited in the sub-directories.</td>
<td></td>
</tr>
<tr>
<td>Check permissions on the Master Roaming directory.</td>
<td></td>
</tr>
<tr>
<td>The end-user must have read, write, and modify privileges</td>
<td></td>
</tr>
<tr>
<td>Check that privileges are inherited in the sub-directories.</td>
<td></td>
</tr>
</tbody>
</table>

**Setting and selecting Roaming User Profile options**

The *Administrative Settings* dialog box also contains several options that you can choose from to indicate how you want a Roaming User Profile to function at each Roaming User Profile location.

These options can affect how much data is transferred across your network when the Master and Local Roaming User Profiles are synchronized. For more information, see Estimating Network traffic caused by synchronization and How Dragon Synchronizes Master and Local Roaming User Profiles.

**Roaming User Profile options on the Administrative Settings dialog box**

**Display Classic Open User Profiles dialog**

Enable this option to display the Classic *Open User Profiles* dialog box. The setting configures the *Open User Profiles* dialog box to display only folders that contain actual Dragon User Profiles in the *Location of User Profiles* box.

**Note:**

For faster performance at large sites with Roaming User Profile directories, Nuance recommends using the default appearance for the *Open User Profiles* dialog box. Displaying the Classic *Open User Profiles* dialog box takes longer because Dragon first
verify that directories contain valid Dragon User Profiles. Directory structures do not display with the Classic setting.

**Allow non-Roaming User Profiles to be opened**

Select this box to permit the end-user to open non-Roaming (local) User Profiles. Nuance recommends clearing this option to prevent anyone from dictating with a non-Roaming (local) User Profile by accident.

**Merge contents of vocdelta.voc into network user profile when file is full**

Select this box to copy the contents of the local *vocdelta.voc* file to the master Roaming User Profile without running the Acoustic and Language Model Optimizer.

If you do not set this option and if you have not run the Acoustic and Language Model Optimizer for a long time, the end-user will see a message when the vocdelta.voc file becomes full. If you do not run the Acoustic and Language Model Optimizer regularly, you should set this option to prevent end-users from seeing this message.

Vocdelta.voc is the file used to store vocabulary changes in the Master Roaming User Profile. It is updated whenever a Local Roaming User Profile is closed, and it is used to update the Local Roaming User Profile with vocabulary changes every time that a User Profile is opened. When you run the Acoustic and Language Model Optimizer on the Master Roaming User Profile, Dragon incorporates the contents of vocdelta.voc into the vocabulary (.voc) file and clears the content of vocdelta.voc.

If you check this setting, Dragon monitors the size of the *vocdelta.voc* file. When the *vocdelta.voc* file reaches 90% of its maximum size (500 KB), Dragon incorporates the contents of the vocdelta.voc file into the vocabulary (.voc) file and clears vocdelta.voc.

This operation occurs when the end-user opens the local Roaming User Profile. This operation can take a long time because the vocabulary file must be transferred over the network twice. Subsequently, opening the local Roaming User Profile on another workstation can also take a long time because the entire vocabulary file must be copied from the master to the local Roaming User Profile.

Selecting this option will transfer at maximum 500 KB, or 12 bytes/word across the network at synchronization if the Roaming and Local copies are different.

**Access network at user profile open/close only**

Select this box to synchronize changes made to the local Roaming User Profile to the Master Roaming User Profile only when a local Roaming User Profile opens or closes. If this box is not selected, then these local changes are immediately transferred to the Master Roaming User Profile. The only changes affected by this setting are the changes an end-user makes locally from the Options dialog box, therefore this setting is highly unlikely to have a perceptible impact on Dragon’s performance.

At synchronization, setting this option will copy approximately

- 21 MB of vocabulary files (*.voc).
- 240 MB of acoustic archive files create for each dictation session (acarchive.nwv and acarchive.enwv).

**Note:** These files are only copied from the Local to the Roaming User Profile; they are never copied from the Roaming User Profile to the local User Profile.

These files synchronize across the network when:
Vocabulary files - when the local end-user modifies the vocabulary with information from the Learn from specific documents, Learn from sent e-mails, or Vocabulary Optimizer dialogs or when the Roaming and Local copies are different.

Acoustic archive files - these files will be copied to session folder if it exists. Once the master voice_container limit is reached, nothing more is copied.

Ask before breaking locks on network user profiles (recommended for UNC and mapped drives)

Select this box to keep the option of maintaining or breaking a network lock when opening a Roaming User Profile. Normally, network locks prevent anyone from opening a Roaming User Profile at the same time someone else is opening that User Profile. While this process does not take a long time, network problems can cause a lock to become "stuck" and not release when the opening process is completed. When this happens, the next time anyone tries to open that User Profile, Dragon displays a message stating that the User Profile is locked and giving them the option of overriding it. If you do not want this message displaying and always want to break a network lock in this situation, you can clear this option to prevent the message from appearing. Because the presence of a lock can indicate a problem that needs to be addressed, Nuance recommends that you enable this option.

Notes:

- This option is valid for users connecting to the Master Roaming User Profile location using a mapped drive or UNC drive, but is not supported for users connecting over HTTP.
- Be careful when in breaking a locked Roaming User Profile. For example, if you break a lock when another end-user is writing to the Master Roaming User Profile, breaking the lock may corrupt the Master Roaming User Profiles.
- If an end-user opens a Roaming User Profile while the Acoustic and Language Model Optimizer is running on the Master Roaming User Profile, the end-user will see a message but can continue.

Set audio levels on each machine (recommended)

Select this box to run the Check your microphone option from the Accuracy Center window before your first session with a Roaming User Profile. This includes the Volume Check and the microphone Quality Check. Check this option if your users are dictating on different computers or on a single computer, like a laptop, in many different locations. When an end-user changes computers or locations, the audio setup data can vary depending on differences in the microphone and sound card, as well as differences in ambient sound levels of each Roaming User Profile location. In situations where Dragon detects a significant difference between operating systems, sound cards, microphones, or other hardware, the program will prompt you to run Check your microphone even if you do not have this option selected.

Save acoustic information

An end-user selects the Save acoustic information option to make sure that their acoustic information is saved along with their local User Profile. By saving the acoustic information, the end-user ensures that any corrections they make will be available after they close and re-open the User Profile. This option also makes sure that these corrections will be synchronized between the Local and Master Roaming User Profile if the end-user also enables the Always copy acoustic information to network option.
The Save acoustic information option is turned on by default.

**Prompt before saving to network location**

An administrator can set the **Prompt before saving to network location** option to let end-users choose where to save their User Profile. When an administrator enables this option, and an end-user attempts to close Dragon or turn off or log off the operating system, a dialog box appears that lets the end-user choose to save their profile locally or to the master network location. An end-user can save their profile locally if they are on a slow network. An end-user can save their profile to the master location to ensure any updates to their profile are available at other network locations.

**Copy Dragon Log to Network**

Select this box to copy the Dragon.log file from the local workstation to the master Roaming User Profile location whenever the program synchronizes the local and master Roaming User Profile. Dragon.log contains information that can help to diagnose problems that your users might encounter using Dragon.

**Note:** The Dragon.log file will not be copied once the maximum size is reached in the **Disk space reserved for network archive** option.

Selecting this option can increase how long it takes to close a Roaming User Profile. It can also limit the usefulness of the Acoustic and Language Model Optimizer because it reduces the amount of acoustic data that can be stored in the network archive. Nuance recommends that you not set this option unless requested by Nuance Technical Support.

Selecting this option will transfer 1 MB or less of data across the network at synchronization. These files are only copied from the Local Roaming User Profile to the Master Roaming User Profile; they are never copied from the Master Roaming User Profile to the Local Roaming User Profile.

**Always copy acoustic information to network**

Select this box to copy the User Profile’s acoustic model (.usr and .sig files) to the Master Roaming User Profile location.

If you chose not to copy the User Profile’s acoustic information to the network, updates to the acoustic model that you make on one computer (for example by correcting and training words) will not be available on other computers used by that particular Roaming User Profile until you run the **Acoustic and Language Model Optimizer** on the Master Roaming User Profile location and the Local and Master Roaming User Profiles synchronize. Therefore, if you do not run the **Acoustic and Language Model Optimizer** on the Master Roaming User Profiles regularly, you should set this option.

By always copying the acoustic information to the Master Roaming User Profile location, you ensure these accuracy improvements will be available when the Master Roaming User Profile is opened from another location. However, setting this option can increase the amount of time it takes to close a Roaming User Profile.

In Dragon NaturallySpeaking13, an end-user can set the **Save Acoustic information** option to control if Dragon saves the .usr and .sig files on each computer they dictate on. See "Controlling updates to the acoustic components of a User Profile" in Dragon - What's New for administrators for more information.
The transfer of acoustic information based on this option’s setting is not limited by setting the *Disk space reserved for network archive* option.

Setting this option will copy approximately 15 MB across the network at synchronization if the Roaming and Local copies are different.

**Conserve archive size on network**

Select this box to prevent copying of .DRA files (files that contain the acoustic data from the latest dictation session) to the Master Roaming User Profile location when the program synchronizes the Local and Master Roaming User Profiles. Leaving this box unchecked allows the local .DRA files to synchronize with the Master Roaming User Profile, which makes the .DRA files available to the *Acoustic and Language Model Optimizer* when it is run on the Master Roaming User Profile locations and provides increased accuracy.

However, because .DRA files can be large, if you experience excessive network slowdowns, checking this option may solve the problem by eliminating the copying of these files each time the Master and Local Roaming User Profiles synchronize. You can still run the *Acoustic and Language Model Optimizer* on the Master Roaming User Profile, but since it will not have the .DRA files to process, the accuracy gains will be less.

**Note:** The .DRA files will not be copied once the maximum size is reached in the *Disk space reserved for network archive* option.

At synchronization, setting this option will copy approximately 1.3 MB for each minute of dictation saved in the .DRA files. These files are only copied from the Local Roaming User Profile to the Master Roaming User Profile; they are never copied from the Master Roaming User Profile to the Local Roaming User Profile.

**Disk space reserved for network archive**

Use this option to specify the maximum size of the directory containing the acoustic data (the .dra and the log files) available to the *Acoustic Optimizer*. By default the archive size is 1000 MB per dictation source. To conserve space, you can reduce the default size and select the *Conserve archive size on network* option.

**Creating a Roaming User Profile on the local computer**

There are two ways to create a Roaming User Profile:

- Train a new Roaming User Profile
- Convert a non-roaming local User Profile into a Roaming User Profile

To open or create a Roaming User Profile, your local installation of *Dragon* must be configured for Roaming User Profiles. For more information, see Enabling the Roaming feature on each computer where an end-user will dictate.

**Notes**

- If you use a variety of microphones or input devices with your Roaming User Profile, see the topic: Using multiple dictation sources with a single User Profile.

- If you modify a master Roaming User Profile while you have a local Roaming User Profile open on a computer that is not currently connected to the network (for example, a laptop at a remote location), the changes to the master Roaming User Profile will overwrite any changes you make to the local Roaming User Profile when you
synchronize the local and master Roaming User Profiles.

- When an end-user that is using a Roaming User Profile exits Dragon, switches User Profiles, closes a User Profile, or saves a User Profile, Dragon saves changes to the Local Roaming User Profile and then synchronizes these changes with the Master Roaming User Profile on the network. For more information, see How Dragon Synchronizes Master and Local Roaming User Profiles

Creating and training a new Roaming User Profile

To create and train a new Roaming User Profile:

1. To display the Open User Profile dialog box, select Profile > Open User Profile on the DragonBar.

   **Note:** When the Roaming feature is enabled, end-users can create only Roaming User Profiles. The Location of user profiles field displays only the Roaming User Profile locations you defined in the Administrative Settings dialog box. To let the end-users create both local (non-roaming) and Roaming User Profiles, select the Allow non-Roaming User profiles to be opened option on the Roaming tab of the Administrative Settings dialog box. Clearing this option prevents User Profiles from being created with a non-roaming local User Profile by accident. For more information, see Enabling the Roaming feature on each computer where an end-user will dictate.

   If you allow end-users to open both non-roaming local and Roaming User Profiles, be sure they select the correct location from the Location of user profiles field.

   If there are multiple roaming profile locations, make sure each end-user selects the correct location from the Location of user profiles field.

2. Click New and begin training the User Profile as you would any other User Profile.
3. When you are finished training the User Profile, the program saves the User Profiles into the master Roaming User Profile location specified in the Location of user profiles field.

Converting a non-roaming local User Profile into a Roaming User Profile

You can convert an existing non-roaming local User Profile to a Roaming User Profile from the Manage User Profiles dialog box. Converting a non-roaming local User Profile copies that User Profile to the Master Roaming User Profile location.

To convert a non-Roaming User Profile to a Roaming User Profile:

1. Select Profile > Manage User Profiles from the DragonBar. This action displays the Manager User Profiles dialog box.
2. In the Location of user profile drop-down list at the bottom of the dialog box, select the non-roaming local location of your User Profiles. Now the list under User Profiles should include all the non-roaming local User Profiles that you can convert to Master Roaming User Profiles.
3. Select the non-roaming local User Profiles you want to convert to a Master Roaming User Profile.

4. Click the Advanced button and then select Copy to Roaming from the menu that pops up. The Copy to Roaming dialog box appears.

5. Under Select Roaming Master Location to save the user, select the appropriate Master Roaming User Profile location from the drop-down list. In the Choose sub-directory if wanted field, you can select a subdirectory within the Roaming Master location. When finished, click OK. A Master Roaming User Profile location appears in this list only if it is currently available to the local computer.

6. Repeat the process for any other non-roaming local User Profiles you want to convert to Master Roaming User Profiles.

**Dictating with a Roaming User Profile**

You dictate with a Roaming User Profile the same way you would with any other User Profile. For specific information about working with a Roaming User Profile, refer to the following topics:

- Opening a Roaming User Profile
- Using multiple dictation sources with a single User Profile
- Running the Acoustic and Language Model Optimizer for Roaming User Profiles
- Synchronizing Master and Local Roaming User Profiles

**Opening a Roaming User Profile**

When the Roaming feature is enabled, you can only open Roaming User Profiles (unless you set an option allowing speakers to open both Roaming and Local User Profiles).

To open a Roaming User Profile:

1. On the DragonBar, select Profile > Open User Profile.
2. On the Open User Profile dialog box, select a User Profile from the list, and click Open. If you do not see the User Profile you are looking for, press F5 to refresh the list of User Profile.

**Notes:**

- If you allow end-users to select both non-roaming local and Roaming User Profiles, make sure they select the correct location from the Location of user profiles drop-down list.
- When the Roaming feature is enabled, you can only open Roaming User Profiles. The Location of user profiles drop down list displays only the Roaming User Profile locations you defined in the Administrative Settings dialog box. To let the end-users open both local (non-roaming) and Roaming User Profiles, select the Allow non-Roaming User profiles to be opened option in the Administrative Settings dialog box. Clearing this option prevents end-users from dictating with a non-roaming local User Profile by
accident. For more information, see Enabling the Roaming feature on each computer where an end-user will dictate.

- If you connect to your Roaming User Profile Master Directory over HTTP or HTTP with SSL, and you find that the Open User Profile dialog box does not display all the vocabularies and acoustic models for your User Profiles, make sure that:

  The .INI extensions is registered in MIME types (ini.png) list of your IIS server.

  Add all file extensions within your Master Roaming User Profile directories and sub-directories to the Registered MIME types list of your IIS server. You could also add a wildcard (.*) MIME-type. For more information on adding a wildcard (.*) MIME-type, see:
  For Windows Server 2008:

  - The end-user’s topics.ini and acoustics.ini files are not locked, password protected, or otherwise access restricted by your server permissions.

Using multiple dictation sources with a single User Profile

It is possible to have a variety of dictation sources (audio input devices) for a single set of User Profiles so that the speaker can deploy various microphones or portable recording devices. This ability is especially useful with the Roaming feature. By allowing multiple dictation sources, you can still have the same User Profiles for each location regardless of the microphone type.

To add a new dictation source to a User Profile

1. In the Open User Profile dialog box, select the User Profile to dictate with the new dictation source.
2. Click the Source button and then click New. The New Dictation Source dialog box appears.
3. Select a new input device for dictation from the list on the New Dictation Source dialog box. You can choose from among different microphone or recorder types.
4. Click OK. You return to the Open User Profile dialog box.
5. Select the User Profile you just created and click Open. If you have not previously trained the User Profile with the new dictation source, the Profile Creation wizard appears and you can begin training.
Running the Acoustic and Language Model Optimizer for Roaming User Profiles

When the Roaming feature is enabled on a workstation, that workstation cannot run the Acoustic and Language Model Optimizer or the Acoustic and Language Model Optimizer Scheduler because the optimizer or scheduler can only be run on the Master Roaming User Profile. Later, any optimizations done by the Acoustic and Language Model Optimizer are copied to each Local Roaming User Profile when synchronization occurs.

The system administrator is responsible for running the Acoustic and Language Model Optimizer on the network location of the Master Roaming User Profiles. The administrator can install Dragon on the computer where the Master Roaming User Profiles are located or an administrator’s computer that has network access to the Master Roaming User Profiles and run the Scheduler for the Acoustic and Language Model Optimizer. If possible, the administrator’s workstation should be co-located with the server because a large amount of data needs to be transferred between the server and the workstation running the optimizer.

Note: You must have Windows Administrator privileges on the computer where you are running the Scheduler for the Acoustic and Language Model Optimizer.

Running the Acoustic and Language Model Optimizer on a multi-core computer

To make sure that corrections and accuracy improvements that end-users make are applied to their Roaming User Profile, an administrator should run the Acoustic and Language Model Optimizer on Roaming User Profiles only on a multi-core computer.

Running the Acoustic and Language Model Optimizer on a User Profile with two acoustic models

If the computer that an end-user dictates on meets certain system requirements, Dragon NaturallySpeaking 13 can use two acoustic models (instead of one) with a User Profile. Using two acoustic models instead of one increases recognition and dictation accuracy. Acoustic models that can be added in pairs to a User Profile are called Two-pass models.

See Using multiple acoustic models with a User Profile for more information.

To run the Acoustic and Language Model Optimizer to optimize Roaming User Profiles

1. Be sure that a copy of Dragon is installed on the computer where you plan to run the Acoustic and Language Model Optimizer. Also be sure that the Roaming feature is not enabled.

2. On the Windows Start menu, select Programs > Dragon NaturallySpeaking > Dragon NaturallySpeaking Tools > Acoustic and Language Model Optimizer Scheduler to start the Acoustic and Language Model Optimizer Scheduler.

3. Access the master directory of the Roaming User Profiles you want to optimize: select File > Set Speaker Directory from the menu of the Acoustic and Language Model Optimizer Scheduler window. In the Set User Profile Directory dialog box, either enter the path of the directory or click the Browse button. If the User Profiles you want to optimize
are located in multiple directories, you can change directories to locate the additional User Profiles.

4. Select the User Profile(s) you want to optimize and set a schedule for running the Acoustic and Language Model Optimizer. For specific instructions, click the Help button in the window.

Controlling access to User Profiles

If you have multiple Dragon end-users on an end-user workstation, those end-users will have multiple User Profiles to choose from in Dragon's Open User Profile dialog box.

If you use a shared directory for User Profiles, whether they are roaming or non-roaming, you may be concerned about the ability of an end-user to see and/or open another end-user's profile as well as their ability to open the correct profile. There are several ways to address this concern:

- Many of Nuance's customers address this concern simply through end-user training. Each end-user should be aware that if they open another end-user's profile and try to use it, their accuracy will be poor and end-user-specific customizations will not be available. Therefore, each end-user has an incentive to use only their own profile. However, this fact doesn't prevent a malicious end-user from damaging another end-user's profile.

- If end-users always log into Windows with a unique Windows user ID, you can use Windows file permissions to control access to the files. Typically, you do this by granting Full Control or Read/Write/Modify access to the shared directory, but do not allow this permission to propagate to sub-directories. That way, each end-user becomes the creator owner of any Dragon User Profile that he or she creates. End-users can still see all of the Dragon User Profiles in the Open User Profile dialog box, but if they try to select another end-user's profile, a message will appear saying that they do not have permission to access that profile. Apply similar file permissions to the local copy of each Roaming User Profile; the default location for local copies is under C:\ProgramData\Nuance\NaturallySpeaking13\RoamingUsers for Windows 7, Windows 8, and Windows Server 2008.

- If end-users log in using a shared Windows user ID, the best way to control access is through HTTP Roaming. In this configuration, you set up a web server running either IIS or Apache and with the WebDAV file system enabled. On each workstation, you specify a URL on the web server as the Roaming User Profile location. When an end-user launches Dragon, before displaying the Open User Profile dialog it prompts for a user name and password, which it uses to authenticate against the web server.

You can use file permissions on the web server to specify which User Profiles are accessible to each account on the web server. File security is a function of the web server and the WebDAV software.

Making it easier for end-users to select their User Profiles

As described above, the Dragon Open User Profile dialog shows a list of all of the User Profiles in a shared directory (unless you are using HTTP Roaming to limit access to User Profiles). If there are more User Profiles than will fit on one screen, you can train end-users to go directly to a specific User Profile by typing the first few letters of its name.
In Dragon NaturallySpeaking 13, you can display and view groups of User Profiles in a tree-style structure. See "Open User Profiles dialog box optimized for Roaming" in Dragon - What's New for administrators for more information.

**Notes:** For use of WebDAV

- After you install Internet Information Services and WebDAV, you need to use the Internet Information Services Manager tool to set the “Allow Unknown MIME Types”, “Allow Custom Properties”, and “Allow Property Queries with Infinite Depth” settings to true. For example, in IIS 7:

  ![WebDAV Settings](image)

  - For more information, see Configuring Internet Information Services and WebDAV for HTTP Roaming.
  - If you connected to your Roaming User Profile Master Directory over HTTP and you find that the Open User Profile dialog box does not display all the vocabularies and acoustic models for your User Profiles, make sure that you:
    - Check that no files in your User Profile directory are locked, password protected, or otherwise access-restricted by your server permissions.
Chapter 6: Configuring and using the Roaming feature and Roaming User Profiles

Configuring Internet Information Services and WebDAV for HTTP Roaming

Here we discuss how to configure Internet Information Services (IIS) and Dragon NaturallySpeaking 13 to allow you to use WebDAV shares as http roaming users profile locations.

You must perform two steps to use IIS and WebDAV for Dragon HTTP Roaming:

1. Configuring Internet Information Services and WebDAV
2. Configuring Dragon internet roaming

Configuring Internet Information Services and WebDAV

To run WebDAV, you must install Internet Information Services (IIS) 7 or greater on a server operating system such as Windows Server 2008.

In this section we discuss installing and configuring WebDAV on IIS 7.0.

Installing and configuring WebDAV on Internet Information Services 7.0

Internet Information Services 7.0 - Install WebDAV

1. Install WebDAV on the IIS 7 server. For more information, see http://technet.microsoft.com/en-us/library/cc431377.aspx

Internet Information Services 7.0 - Configuring WebDAV

1. Create a virtual directory that points to the Roaming User directory. For more information, see http://msdn.microsoft.com/en-us/library/bb763173.aspx
3. In the IIS Manager, select Default Web Site in the left pane.
4. In the main view, double-click WebDAV Authoring Rules.
5. Select WebDAV Settings.
6. In the WebDAV Settings page, under Authoring Behavior, set the Allow Unknown MIME Types property to True.
7. Under Property Behavior, set the Allow Custom Properties and Allow Property Queries with Infinite Depth properties to True.
8. Click Apply to save the changes.
9. Make sure that the files in your Roaming User Profile directory are not locked, password protected, or otherwise restricted for access by server permissions.

### Configuring Dragon internet roaming

Perform the following steps to configure Dragon internet roaming on all workstations.

2. Open the Administrative Settings dialog. On the Dragon Bar, select **Tools > Administrative Settings**.
3. In the Roaming tab, select **Enable**.
4. Click the **Add** button to add a new network location.
5. Set the Display Name and the Network Location. The Roaming User Network Location dialog box displays examples of what you can enter in the **Address** field.
   - For HTTP locations, you can click the **HTTP Settings** button to set information specific to your HTTP connection like Authentication, Firewall, and Proxy Server information. Nuance strongly recommends that you test your connection to the HTTP server from the HTTP Settings dialog box.
Upgrading Roaming User Profiles: Overview

This section describes how to upgrade Roaming User Profiles to Dragon NaturallySpeaking 13.

Since the Local Roaming User Profile is a copy of a subset of the end-user data taken from the master Roaming User Profile, an administrator cannot directly upgrade the Local Roaming User Profile when they upgrade the local Dragon installation to Dragon NaturallySpeaking 13.

See “Upgrading User Profiles to Dragon NaturallySpeaking 13” in Dragon - What's New for administrators for more information.

Notes:

- Upgrading a set of master Roaming User Profiles to Dragon NaturallySpeaking 13 leaves the current master Roaming User Profiles unchanged. Leaving the current files intact allows the users in the network to run the current installation of Dragon while the administrator plans the upgrade.

- You can upgrade from a variety of Dragon products to Dragon NaturallySpeaking 13. If you have custom vocabularies from other versions or editions of Dragon, you must recreate the custom vocabularies in Dragon NaturallySpeaking 13. See ‘Upgrading to Dragon NaturallySpeaking 13’ in What you should know before upgrading from a previous version for details.

- Plan to upgrade the master Roaming User Profiles at a time when User Profiles are not in use, for example during the night or on a weekend.

- Even though the Dragon NaturallySpeaking 13 User Profile Upgrade Wizard supports both mapped drives and UNC paths, Nuance strongly recommends that administrators upgrade the Master Roaming User Profiles on a drive on a computer where Dragon NaturallySpeaking 13 is locally installed. Nuance does not recommend that administrators upgrade the Master Roaming User Profiles across a network to either a mapped drive or UNC path; upgrading over a network will take an undetermined length of time. In addition, the User Profile Upgrade Wizard does not support upgrading User Profiles over an HTTP connection.

- If upgrading from Dragon version 10.x or earlier to Dragon NaturallySpeaking 13, version 10.x or earlier custom words and commands can be re-used in Dragon NaturallySpeaking 13:
  1. In Dragon 10.x or earlier, export the custom words and commands
  2. In Dragon NaturallySpeaking13, create a new User Profile
  3. In Dragon NaturallySpeaking13, import the custom words and commands

See the Dragon Help for information on exporting and importing custom words and commands.

Step 1: Preparing to upgrade Roaming User Profiles

To upgrade Master Roaming User Profiles from a previous version of Dragon, Nuance recommends that an administrator install Dragon NaturallySpeaking 13 directly on the network computer where the current Master Roaming User Profiles are located and
upgrade those Master Roaming User Profiles directly to Dragon NaturallySpeaking 13 Master Roaming User Profiles.

If an administrator is unable to install Dragon where the current Master Roaming User Profiles are located, Nuance recommends that the administrator:

- Install Dragon NaturallySpeaking 13 on a separate computer where the administrator will perform the upgrades.
- Copy the current Master Roaming User Profiles from the network location to the computer where Dragon NaturallySpeaking 13 is installed.
- Upgrade the current Master Roaming User Profiles on the computer where Dragon NaturallySpeaking 13 is installed.
- Copy the upgraded Dragon NaturallySpeaking 13 Master Roaming User Profiles to a network accessible directory on the original network location.

For more information, see Preparing to upgrade Roaming User Profiles.

Step 2: Upgrading the User Profiles

An administrator must separately upgrade the master Roaming User Profiles to Dragon NaturallySpeaking 13 using the User Profile Upgrade Wizard.

After an administrator upgrades the current Master Roaming User Profiles, they can then proceed to upgrade end-user systems that deploy the Roaming feature.

For more information, see Upgrading master Roaming User Profiles

Step 3: Upgrade the end-user systems

After an administrator upgrades the master Roaming User Profiles, they can then proceed to upgrade end-user systems that deploy the Roaming feature.

For more information, see Upgrading end-user systems.

**Preparing to upgrade Roaming User Profiles**

**Step 1: Install Dragon NaturallySpeaking13 on the computer where you upgrade Dragon 11.x or 12.x User Profiles**

Nuance recommends that administrators install Dragon NaturallySpeaking13 on the computer where the Dragon 11.x or 12.x Master Roaming User Profiles are located. If that is not possible, Nuance recommends that administrators install Dragon NaturallySpeaking13 on a separate computer where they will perform the upgrades.

For more information on installing, see Installing Dragon on a single computer.

**Notes:**

- If you are unable to install Dragon where the Dragon 11.x or 12.x Master Roaming User Profiles are located, Nuance recommends that you install Dragon NaturallySpeaking13 on a separate computer where you perform the upgrades. For more information, see Upgrading Roaming User Profiles: Overview.
- Version 10.x or earlier custom words and commands can be re-used in Dragon NaturallySpeaking13. See the Dragon Help for information on exporting and importing custom words and commands:
i. In Dragon 10.x or earlier, export the custom words and commands
ii. In Dragon NaturallySpeaking13, create a new User Profile.
iii. In Dragon NaturallySpeaking13, import the custom words and commands

Step 2: On the current Dragon end-user systems that use the Roaming feature

On the end-user systems where the end-users dictate using the Dragon 11.x or 12.x Roaming feature, save and close any open User Profiles on each Dragon 11.x or 12.x system that uses the Roaming feature.

Note: If there is no time when all the Roaming User Profiles are not in use (for example, in a hospital where some physicians use Dragon during a night shift), administrators can upgrade different groups of Roaming User Profiles at different times.

Step 3: On the central network storage location for the current Master Roaming User Profiles

1. (Optional) Back up the master Roaming User Profiles to a separate location, either by using any system backup utility that is implemented at your facility or by using the Dragon The Manage User Profiles dialog.

Note: You do not need to back up the Roaming User Profiles because the upgrade retains the current User Profiles in a directory that is separate from the Dragon NaturallySpeaking13 User Profiles.

2. Create a new directory on the shared network drive to store the upgraded Dragon NaturallySpeaking13 Master Roaming User Profiles. Although you can store the upgraded User Profiles in the same location as the current User Profiles — this would make two versions of each User Profile visible to the end-user and lead to confusion — Nuance recommend creating a location that is different from the location that stores the current (Dragon 11.x or 12.x) User Profiles.

Step 4: Copy the current Master Roaming User Profiles to the Dragon NaturallySpeaking13 client computer

If you install Dragon NaturallySpeaking13 on the computer where the Dragon 11.x or 12.x Master Roaming User Profiles are located, then proceed to Step 5 below.

If Dragon NaturallySpeaking13 is not installed on the computer where the Dragon 11.x or 12.x Master Roaming User Profiles are located, perform the following steps on the Dragon NaturallySpeaking13 client computer:

1. Create a directory to store all the Master Roaming User Profiles you plan to upgrade.
2. Copy the Dragon 11.x or 12.x Master Roaming User Profiles from the network location to the directory.

Step 5: On the administrator system where you plan to upgrade the Dragon 11.x or 12.x Master Roaming User Profiles

1. Start Dragon and make sure the Roaming feature is off.

To turn off the Roaming feature:
   i. Close any open User Profiles.
   ii. Click Administrative Settings on the DragonBar Tools menu. This action displays the Administrative Settings dialog box.
iii. On the Roaming tab, make sure Enable is not selected.

2. Close Dragon.
3. Follow the instructions in the next section, Upgrading master Roaming User Profiles.

See "Upgrading User Profiles to Dragon NaturallySpeaking13" in Dragon - What's New for administrators for more information.

**Upgrading master Roaming User Profiles**

You must use the User Profile Upgrade Wizard to upgrade master Roaming User Profiles to Dragon NaturallySpeaking13.

Before you proceed with the tasks in this topic, complete the procedure in Preparing to upgrade Roaming User Profiles.

After you upgrade the Dragon 11.x or 12.x Master Roaming User Profiles and optionally copy them back to their network location, you can proceed to upgrade your end-user systems that use the Roaming feature. For more information, see Upgrading end-user systems.

Step 1: Upgrade the Dragon 11.x or 12.x Master Roaming User Profiles

On the computer with the current Master Roaming files and where Dragon NaturallySpeaking13 is installed:

1. Select Start > Programs > Dragon NaturallySpeaking > Dragon NaturallySpeaking Tools > Upgrade User Profiles.
2. On the Select the profile(s) to upgrade page, click Browse to add a profile to select the location of the Dragon 11.x or 12.x Master Roaming User Profiles. The Select the profile(s) to upgrade page now displays a list of User Profiles in the selected directory:
Continue to add User Profiles from other local locations or use the **Remove from list** button to remove specific User Profiles. Click **Next** to continue.
3. If you choose to upgrade only one User Profile, the wizard displays the number of minutes the upgrade requires to complete the upgrade.

![User Profile Upgrade Wizard](image)

The following user profile will be upgraded:

**Profile1**

The estimated time to complete the upgrade is 12-24 minutes.

4. On the **Choose where to store the upgraded profile(s)** page, in the **Location for upgraded profile(s)** text box, choose the local location you previously created to contain the upgraded Dragon NaturallySpeaking13 master Roaming User Profiles. If a location is
not visible, click **Browse**, find the correct location, and click **Next**.

5. The **Begin profile upgrading** page displays the number of User Profiles that the wizard is prepared to upgrade. Click **Begin upgrading** to start the upgrade process. The upgrade process can take 12-24 minutes or more per User Profile, depending on the speed of the computer system and the speed of the network. Click **Stop** at any time to interrupt this process. The upgrade process creates new master Roaming User Profiles in the destination you selected.

6. Click **Finish** to complete the upgrading process and exit the **User Profile Upgrade Wizard**.

The **User Profile Upgrade Wizard** names each Dragon NaturallySpeaking13 master Roaming User Profile as follows: `<name> (v13.x)`. For example, Dragon copies and upgrades a Dragon 11.x Master Roaming User Profile with a filename of `roaminguser1` to `roaminguser1 (v13)`. Dragon does not change the name of the Dragon 11.x Master Roaming User Profile.

Do not store the Dragon 11.x or 12.x Roaming User Profiles in the same directory as the upgraded Dragon NaturallySpeaking13 Roaming User Profiles. The **Open User Profile** dialog box displays all the Dragon 11.x and 12.x profiles. A Dragon end-user may not be sure of the profile they should select for dictation.

**Step 2: Clean up the Dragon 11.x or 12.x locations for master Roaming User Profiles (optional)**

When the **User Profile Upgrade Wizard** modifies the Dragon 11.x or 12.x master Roaming User Profiles, it create a copy of the upgraded User Profile and does not change
the original profiles. This ensures the original profiles are available in case someone requires them.

An administrator can optionally rename or remove the Dragon 11.x or 12.x master Roaming User Profiles through the Manage User Profiles dialog box.

**Step 3: Copy the Dragon NaturallySpeaking 13 Master Roaming User Profiles to their network location (Optional)**

If you were unable to install Dragon NaturallySpeaking 13 where you store the Dragon 11.x or 12.x Master Roaming User Profiles, and you instead copy them to a different computer with Dragon NaturallySpeaking 13 installed, you must now copy the Dragon NaturallySpeaking 13 Master Roaming User Profiles back to the new network directory. This is the directory you created on their original network location.

You can skip this step if you installed Dragon NaturallySpeaking 13 on the computer where the Dragon 11.x or 12.x Master Roaming User Profiles are located and you upgraded those Master Roaming User Profiles directly to Dragon NaturallySpeaking 13.

**Step 4: Upgrade end-user systems to Dragon NaturallySpeaking 13**

After you upgrade the master Roaming User Profiles, you can upgrade the end-user systems that use the Roaming feature.

For more information, see Upgrading end-user systems.

### Upgrading end-user systems

After you upgrade the master Roaming User Profiles, you can upgrade the end-user systems that use the Roaming feature.

Before proceeding with this section, make sure you perform the procedure in Upgrading master Roaming User Profiles.

**Step 1: Upgrade systems that use the Roaming feature**

Since the User Profile Upgrade Wizard does not change or move the current master Roaming User Profiles, your current Dragon systems can continue to use the Roaming feature until you upgrade to Dragon NaturallySpeaking 13.

To upgrade a Dragon 11.x or 12.x system to Dragon NaturallySpeaking 13, follow the installation instructions under Installing Dragon on a single computer.

**Notes:**

- When prompted, choose to remove the Dragon 11.x or 12.x installation. If you choose not to remove the previous installation, you cannot continue to upgrade.

**Step 2: Enable the Roaming feature on the Dragon systems**

When you upgrade to Dragon NaturallySpeaking 13, the Roaming feature is off by default.

To turn on the Roaming feature, perform the following steps on each Dragon NaturallySpeaking 13 client computer:

1. Start Dragon.
2. Close all User Profiles.
3. Click Administrative Settings on the DragonBar Tools menu. This displays the Administrative Settings dialog box.


5. The Network Directories list displays the network location of the current master Roaming User Profiles.

   If you created a new network directory for the Dragon NaturallySpeaking 13 master Roaming User Profiles, you can either click the Add button to add the new network location or select a listed directory and then click Edit to change the path to the new location. When you have finished, click OK to close the Administrative Settings dialog box. You should also remove any Dragon 11.x or 12.x master Roaming User Profile directories that are not in use.

6. Select Profile > Open User Profile on the DragonBar. This action displays the Open User Profile dialog box. If you allow end-users to select both non-roaming local and Roaming User Profiles, make sure they select the correct location (the Dragon NaturallySpeaking 13 Roaming User Profile location) from the Location of user profile field.

7. Select a User Profile and click Open.

   Note: If you did not upgrade the Roaming User Profiles and store them in the new master Roaming User Profile directory, when you click Open, the User profile needs to be upgraded dialog box appears. Since you cannot upgrade Roaming User Profiles locally, you should click Cancel and return to Upgrading master Roaming User Profiles. If you click OK instead of Cancel, you receive a message stating You cannot upgrade a roaming user because you cannot upgrade Roaming User Profiles on a workstation where the Roaming feature is on.
Chapter 7: Using Dragon through a remote desktop connection

This section contains information on using Dragon through a remote desktop connection, including support for using the PowerMic II and Terminal Services.

You can connect to Dragon on a remote computer from the following client operating systems:

- Windows 7 (all editions), 32-bit and 64-bit
- Windows 8 (all editions), 32-bit and 64-bit

You can run Dragon on remote computers that run the following operating systems:

- Windows Server 2008 R2
- Windows 7 Ultimate and Enterprise
- Windows 8 Professional and Enterprise
- Windows Server 2012

Using Dragon through a remote desktop connection

This section provides information on how to deploy and use Dragon through a remote desktop connection.
<table>
<thead>
<tr>
<th>Tasks</th>
<th>Topic</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overview of how client users can remotely connect to Dragon running on a remote computer.</td>
<td>Overview of using Dragon on a remote computer through a remote desktop connection</td>
</tr>
<tr>
<td>Install Dragon on a remote computer and install the Dragon Client For Remote Desktop</td>
<td>Overview of configuring Dragon and the Remote Desktop connection feature</td>
</tr>
<tr>
<td>Set up the remote computer</td>
<td>Configuring the remote computer</td>
</tr>
<tr>
<td>Set up client computers by setting audio policies, roaming user directories, and the Remote Desktop Connection 7.</td>
<td>Configuring the Dragon client computer</td>
</tr>
<tr>
<td>System Requirements for running Dragon on a remote computer.</td>
<td>System Requirements for using Dragon through a remote desktop connection</td>
</tr>
</tbody>
</table>

**Overview of using Dragon on a remote computer through a remote desktop connection**

Remote computers that run the following Windows operating systems include the ability to enable audio redirection from a remote desktop connection:

- Windows Server 2008 R2
- Windows 7 Ultimate and Enterprise
- Windows 8 Professional and Enterprise
- Windows Server 2012

For Dragon NaturallySpeaking 13 users, this allows speech recognition to take place over the network when Remote Desktop Connection version 7 (or higher) is used to connect the Windows client to the remote computer.

End-users can connect to Dragon NaturallySpeaking 13 running on a supported remote computer from a workstation where Dragon is not installed. The workstation connects to the remote computer using Microsoft’s free Remote Desktop Connection, version 7 or higher. This provides bi-directional audio with:

- Windows Server 2008 R2
- Windows 7 Ultimate and Enterprise
- Windows 8 Professional and Enterprise
- Windows Server 2012

End-users can use Dragon NaturallySpeaking 13 on the remote computer with the same applications they use when Dragon runs on a workstation.

When Dragon NaturallySpeaking 13 is installed on:
Chapter 7: Using Dragon through a remote desktop connection

- Windows Server 2008 R2
- Windows 7 Ultimate and Enterprise
- Windows 8 Professional and Enterprise
- Windows Server 2012

Dragon detects when the RDC 7 client session starts and allows users to dictate into remote applications that are published on the remote computer.

A single installation of Dragon NaturallySpeaking 13 on Windows 7 Ultimate and Enterprise allows only one client connection at a time. A single installation of Dragon NaturallySpeaking 13 on Windows Server 2008 R2 allows multiple client connections at once. Keep this in mind, as well as server capacity and network bandwidth requirements, when you plan your configuration.

Benefits of using Dragon on a remote computer through a remote desktop connection

**Reduces administrative work:** You only need to install, configure, and administer Dragon on the remote computer instead of on multiple workstations. This reduces the amount of administrative work that needs to be performed.

**Eliminates the need for Citrix client and server software:** You no longer need to install Citrix software to enable multiple end-users to dictate into supported applications.

**Maintenance of audio quality:** The capacity and quality of audio is the same as when using Citrix.

**Reduces the need to upgrade workstations:** You can install and configure Dragon NaturallySpeaking 13 on a remote computer and avoid having to upgrade workstations that do not meet system requirements for Dragon NaturallySpeaking 13.

**Supported features**

All Dragon NaturallySpeaking 13 features are available to end-users that use Dragon on a remote computer through a remote desktop connection.

End-users can use Full Text Control with the same applications that are supported when Dragon NaturallySpeaking 13 is installed locally.

You should advise end-users to save their documents and dictation frequently in case network connectivity is lost, audio quality is degraded by low availability of network bandwidth, etc.

**Support for audio transmission between workstations and remote computers**

In order to transmit audio from the client computer to

- Windows Server 2008 R2
- Windows 7 Ultimate and Enterprise
- Windows 8 Professional and Enterprise
- Windows Server 2012

running Dragon NaturallySpeaking 13, you must:

- enable the audio recording option on the remote client software
- enable the audio recording redirection policy on the remote computer
Important notes

The number of concurrent end-users that can simultaneously use Dragon NaturallySpeaking 13 on a remote computer is determined by a number of factors, including disk space capacity and network bandwidth.

Installation of Dragon NaturallySpeaking 13 on a remote computer requires product activation to occur once. Afterwards, Nuance does not limit the number of end-users that can access and use a single remote computer-based installation of Dragon NaturallySpeaking 13.

For Citrix, administrators are responsible for configuring and troubleshooting remote computer-based issues, including WTS, that may affect the use of Dragon NaturallySpeaking 13.

Overview of configuring Dragon and the Remote Desktop connection feature

To enable audio redirection through a remote desktop connection, and allow users to connect and use Dragon on:

- Windows Server 2008 R2
- Windows 7 Ultimate and Enterprise
- Windows 8 Professional and Enterprise
- Windows Server 2012

you install software on the remote computers and on Dragon workstations. You can expect to spend around thirty minutes installing and configuring the required software.

Overview of configuring the remote computer

For more details, see Configuring the remote computer.

1. Install Dragon NaturallySpeaking 13 on one of the following systems:
   - Windows Server 2008 R2
   - Windows 7 Ultimate and Enterprise
   - Windows 8 Professional and Enterprise
   - Windows Server 2012
   See Installing Dragon on a single computer for more information.

2. On the system where you installed Dragon, install any applications that your end-users will use with Dragon NaturallySpeaking 13.

3. If using Windows Server 2008 R2:
   1. Install the Remote Desktop Services Role from the Server Manager Console (follow the steps in the Add Roles Wizard).
   2. Configure the Local Group Policy to allow connections from clients (run gedit.msc from a command prompt).
   3. Configure the server to allow connections from any version of Remote desktop (Control Panel > System > Remote Settings > Remote).

4. If using Windows 7 Ultimate or Enterprise or Windows Server 2012, configure the server to allow connections from any version of Remote desktop (Control Panel > System Properties > Remote).
5. If using Windows 8 Professional and Enterprise, configure the workstation to allow remote connections (Settings > System > Remote settings).

Overview of configuring the client computer

The following information applies to:

- Windows 8 (all editions)
- Windows 7 (all editions)

For more details, see Configuring the Dragon client computer.

1. **To use a smartphone device as a microphone** - Configure the Dragon Remote Microphone application on your iPhone to communicate with Dragon. Installing the Dragon Client for Remote Desktop software and using the Audio Setup wizard is not required for smartphones.

   **To use a non-smartphone device as a microphone** - On each client computer that will connect to Dragon on the server, install the **Dragon Client For Remote Desktop** on the client computer:

   1. Insert your Dragon DVD in your local computer’s DVD drive.
   2. In the **Dragon Client For Remote Desktop** folder, run setup.exe and follow the steps to install the software. The program group "Dragon Client For Remote Desktop" appears in your Windows program folders available from the Windows Start menu.
      
      **Note:** If you are installing Dragon Client for Remote Desktop using the MSI Windows Installer, run dragonclientinstaller.msi.
   3. Connect the microphone that you will use to dictate with Dragon.
   4. If your computer has multiple audio sources, make sure that your microphone is set as the Default recording.
   5. From the **Dragon Client for Remote Desktop** program group, run the Audio Setup Wizard to configure your microphone.
      
      **Note:** To use a smartphone or other supported wireless device as a remote microphone, do not use the Audio Setup wizard. See Set up a smart device as a microphone.

   2. In the Remote Desktop Connection, enable "Record from this computer".

**Dragon Client For Remote Desktop components**

The Dragon Client For Remote Desktop installation consists of two components that you install on the client computer:

- Audio Setup Wizard: a stand-alone application that provides a way to check that your microphone sound levels and signal quality are suitable for using Dragon NaturallySpeaking13 with a remote desktop connection.

**User Profiles and using Dragon through a Remote Desktop session**

1. To ensure that audio quality is acceptable, on the local workstation, connect the microphone and run the Audio Setup Wizard. **Note:** This is not part of
User Profile creation because the microphone and the Audio Setup Wizard are on the local workstation, not the remote computer.

2. From the workstation, connect to the remote computer.
3. Start Dragon.
4. Create a User Profile or open an existing profile. If you are creating a User Profile, you must perform a microphone test.

Notes:

- In the Windows Control Panel, you must set the audio source on the client as the default audio source.
- End-users can use User Profiles created on Dragon workstations without performing additional training on:
  - Windows Server 2008 R2
  - Windows 7 Ultimate and Enterprise
  - Windows 8 Professional and Enterprise
  - Windows Server 2012
- Nuance recommends that you create and train a User Profile (or add a dictation source to an existing User Profile) while Dragon is running in a Remote Desktop session.
- If an end-user already has a Dragon profile on a different machine, they can copy or import it to the remote computer so it can be accessed in Dragon there. For these profiles, we strongly recommend you run the Audio Setup Wizard locally before using the profiles with Dragon on the remote computer.

Troubleshooting tips

On the remote computer

After running the Remote Desktop Connection session on:

- Windows Server 2008 R2
- Windows 7 Ultimate and Enterprise
- Windows 8 Professional and Enterprise
- Windows Server 2012

Ensure that "Remote Audio" device is created on the server: In the Control Panel, select Sound settings > Recording).

In the Windows registry, under the registry key:

```
HKLM\SYSTEM\CurrentControlSet\Control\Terminal Server\WinStations\RDP-Tcp
```

verify that the value for "fDisableAudioCapture" is 0.

On a workstation

In Remote Desktop Connection, verify the Record from this computer option is enabled.
Chapter 7: Using Dragon through a remote desktop connection

Configuring the remote computer

1. Ensure the remote computer meets the system requirements. See System Requirements for using Dragon through a remote desktop connection for more information.

2. Make sure that the "Remote audio" recording device already exists on:
   - Windows Server 2008 R2
   - Windows 7 Ultimate and Enterprise
   - Windows 8 Professional and Enterprise
   - Windows Server 2012

3. If you are using Windows Server 2008 R2, perform the steps in Configuring Remote Desktop Connection for Windows Server 2008 R2.

4. If you are using:
   - Windows 7 Ultimate and Enterprise
   - Windows 8 Professional and Enterprise
   Perform the steps in Configuring Remote Desktop Connection for Windows 7 and Windows 8 that run Dragon.

5. Optionally, you can use Remote Application Manager to publish all applications and EMRs on
   - Windows Server 2008 R2
   - Windows 7 Ultimate and Enterprise
   - Windows 8 Professional and Enterprise
   - Windows Server 2012
   This provides full support for dictation and playback.


7. Proceed to Configuring the client computer to connect to Dragon through a remote desktop connection.

Configuring Remote Desktop Connection for Windows Server 2008 R2 Part 1

Perform the following steps to install and configure the Remote Desktop Services role.

1. Open Remote Desktop Connection.

2. Open the Server Manager.

3. Select Roles.
4. Select **Add Roles**.

5. On the **Before You Begin** screen, click **Next**.

6. On the **Select Server Roles** screen, select **Remote Desktop Services**, click **Next**.

7. On the **Remote Desktop Services** screen, click **Next**.
Chapter 7: Using Dragon through a remote desktop connection

8. On the **Select Role Services** screen, select **Remote Desktop Session Host**, click **Next**.

9. On the **Uninstall and Reinstall Applications for Compatibility** screen, click **Next**.
10. Select **Do not require Network Level Authentication**, click **Next**.

11. On the Specify Licensing Mode screen, click **Next**.
12. Click **Next**.
13. Select the **Audio and video playback** option and the **Audio recording redirection** option.
14. Confirm your selections, and click \textbf{Install}.

![Add Roles Wizard](image)

The \textit{Installation Progress} screen display the status of the installation.

15. On the \textit{Installation Results} screen, verify that the installation was successful. Click \textit{Close}.

16. Restart the computer.


### Configuring Remote Desktop Connection for Windows Server 2008 R2 Part 2

Perform the following steps to configure the local group policy on the server and to allow connections from client computers.

1. From a command prompt, run \texttt{gpedit.msc}.

2. Navigate to \texttt{Computer Configuration > Administrative Templates > Windows Components > Remote Desktop Services > Remote Desktop Session Host > Device and resource redirection}.

3. Enable the \textit{Allow audio and video playback redirection} option: on the \textit{Allow audio and video playback redirection} screen, select \textit{Enabled} and Press \textit{OK}.
4. Enable the **Allow audio recording redirection** option: on the **Allow audio recording redirection** screen, click **Enabled** and Press **OK**.

5. Launch **regedit** and set the following registry setting to **0**:
   
   ```
   HKLM\SYSTEM\CurrentControlSet\Control\Terminal Server-\WinStations\RDP-Tcp
   fDisableAudioCapture REG_DWORD 0x00000000
   ```

6. Open the Control Panel.

7. Navigate to **System and Security > System**.

8. Select **Remote**.

9. Enable the **Allow connections from computers running any version of Remote Desktop (less secure)** option.

10. Click **OK**.

11. Continue at step 5 in **Configuring the remote computer**.

### Configuring Remote Desktop Connection for Windows 7 and Windows 8 that run Dragon

The following steps are for configuring:

- Windows 7 Ultimate and Enterprise
- Windows 8 Professional and Enterprise

1. Open the Control Panel.
2. Open System Properties.
3. Click the Remote tab.
4. Enable the **Allow Remote Assistance connections to this computer** option.
5. Enable the **Allow connections from computers running any version of Remote Desktop (less secure)** option.

6. From a command prompt, run gpedit.msc.

7. Navigate to **Computer Configuration > Administrative Templates > Windows Components > Remote Desktop Services > Remote Desktop Session Host > Device and resource redirection.**

8. Enable the **Allow audio and video playback redirection** option.

9. On the **Allow audio and video playback redirection** screen, select **Enabled** and Press **OK**.

10. Enable the **Allow audio recording redirection** option.

11. On the **Allow audio recording redirection** screen, click **Enabled** and Press **OK**.

12. Launch regedit on and set the following registry setting to 0:
    HKLM\SYSTEM\CurrentControlSet\Control\Terminal Server\WinStations\RDP-Tcp\fDisableAudioCapture.
Chapter 7: Using Dragon through a remote desktop connection

Configuring the client computer to connect to Dragon through a remote desktop connection

After you install Dragon on a remote computer and Dragon Client for Remote Desktop on each client computer, perform the following steps on each client computer that will connect to Dragon on the remote computer.

1. Ensure the client computer meets the system requirements. See System Requirements for using Dragon through a remote desktop connection for more information.

2. On the client, plug in the microphone that you will use to dictate with Dragon. Then run the Audio Setup Wizard to check that microphone sound levels and signal quality are suitable.

3. Ensure Remote Desktop Connection 6.1 (RDC 6.1) or higher is installed on the client computer. If it is not, visit the following link to download Remote Desktop Connection 7.0 client update http://support.microsoft.com/kb/969084

4. When you start Remote Desktop Connection 7, in the Remote Desktop Connection dialog box, click Options.
5. Select the **Local Resources** tab, click **Settings**.

6. Select **Play on this computer** and **Record from this computer**, and click **OK**. Selecting these options enables audio support each time the end-user opens the remote con-
7. In the Windows sound settings, verify that Remote Audio device appears.
Updating earlier versions of Dragon to support audio redirection

As mentioned in other sections, whenever you create a new User Profile and want the ability to access Dragon with Remote Desktop Connection 7, you must perform short training.

Using the PowerMic II through a remote desktop connection

If you use the Nuance PowerMic II microphone to dictate with Dragon, the buttons will not work with Remote Desktop Connection 7 unless you customize button settings using the PowerMic II Button Control application. You use the PowerMic II Button Control application to assign the buttons for use in any application that accepts hotkeys, such as EMRs, audio recorders, etc. You do not need to start the Remote Desktop Connection to assign hotkey settings to the buttons.

Configuring the PowerMic II buttons

1. In Windows explorer, navigate to the folder that contains PMIIControl.exe. The default location of PMIIControl.exe is:
   C:\Program Files\Nuance\Dragon Client For Remote Desktop\PMIIControl.
2. Double-click PMIIControl.exe. The following screen appears:

3. Place your cursor in the text box under Button Pressed Key Sequence.
4. Enter the Windows keystrokes that will be sent to the remote computer when you press the microphone button, release the button, or press and release the button.

- **Button 1**: is set to send the sequence {Shift + Ctrl+D}, which is assigned to the Dragon desktop shortcut and will start Dragon. Simply pressing Button 1 starts Dragon; nothing happens when you let go of the button.

- **Button 2**: is set to simulate the Dragon Press-to-Talk button by pressing function key F3. Let’s say the administrator assigns F3 in Dragon as the hotkey setting for using Press-to-Talk: for a Remote Desktop Connection, the end-user must also set F3 in the PowerMic II Button Control application. In order for the microphone to turn off when the end-user lets go of Button 2, it is necessary to enable the Button Release Triggers Key Up checkbox. No additional key sequence is required for this type of usage.

- **Button 3**: is set to send two key sequences to simulate turning a feature on and off. For example, let’s say the end-user assigns {Ctrl+ P} and {Alt} to use to play and stop the audio playback feature. The same key sequences must be assigned to buttons in order for the feature to work with a remote desktop connection. This set of key sequences works differently from the example for Button 2, since the keystroke for the Button Released is defined explicitly by the user. It is not necessary to enable the Button Release Triggers Key Up checkbox, since the key sequence itself defines the action.
Chapter 7: Using Dragon through a remote desktop connection

Notes: Configuring the PowerMic II buttons

- If you type a letter key (A-Z), the system automatically adds "Ctrl+Alt" as a modifier.
- If you type a digit (0-9), the system adds "Shift+Alt" as a modifier.
- Support is present for the Ctrl and Alt modifiers for all keys; Shift can only be allowed with another modifier, followed by a letter or digit key. For example, you can assign "{Shift+Extended -}," but not "{Shift -}.
- It is not possible to assign key sequences for mouse control features, or map the predefined mouse buttons. However, you may modify the mouse speed by changing the Mouse settings in the Windows Control Panel.
- If you use the PowerMic II Button Control application on a computer where Dragon is installed, you will receive a warning if you try to assign a key sequence that is already assigned in Dragon.
- The PowerMic II Button Control application will not run if an installation of Dragon other than Dragon NaturallySpeaking13 is running on the local computer. In this case, the end-user will receive a warning.
- You can assign a key sequence for:
  - The Scan button, located on the under-side of the PowerMic II
  - The Tab and Enter keys

Keyboard keys you can assign to PowerMic II buttons

You can use the PowerMic II Button Control application to assign the following keyboard keys to the PowerMic II buttons:

- BACKSPACE
- DOWNARROW
- END
- ENTER
- ESC
- F1
- F10
- F11
- F12
- F2
- F3
- F4
- F5
- F6
- F7
- F8
- F9
- HOME
- INS
- LEFTARROW
- MINUSKeyPad
- PAGEDOWN
- PAGEUP
- PLUSKeyPad
- RIGHTARROW
- SLASHKeyPan
- STARKeyPad
- TAB
- UPARROW

System Requirements for using Dragon through a remote desktop connection

- **Dragon client:** Dragon NaturallySpeaking13, Dragon Professional or Legal.
- **Remote computer Operating System:**
  - Windows Server 2008 R2
  - Windows 7 Ultimate and Enterprise
  - Windows 8 Professional and Enterprise
  - Windows Server 2012

Window Server 2008 R2 supports multiple client connections at the same time. Windows 7 Ultimate and Enterprise only supports a single client connections at one time.

- **Software:** Remote Desktop Connection 7 (RDC 7). The RDC 7 download is available here, and works for all operating systems: [http://support.microsoft.com/kb/969084](http://support.microsoft.com/kb/969084) Optionally, you can use USB Redirector rather than RDC 7.

- **Client Operating System:** The following operating systems support Remote Desktop Connection 7 (RDC 7):
  - Windows 8 (all editions), 32-bit and 64-bit
  - Windows 7 (all editions), 32-bit and 64-bit

- **Client Hardware - CPU and RAM:**
  - Windows 8 (all editions): 1 GHz CPU and 1 GB RAM (2 GB if 64-bit)
  - Windows 7 (all editions): 1 GHz CPU and 1 GB RAM (2 GB if 64-bit)
  - Network card: 100 Mbps capable network card

- **Remote computer Hardware:** For Windows Server 2008 R2, to support 6 concurrent users connecting to Dragon, the minimum requirements are:
  - **Cache:** 1 MB L2 cache per CPU
  - **CPU:** 3.x Ghz
  - **Disk space:** 5 GB
  - **Processor:** Multi-core processor with 4 cores
  - **RAM:** 16 GB DDR2 RAM

For double the users, double the CPU cores and the RAM.
Chapter 7: Using Dragon through a remote desktop connection

- **Client Hardware**: Disk space: 8 MB
- **Dictation source**: End-users can use the same types of dictation sources as for a local installation of Dragon NaturallySpeaking 13.
  - **Nuance headset**: USB headset
  - **Other Headset**: Radio Frequency (RF) Headset, other USB Headsets. The RF Headset uses a USB dongle and may show up as a “regular” USB device option in Dragon.
  - **Analog-Headset**: For use with Mic-in / Audio-out jacks on the audio system, or a docking station.
  - **Mic Array**: Built-in or identified by the operating system.
  - **System default**: If none of the above dictation sources are detected, the system default is used. This includes: a built-in (single element) mic, a mic Array without APO capabilities, other USB (handheld or stick-mic), or a non-USB Bluetooth Mic paired directly with the system.
  - **Smartphones**: Apple iPhone 3GS and higher, Smartphones and tablets using Android OS 2.2 and higher. See Using a smart device as a microphone over VPN for details.

- **Network**:
  - 100 Mbps connection speed
  - Network bandwidth required per active end-user is 1.3 Mbps

Using Dragon NaturallySpeaking 13 on Windows Server 2008 R2, Windows 7 Ultimate and Enterprise, or Windows 8 Professional and Enterprise, or Windows Server 2012

- If you are using the Remote Application web interface - When you launch Dragon from the Remote Desktop Connection, if you launch the DragonBar in Docked-to-Top or Docked-to-Bottom mode, the Dragon menus will not be visible. To access the menus, you need to switch to work with Floating, Clinging, or the Tray Icon mode.

Using a smart device as a microphone over VPN

It is possible to use a VPN connection to dictate to Dragon on a remote computer using a supported smart device and the Dragon remote microphone application. For detailed VPN setup and access instructions, please contact your company’s IT department and refer to your device support.

- For iOS devices, see the Apple knowledge base article "iOS: Setting up VPN" - http://support.apple.com/kb/ht1424
- For Android-based devices, consult Google support.
- If you have problems using Bonjour over VPN, please use the barcode setup or manual setup. method. See the Dragon Help for details.
Chapter 8: Working with Web applications

This section contains information about support for Rich Internet Applications. Dragon includes browser extensions, also known as add-ons, for most Web-based applications, like Gmail and Hotmail. These extensions give you Full-Text Control in text fields, and enable spoken commands for important tasks.

About the Dragon Web Extension

The Dragon Web Extension allows you to use Full Text Control in supported browsers and most Web applications to help you perform common tasks by voice. For example, you can say ”Click Link”, ”Click Button”, or ”Click Inbox” to click the elements on the page. If you do not install the Dragon web extension, you cannot click page elements by voice. In addition, Full Text Control is not available for dictation in the browsers and Web applications. Without the Dragon web extension enabled, you’ll need to click Web page elements using your mouse and keyboard, and dictate content using the Dictation Box.
Browser requirements for the Dragon Web Extension

The Dragon Web Extension is available in the following Web browsers and versions:

- Microsoft Internet Explorer, version 9, 10, and 11, both 32-bit and 64-bit
- Mozilla Firefox version 24 and later
- Google Chrome

Important: The makers of Firefox and Chrome frequently release new versions of their browser. For the latest details on Dragon functionality with a particular application, please see the Technical Support page for Dragon on the Nuance web site.

If you don't have one of these browsers in the version listed, you cannot click page elements by voice. In addition, Full Text Control is not available in the browsers and Web applications. You'll need to click page elements manually (or using MouseGrid and mouse commands) and, if you want Full Text Control, you'll need to use the Dictation Box.

Feature support

The feature is not supported in the following modes:

- Internet Explorer’s Metro mode
- Chrome’s Incognito mode
- Chrome’s Metro mode
- Firefox’s Metro mode
Installing and enabling the Dragon Web Extension

To enable The Dragon Web Extension, do the following.

If you need to re-install, see here.

Internet Explorer 9 and later

1. Open Internet Explorer. A prompt appears the first time you open the browser after Dragon installation.

![Enable Dragon in Internet Explorer](image)

**Note:** If you click **No Thanks** at the initial prompt and then later decide to install the extension, you must close and reopen both Internet Explorer and Dragon for the prompt to reappear. If you select **Do not ask me again** and then later decide to install the extension, see **Do you need to reinstall?** below.

2. Click **Proceed**. Installation instructions appear.
3. Follow the instructions provided.

Mozilla Firefox 24 or later

1. Open Firefox. When a valid user profile is loaded, a prompt appears the first time you open the browser after Dragon installation.

![Enable Dragon in Firefox](image)

**Note:** If you click **No Thanks** at the initial prompt and then later decide to install the extension, you must close and reopen both Firefox and Dragon for the prompt to reappear. If you select **Do not ask me again** and then later decide to install the extension, see **Do you need to reinstall?** below.

2. Click **Proceed**. Installation instructions appear.
Install Dragon web extension for Firefox

Step 1
Click the button below to install the Dragon web extension for Firefox:

Install web extension

When you see this message, click "Allow".

When you see this message, click "Install Now".

Step 2 - Important!
You must now ensure that the Dragon Plugin is set to "Always Activate". Click the button below to view the plugin settings in a new tab. This screenshot shows the location of the setting.

Verify plugin settings

When you are done, you may close the Add-Ons Manager tab.
3. Click the **Install web extension** button, and then follow the instructions on the screen to install the web extension.

4. Click the **Verify plugin settings** button, and then follow the instructions on the screen to verify the plugin settings.

When you've installed the extension and plugin, ensure that the **Update Add-ons Automatically** option is selected to receive updates from Nuance. To select it:

1. Click the Firefox button, and then select **Add-ons**. The Add-ons Manager appears.

2. Click the cog icon, and then select **Update Add-ons Automatically** if it is not already selected.

---

**Google Chrome 16 or later**

1. Open Chrome. When a valid user profile is loaded, a prompt appears the first time you open the browser after you install Dragon.

---

**Note:** If you click **No Thanks** at the initial prompt and then later decide to enable RIA support, you must close and reopen both Chrome and Dragon for the prompt to reappear. In addition, if you select **Do not ask me again** and then later decide to install the extension, see **Do you need to reinstall?** below.
2. Click **Proceed**. The Chrome Web Store opens.

3. Click **Add**. A confirmation appears.
4. Click **Add**. Chrome downloads and installs the extension.

Do you need to re-install?

To use all of Dragon’s functionality in your browser, you must enable Dragon’s web extension. If you did not enable the extension, open the browser you want to install to use the following links while in that browser:

Internet Explorer: https://dnsriacontent.nuance.com/13/addons.html?lang=ENX&browser=ie


How to tell if the Dragon Web Extension is Enabled

To determine if the Dragon Web Extension is enabled:

Internet Explorer

1. Open Internet Explorer.
2. Click the cog icon, and then select Manage add-ons. The Manage Add-ons dialog box opens.
3. Look for the Dragon Web Extension and plugin and ensure the status is Enabled.

If the status is Disabled, do the following to enable it:
- Select the extension.
- Click Enable at the bottom of the Manage Add-ons dialog box.
- Restart the browser.

Mozilla Firefox

1. Open Mozilla Firefox.
2. Click the Firefox button or the Menu icon, and then select Add-ons. The Add-ons Manager appears.
3. Click Plugins and look for the Dragon NaturallySpeaking Plugin.
4. Click Extensions and look for the Dragon Web Extension.

In older versions of Firefox, the Enable option appears rather than Always Activate. Click the Enable button to enable it.

Google Chrome

1. Open Google Chrome.
2. Click the menu icon, and then select Settings. The Settings page opens.
4. Look for the Dragon Web Extension and ensure it is enabled.

If it is disabled, select the **Enabled** check box to enable it.

**Resolving problems**

If this is the first time you've tried using a supported web application with Dragon, try restarting your browser and reconnecting to the web application.

If you are using a Web application and browser that support the Dragon web extension, but the feature is not active, see "If you have problems using Web application support" in the Dragon Help.

If you can't use the Dragon web application, such as if you are using a Web application or browser that is not supported, you cannot click page elements by voice. In addition, Full Text Control is not available for dictation in the browsers and Web applications. Without the Dragon web extension installed and enabled, you'll need to click Web page elements using your mouse and keyboard, and dictate content using the Dictation Box.
Chapter 9: Customizing a User Profile

This section contains information on how you can add or remove the custom words, vocabularies, and commands for a User Profile.

Adding words, commands, or Vocabularies to User Profiles

You use the `nsadmin` utility or the `Data Distribution Tool` to make new words, customized Vocabularies, or new commands available to all User Profiles on a particular installation of Dragon. Both the `nsadmin` utility and `Data Distribution Tool` can work across a network.

The `nsadmin` utility lets you use the command line to make new words, commands, and Vocabularies available to users. The `nsadmin` utility can perform only one action at a time. However, you can create a batch file or script that can perform multiple `nsadmin` operations on a computer.

The `Data Distribution Tool` lets you use a GUI to interact with the `nsadmin` utility and make new words, commands, and Vocabularies available to users.

Note

You can use the `VocTool` to customize a Vocabulary by adding new words or optimizing the language model for a particular User Profile. For more information, see the `VocTool` Help.

Using the Data Distribution Tool

You can use the `Data Distribution Tool` to interactively make new words, customized vocabularies, or custom commands available to all users on a particular installation of Dragon.

You run the `Data Distribution Tool` on each installation of Dragon where you want the new words or vocabularies to be available to Dragon users.

This section describes:

- Creating the Data Distribution Directory
- Starting the Data Distribution Tool
Adding and removing custom words
- Adding and removing vocabularies
- Adding and removing custom commands

You can also run nsadmin from the command line. For more information, see Nsadmin utility for new words, vocabularies, and commands.

Creating the Data Distribution Directory

You create a data distribution directory to store word lists, commands, or both, that you plan to distribute to multiple users of Dragon NaturallySpeaking.

When word lists and commands are in the data distribution directory, as soon as a person opens their User Profile, Dragon automatically imports words and commands from the data distribution directory into the User Profile. This occurs regardless of the location of the computer the user dictates on.

You can use the Data Distribution Tool to put words and commands into a data distribution directory. For more information, see Starting the Data Distribution Tool.

**Note:** The default installation of Dragon places custom words for existing Dragon users in:

Windows 7/Windows 8
C:\ProgramData\Nuance\NaturallySpeaking13\Custom

Create a data distribution directory in a location other than the default location

Repeat the following steps for each workstation that should share the distributed words or commands.

1. In Dragon, close all open users.
2. On the network, create a directory and give all users that dictate with Dragon access to the directory. Grant read access to providers that dictate. Grant write access only to administrators.
3. If Dragon is running, on the New DragonBar or Classic DragonBar, select Tools > Administrative Settings. When the Administrative Settings dialog box opens, proceed to Step 6.
4. If Dragon is not running, select Start > Run. When the Run dialog box opens, in the Open text box, type the following, making sure to put a space between natspeak.exe and the /SetDefaultAdministrativeOptions option:

   "C:\ProgramFiles(x86)\Nuance\NaturallySpeaking13\Program\natspeak.exe"/setdefaultadministrativeoptions

   (The quotation marks are required because Program Files contains a space. Your path might not require quotation marks.)
5. Click OK.
6. When the Administrative Settings dialog box opens, if the user opens automatically, click Cancel to close the user or go to the DragonBar and select Profile > Close User Profile.
Chapter 9: Customizing a User Profile

7. Click the **Miscellaneous** tab.
8. In the **Data distribution location** text box, click **Change...** and browse to a location where you want Dragon to store custom words and commands.
9. Click **OK**.
10. Click **Apply** to save the changes.
11. Click **OK** to close the dialog box.

You can now use the **Data Distribution Tool** or the nsadmin command line utility to put new words and commands into the data distribution directory. For more information, see **Starting the Data Distribution Tool** or **Starting the nsadmin command line utility**.

**Starting the Data Distribution Tool**

You can use the **Data Distribution Tool** to make new words, customized vocabularies, or new commands available to all Dragon users on a particular installation of Dragon.

You can run the **Data Distribution Tool** on a local machine or through a network connection. The tool supports both mapped drives and UNC paths.

Before you use the **Data Distribution Tool**, you must create a data distribution directory. For more information, see **Creating Data Distribution Directory**.

**Start the Data Distribution Tool**

A default installation of Dragon stores custom commands for Dragon users in:

**Windows 7/Windows 8:**

\ProgramData\Nuance\NaturallySpeaking13\custom\<language>

1. Select **Start > All Programs > Dragon NaturallySpeaking > Dragon NaturallySpeaking Tools > Data Distribution Tool**. Dragon displays the first page of the Data Distribution wizard (in Windows 8 the Data Distribution Tool can be started from the Apps screen).
2. Select one of the following options:
   - Add or remove base vocabularies
   - Add or remove shared commands
   - Add or remove word to share across vocabularies
3. Click **Next**.
4. Click the **Advanced** button to set the location where the local installation of Dragon stores customized words and commands.

**Adding and removing custom words**

You can use the **Data Distribution Tool** to make new words available to all user profiles on a particular installation of Dragon.

Before you use the **Data Distribution Tool**, you must create a data distribution directory. For more information, see **Creating Data Distribution Directory**.
You must first either export words from an existing user profile or create a text file of custom words (for example, a list of new drug names) before you can distribute them to a different installation of Dragon.

After you use nsadmin to import the custom words, you must close your user profiles, re-open them, and save them for the changes to become available.

Create a text file that contains custom words

1. Create a text file.
2. At the top of the text file, add @Version=Plato-UTF8.
3. In the text file, add each word or phrase that you want to add to the vocabulary. Make sure each word or phrase uses correct spelling and is on a separate line. Each line can only contain a maximum of 99 characters (written and spoken combined).
4. If you have Dragon installed on another computer, you can use it to create custom words and export the words to a .txt file. See "To export a list of custom words or phrases" in the main Dragon Help file.

Notes:

- Type the written form of the word first.
- To add a multiple-word phrase, such as "Mayberry Tribune", type it on one line.
- To add a spoken form of a word, type the word, followed by two backslashes \, and the spoken form of the word. For example, to have Dragon enter "Robert F. Kennedy" when you say "RFK", in the text file, type Robert F. Kennedy\RFK.

Add custom words to a shared location

When you use nsadmin, you can enter paths as complete local paths, relative paths, mapped network drives, a UNC path, or the path to removable media such as a CD-ROM or ZIP drive. For more information, see Using paths with nsadmin.

You must create .txt file (new words.txt in the following examples) that contains custom words before you perform the following steps. For more information, see Create a text file that contains custom words.

1. If you have not already created it, create the data distribution directory. For more information, see Creating Data Distribution Directory.
2. On each computer that a user uses for dictation, map a network drive to the location of the data distribution directory. As an alternative, you may reference the network UNC address of the location of the nsadmin utility.
3. Start the Data Distribution Tool. For more information, see Starting the Data Distribution Tool.
4. In the Data Distribution Tool, make the appropriate selections to add the list of words to the data distribution directory. For more information, see Use the Data Distribution Tool to add custom words.

Use the Data Distribution Tool to add custom words

If you add custom words to a Commands Only vocabulary, when you upgrade a user, the upgrade process does not retain the custom words. In general, you should not add custom words to a Commands Only vocabulary.
1. On the Data Distribution Tool, select **Add or remove words to share across vocabularies.**

2. (optional) To choose a location for the custom words on the local machine, click **Advanced.** In the Custom directory text box of the Advanced Settings dialog box, type the path to the new location for the custom words. If you do not take this step, Dragon copies the files to the following default location: C:\ProgramData\Nuance\NaturallySpeaking13\Custom\enx

3. Click **Next.**

4. Associate a language with the custom words.

5. Click **Next.**

6. When the list of files appears, use the Import button to select the .txt files that contain custom words. To view the content of a file, select the file and click View. To remove a file from the list of files, select the file and click **Remove.** To remove all files from the list, click **Remove All.**

   **Note:** Once you add a text file that contains custom words to the data distribution directory, and a user opens the file, you cannot use the **Remove** and **Remove All** buttons to remove the custom words.

7. Click **Next.** The Data Distribution Tool displays a log of the operations it performs.

8. Click **Finish** to re-display the first page of the Data Distribution Tool or click **Cancel** to exit.

**Adding and removing vocabularies**

You can use the Data Distribution Tool to make a customized vocabulary available to all users on a particular installation of Dragon. For example, you can use the Data Distribution Tool to copy a user's vocabulary and set it as the base vocabulary on any installation of Dragon. After you add a base vocabulary to an installation of Dragon, new users you create can use that vocabulary.

**Notes**

- The default installation of Dragon places vocabularies for existing Dragon users here: C:\ProgramData\Nuance\NaturallySpeaking13\Users\<user_name>\current
- Vocabulary files end with the *voc extension.
- If you create a User Profile on a dual core machine that uses a custom vocabulary, make sure that the User Profile uses the BestMatch V speech model (BestMatch V has the greatest recognition accuracy on dual-core systems with more than 2 GB of RAM). To check this, select the Advance button on the Creating a User Profile screen of the New User Profile wizard and make sure that BestMatch IV is selected.
- You cannot use a custom vocabulary created in Dragon 10.x or earlier with Dragon NaturallySpeaking 13. You must recreate the custom vocabulary in Dragon NaturallySpeaking 13. If you have a custom vocabulary from a Nuance VAR, you should contact the VAR to obtain a new version of the vocabulary.
Prepare to use the Data Distribution Tool to add a vocabulary

1. If you have not already created it, create the data distribution directory. For more information, see Creating Data Distribution Directory.

2. On each computer that a user uses for dictation, map a network drive to the network location of the data distribution directory.

3. Start the Data Distribution Tool. For more information, see Starting the Data Distribution Tool.

4. In the Data Distribution Tool, add the vocabulary to the data distribution directory. For more information, see Adding a vocabulary.

Use the Data Distribution Tool to add a vocabulary

1. In the Data Distribution Tool, select Add or remove base vocabulary.

2. Click Next.

3. Click Add to add a Base Vocabulary. Dragon displays the Add Base Vocabulary dialog.

4. In the Add Base Vocabulary dialog box:
   - Give the vocabulary a name. The name should describe the content of the vocabulary, such as Astronomy or Marketing.
   - Select the location of the vocabulary, either a mapped drive or a UNC address.
   - Give the vocabulary an unique numeric ID. Use a value greater than 9000 for the topic ID parameter.

5. Click OK.

The next time you open a user, Dragon automatically updates the user’s vocabulary.

Use the Data Distribution Tool to add an exported vocabulary

You can use the Data Distribution Tool to distribute a vocabulary that you create using a separate installation of Dragon. A Dragon vocabulary that you export saves as a group of files.

One of the exported files has a .top file extension, the other files have .to* file extensions, where * is an integer.

In a command prompt, provide the path to the file with the .top file extension as an argument to the nsadmin utility. Do NOT include the .top file extension on the command line.

The following command adds the myvoc exported topic (myvoc.top) as a new base vocabulary:

```
<PATH>\nsadmin /vocabulary D:\MyDocuments\myvoc "US English | Large | Nuance" 9005
```

Use the Data Distribution Tool to add or remove a base vocabulary

Use the Data Distribution Tool to add a base vocabulary

1. In the Data Distribution Tool, select Add or remove base vocabulary.

2. Click Next. Dragon displays the existing base vocabularies by ID and username.
3. Click **Add**.
4. Click **Browse** and navigate to the location where your vocabulary is stored.
5. Provide a unique ID for the vocabulary, and click **OK**.
6. Click **Next**. The Data Distribution Tool displays a message when it adds the vocabulary.
7. Click **Finish** to close the **Data Distribution Tool** or click your browser’s back button to re-display the screen.

**Use the Data Distribution Tool to remove a base vocabulary**

1. In the **Data Distribution Tool**, select **Add or remove base vocabulary**.
2. Click **Next**. Dragon displays the existing base vocabularies by ID and username.
3. Select the vocabulary to delete.
4. Click **Remove** and then click **Next**. The **Data Distribution Tool** displays a message when it deletes the vocabulary.
5. Click **Finish** to close the **Data Distribution Tool** or click your browser’s back button to re-display the screen.

**Adding and removing custom commands**

Custom commands are voice commands that you can create and modify to enter text, insert graphics, or activate menus and keystrokes in any application. You can use the **MyCommands Editor** to create custom commands or the **Command Browser** to modify custom commands.

You can use the **Data Distribution Tool** to copy a set of custom commands to the data distribution directory and make the set of custom commands available to all users at a particular installation of Dragon.

Before you use the **Data Distribution Tool**, you must have already created a data distribution directory, as explained in Creating Data Distribution Directory.

**Notes**

- The default installation of Dragon places custom commands for existing Dragon users here:
  - In Windows 7/Windows 8
    - `C:\ProgramData\Nuance\NaturallySpeaking13\custom\<language>`
  - After you import the custom commands to Dragon, for the changes to become available to those users, you must close your users, then re-open and save the users.
  - You can enter a path as a complete local path, a relative path, a mapped network drive, a UNC path, or the path to removable media, such as a DVD, CD, or ZIP drive. For more information, see Using paths with nsadmin.

**Prepare to use the Data Distribution Tool to export custom commands**

1. In Dragon, create custom commands.
2. Use the **Command Browser** to export the custom commands to a .dat file, for example, `NewCommands.dat`.
3. If you have not already created it, create the data distribution directory. For more information, see Creating Data Distribution Directory.
4. On each computer that a user uses for dictation, use the **Data Distribution Tool** to add the `.dat` file to the data distribution directory. For more information, see Adding custom commands.

Use the Data Distribution Tool to add custom commands

1. Start the **Data Distribution Tool**. For more information, see Starting the Data Distribution Tool.
2. In the **Data Distribution Tool**, select **Add or remove shared commands**.
3. Click **Next**.
4. Select the languages for the User Profile that you will add custom words to.
5. Click **Next**.
6. Use the **Import** button to select the `.dat` files that contain the custom commands to add. Place the `.dat` files into the **New shared commands** list in the upper half of the dialog box. You can modify the list by selecting particular file names and using the **Remove** and **Remove All** buttons.
7. Click **Next**. The **Data Distribution Tool** displays a log of all the operations it performs.
8. Click **Finish** to re-display the **Data Distribution Tool** main screen or click **Cancel** to exit.

The next time you open a user, **Dragon** updates the commands in the associated User Profile.

Use the Data Distribution Tool to remove shared commands

1. In the **Data Distribution Tool**, select **Add or remove shared commands**.
2. Click **Next**.
3. Select the languages for the User Profile that you will remove words from.
4. Click **Next**.
5. In the **Existing shared commands** list, select the command.
6. Click **Remove**.
7. Click **Next**. The **Data Distribution Tool** displays a log of all operations it performs.
8. Click **Finish** to re-display the **Data Distribution Tool** main screen or click **Cancel** to exit.

Nsadmin utility for new words, Vocabularies, and commands

**Dragon** Professional, and **Dragon** Legal include the `nsadmin` utility. The `nsadmin` utility is a command line utility that lets you make new words, customized Vocabularies, and new commands available to all users on a particular installation of **Dragon**.

The `nsadmin` utility performs only one operation at a time. You can write a batch file or script to execute multiple `nsadmin` operations on each computer.

For step-by-step instructions on using the `nsadmin` utility, see the following topics:

- Creating the Data Distribution Directory
- Starting the nsadmin command line utility
- Adding custom words from a command line
- Adding and removing custom Vocabularies from a command line
- Adding custom commands from a command line

You can use the Data Distribution Tool to run the nsadmin utility from a GUI. For more information, see Starting the Data Distribution Tool.

**Starting the nsadmin command line utility**

You can use the nsadmin utility on a command line to make new words, vocabularies, or commands available to users.

The nsadmin utility performs only one operation at a time. However, you can write a batch file or script to execute multiple nsadmin operations on a computer. You can place the network location of new words or vocabularies in a script and run the script from a client machine to copy the new functionality to the machine.

You can find the nsadmin.exe file in the \Program directory under the parent Dragon installation directory. The default installation directory for Dragon is C:\Program Files\Nuance\NaturallySpeaking13\Program.

The nsadmin utility supports both mapped drives and UNC paths. For more information, see Using paths with nsadmin.

Before you can use the nsadmin utility, you must create a data distribution directory. For more information, see Creating Data Distribution Directory.

Start the nsadmin utility

1. Select Start > All Programs > Dragon NaturallySpeaking > Tools > NSAdmin

nsadmin starts in a DOS window and lists the nsadmin syntax.

Display help information for the nsadmin utility

1. From a command prompt, type nsadmin/?

Command line syntax for the nsadmin utility

The nsadmin.exe utility uses the following syntax.

```
nsadmin <operation> <parameters> [options]
```
Adding custom words from a command line

You can use `nsadmin` to make new words available to all users on a particular installation of Dragon.

You must first either create a text file or export words from an existing user’s installation of Dragon before you can distribute the words (for example, a list of new drug names) to a different installation of Dragon.

After you use `nsadmin` to import the custom words, you must close your users, re-open the users, and save them for the changes to become available.

Create a text file that contains custom words

1. Create a text file.
2. At the top of the text file, add `@Version=Plato-UTF8`.
3. In the text file, add each word or phrase that you want to add to the vocabulary. Make sure each word or phrase uses correct spelling and is on a separate line. Each line can only contain a maximum of 99 characters (written and spoken combined).
4. If you have Dragon installed on another computer, you can use it to create custom words and export the words to a .txt file. See "To export a list of custom words or phrases" in the main Dragon Help file.

Notes:

- Type the written form of the word first.
- To add a multiple-word phrase, such as "Mayberry Tribune", type it on one line.
- To add a spoken form of a word, type the word, followed by two backslashes \\, and the spoken form of the word. For example, to have Dragon enter "Robert F. Kennedy" when you say "RFK", in the text file, type Robert F. Kennedy\\RFK.
Chapter 9: Customizing a User Profile

Export words from a Dragon installation

If you have Dragon available on another machine, you can use it to create custom words and export the words to a .txt file. For more information, see "To export a list of custom words or phrases" in the main Dragon Help file.

Add custom words to a shared location

When you use nsadmin, you can enter paths as complete local paths, relative paths, mapped network drives, a UNC path, or the path to removable media such as a CD-ROM or ZIP drive. For more information, see Using paths with nsadmin.

Perform the following steps after you create a text file that contains custom words or after you export words from an installation of Dragon:

1. If you have not already created it, create the data distribution directory. For more information, see Creating the Data Distribution Directory on page 241.

2. On each computer that a user uses for dictation, map a network drive to the location of the data distribution directory. As an alternative, you may reference the network UNC address of the location of the nsadmin utility.

3. In a command prompt, type a command to add the custom words from the .txt file. The following command copies the NewWords.txt file to the

   In Windows 7/Windows 8
   C:\ProgramData\Nuance\NaturallySpeaking13\Custom\Enx\NewWords.txt
directory:

   <PATH>\nsadmin /words G:\NsAdmin\NewWords.txt

The next time you open a user, Dragon automatically updates the user’s words to include the words from the .txt file.

Use the command line to overwrite a custom word file

1. Use the /overwrite option to overwrite an existing custom word file. If the custom word file already exists in the ProgramData\Nuance\NaturallySpeaking13\Custom\enx directory, Dragon overwrites it without prompting you.

   The following command overwrites the NewWords.txt custom word file:

   <PATH>\nsadmin /words G:\NsAdmin\NewWords.txt /overwrite=yes

Note

If you add custom words to a Commands Only vocabulary, Dragon does not retain those words if you upgrade the user at a later date. In general, you should not add custom words to a Commands Only vocabulary.
Adding and removing custom Vocabularies from a command line

You can use **nsadmin** to make a customized Vocabulary available to all users on a particular installation of *Dragon*. For example, you can use **nsadmin** to copy a user's Vocabulary and set it as the base Vocabulary on any installation of *Dragon*. After you add a base Vocabulary to an installation of *Dragon*, new users you create can use that Vocabulary.

The **nsadmin** command uses the following syntax:

```
(PATH>\nsadmin /vocabulary <directory> "<language or dialect> | <model name> | <category>" <topic_ID>
```

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;language or dialect&gt;</td>
<td>Links a Vocabulary to a language. For example, <em>US English</em> or <em>UK English</em> for an English install. The language or dialect must exist in the version of <em>Dragon</em> on the computer.</td>
</tr>
<tr>
<td>&lt;model_name&gt;</td>
<td>Specifies the size of the Vocabulary you are importing.</td>
</tr>
<tr>
<td>&lt;category&gt;</td>
<td>Describes the content of the Vocabulary, for example, <em>Astronomy</em> or <em>Marketing</em>.</td>
</tr>
<tr>
<td>&lt;topic_ID&gt;</td>
<td>Sets an ID for a topic.</td>
</tr>
</tbody>
</table>

The following **nsadmin** command copies the model name (Large), the category (Nuance), and the topic ID (9005) to the **models.ini** file and copies the contents of the **myvoc** directory to \ProgramData\Nuance\NaturallySpeaking13\Data\enx\Custom9005.\n
```text
<PATH>\nsadmin /vocabulary G:\NsAdmin\myvoc "US English | Large | Nuance" 9005
```

Notes

- The default installation of *Dragon* installs Vocabularies for existing *Dragon* users in the following directory: \ProgramData\Nuance\NaturallySpeaking13\Users\<user_name>\-current
- Vocabulary files have a *.voc* file extension.
- In the Professional and Legal editions of Dragon, you can use Voctool to customize a Vocabulary. For more information on Voctool, see Customizing Vocabularies with the Dragon Vocabulary Tool (Voctool).
- If you create a User Profile on a dual core machine that uses a custom Vocabulary, make sure that the User Profile uses the BestMatch V speech model (BestMatch V has the greatest recognition accuracy on dual-core systems with more than 2 GB of RAM). To check this, select the Advance button on the Creating a User Profile screen of the New User Profile wizard and make sure that BestMatch IV is selected.
Prepare to use the command line to add a Vocabulary

1. If you have not already created it, create the data distribution directory. For more information, see Creating the Data Distribution Directory.

2. On each computer that a user uses for dictation, in a command prompt, start the nsadmin utility and use it to add the Vocabulary to the data distribution directory. Make sure to reference the network UNC address of the computer in the command. Use the following syntax for the command:

   `<PATH>\nsadmin /vocabulary <directory> "<language or dialect> | <model name> | <category>" <topic_ID>`

   The next time you open a user, Dragon automatically updates the user's Vocabularies. For more information on using the nsadmin utility, see Starting the nsadmin command line utility.

Use the command line to overwrite a Vocabulary

1. Use the /overwrite option to overwrite an existing Vocabulary file. If the Vocabulary file already exists in `\ProgramData\Nuance\NaturallySpeaking13\Data\enx\Custom9005`, Dragon overwrites it without prompting you.

   The following command overwrites the `myvoc` topic:

   `<PATH>\nsadmin /vocabulary G:\NsAdmin\myvoc "US English | Large | Nuance" 9005 /overwrite=yes`

Use the command line to add an exported Vocabulary

You can use the nsadmin utility to distribute a Vocabulary that you create using a separate installation of Dragon. A Dragon Vocabulary that you export saves as a group of files.

One of the exported files has a .top file extension, the other files have .to* file extensions, where * is an integer.

1. In a command prompt, provide the path to the file with the .top file extension as an argument to the nsadmin utility. Do NOT include the .top file extension on the command line.

   The following command adds the `myvoc` exported topic (`myvoc.top`) as a new base Vocabulary:

   `<PATH>\nsadmin /vocabulary D:\MyDocuments\myvoc "US English | Large | Nuance" 9005`

Use the command line to remove a base Vocabulary

1. On each client computer, in a command prompt, enter a command to delete the Vocabulary and the corresponding entry in `models.ini`. You cannot use Vocabularies that are based on a base Vocabulary you delete. Use the following syntax:

   `<PATH>\nsadmin /vocabulary delete <topic_ID>`

   The following nsadmin command deletes a Vocabulary with a topic id of 9005:
Adding custom commands from a command line

Custom commands are voice commands that you can create and modify to enter text, insert graphics, or activate menus and keystrokes in any application. You can use the MyCommands Editor to create custom commands or the Command Browser to modify custom commands.

You can use the nsadmin tool to copy a set of custom commands to the data distribution directory and make the set of custom commands available to all users of a particular installation of Dragon.

Before you use the nsadmin utility, you must have already created a data distribution directory, as explained in Creating the Data Distribution Directory.

Notes

- The default installation of Dragon places custom commands for existing Dragon users here:
  In Windows 7/Windows 8
  C:\ProgramData\Nuance\NaturallySpeaking13\custom<language>\NewWords.txt
- After you import the custom commands to Dragon, for the changes to become available to those users, you must close your users, then re-open and save the users.
- You can enter a path as a complete local path, a relative path, a mapped network drive, a UNC path, or the path to removable media, such as a DVD, CD, or ZIP drive. For more information, see Using paths with nsadmin.

Use the command line to add custom commands

Use the Command Browser Manage mode to export custom commands to a .dat file.

1. In Dragon, create custom commands.
2. Use the Command Browser to export the custom commands to a .dat file, for example, NewCommands.dat.
3. If you have not already created it, create the data distribution directory. For more information, see Creating the Data Distribution Directory.
4. On each computer that a user uses for dictation, in a command prompt, type a command line using the following syntax, to add the custom commands from the .dat file. Reference the network address of the data distribution directory in the command:

   <PATH>\nsadmin /commands G:\NsAdmin\NewCommands.dat

The next time you open a user, Dragon updates the commands in the User Profile for the user.

Use the command line to add custom commands to a language other than English

Use the /language option to associate commands with a non-English language.
The following command associates the NewCommands.dat file with the language of French.

```
 PATH\nsadmin /commands G:\NsAdmin\NewCommands.dat /language=fra
```

Use the command line to overwrite a custom command file

Use the /overwrite option to overwrite an existing command file.

The following command overwrites the NewCommands.dat file if it already exists in the G: \NsAdmin directory. Dragon overwrites the file without prompting you.

```
 PATH\nsadmin /commands G:\NsAdmin\NewCommands.dat /overwrite=yes
```

**Using paths with nsadmin**

When you use the nsadmin utility, you can use a path that is a complete local path, a relative path, a mapped network drive, a UNC path, or the path to removable media, such as a DVD, CD, or ZIP drive. If a path name includes spaces, you must enclose the path name in quotation marks.

When you are running nsadmin from a directory other than the one nsadmin resides in, you must provide the full path to the nsadmin.exe program on the command line.

The following command copies the NewCommands.dat file to the <drive>:\ProgramData\Nuance\NaturallySpeaking13\custom\enx\NewCommands.dat directory.

```
 PATH\nsadmin /commands \\HostComputer\NsAdmin\NewCommands.dat
```
Chapter 10: Maintaining a Dragon installation

This section contains information on the tools and procedures you can use to maintain Dragon installations, including User Profiles and vocabularies. You can also view information on resources that can help you trouble shoot issues that may occur in Dragon.

Maintaining Installations

There are several actions you can take to maintain your Dragon NaturallySpeaking installation:

- Run the **Acoustic and Language Model Optimizer** and schedules the **Optimizer** to run automatically (see Using Acoustic and Language Model Optimizer and Scheduler Tools). The Dragon service monitors the acoustic optimizer and the language model optimizer schedules and runs the optimizers according to their schedules.

- Export User Profiles from one computer and import them to another as outlined in Exporting and Importing User Profiles.

- Work with the **Dragon.log** file to determine the cause of error messages (see Handling Dragon Error Messages).

- Work with a Usability log file—create a usability log (DgnUsability.log) by pressing the **Advanced** button on the **Data** tab of the **Options** dialog box. For more information, see Working with the Usability Log.

- Work with the **Dragon** knowledge base as outlined under Accessing Dragon Knowledge Database.

- Work with the hardware compatibility list (see Hardware Compatibility List)

- Manage who has administrative privileges (see Managing Who Has Administrative Privileges).

Using Acoustic and Language Model Optimizer and Scheduler Tools

You run **Acoustic and Language Model Optimizer Scheduler** to:
- Choose to optimize the acoustic files for the User Profile
- Choose to optimize the language model for the User Profile
- Schedule one or both types of optimization to occur on a particular day or time at particular intervals
- Enable or disable the scheduled optimizations
- Separate procedures exist for running the optimization on a Non-Roaming User Profile (see Running Acoustic and Language Model Optimizer on Non-Roaming User Profiles) or a Roaming User Profile (see Running Acoustic and Language Model Optimizer on Roaming User Profiles on page 259).

Checking the optimization status of a User Profile

Dragon NaturallySpeaking checks the optimization status of a User Profile when:

- Dragon creates a User Profile and loads the profile
- Dragon loads a User Profile one week after its creation and the "Learn from" wizards have not run for the profile
- Dragon loads a User Profile and the "Learn from" wizards have not run for six months
- The Language Model Optimizer has not run in over two months
- The Acoustic Optimizer has never run and at least 1 hour worth of DRA data is available

See the Dragon Help for details.

Keeping custom words up-to-date

Using Dragon’s support for custom words, especially contact names, can make communicating with Dragon faster and more precise. To facilitate this, when Dragon loads a User Profile, Dragon examines how long it has been since the last time custom words were updated. If required, Dragon displays the Personalize Your Vocabulary dialog box to step the end-user through the custom word update process.

The Personalize Your Vocabulary dialog box contains information about the last time the "Learn from specific document" wizard and the "Learn from sent e-mails" wizard ran for the profile. The dialog also displays the total time required to run the wizards.

Users can run both the "Learn from specific document" wizard and the “Learn from sent e-mails” wizard from the dialog.

Dragon displays the Personalize Your Vocabulary dialog box:

- Two days after creating a User Profile if the "Learn from" wizards have not run for the profile
- Once a week after not running a "Learn from" wizard for 1 month or if the end-user pressed cancel the first time Dragon displays the Personalize Your Vocabulary dialog box:

Checking for User Profile maintenance when saving a User Profile

When an end-user saves a User Profile or closes Dragon, Dragon checks to make sure that scheduled language model User Profile maintenance has been performed recently. If not, then an additional check box will appear on the Save dialog. The maintenance should only
take an extra minute or two complete and is always beneficial – especially when new custom words have been added.

Running Acoustic and Language Model Optimizer on Non-Roaming User Profiles

An open local end-user cannot run the optimizer tools on User Profiles. Only an administrator can run the **Acoustic and Language Model Optimizer** or the associated **Scheduler** tools. You must have Windows Administrator privileges (at the operating system level) on the computer where you are running the **Scheduler**. If you want to optimize a Roaming User Profile on the computer where you are running the Acoustic and Language Model Optimizer, disable roaming and browse to the Master Roaming User Profile location as if it were local.

As system administrator, you are responsible for running the **Acoustic and Language Model Optimizer** on the network location of the Master Roaming User Profiles. You can install **Dragon** on the computer where the Master Roaming User Profiles are located or on any computer that has network access to the Master Roaming User Profiles, then run the **Scheduler**. Later, any optimizations that result from running these tools are copied to the Local Roaming User Profile when **Dragon** synchronizes it with the Master Roaming User Profile.

You can run the **Acoustic and Language Model Optimizer** from the Windows Start menu without opening a User Profile, or you can run it from the **DragonBar** using the **Tools** menu when a User Profile is open as indicated here.

Select **Start > All Programs > Dragon NaturallySpeaking > Dragon NaturallySpeaking Tools > Acoustic and Language Model Optimizer Scheduler**.

Running the Acoustic and Language Model Optimizer on a multi-core computer

To increase the accuracy of the User Profile, select **Audio > Launch Accuracy Tuning** from the DragonBar.

To make sure that corrections and accuracy improvements that end-users make are applied to their non-Roaming User Profile, an end-user should run the Acoustic and Language Model Optimizer on non-Roaming User Profiles only on a multi-core computer.

To run the acoustic and language model optimizers on non-Roaming User Profiles:

1. On the DragonBar, select **Profile > Open User Profile**.
2. In the **Open User Profile** dialog box, select a User Profile to run the optimization on and click **Open**.
3. On the DragonBar, select **Help > Improve my accuracy**. The Accuracy Center opens.
4. Click **Launch Accuracy Tuning now**. The **Acoustic and Language Model Optimizer** dialog box opens.
5. If the end-user has not dictated and corrected recognized text since the last time the optimizer was run, you receive this message: **There is no new data in the acoustic archive. Acoustic Optimizer does not need to be rerun**. Click **OK** and the **Acoustic and Language Model Optimizer** opens with the **Perform Acoustic Optimization** option grayed out.
6. Check the types of optimization you want to perform, **Perform Acoustic Optimization** (to optimize the acoustic files of the User Profile), **Perform Language Model Optimization** (to optimize the language model of the User Profile), or both.

7. Click **Go** to start the process. The process may take some time to complete. When the process completes, you receive a message notifying you that it has completed.

8. Click **Done**.

9. When asked if you would like to save your User Profiles click **Yes** to return to the **Accuracy Center**. Click **Exit** in the **Accuracy Center** dialog box.

---

**Running Acoustic and Language Model Optimizer on Roaming User Profiles**

To run the **Acoustic and Language Model Optimizer** on Roaming User Profiles:

1. Be sure that a copy of **Dragon** is installed on the computer where you plan to run the **Acoustic and Language Model Optimizer**.

2. Select **Start** > **All Programs** > **Dragon NaturallySpeaking** > **Dragon NaturallySpeaking Tools** > **Acoustic and Language Model Optimizer Scheduler**. The **Acoustic and Language Model Optimizer Scheduler** dialog box opens.

3. To access the master directory of the Roaming User Profiles you want to optimize, in the **Acoustic and Language Model Optimizer Scheduler** dialog box, select **File** > **Set User Directory**. The **Set a Directory Containing User Files** dialog box opens.

4. On the **Set a Directory Containing User Files** dialog box, either enter the path to the directory or click the **Browse** button and browse to the location of the **Master Roaming User Profiles**, then click **OK**. If the User Profiles you want to optimize are located in multiple directories, you can later repeat the steps outlined here and change this directory to locate the additional User Profiles.

5. In the tree of User Profiles, select the User Profile you want to optimize. Notice that if you expand that User Profile in the tree, you see one or more dictation sources under the **Acoustic Optimization** tasks in the tree. You also see the vocabulary of the User Profile under the **Language Model Optimization** tasks.

6. Before you proceed, enter your Windows user name and password. If you are logged in to a domain, you must insert the domain name in front of your user name; for example, **HospitalDB\RSessions** for the **HospitalDB** domain.

7. Click **OK**. The **Select Frequency** dialog box opens.


9. Under **User Information**, you can either select another User Profile from the **User Name** drop-down list or, to select multiple User Profiles, click the **Multiple Users** button to open the **Select User Profiles** dialog box.

   a. In the **Select User Profiles** dialog box, use the **Add** and **Remove** buttons to put the User Profiles you want to run optimization on in the Selected end-users in this task list to the right. Or you can click **Add All** or **Remove All** to add or remove all User Profiles from the list.
b. You can also move a User Profile up and down in the list by selecting a name and clicking the **Move Up** or **Move Down** button. When you are satisfied with the list, click **OK** to proceed.

10. If you selected multiple User Profiles in the previous step, skip this step. Otherwise, in the **Dictation Source** text box, select an audio input device from the drop-down list and in the **Vocabulary** text box, select a vocabulary from the drop-down list.

11. Under **Select Frequency and Start Date & Time**, select how often and at what time you want the optimization to run, as well as the first date it should run.

12. At the bottom of the dialog, click the **Enabled** (schedule task runs at specified time) check box to enable the optimization.

13. Click **Apply** to apply the changes.

14. Click **OK** to close the **Select Frequency** dialog box. The **Acoustic and Language Model Optimizer Scheduler** dialog box displays a list of the events scheduled in the right pane of its dialog box. You can create more than one optimization schedule for a single User Profile. When you do, both optimization events appear in the schedule list.

15. Click **Files > Exit** to close the acoustic and language model optimizer scheduler

### Removing One or More Optimization Schedules

To remove one or more scheduled optimizations from the scheduler:

1. Select the schedule you want to remove. You can select multiple schedules by holding the CTRL key while clicking a schedule.

2. Press the **Delete** key on your keyboard or select **Options > Delete Selected Tasks** on the toolbar.

3. Click **OK** when you are asked to confirm the deletion.

### Exporting and Importing User Profiles

You can export User Profiles on one computer and import them for use on another.

When you export a User Profile to a new location, any custom words added to a Local Roaming User Profile do not accompany the User Profiles unless you first run the **Learn from specific documents** wizard in the **Accuracy Center**.

Exporting User Profiles

To export User Profiles from **Dragon**:

1. On the **DragonBar**, select **Profile > Manage User Profiles**.

2. The **Manage User Profiles** dialog box opens.

3. Select the User Profile in the list that you want to export.

4. Click the **Advanced** button and select **Export** from the menu that appears.

5. When the **Browse For Folder** dialog box opens, navigate to the folder where you want to store the exported User Profile (or create a new folder by clicking the **Make New Folder** button) and click **OK**.

6. When a dialog box opens displaying a message indicating the export was successful, click **OK**.

7. Repeat steps 3 through 6 for each set of User Profiles you want to export.
8. Click Close to close the Manage User Profiles dialog box.
9. In the operating system, navigate to the directory where you exported the User Profiles. In that directory you find a separate folder for each exported User Profile, labeled with the user name.

Importing User Profiles

To import User Profiles into Dragon that you previously exported on a different computer:

2. Click the Advanced button and select Import from the menu.
3. When the Browse For Folder dialog box opens, navigate to the folder to retrieve a set of exported User Profiles from.
4. Select the folder in that directory that has the name of the User Profile to import and click OK.
5. If the User Profile already exists a User already exists dialog box opens and asks you to choose how to proceed: Overwrite the existing user or Import the user with an alternate name. If you choose to import the User Profile and assign it another name, enter the name in the text box provided and click OK.
6. Repeat steps 2 through 5 for each end-user whose User Profiles you want to import.
7. Click Close to close the Manage User Profiles dialog box.

Backing up and restoring a User Profile

If Dragon is unable to open your User Profile, click Launch Restore to open a backup copy of the profile. See the Dragon Help for details.

Dragon automatically creates a full User Profile backup

- after you first create your profile
- if you add a new vocabulary to your profile
- every 5th time* your profile is saved

* Backup frequency is configurable in the Options dialog box Data tab.

Dragon displays the "Dragon couldn't restore backup" message if any of the component files in a backed up User Profile are damaged or inaccessible. Data corruption can occasionally occur when Dragon loads or manipulates files, and files can be temporarily inaccessible when they are in use by another process, such as during a save operation over a network or analysis by anti-virus software.

Users can backup and restore a User Profile. The Profile Restore wizard allows end-users to choose restore a profile from a checkpoint or a backup copy.

Dragon displays the Profile Restore wizard when it cannot load a User Profile. End-users can also launch the Profile Restore wizard through the Manage User Profiles dialog box.

Dragon places corrupt profiles in to the 'BadUsers' directory located beside the 'Users' directory.

To back up a User Profile:
1. On the DragonBar, select Profile > Manage User Profiles.
2. The Manage User Profiles dialog box opens.
3. Select a User Profile in the list.
4. Click the Advanced button and select Backup.
5. Repeat steps 3 and 4 for every profile you want to back up.
6. Click Close to close the Manage User Profiles dialog box.

or

- Select Profile > Backup User Profile.

To restore a User Profile:

1. Click Launch Restore. Dragon opens the Choose a Backup to Restore window.
2. Choose the backup User Profile you want to restore from. When you backup profile opens, you can resume dictating as usual.

or

1. On the DragonBar, select Profile > Manage User Profiles.
2. The Manage User Profiles dialog box opens.
3. Click the Advanced button and select Restore.
4. When the Profile Restore dialog box opens, select a profile.
5. Click Restore.
6. Click Yes to confirm the restore or click No to cancel the action.
7. Repeat steps 4 and 6 for each profile you want to restore.
8. Click Close to close the Manage User Profiles dialog box.

or

- Select Profile > Restore User Profile.

The Dragon log file

Dragon log location

In Dragon 13, the Dragon.log file is located in the following directory:

%programdata%\Nuance\NaturallySpeaking13\logs\WindowsUserName.

- WindowsUserName is the name of the user that is sending messages to the log service.

Dragon log filename format

The Dragon log filename format is “Dragon_Date_Time.log”:

- Date: the date when the file was created in YYYYMMDD format.
- Time: HHMMSS in 24-hour format.
The log file is named “Dragon.log” when the log services is updating the file. When the log file is closed, the log service renames the file using the “Dragon_Date_Time.log” format.

For example: “Dragon_20130820_105023.log”: This Dragon log was created on the 20th of August, 2013, 10:50:23.

The full path to this log file is:

```
%programdata%\Nuance\NaturallySpeaking13\logs\Admin\Dragon_20130820_105023.log
```

**Dragon log management**

The log service manages the Dragon log files; creating new log files and deleting old ones. The service creates a new log file when the current file exceeds the size limit of 10 MB.

The service stores the last 10 log files.

**Manually creating a new Dragon log file**

An administrator can start a new Dragon log file when Dragon starts.

In the nssystem.ini file, set the following parameter:

```
[Settings]
New Log On Startup=1
```

1. Open text editing software such as Notepad. On Windows 7, or Windows 8, make sure you have administrator rights when you open the text editor (use the “Run as administrator” option to open the text editor).
2. In the text editor, navigate to the folder that contains the nssystem.ini file. In Windows 7 and Windows 8, by default, the nssystem.ini file is located in:

   C:\ProgramData\Nuance\NaturallySpeaking13

3. In the text editor, open the nssystem.ini file.
4. In the “[Settings]” section, add the following line of text: **New Log On Startup=1**.
5. Save and close the nssystem.ini file.
6. To activate the setting, re-open the User Profile.

**Handling Dragon Error Messages**

When Dragon displays an error message:

1. Read the message carefully. It may give you enough information to determine what to do.
2. If you dictated text into your document, click **Close** to close the error message box and then save your document.
3. Do not save your User Profiles.
4. Copy the error message log file (**Dragon.log**) to a safe place. To locate this file, click **Start > Programs > Dragon NaturallySpeaking > Show Dragon Log**. In Dragon 13, the Dragon.log file is located in the following directory:

   `%programdata%\Nuance\NaturallySpeaking13\logs\WindowsUserName`

   WindowsUserName is the name of the user that is sending messages to the log service.
5. Exit Dragon and start it again. In some cases it may be necessary to restart your computer.

6. Insert your Dragon DVD into your DVD reader, run the installation program again, and choose the Repair option on the first screen of the Dragon setup program. After setup finishes, reinstall any Dragon patches that were previously installed.

7. If the error message does not provide enough information to determine what to do, search our Web site for information on the error message. You may find a solution that can save you time and trouble:

Working with the Usability Log

In Dragon NaturallySpeaking, you can set up Dragon to create a usability log that logs all menu commands, toolbar buttons, and voice commands that you use during a dictation session.

To set up a usability log:

1. With a User Profile open, on the DragonBar, select Tools > Options.
2. Click the Data tab.
3. Click the Advanced button.
4. When the Advanced dialog box opens, check the Create usability log check box and click OK to return to the Data tab.
5. Click Apply and then click OK to close the Data tab of the Options dialog box.

The log is located here:
C:\ProgramData\Nuance\NaturallySpeaking13\logs.

See Dragon file structure for information on default locations on Windows 8 and other operating systems.

Accessing the Dragon Knowledge Database

Solutions to known problems with Dragon are provided at the Nuance Knowledge Base, located at http://nuance.custhelp.com/.

To locate and use the Dragon Knowledge Database:


1. In the Search by Product drop-down list, select Dragon NaturallySpeaking.
2. In the field that appears below the Search by Product field, select the Dragon version number.
3. In the next field that appears, select the Dragon edition.
4. In the Refine by Category drop-down list, select a category to further refine the search criteria.
5. In the Search by Keyword field, type the words that would be expected to be found in the pages that contain the answer. Do not use words such as "how", "why", "the", "in", or "on".
3. Beside the Search by Keyword field, click the magnifying glass to start the search.

Managing end-user administrative privileges

Before You Give Windows Administrator Privileges

Before you decide to give a Dragon user Windows Administrator privileges on a laptop computer, note that you are giving that person access to the Administrative Settings dialog box on that computer.

Determining Logged In User Has Admin Privileges

If the logged in end-user has Windows Administrator privileges, the following line appears in the Dragon.log file after he or she logs in:

2014-07-28|23:26:02.485| LEGACY| 1392| 5180|I|LOG (MainWin): Windows user has administrative access to NatSpeak
Chapter 11: Working with Custom commands

This section contains information on how you can use tools in Dragon to control access to your custom commands.

Managing and Securing Custom Commands

Make your custom commands more secure in two ways:

To prevent users from editing command files, convert any XML files of commands to DAT format. For details see Using the Convert XML to DAT tool.

To prevent any Dragon end-users from editing the commands, lock the commands and then import them. For details see Using the MyCommands Protection Utility.

Using the Convert XML to DAT tool

You can use a text editor to edit commands that are in XML format. To allow only Dragon end-user to access those command files, you can convert them from XML format to DAT format. Dragon uses .dat files to store commands.

You can use the XML to DAT tool (mycmdxml2dat.exe) to extract end-user-defined Dragon commands from an XML file. The tool writes the commands to a .dat file. Use the nsadmin utility or the Data Distribution Tool to make the new .dat files available to those other end-users.

Starting the Convert XML to DAT tool

- In Dragon NaturallySpeaking:

  Start > All Programs > Dragon NaturallySpeaking > Dragon NaturallySpeaking Tools > Convert XML to DAT

The Convert XML to DAT tool starts in an MS-DOS window, listing the tool's syntax.
Convert XML to DAT syntax

Convert XML to DAT (mycmdsxml2dat.exe) uses the following syntax:

```
mycmdsxml2dat.exe <dat-file-path> <xml-file-path> [options]
```

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;dat-file-path&gt;</td>
<td>Required</td>
<td>The full path to the local copy of the current end-user’s .DAT file</td>
</tr>
<tr>
<td>&lt;xml-file-path&gt;</td>
<td>Required</td>
<td>The full path to the .XML file</td>
</tr>
<tr>
<td>-v</td>
<td>Optional</td>
<td>Validates the specified .xml file over the Internet with a Nuance DTD (Document Type Definition) file. Disabled by default.</td>
</tr>
</tbody>
</table>

Use the XML to DAT tool to convert data in an XML file

1. Create an XML file that contains the commands to use with Dragon.
2. On a command line, use mycmdsXML2DAT.exe to convert the XML file to DAT format.
3. Use the nsadmin utility or the Data Distribution Tool to copy the .dat file to the data distribution directory.

The next time you open a User Profile, Dragon incorporates the new commands from the .dat file into the User Profile.

For more information, see:

- Adding custom commands (nsadmin)
- Adding and removing custom commands (Data Distribution Tool)

Using the MyCommands Protection Utility

In Dragon Professional and higher, you can export a set of custom Text-and-Graphics, Step-by-Step, Macro Recorder, and/or Advanced Scripting commands into a .dat file, so that after an end-user imports them, that end-user can dictate the commands but cannot view their source code, edit their source code, or re-export the commands. As a result, the integrity of the commands remains intact.

To protect the commands in a .dat file:

1. Make a backup copy of the unprotected .dat file and store it in a secure location. You later use that file to edit the commands, because once you protect the .dat file that you are distributing, you cannot make the file available for editing again.
2. Select Start > Run and enter cmd into the Run dialog box.
3. Change directories to:
   C:\Program Files (x86)\Nuance\NaturallySpeaking13\Program

See Dragon file structure for information on default location on Windows 7 and 8 and other operating systems.
4. Enter the following on the command line:
   `protectcmds.exe <dat-file-path> <vendor-name> [<vendor-contact-info>]`

5. Once you press return, after an end-user imports these commands, if that end-user
   attempts to view, copy, or edit any of them, the following message indicates that the com-
   mands cannot be edited:
   
   **The command was protected by** <vendor-name>.  
   **Please contact** <vendor-contact-info> **for more information.**

In the **Command Browser**, the same message appears as the **Preview Content** in **Script**
mode.

Once you have protected the file, you can put it into the **Data Distribution** directory for
distribution to multiple User Profiles. For more information about distributing saved
commands, refer to **Creating the Data Distribution Directory**, then refer to one of the
following topics about distributing commands to multiple User Profiles by either:

- Using the **Data Distribution Tool** (**Data Distribution Tool: Adding and removing
  custom commands**)
- Using the **nsadmin** command line tool (**nsadmin: Adding custom commands**)
Chapter 12: Commands that perform actions based on the application state

This section contains information how to create and use structured commands that perform actions based on the state of the application.

About Structured Commands

Dragon includes an extension to text and graphics commands that lets you set the values of variables in text blocks based on voice input.

You can create simple text and graphics commands with variables in the My Commands Editor dialog box without having to do extensive programming in Microsoft® VBA.

Application states

Structured commands let you control the action of a command based on the existence of a state in the application. For example, when you assign a state to each field in a form, the same command can perform different actions depending on which field is activated.

You can use Advanced Scripting methods to control the states within structured commands or to set the initial state from a non-structured command. You can also create structured commands that prompt the user to select values from a predefined list.

When the user speaks a command, the user is presented with a list of pre-defined values for the command. Once the user selects a value, the value is inserted into the correct location in the macro.

Samples

Dragon includes several sample text and graphics commands with variables and sample structured commands. You can import the samples into Dragon to use them as templates for your own commands. The sample commands are fully commented.

For more information, see:
Structured Commands Samples

Importing Sample Commands

Methods

For more information on the methods used by the sample commands, refer to the following:

- Global Methods
  - SetState
  - GetState
- EngineControl Methods
  - MyCommandsActiveState
  - PromptValue

Structured Commands Samples

Dragon includes several sample text and graphics commands with variables and sample structured commands. You can import the samples into Dragon to use them as templates for your own commands. The sample commands are fully commented.

Sample location

The sample commands are installed in:

- **Windows 7, Windows 8:**
  \ProgramData\Nuance\NaturallySpeaking13\custom\<language>\samplecommands

A shortcut to this directory is available on the Windows Start menu. To open this directory, click Start > All Programs > Dragon NaturallySpeaking > MyCommands Samples. In Windows 8 My Commands Samples can be opened from the Apps screen.

Importing Sample Commands

You can import the samples into Dragon to use them as templates for your own commands. For information, see Importing Sample Commands

Samples

The following samples are included with Dragon:

**GroceryListSample_DragonPad**

GroceryListSample_DragonPad.xml contains Advanced Scripting commands that simulate an on-line grocery order form in DragonPad. It demonstrates how to set and change command states, activating and deactivating various state structured commands, and how to use the command prompt. The voice command "Prepare Grocery List" causes the first section of a grocery list to display in DragonPad and sets a command state. Each section of the grocery list is designed to have a separate state. The voice command "What's Available" will prompt the user with a set of grocery list commands that are active in the given section.
Chapter 12: Commands that perform actions based on the application state

**GroceryListSample_WordPad**

GroceryListSample_WordPad.xml contains Advanced Scripting commands similar to those of GroceryListSample_DragonPad.xml. It demonstrates how to set and change command states and to use the command prompt in WordPad and uses a different coding style. The same voice command "Prepare Grocery List" will start the grocery list in WordPad, activate the initial grocery list state, and prompt the user with a set of grocery list commands that are active in the given state. To read more about this sample and its commands, refer to the code comments in the XML file.

**SampleBoilerPlate_ColonCancer**

SampleBoilerPlate_ColonCancer.xml contains Advanced Scripting commands that demonstrate how to use structured commands and the command prompt for boilerplate text. This sample is modeled after a colon cancer checklist and is designed to work in Microsoft Word. The voice command "Colon Cancer Checklist" causes the boilerplate text to display and takes the user, field by field, through the checklist.

**SampleBoilerPlate_EndoBiopsy**

SampleBoilerPlate_EndoBiopsy.xml contains a single Advanced Scripting macro that demonstrates how to set up boilerplate text and use the command prompt to guide users in filling the boilerplate text without using states. This sample is modeled after an endoscopic biopsy report and is designed to work in Microsoft Word 2003 or 2007. The voice command "Prepare Endoscopic Biopsy Gross Template" causes the boilerplate text to display and takes the user, field by field, through the report.

**SampleTGV_Restaurant**

SampleTGV_Restaurant.xml contains Text and Graphics and Advanced Scripting commands that are used in DragonPad to simulate an ordering system for a Chinese and Japanese restaurant. This sample demonstrates how to set states for structured commands as well as how the same commands can be used to produce different results in different states. The voice command "Chinese Menu" or "Japanese Menu" starts the ordering system and activates the structured commands created for the given state. The voice command "Exit Ordering System" ends the ordering session.

**SetStateSample**

SetStateSample.xml contains simple Text and Graphics commands that demonstrate how to use variables and text formats and Advanced Scripting commands to set and unset a command state. This sample is designed to work in DragonPad with the initial command "Sample Set State." When the command executes, a command state is set for DragonPad and a simple exchange of greetings is simulated between the user and the system. The user speaks the greeting, e.g. "Good Morning", and the system responds in bold red text. When the user says "Good-bye", the exchange is terminated and the command state is unset.

**SampleInjuryReport**

SampleInjuryReport.xml together with SampleInjuryReport.dot demonstrates how structured commands and Microsoft Word templates can be used together to create a voice-enabled form filling environment. The template is a mock injury report with several text and checkbox fields can be filled using the commands included in the XML file. You start a form filling session with the voice command "Edit Report" spoken in a new...
Importing Structured Commands

You can import existing structured commands, such as the Structured Commands Samples, into Dragon to use as templates for your own commands. Use the following procedure to import the sample structured commands that are supplied with Dragon:

To import the sample structured commands:

1. On the New DragonBar or Classic DragonBarTools menu, click Command Browser to open the Command Browser window.
2. Click the Manage button on the Command Browser toolbar.
3. In the Manage area, click the Import button, and in the Import Commands window choose MyCommands XML files from the Files of type list.
4. Use the Import Commands window to browse to the directory. You'll find it in the following location:
   - Windows 7, Windows 8:
     \ProgramData\Nuance\NaturallySpeaking13\custom\<language>\samplecommands
5. Select one of the sample .XML files (for example, sampletgv_restaurant.xml) and click Open.
6. Click Yes on the Import Commands validation dialog box and then click Import on the Import Commands window to import the commands contained in the file.

   Note: The syntax of XML command files is defined by a document type definition (DTD) file that resides on the Nuance Web site. When you import an XML command file, the application gives you the option of validating the syntax of the XML file against the DTD. The validation step is useful if you receive a XML command file from another person and want to check it for syntax errors prior to importing it.
7. Click OK on the success message and return to the Manage area of the Command Browser.

To examine the sample code

1. Open the Command Browser and click the Manage button.
2. Expand and select the appropriate item (for example, "<restaurant_type> Menu")
3. Click the To Script button and then click the Edit button.

The My Commands Editor dialog box opens with the command you selected entered into it. You can examine and modify the command with the My Commands Editor.
Chapter 13: Configuring administrative features in Dragon

This section contains information how to use the Administrative options, in the Administrative Settings dialog box, to set and control many administrative features in Dragon.

Summaries of Administrative Settings Dialog Boxes

The tabs in the Administrative Settings dialog box are:

- Roaming
- Miscellaneous
- Scheduled Tasks

For more on each tab, see the corresponding topic below:

- Administrative Settings: Roaming tab
- Administrative Settings: Miscellaneous tab
- Administrative Settings: Scheduled Tasks tab

Administrative Settings: Roaming tab

You use the Roaming tab of the Administrative Settings dialog box to set up the Roaming feature. You must set up the Roaming feature on each computer where you want end-users to dictate with a Roaming User Profile.

When Roaming is enabled in Administrative Settings by default the Open User Profiles dialog box displays large numbers of User Profiles quickly. They can also be organized into subfolders. See "Creating subfolders for Roaming User Profiles" in the Dragon Help for more information.

Enable

Select Enable to activate the Roaming feature and the Roaming User Profile options.

Network Directories

To set the location of the master Roaming User Profile(s):
1. Click the Add button. You use the Roaming User Network Location dialog box to define the network location of the master Roaming User Profiles. The location you pick must be accessible to all computers on the network that you want available for dictation with Dragon.

2. Set the Display Name and the Address under Network Location. The Roaming feature supports the following types of locations:
   - Mapped Drive—the format is: <drive letter>:\<folder name>. For example, y:\roaming.
   - UNC Path—the format is: \server\name\share\path\filename.
   - HTTP (http:)—the format is: http://myserver.com/<name_of_virtualdirectory> where <name_of_virtualdirectory> is the name of the virtual directory set up by an administrator during setup of the IIS or Apache web site. For HTTP locations, click the HTTP Settings button to set information specific to your HTTP connection. You can also test your connection to the HTTP server from the HTTP Settings dialog box.
   - HTTP with SSL (https:)—the format is: https://myserver.com/<name_of_virtualdirectory> where <name_of_virtualdirectory> is the name of the virtual directory set up by an administrator during setup of the IIS or Apache web site. For HTTP with SSL locations, click the SSL Settings button to set information specific to your HTTP with SSL connection. You can also test your connection to the HTTP with SSL server from the SSL Settings dialog box.

Local directory (for cache)

When an end-user opens a Master Roaming User Profile, Dragon transfers a copy of that User Profile to the local computer. The local copy is called the Local Roaming User Profile.

You can change the setting of this location, always called <Roaming Local>.

The default location of <Roaming Local> is:

C:\ProgramData\Nuance\NaturallySpeaking13\RoamingUsers\<display name>\<username>

See Dragon file structure for information about the default location of the RoamingUsers directory for Dragon NaturallySpeaking13 on other Windows operating systems.

The <display name> is a name you assigned as a Master Roaming User Profiles location. You can have multiple network storage locations for your Master Roaming User Profiles.

The <username> is the name of an individual Master Roaming User Profile. There is a separate directory for each User Profile.

Click the Browse button to find or create a new location.

Check Boxes for Roaming User options

The check boxes and other components below the Local directory are the Roaming User options. You can also configure the Open User Profiles dialog box to display the Classic Open User Profiles dialog if desired. See Selecting Roaming User Profile options for details.
Chapter 13: Configuring administrative features in Dragon

Restore Defaults

Returns the Administrative Settings dialog box to the state it had when you first installed Dragon. Note that the default is to have the Roaming feature turned off.

Notes: For use of WebDAV

- After you install Internet Information Services and WebDAV, you need to use the Internet Information Services Manager tool to set the “Allow Unknown MIME Types”, “Allow Custom Properties”, and “Allow Property Queries with Infinite Depth” settings to true. For example, in IIS 7:

![WebDAV Settings](image)

- For more information, see Configuring Internet Information Services and WebDAV for HTTP Roaming.

- If you connected to your Roaming User Profile Master Directory over HTTP and you find that not all your User Profiles are listed in the Open User Profile dialog box, or after creating a Roaming User Profile you cannot open it again, or the Open User Profile dialog box does not display all the vocabularies and acoustic models for your User Profiles, make sure that you:
  - Check that no files in your User Profile directory are locked, password protected, or otherwise access-restricted by your server permissions.
Administrative Settings: Roaming User Network Location

You use the Roaming User Network Location dialog box to define the network location of the master Roaming User Profiles.

The location you pick must be accessible to all computers where end-users will dictate using a Roaming User Profile.

Display Name

Sets the directory name displayed in the following locations:

- The Roaming tab of the Administrative Settings dialog box
- The Location of user profile drop-down list in the Open User Profile dialog box.

**Note:** With the Roaming feature enabled, the Open User Profile dialog box displays only User Profiles in the Roaming User Profile locations. To let the end-users open both local (non-roaming) and Roaming User Profiles, select the Allow non-roaming user profiles to be opened option on the Administrative Settings dialog box. Clearing this option prevents end-users from dictating with a non-roaming (local) User Profile by accident. For more information, see Enabling the Roaming feature on each computer where an end-user will dictate.

- The Location of user profile drop-down list in the Manage User Profiles dialog box.

Network Location—Address

On each computer where you plan to have users dictating as Roaming users, you must tell that installation of Dragon where the Master Roaming User Profiles are located.

The Roaming feature supports the following types of locations:

**Mapped Drives and UNC Paths**

Mapped drives connect to a shared network folder that has a drive letter assigned to it.

UNC paths connect to a shared network folder using the Universal Naming Convention (UNC) to locate a User Profile. The UNC is a way to identify a shared file on a computer or network without having to know the storage device it is on. The UNC path format is: \servername\sharename\path\filename.

To use a mapped drive or UNC path:

1. **Under Network Location**, enter the address of the mapped drive or UNC path. You can click Browse to browse for the location of the mapped drive or UNC path. This displays the Browse for Folder dialog box. You can also create a new directory on the mapped drive or UNC path by clicking the Make New Folder button.

2. **Click OK** when you are done.

**Intranet/Internet connections**

The Intranet/Internet connection supports both HTTP and HTTPS over an encrypted Secure Sockets Layer (SSL).

To use an Intranet/Internet connection:
Chapter 13: Configuring administrative features in Dragon

1. Under **Network Location**, enter the URL address of your HTTP or HTTPS server where your master Roaming User Profiles are located.

2. Click
   - **HTTP Settings**... to display the **HTTP Settings** dialog box, where you can set information specific to your HTTP connection like Authentication, Firewall, and Proxy Server information. You can also test your connection to the HTTP server from this dialog box. For more information, see HTTP Settings.
   - **SSL Settings**... to display the **SSL Settings** dialog box, where you can set information specific to your HTTPS (SSL) connection. You can also test your connection to the HTTPS server from this dialog box. For more information, see SSL Settings.

**Note:** You cannot create a non-Roaming User Profile on an HTTP or HTTPS connection. You can create only Roaming User Profiles on an HTTP or HTTPS connection and only when the Roaming feature is enabled.

**Administrative Settings: Miscellaneous tab**

The **Miscellaneous** tab of the **Administrative settings** dialog box contains the following options:

**Backup location for User Profiles**

Shows the location where Dragon will save backup User Profiles.

- Click the **Change** button to open a dialog box where you can specify a new location.
- Click the **Use Default** button if you want Dragon to use each Windows user's My Documents folder.

You can change the **Backup Location for User Profiles** to any directory where Windows has both read and write permissions, including portable devices such as Zip drives and CD/DVD burners. If you change the location, backups for all User Profiles will be located in the same directory.

**Data Distribution location**

Shows the location where the local installation of Dragon stores customized words and commands.

- Click the **Change** button to open a dialog box where you can specify the location for this directory.
- Click the **Use Default** button to set the location to this default path:

```
C:\ProgramData\Nuance\NaturallySpeaking13\custom
```

You can change the **Data Distribution location** to any directory where Windows has both read and write permissions, including portable devices such as Zip drives and CD/DVD burners.

For a default installation, custom words and commands are located in:

- **Windows 7, Windows 8, and Windows Server 2008:**
  
  ```
  C:\ProgramData\Nuance\NaturallySpeaking13\custom\<language>
  ```
Check for product updates at startup

Automatically looks on the Nuance Web every time you start Dragon. Any change to this option does not take effect until you restart Dragon.

Do not allow restricted users to add or modify commands

Select this check box to prevent restricted Windows users from adding or modifying Dragon commands. Selecting this option allows only end-users logged on with administrator privileges to add or modify commands.

Disable use of Macro Recorder Commands

Select this box to prevent end-users from using macro recorder commands. End-users can still run the commands.

Disable use of Step-by-Step Commands

Select this box to prevent User Profiles from using step-by-step commands. End-users can still run the commands.

Disable use of Advanced Scripting Commands

Select this box to prevent User Profiles from using advanced scripting commands. End-users can still run the commands.

Do not allow restricted users to modify Vocabularies

Select this check box to prevent restricted Windows users from modifying Dragon Vocabularies. Selecting this option allows only end-users logged on with administrator privileges to modify Vocabularies.

Record wave data between utterances

Select this option to capture all dictation, preserving all audio including any pauses, filler speech like "ums" and "ahs", extraneous noises, and anything else the speaker may do like cough or laugh.

Correction Only Mode (no dictation available)

Select this option to enable Correction Only Mode.

Correction Only Mode allows transcriptionists to play back a speaker's dictation without having their User Profile loaded. Note that dictation is disabled if you select this option.

Note: You must disable Correction Only mode before running the Acoustic and Language Model Optimizer.

Disable automatic acoustic model selection in the Acoustic Optimizer

Running the Acoustic Optimizer updates your User Profiles with accumulated acoustic data from any corrections and additional training end-users may have done. Running Acoustic Optimization increases your overall accuracy. In the process of increasing your accuracy, Acoustic Optimization may select a different acoustic model for your User Profile. For example, if you chose a General accent during User Profile setup, Dragon may change it if your speech more closely matches another accent. For more information, see "About speech and acoustic models" in the Dragon Help.

Select this option to disable the Acoustic Optimizer from selecting a different acoustic model when run.
If you are using Dragon NaturallySpeaking, see Using multiple acoustic models with a User Profile for information on acoustic model selection and User Profiles that use two acoustic models.

**Restore Defaults**

Returns the current tab to the state it had when you first installed Dragon. The button does not affect to other tabs, including the Roaming tab.

**Notes**

- When the User Profile is closed, you cannot use Dragon to dictate or to perform actions by voice.
- You must have administrator privileges to change the Backup Location. Dragon will not let restricted end-users create backup files in directories reserved for the operating system (for example, the Windows directory). When specifying a backup location, make sure that directory can be accessed by all end-users.
- In some versions of Windows, you must be logged on as the administrator before you can access this dialog box.
- In some situations, an end-user that does not have administrator privileges may have access to options on this dialog that they would not normally have.
- Dragon NaturallySpeaking allows you to use the Universal Naming Convention (UNC) to locate a User Profile. The UNC is a way to identify a shared file on a computer or network without having to know the storage device it is on. The format is: `\servername\sharename\path\filename`.

**Administrative Settings: Scheduled Tasks tab**

The Scheduled Tasks tab of the Administrative settings dialog box allows you to schedule Accuracy Tuning and Data Collection for all User Profiles created with this installation of Dragon NaturallySpeaking. Data collection is available in non-US English versions of Dragon NaturallySpeaking.

**Accuracy Tuning**

Schedule Accuracy Tuning to help Dragon to learn from you and make your dictation more accurate. Accuracy Tuning runs the Acoustic and Language Model Optimizer to update your User Profile with

- frequently dictated word sequences
- acoustic data from any corrections you make, including with the keyboard
- trained words
- commands used
- any additional training you perform

**Enable scheduled Accuracy Tuning**

Check to turn on periodic scheduled acoustic model tuning for all end-users.

Clear this checkbox if you want to disable Accuracy Tuning for the User Profile. The setting is enabled by default.
Configure

Click **Configure** to open the **Select Frequency, Data Collection** tab and set the Data Collection schedule. You are immediately asked to log in with your Windows Administrator password to make a schedule change. After you log in, you can set one schedule for **Acoustic** model tuning and another for **Language Model** tuning by clicking the appropriate tab and choosing **Daily, Weekly, or Monthly** and the start date and time.

Data Collection

Data collection is available in non-US English versions of Dragon NaturallySpeaking.

Enable Scheduled Data Collection—Check to allow Nuance to collect up to 500 MB of acoustic data and text from your dictation sessions. Once the data is collected, you have the option of sending it to Nuance to help improve the accuracy of future versions of Dragon Professional. No personal information is ever sent to Nuance and participation is voluntary.

- Click **Configure** to set the schedule for data collection. You are immediately asked to log in with your Windows Administrator password to make a schedule change. After you log in, you can choose **Daily, Weekly, or Monthly** and the start date and time.

Let the user choose when to run Accuracy Tuning and Data Collection—Check to give end-users access to this tab, effectively allowing them to change the schedules for Accuracy Tuning and Data Collection.

Restore Defaults

Click this button to restore the default values for Data Collection and Periodic Optimization.

Notes:

- When the User Profile is closed, you cannot use Dragon to dictate or to perform actions by voice.
- Scheduled Accuracy Tuning and Data Collection cannot run if Dragon is open, including if Dragon is running in QuickStart mode, if Dragon is left open with no User Profile loaded, or if Dragon is left open by another end-user in a separate Windows session on the same computer.
- Since Dragon uses a local system account to schedule periodic tasks, User Profiles placed on network shares will not be available for scheduled Accuracy Tuning and Data Collection unless special arrangements are made with the network administrator.

For more information, see the following topics in the Dragon Help:

- "About the Acoustic and Language Model Optimizer" for information about Accuracy Tuning.
- "About Data Collection" for more information about Data Collection.
- The "Options dialog box Data tab" for more information about scheduling Accuracy Tuning and Data Collection for the current Dragon User Profile.
.DRA files (definition)
Dragon Recorded Audio (DRA) files. By default, Dragon automatically saves audio and text transcripts of your dictation in the DRA files.

Accuracy Center (definition)
Offers a central location for tools and information you can use to ensure recognition. The link in the description of each feature opens a topic describing that feature more completely. Say “display Accuracy Center” or click “Improve my accuracy” on the DragonBar Help menu.

Accuracy Tuning (definition)
A process Dragon can use to adapt to your usage. Once you have been dictating for a period of time, Dragon uses Accuracy Tuning to automatically refine your User Profile, analyzing your dictation, corrections, and any other acoustic training you have done. Accuracy Tuning uses two of Dragon’s accuracy tools, the Acoustic Optimizer and the Language Model Optimizer.

Acoustic Optimizer (definition)
Looks for any corrections you have made or additional training you may have performed. Optimization enhances recognition accuracy and helps predict words most likely spoken in a given context by a speaker (the language model).

Advanced Scripting (definition)
Supports using programming languages such as Microsoft® VBA to create commands that can perform virtually any function on the computer with voice commands.

Commands-only Vocabulary (definition)
A restricted Vocabulary containing only words and phrases that Dragon recognizes as commands. Choose this way of dictation if you want to use Dragon only for command and control of programs and not for dictation.
Command Browser (definition)
A window showing voice commands that Dragon recognizes, including commands that are provided with the software as well as any commands that you or your system administrator might have added (custom commands). The Command Browser is the most comprehensive place to see the commands that are available in each application.

Correction menu (definition)
Shows Dragon’s best guess for alternatives to words you dictated and selected. Choose the correct word from the Correction menu by saying “Choose” and the number next to your choice.

Command Mode (definition)
A restricted recognition mode that causes Dragon to interpret everything you say as a command and nothing is interpreted as dictated text. Say "Start Command Mode" or "Command Mode On".

Correction-only mode (definition)
Enables transcriptionists to play back a Dragon end-user’s dictation without having their User Profile loaded. Note that dictation is disabled if you select this option.

Data Distribution Tool (definition)
Enables developers to interactively create new words, customized Vocabularies or commands, and to make them available to all User Profiles on a particular Dragon installation.

Dictation Box (definition)
Provides full support for dictating and editing text in non-standard windows. The Dictation Box supports voice commands like Delete, Correct, and Insert, and custom commands as well. When you are finished, the content is transferred to the non-standard window where your cursor was positioned when you opened the Dictation Box. The Dictation Box can be anchored or unanchored.

Dictation Mode (definition)
A restricted recognition mode that causes Dragon to interpret everything you say as dictation and nothing is interpreted as a command. Dictation Mode can be helpful if you want to dictate as quickly as possible, or dictate without looking at the words Dragon transcribes. Say "Start Dictation Mode" or "Dictation Mode On".

Dictation Source (definition)
An audio input device or multiple devices associated with a User Profile. An end-user can select a headset microphone at one computer, an array microphone at another, and a portable recorder for transcription at several computers. This way, Dragon supports end-users that need to move, or “roam”, from computer to computer regardless of the microphone type or differences in ambient noise.
Dragon Web Extension (definition)

Enables page element commands such as "Click Link" and "Click Button" and Full Text Control in supported browsers and Web-based applications. With the Dragon Web Extension installed and enabled, you can dictate content and use commands just as you would in a desktop program. Without the extension, you'll need to click Web page elements using your mouse and keyboard, and dictate content using the Dictation Box.

DragonPad (definition)

Dragon’s built-in word processor, optimized for dictation and includes basic text formatting features as well as the ability to save and print documents.

Full Text Control (definition)

Refers to the level of dictation support available in Web and desktop programs and windows when Dragon fully supports creating, editing, and formatting content. When a program or part of a program has Full Text Control, you can move the cursor reliably – for example, to the beginning or end of a line or paragraph. You can also select, format, and revise text as needed using Direct Editing commands, the Correction menu, or the Spelling Window.

For supported Web applications, Full Text Control is activated using the Dragon web extension in supported browsers.

When the cursor is in a text field for which Dragon has Full Text Control, the Text Control Indicator on the Classic DragonBar or the New DragonBar is green when all of Dragon’s selection and dictation capabilities are supported.

Language Model optimization (definition)

Updates the language model of the current Vocabulary. Language Model Optimization uses text Dragon extracts from the .DRA files that are created when you correct words. Based on the speech data collected, Language Model Optimization applies modifications to the language model to reflect your word usage.

Language Model Optimizer (definition)

Performs Language Model Optimization from the Accuracy Center. Any Dragon end-user with administrator privileges can schedule Dragon to perform optimization periodically.

Normal Mode (definition)

Dragon's default mode of dictation. In Normal Mode, Dragon distinguishes dictation from words, numbers, and commands by analyzing what you say between pauses. Say "Start Normal Mode" or "Normal Mode On".

Numbers mode (definition)

A restricted recognition mode that causes Dragon to recognize only numbers, commands, and punctuation. If you are dictating only numbers (including currencies), working in this mode increases recognition accuracy. Say "Start Numbers Mode" or "Numbers Mode On".
QuickStart (definition)

Allows Dragon to load in the background when you start your computer or log in to your operating system, depending on your version of Windows. When Dragon is launched in QuickStart mode, Dragon is available for use more quickly than when you start in normal mode. The microphone icon appears in the system tray.

Recognition Modes (definition)

By default, Dragon functions in Normal Mode, distinguishing dictation from words, numbers, and commands, and analyzing what it hears between pauses. Dragon also offers restricted recognition modes for dictating only commands (Command Mode), numbers (Numbers Mode), characters (Spell Mode), or words (Dictation Mode).

Roaming User (definition)

Enables you to dictate with Dragon from different network locations and on different computers without having to create and train individual User Profiles at each location. User Profiles are stored in a network location available to all computers on the network, so that the information Dragon learns from an end-user dictating on one computer is also available to the same end-user when they log in on other computers.

Spell Mode (definition)

A restricted recognition mode that causes Dragon to recognize only letters, numbers, commands, and punctuation. Spell mode is useful for dictating unpronounceable alphanumeric strings, such as part numbers and license plate numbers, and other terms you anticipate Dragon may not recognize, such as Web addresses, words in a foreign language, or unusual product names. Say "Start Spell Mode" or "Spell Mode On". You can still use commands while in Spell Mode.

User Profile (definition)

A set of files created the first time you use Dragon, which is subsequently used to reflect your characteristics and adapt to your usage. Each person who uses Dragon must have a User Profile, which the software stores in a set of files containing, among other things, acoustic and lexical data. These data contain information about how you sound, and the words you use, and how often you use them. When you add a word to your Dragon Vocabulary, make corrections, read a training text, or change a setting in the Options dialog, Dragon can save these refinements in your User Profile. If your edition of Dragon supports custom commands, these are also saved in the User Profile.

Web application support (definition)

Provides the Dragon web extension in supported Web browsers to enable commands and Full Text Control for selected browser-based applications. With the Dragon web extension installed and enabled, you can dictate content and use commands just as you would in a desktop program.